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Introduction to Ultimus BPM 
Studio   
BPM Studio Overview  
  

Ultimus BPM Studio is a next-generation BPM IDE (Integrated Design 
Environment). It includes all of the capabilities currently found in both Ultimus 
Builder and Ultimus Process Designer. By combining the capabilities of these 
products, process design participants now have one place to go to design, 
model, develop, simulate, and test every business process.  

Note: For users that simply wish to model processes in a standalone 
fashion, and do not require the more powerful BPM Studio module, 
Process Designer will continue to be made available as a standalone 
module. 

Beyond this, Ultimus BPM Studio also changes the way teams work on business 
processes. In the past, the parties involved in BPM development (process 
analysts, owners, designers, and developers) all worked independently using 
their own tools. Collaboration occurred off-line in conference rooms and e-mail. 
With Ultimus BPM Studio, these parties now have a unified environment that 
supports multiple editing tools (e.g. Ultimus Form Designer, Visual Studio.NET) 
appropriate to the user role, provides a shared repository that improves process 
integrity, and enables on-line collaboration (e.g. multiple users working on 
different parts of the same process through the new Ultimus Inlets capability). 
The expected result of this new environment is more efficient and effective 
process teams and reduced total cost of ownership for the entire Ultimus BPM 
Studio.  
  



BPM Studio New Features 
The sections in this chapter provide a high-level overview of the key new features 
of the Ultimus BPM Studio. Some of these features include: 

• Support for collaborative design of business processes across the Internet 
or intranets. 

• The ability to check-in and check-out processes and objects with full 
support for versioning.  

• Powerful capabilities for leveraging Web Services and .Net Code (C#, 
VB.NET, ASP.NET) in Ultimus business processes.  

• Support for new Microsoft technologies such as Microsoft Office 2003, 
including support for InfoPath Forms. 

• Easy One-Click Publishing of business processes to servers, and support 
for on-the-fly updates of live business processes. 



Collaborative Process Design  

Through BPM Studio, employees at organizations involved in process 
automation initiatives now have an easy way to centrally store and manage 
business processes in a shared repository environment. Processes can easily be 
checked-in and checked-out from the repository as required, and multiple users 
can work on different portions of processes in a collaborative fashion, all at the 
same time. When a process or object (Step, Form etc) is checked-out to a 
specific user, no one else will be allowed to make changes to that process or 
object, ensuring that work is not overwritten or duplicated. Full object versioning 
is supported, along with the ability to get previous object versions. 

Amongst other features, BPM Studio users are also able to add comments at 
check-in time. These comments are version specific and can be viewed by other 
users for reference purposes. 

Benefit: 

Enhanced productivity in that BPM Studio users can collaboratively design, 
model and automate processes in team fashion, and tight object security ensures 
users do not overwrite each other’s work. 

Also, centralizing processes into one location also allows for easier management 
of those processes and ensures that users are working on the most up-to-date 
versions of processes and objects at all times. 



Enhanced User Interface 

The Ultimus BPM Studio now includes an enhanced interface that further 
simplifies the task of designing, modeling, automating, and deploying business 
processes from a single integrated environment. This interface includes: 

• An explorer-like dockable Repository Window for browsing and 
manipulating processes, process objects and external process objects. 
Context-sensitive menus associated with tree nodes enable the designer 
to perform a variety of functions through simple right-clicks of the mouse. 

• An Editor Window that supports a multitude of context sensitive editors for: 

• Previewing processes  
• Modeling processes  
• Automating processes  
• Managing process documentation  
• Managing reusable Form objects  
• Managing external content. This is installed from the 

Tools menu bar menu by selecting add Custom Editor 
option.  

• A Status Window for viewing the status of objects in the repository. This 
status contains information about who has checked-out the object, last 
change date, comments, and so forth. 

Benefit: 

Enhanced, more productive user experience due to a more intuitive design 
interface. 



Object Security 

Process administrators can easily define object security privileges at the process 
and object level for editing, deleting and publishing processes, individual objects, 
or groups of objects.  

Benefit: 

Granular access control and security privileges give process administrators tight 
control over who can make certain changes to processes and who cannot. 



Archiving and Versioning 

This powerful feature automatically creates a new version of an object when it is 
changed in BPM Studio. Users can then easily view version history or get 
previous versions of that object. 

Benefit: 

As an example, if a BPM Studio user makes an erroneous change to a particular 
object, they can easily roll back to a previous version of that object. This 
capability can also be used for informal auditing of changes made to processes 
and objects. 



Reusing Process Objects 

BPM Studio users have the ability to easily leverage existing development efforts 
by dragging and dropping steps from one process into another. 

Benefit:  

Reduced design effort through leveraging existing design elements of other 
processes. 



Reusing Entire Processes 

Users have the ability to drag a process into another process. This automatically 
creates a sub process in the target process, and also creates a reference to the 
original process. Cross dependencies are automatically managed, and any 
change to the original process is automatically reflected in processes where it is 
referenced. 

Benefit: 

Reduced design-time through point-and-click process reuse functionality and 
automatic cross-reference dependency management 



Segmenting Processes for Modular Design 

Users have the ability to define continuous sections of a process as an Inlet. Inlets 
allow process owners to segment processes into exclusive, independent 
sections, and users can then work individually on different sections of the 
process. 

Benefit:  

Users can modify individual sections of a process without interfering with each 
other’s work. 



Web Services Integration 

Ultimus now supports the consuming of external web services through the 
following capabilities: 

Step Events Web Services:  Web services in other applications can now be 
called in real-time through intuitive point-and-click mechanisms from Ultimus 
Step Event Conditions. 

Form Events Web Services: Web services can also be called from Controls in 
Ultimus Forms, for real-time interaction with other web services-compliant 
applications. 

Web Services Flobot: Web services compliant external applications can also be 
invoked in an automated or asynchronous manner using the Web Services 
Flobot. BPM Studio users can easily invoke capabilities in other applications over 
the Internet; independent of the platform that those applications run on, or the 
language they were written in. 

Benefit:  

BPM Studio users can easily invoke capabilities in other applications over the 
Internet.  

Note: The Web Services Flobot was previously made available as a 
separate download for Ultimus v5.0d  



.NET Code Integration 

BPM Studio now allows designers to easily call .NET Code (C#,VB.NET) through 
the following capabilities: 

Step Events .NET Code:  .NET Code can be called from Ultimus Step Events, 
such as Activate/Complete, through simple point-and-click interfaces. 

Form Events .NET Code: .NET Code can also be called from Controls in 
Ultimus Forms. 

.NET Code Flobot: .NET Code can also be invoked in an automated manner 
using the new .NET Code Flobot  

Benefit: 

This functionality allows the developer to easily leverage the enhanced power 
and flexibility of powerful development tools, such as Visual Studio.NET, and 
.NET Code directly from Ultimus processes through intuitive point-and-click 
interfaces 



Custom Editor Plug-Ins 

BPM Studio users have the ability to easily plug-in external editing tools for in-
context creation and manipulation of any type of external content from within the 
BPM Studio environment. Examples of some editors that can be leveraged 
include: 

• Powerful Forms design tools such as Adobe Acrobat and Microsoft Office 
InfoPath 2003 – for managing external Forms 

• Powerful development tools such as Visual Studio.NET – for managing 
ASP.NET, VB.NET or C# code 

Benefit: 

Designers have one central place to manage and reference all process-related 
objects from within Ultimus BPM Studio. 



Microsoft Office InfoPath 2003 Forms Support 

Users are able to leverage InfoPath 2003 Forms in their processes by linking 
process variables to/from InfoPath fields through an intuitive point-and-click 
trainer interface. 

Benefit: 

The combination of InfoPath 2003 and Ultimus BPM Suite allows customers to 
create powerful data-driven business processes that natively leverage the power 
and ease-of-use of InfoPath 2003 Forms. 



Microsoft Office 2003 Support 

Information from business processes can easily be sent to Word 2003 and Excel 
2003 through leveraging updated Word Flobot and Excel Flobot, and Process 
Documentation features in Ultimus. 

Benefit: 

Customers can easily exchange process-driven information with the new 
Microsoft Office 2003 productivity tools in the business workplace. 



Microsoft Exchange Server 2003 Support 

The Ultimus E-mail Flobot and Exchange Flobot now support integration with 
Exchange Server 2003. 

Benefit: 

Customers can easily use Exchange Server 2003 for sending e-mails, tasks and 
calendar items to process participants. 



Offline Process Design 

BPM Studio users have the ability to check processes out, save them offline, and 
then work with those processes in an offline/disconnected mode. Once the user 
has finished working with the offline processes/objects, they can be easily be 
imported using the BPM Studio and checked in. 

Benefit: 

This feature provides great benefit for portable users as an example, who may 
want to work on a process at home one evening without being connected to the 
server (but whilst still benefiting from the check-in/check-out capabilities that 
BPM Studio provides), and then import the process back in to the repository the 
next morning. 



Importing and Exporting Processes 

Through a single click, BPM Studio users have the ability to import processes 
into repositories, and export entire processes from BPM Studio as a standalone 
process map (.WFL) file.  

Benefit:  

BPM Studio users can easily package processes into a single file, and share 
those processes with people outside their organization by attaching processes to 
e-mails as an example. 



Process Level Resource Management 

When modeling business processes, BPM Studio and Process Designer now 
support process-level Resource Management. This means the resources 
definitions can be defined at the process level and can then be reused at multiple 
Steps in a process. An example of a Resource is a group of engineers who are 
responsible for executing multiple Steps in a process, and must all have the 
same associated cost rate structure across all the Steps. One can now define 
one resource “Engineers”, and use key information about that resource group 
(such as Task Rate), across multiple Steps. 

Prior to this capability, resources had to be defined at individual Steps in a 
process and could not be reused across steps. 

Benefit:  

Enhanced productivity and ease of use since designers don’t have to delve down 
to the individual Step level to manage resources, and can perform this task at 
one central place when modeling processes. 



General Modeling Enhancements 

When modeling processes, users can now benefit from a variety of 
enhancements in BPM Studio and Process Designer: 

• Right-click on Steps to view Reports when a modeling run is complete. 
• A new Word-like editor for manipulating all process-related documentation 

(In Map Properties, Step Inputs/Outputs/Actions-related documentation 
and so forth). 

• In entering Input/Outputs/Actions documentation for a process, designers 
now can easily switch between Steps using a drop-down list box for 
selecting Steps. 

Benefit: 

Improved designer productivity through enhanced ease-of-use. 



One-Click Process Publishing 

BPM Studio users now have the ability to easily publish processes to one or 
more run-time servers through One-Click Publishing from within BPM Studio. 

Benefit: 

This feature empowers designers and owners to publish processes on their own, 
without involving administrators.  



One-Click Object Publishing 

BPM Studio users now also have the ability to easily publish individual process 
objects and process-related objects (such as .NET Code and images) to one or 
more run-time servers. 

Benefit: 

The ability to only publish individual process objects allows process publishers to 
make targeted updates to business processes, and is also optimal from a 
network performance perspective in that only the object that needs to change is 
being transmitted across the network. 



On-the-Fly Process Updates 

When publishing a process, in addition to having the capability to create a new 
version of the published process at the server, designers can now also update an 
existing process version on-the-fly at the server. 

Benefit: 

Updating a process on-the-fly allows process owners to rapidly institute changes 
to any existing live processes (without creating a new version), and all process 
participants will be able to immediately benefit from that change. 



Architectural Overview 

 
BPM Studio is designed on a 3-tier architecture, which consists of the following 
objects: 

• The BPM Studio client resides on every designer’s PC. This module 
serves as the primary interface that developers will use for designing, 
modeling, and automating processes.  

• The BPM Studio server is a server module that controls access to process 
repositories. Designers who are working collaboratively on process maps 
in the BPM Studio client will each have a connection to the particular BPM 
Studio server that manages access for those repositories.  

• The process repository tier - all processes managed by BPM Studio 
servers are kept in a SQL Server or Oracle database.  

• Communication from the BPM Studio client to the BPM Studio server is 
provided through HTTP, HTTPS and DCOM in order to ensure maximum 
deployment flexibility, and to make it easy for remote users to participate 
in the development process.  

Provided below is a high-level BPM Studio architecture diagram:   

 



BPM Studio User Interface 
The new BPM Studio User Interface is much more flexible, intuitive and user-
friendly than ever before. The user interface has been split up into 3 intuitive 
views:    

• A Repository View Window for easily browsing process and objects, 
actions can be performed against objects through simple right-click 
context-sensitive menus  

• An Editor Window for previewing and editing process maps , individual 
process objects, and external objects via the Editor Plug-in capability 

• A Status Window for viewing the status of objects in the process 
repository.  
  

   



Starting Ultimus BPM Studio 

Ultimus BPM Studio supports collaborative design and deployment, whereby 
multiple users are able to work on processes at the same time by connecting to a 
central process repository. In connecting to the repository for the first time, you 
may require some assistance from your Ultimus administrator for defining the 
settings below. 

Starting Ultimus BPM Studio:   

• Click the Start button on the Windows Taskbar. 
• Select Programs. Select Ultimus BPM Suite 6.0. Select Ultimus BPM 

Studio.  
• Enter User Name and Password 

                         

• Select the connection to the BPM Studio server i.e. Local (uses COM), 
Remote (DCOM, HTTP, HTTPS) or Work Offline.  

o Choose Local if the BPM Studio server (and process repository) is 
located on the same machine that you are currently working on. 
The majority of the time though, the BPM Studio server will be on a 
different machine, and the Remote option will need to be used. 

o In case of Remote connection to a BPM Studio server located on a 
different machine, when using DCOM, enter the name of the 
machine containing the BPM Studio server that you wish to connect 
to. When using HTTP or HTTPS either enter the fully qualified 
domain name of the machine you wish to connect to (i.e. 
servermachine.mycompany.com), or the IP address of the machine 
(i.e. 192.168.1.100). 

o The Port option is used when Remote and HTTP/HTTPS is 
selected, and the BPM Studio server is installed on a web server. 
The default port for HTTP is 80 and for HTTPS is 443. 



o Work Offline allows a user to work in a disconnected fashion on the 
local machine without being connected to a repository on a BPM 
Studio server. If the Work Offline option is selected only the 
username option is active and the rest of the controls will be grayed 
out. 

• Once you have selected a connection type, select the Repository that you 
wish to work with. In order to refresh the list of repositories available on 
the BPM Studio server, click Refresh. This will provide the list of 
repositories that you have been granted access to. 

• Click OK when done 
• The next time you log onto BPM Studio, you will only need to enter your 

user/password information. The rest of the login information will be 
retained from your first login and only needs to be verified. Detailed login 
information can be viewed by simply clicking the Details button in the 
dialog below: 

 

Selecting a Default BPM Server 

If you are logging onto BPM Studio for the first time, you will be required to enter 
a Default BPM Server.  This BPM Server information will be used for purposes of 
providing Org Chart and FloStation data when building processes in BPM Studio. 
Once you have entered this information during login, you will not be asked for 
this information again. The Default BPM Server setting can be modified in BPM 
Studio from the Tools, Default BPM Server menu option. 

Provided below is the Default BPM Server dialog: 



         

1. Choose to connect to a local BPM Server (on your machine) or to a 
remote BPM Server via DCOM or HTTP/HTTPS  

2. For DCOM connections, enter the server name in the BPM Server field.  
3. For remote connections, enter Port number, select HTTP or HTTPS 

connection and enter the IP address or fully qualified domain name of the 
BPM Server  

4. Click OK when done  

Note: A user cannot log on using the same credentials on another machine. 
To do so the previous session must be terminated from BPM Studio 
Activity in BPM Studio Configuration. 

The Main View  

Once you have successfully logged on, the Main View of BPM Studio has the 
following appearance: 



 

The user interface is split into 3 main windows: 

• An explorer-like dockable Repository View Window for browsing and 
manipulating processes, process objects and external process objects. 
Context-sensitive menus associated with tree nodes enable the designer 
to perform a variety of functions through simple right-clicks of the mouse. 

• An Editor Window that supports a multitude of context sensitive editors for:  

• Previewing processes  
• Modeling processes  
• Building/Automating Processes  
• Managing process documentation  
• Managing reusable Form objects  
• Managing external content and code (discussed later) 

Note: When you are building/automating processes, there are also a variety 
of object editors available for editing Steps, Forms, and Workflow Variables 
and the like. These object editors will be described in more detail in a later 
chapter. 

• A Status View for viewing the status of objects in the repository. Examples 
of status information include information around who has the object 
checked out, last change date, object documentation and so forth. 

Each of the areas referenced in the diagram above will be covered in more detail 
in the following sections. 



Repository View Window  

Repository View Window of the BPM Studio has the following appearance: 

 

The Repository View Window consists of the following default nodes: 

1. Processes: The Processes folder is the location where all business 
processes will be stored. Each Process contains three sub nodes - namely 
Map Properties, Workflow Variables, and Steps. Steps will have additional 
sub-nodes for managing business rules, properties for the step, and other 
step-related settings that are dependant on the step type 

2. Documentation Templates: This folder stores document templates that 
are used as a foundation for generating technical documentation for 
processes. Ultimus BPM Studio has the ability to produce detailed 
documentation and design instructions about workflow requirements.  This 
documentation is produced using Microsoft Word templates that can be in 
any customer-defined format. These include ISO 9000 document formats 
and the format recommended by the Ultimus Workflow Development 
Methodology. 

3. Form Object Library: The Ultimus BPM Studio allows you to create and 
save reusable "form objects" in a library. A standard set of form controls 
can be grouped and saved in the Form Object Library for insertion in any 
Form in Ultimus processes. Objects in the Form Object Library retain their 
positioning, spreadsheet and recordset links, and formatting properties 
when inserted into Forms. 

The context-sensitive Object menu-bar can be accessed from any object in the 
Repository View Window by right clicking on the particular object. 



The Editor Window   

The Editor Window functions are “context sensitive” to the object being edited. 
The Editor Window functions in 3 key modes:  

• A Generic Preview Mode: This mode is active when an object is 
checked-in or checked-out, but not actively being edited. In this mode a 
“preview” snapshot of the object will be provided in the Editor Window. 
Different objects will have different display modes. For example, when 
previewing a process, the process map preview will appear in the Editor 
Window. When previewing a Step's Properties, the Step Properties 
preview will appear in the Editor Window. 

• A Build Mode: This mode is active when any object is checked-out and 
being actively edited. As an example, if one drags a process across to the 
Editor Window, it will automatically check-out the process, and open it in 
Edit mode in the Build Editor. A checked-out process can also be opened 
for editing in the Build Editor by right clicking on the process, and selecting 
Edit from the pop-up menu. For more information on working with 
processes in the Build Editor see the chapter titled Working with the Build 
Editor. 

• Individual process objects and external objects can also be edited in Build 
mode, through the same actions mentioned above. When individual 
objects are edited in Build mode, they will be rendered in their Object 
Editors. There are different Object Editors for each of the following 
objects: 

• Process - Map Properties 
• Process - Steps (Properties, 

Event Conditions, Trainer 
Dialogs, and Forms)  

• Process - Spreadsheets  
• FOL Objects  
• Documentation Templates  
• External Content and Code (that 

are being manipulated through 
Custom Editor Plug-ins)  

• A Model Mode: In order to Model a checked-out process, simply check it 
out, right click on the process, and choose the Edit (Model) option from the 
pop-up menu, it will open in the Modeling Editor. The Edit (Model) function 
is supported only at the process level. For more information on modeling 
processes, see the chapter titled “Working with the Modeling Editor”.   

 The Process Preview Mode   



 

Process in the Build Editor Mode  

 

Step Properties (Preview Mode)  



 

Step Properties (Object Editor)  

 

  



Status Window 

 

The Status Window at the top right of the screen provides the status of the 
currently highlighted process or object in the Repository View Window. The 
Status Window displays the following data:  

• Name: The name of the currently highlighted process or object in the 
Repository View Window 

• Owner: The name of process/object owner, that is, the person who 
created the object, or who has it checked-out/locked at that time 

• Created: This specifies the date and time at which the process or object 
was created.  

• Modified: This specifies the date and time at which the process or object 
was last modified.    

• Status: Indicates whether the process or object is checked in, checked 
out, or locked by another user.  

• Version: Describes the number of times the process or object has been 
changed and saved.>  

• Comments: Free format descriptive text that last user entered when they 
made changes to the process or object 

The Notes Icon in the Status Window indicates whether the process or object 
has documentation associated with it. For more information on adding object-
level Notes, please see information on the Edit Notes function in the Working 
with Object Notes 



The BPM Studio Menu Bar 

The BPM Studio menu bar is context sensitive menu bar that contains different 
menu options dependant on whether users are previewing objects, working in the 
Build Editor, Modeling Editor, or working with the individual Object Editors. When 
you start BPM Studio, you will always be working in Preview Mode as a default, 
and the menu options in the BPM Studio Menu Bar will be as follows: 

• File 
• Object 
• View 
• Tools 
• Help 

File 

• Exit: This option closes the Ultimus BPM Studio, and will terminate your 
connection to the BPM Studio server (process repository) to which you are 
connected 

Object 

The Object Menu is the main menu from which the majority of the collaborative 
design features in BPM Studio can be performed. The functions on this menu are 
described in each of the sub-sections below this chapter. 

Each option in the object menu is context sensitive depending on the object type 
in the Repository View Window that is currently highlighted. The different Object 
types supported in BPM Studio are: 

• Processes 
• Process Objects (Map Properties, Workflow Variables Step Properties, 

Step Forms, Step Event Conditions etc) 
• Form Object Library (FOL) Objects 
• Documentation Templates 
• External Objects manipulated in BPM Studio through the Custom Editor 

plug-in capability 
  

View 

• Toolbar: For toggling the BPM Studio Toolbar on and off 
• Status Bar: For toggling the Status Bar (at bottom of screen) on and off 
• Repository Window: For displaying/hiding the Repository View Window 

Tools 



Change Repository 

This option allows users to switch to a different 
repository on the BPM Studio server   

         

• Default BPM Server: The default BPM Server 
provides the User and FloStation definitions that are 
used when browsing for Users in Step Properties for 
User Steps in Build Editor, and for browsing 
FloStation definitions for Flobot Steps in Build Editor.   

 

• Add Custom Editor: This menu option allows the 
user to specify a Custom Editor plug-in for the 
repository currently open in BPM Studio. Through 
Custom Editors, users can then edit external content 
and code through BPM Studio. For details on editing 
external objects view the to Editing Objects section. 

Note: By default the "Use Default Registered 
Executable” is checked. When this option is 
checked, BPM Studio will use the default 
Windows application associated with the 
particular external file type when you choose to 
edit the file. 



 

         Setting up a Custom Editor: 

• Name: Specify a name for the Custom Editor. This 
will become the name of the Custom Editor folder in 
the Repository View Window. 

• Extension: Give the extension of the file type you 
wish to edit through the Custom Editor (e.g. DOC, 
PDF etc) 

• Host Application: This is inactive by default. 
However this can be activated by un-checking the  
"Use Default Registered Executable" check box. Then 
by clicking the browse button, select the Custom 
Editor executable to be used for editing the external 
objects from the directory. 

Import Offline Object:  

Allows users to import an offline Process from the 
offline process repository on the local client machine.  



 

More information regarding the Import of Offline 
Object can be found in the Working With Processes 
Offline. 

Help 

This has two options; 

Contents: Provides Help about the Ultimus BPM 
Studio. 
About Ultimus BPM Studio: This option provides 
licensing and version information for Ultimus BPM 
Studio.  
  



Creating and Adding Objects 

Through the New and Add options of the Object menu, new objects can be easily 
created, and existing objects can be imported into BPM Studio process 
repositories 

• New: This option creates a new object under the currently highlighted 
folder in the Repository View Window. Note that this menu option is 
context sensitive depending on the folder currently selected. For example, 
if the Processes folder is highlighted, and the user selects New from the 
menu, a new process will be created under that folder. If the Form Object 
Library (FOL) folder is highlighted, New will create a new FOL Object 
under the FOL tree. The New option is not available for External Objects 
accessed through the Custom Editor capability. These objects must be 
created outside of BPM Studio, and then can be Added to the BPM Studio 
through the Add function (described below). 

• Add:This context-sensitive menu option allows you to add pre-defined 
objects to your Ultimus BPM Studio repository. To Add the object, select 
the object and then click Open. If working offline, the Add option will add 
the object to an offline process repository on the local client machine. The 
Add function is supported for all object types in BPM Studio.  

 

•         Create Folder: Folders provide a convenient way to organize objects in 
the Repository View Window. This option allows users to add new folders 
under the currently selected folder in the Repository View Window. 
Objects can then easily be moved to that folder by dragging and dropping 
them into this folder. By holding down the control key and selecting an 
object, a copy of that object will be made when it is dragged and dropped 
into the folder. 



Defining Object Security 

Object security allows BPM Studio administrators to control who is able to 
modify, delete and publish objects. BPM Studio administrators are the only users 
allowed to define object security. A person is given administrative rights by 
assigning the "Administrative Rights" privilege to the user in the BPM Studio 
Configuration application. For more information on this privilege, please view the 
"Configuring Access Rights" section of the BPM Studio Configuration help. 

The administrator can define object security on all object types in BPM Studio. 
Object Security can be set from the Object menu by selecting the Security option. 
This will display the window provided below.  

 

“Object Rights” are those rights that can be explicitly defined for a specific object. 
Whenever security is defined for a parent object, all children below that parent 
object will automatically have the “Rights inherited from Parent” activated, 
meaning they will inherit all the parent object’s security settings. Individual 
security rights for child objects can then be overridden by selecting the object in 
the Repository View Window, selecting Security, selecting “Object Rights” and 
explicitly defining security for the relevant child object.  
 
To assign Object Rights:   

1.      Select Object Rights radio button  



2.      Click the browse button to select a user (this list of users only includes 
those users who are allowed access to the process repository currently 
being worked on in BPM Studio. User Access Rights for process 
repositories is controlled through the BPM Studio Configuration application)  

3.      Click the Add User button to add a user. The following rights Object 
Security Rights then become active and can be selected: 

•         Edit: Allows users to check-out and edit processes and objects. For more 
information on Checking Out Objects, please view the Checking Out, 
Checking In, and Locking Objects section  

•         Delete: Allows users to delete processes and objects. 

•         Lock: Allows users to lock processes and objects without checking them 
out. For more information on Locking Objects, please view the Checking 
Out, Checking In, and Locking Objects section 

•         Publish: Allows users to publish processes and objects. For more 
information on Publishing Objects, please view the Publishing Processes 
section. 

Important Rules for Defining Object Security  

•         By default no Object Security is active for new objects that are created in, 
or added to BPM Studio. This logic applies to all object types. Thus, any 
user can perform any action on these objects (Edit, Delete, Publish, Lock) 
initially as a default.  
Security for these objects can be "activated" by explicitly setting security for 
that object through the Security dialog.   

•         When Object Security is set on a parent object, the security rights are 
automatically cascaded down to all child objects. Thus, if a Publish privilege 
is set for a Process, all children of that Process (Map Properties, Steps etc) 
will implicitly inherit the Publish privilege.   

•         As a rule for Processes, a child object can only be explicitly assigned 
security once security has been explicitly set for the Process itself. As an 
example, to assign security explicitly for a Step, you would need to activate 
security for the Process first by assigning some level of security rights to 
that Process.  

•         When object security is explicitly set on child objects, the security rights set 
for the child are additive to security rights set for all parents above it. As an 
example, if a Process has the Publish Privilege, the Steps node below it 
has the Lock privilege explicitly defined for it, and a Form for a particular 



Step explicitly has the Delete privilege set for it, then the Form will inherit 
have all 3 Security Rights assigned to it - Publish, Lock (through 
inheritance) and Delete. 



Checking Out, Checking in and Locking Objects 

Once the appropriate Object Security Rights have been defined for objects, they 
can then be checked-out of the repository.  

 

• Check Out: Check Out allows the object to be checked out for editing. If a 
user has an object checked out, no one else will be able to work with that 
object. In the Repository View Window, objects with red checkmarks 
shows that you have checked-out an object, whereas blue checkmarks 
shows that another user has checked the object out. All child objects of 
the checked out node are automatically checked out when the parent is 
checked out. 

• Check In: Once changes are made to an object, this option allows the 
user to check the object back into the process repository. When this 
happens, the version number of the object is automatically incremented in 
the process repository.  

• Undo Check Out: Allows the user to reverse the check-out process 
without creating a new version of the object.    

• Lock: This menu option allows the user to Lock an object without 
checking the object out. This functionality is useful if the user wants to 
prevent other users from changing an object without having to check that 
object out though, and in so doing, create a new version of that object.  



Note: In order to Check Out objects, the user must have the "Edit" Object 
Security privilege defined for that object. In order to Lock objects, the user 
must have the "Lock" Object Security privilege defined for that object. For 
more information on Object Security, see the section titled "Defining Object 
Security"  



Editing Objects 

Ultimus BPM Studio supports 4 main editor types for manipulating objects.  

1. Modeling Editor: For designing and modeling processes 
2. Build Editor: For designing and automating processes 
3. Object Editors: For editing individual process objects such as Map 

Properties, Steps and Workflow Variables 
4. Custom Editors: For editing external objects in BPM Studio (PDF, C#, 

VB.NET files) 

These editors can be accessed from the Object Menu from the following menu 
options: 

• Edit/Edit (Build) : This menu option allows for processes and objects to 
be edited. If Edit is selected for a process, it will open the Build Editor, 
where entire processes can be automated. If this option is selected for an 
individual process object (Map Properties, Workflow Variables, Step 
Properties, Step Event Conditions and so forth), the object can then be 
edited in it's individual Object Editor. If this menu option is selected for an 
external object, the Custom Editor associated with that object will be 
opened (for more information on setting up a Custom Editor, see the The 
BPM Studio Menu Bar section). For additional information on working in 
this editor mode, see the Editor Window section in this chapter, and the 
Working with the Build Editor chapter.  

• Edit (Model): This opens the Modeling Editor and allows the process to 
be modeled. The Edit (Model) function is only available at the process 
level, it is not accessible for individual process objects. For more 
information on working in this editor mode, see the Editor Window section 
in this chapter, and the Working with the Modeling Editor chapter.    

In order to Edit an object, two conditions must be met: 

• The object must be checked out 
• The user must have the "Edit" Object Security Privilege enabled for that 

object 

Note: When in editing an object in BPM Studio it is not possible to perform 
other tasks, unless the object being edited is closed and the Editor Window 
switches back to Preview Mode.  

In order to save and close an object being edited, select the "Close Editor" button 
from the BPM Studio toolbar; or File/Close from the BPM Studio Menu Bar. 



Copying, Renaming and Deleting Objects 

The Create Copy and Rename Object Menu functions are supported for all object 
types in BPM Studio, with the exception of process objects (Map Properties, 
Workflow Variables, and Steps).  

These functions can be accessed from the following options in the Object Menu: 

1. Create Copy: This option allows users to create a copy of the currently 
selected object. When a copy is created, it will be called 
Copy_Of_(objectname). In order to make a copy of an object, two 
conditions must be met:  

o The object must be checked in 
o The user must have the "Edit" Object Security 

Privilege enabled for that object 

 

2. Rename: This option allows users to rename objects in BPM Studio. It is 
also possible to rename an object by clicking once object in the Repository 
View Window. In order to rename an object, two conditions must be met:  



o The object must be checked out 
o The user must have the "Edit" Object Security 

Privilege enabled for that object 

. 
 

 
 
  

• Delete: This option allows users to delete objects. In order to delete an 
object, two conditions must be met:  

o The object must be checked out 
o Object Security Privilege enabled for that object 



 



Object History and Rollback 

BPM Studio supports full object versioning and rollback capabilities. When an 
object is checked-out in BPM Studio, edited, and checked back in, the version 
number for that object will be automatically incremented.  

The history of changes to any object can be viewed by selecting the History 
menu option from the Object menu. This will display the following dialog: 

• Version: Specifies the version number of the process or object, the latest 
version number being the most current. 

• User: Provides the name of the user who made the change to that 
particular version. 

• Date: Specifies the date on which the change was made. 
• Comments: Provides any comments the user may have added to the 

process or object when making the change 

 

If an object is checked out to the current user, and the user selects History from 
the Object Menu, the following options will also be available in the History 
window: 

• Get: Gets the selected version of the object and overwrites the checked 
out (latest) version of the object. 

• Create Copy: This creates a copy of the selected version as a new object 
named HistoryCopy_Of_<objectname>. This option is not available for 
process objects (such as Map Properties, Workflow Variables and Steps) 

• Delete: This option allows the user to delete the selected version of the 
object. It is not possible to delete the last version of an object from this 
window. This action must be performed from the Process View Window 
using the Delete functionality  



Working With Objects Offline 

Users can save Processes, FOL Objects, Documentation Templates and 
external objects offline on their local machine by selecting Save Offline option 
from the Object Menu.  

 

When working offline, a user can work with objects on their local machine, 
without having to be connected to a process repository. In order to save an 
object offline, the object must be checked out of the repository first. This ensures 
that no other user can make changes while the object is offline.  

Once the object has been saved offline, you will be notified through the dialog 
below  

 



Once an object is saved offline, you can switch to offline mode, by exiting BPM 
Studio, logging on again, and selecting the Work Offline option when logging on 

 

Working with objects offline is almost identical to working with processes from a 
central repository, the only difference being that you are working with the objects 
against a “local/offline” process repository on your client machine. Thus, when 
working offline, you will still need to perform tasks like checking an object out 
from the offline process repository before editing the object. Once you have 
made the necessary changes to the objects, be sure to check these objects in 
before proceeding to the next step of importing the offline objects. 

Importing Offline Objects 

Once you have finished working with objects offline and are connected to a 
repository again, objects can be imported into the repository as follows. Select 
Import Offline Objects menu option from Tools on the BPM Studio Menu bar.  

 



Expand the Repository Window View and select the object(s) to import by 
clicking the check boxes or select the main Offline Node check box, which will 
select all the objects. 

 

When this action is selected, the Offline Object will replace the 
corresponding object in the repository and the version will automatically be 
updated for that object. 

Note: Processes and objects created offline will not replace online 
processes having the same name, but BPM Studio rather creates a 
separate identifier in the repository for those objects. 



Outputting Technical Documentation 

Ultimus BPM Studio provides the extremely powerful capability to take the 
process design and produce an electronic document (in Microsoft Word) format 
that describes the technical aspects of the process, its objects and requirements. 

In order to create this technical documentation, a Document Template needs to 
be created first. For more information on creating documentation templates, 
please review the Creating Technical Documentation section.  

Once a documentation template is created, it can be applied to any process 
within the process repository, and technical documentation can be outputted for 
that process. In order to output technical documentation for a process, select a 
documentation template in the Documentation Templates folder, and from the 
Object menu, select Run Report. 

 

Once this option has been selected, a dialog will be provided where the user can 
select the process for which they would like to output technical documentation. 



 

Select a process and hit OK. BPM Studio will then produce the technical 
documentation for that process, and prompt you for a location where you can 
save the documentation. 

         

  



Working with Object Notes 

BPM Studio allows users to add descriptive notes to all object types for reference 
purposes. These notes can then be viewed by other developers to assist them in 
design of the process. 

In order to add notes to an object, the object must first be checked out. Then, 
select the Notes option from the Object menu.  

 

This will open a comprehensive text editor, where the user can enter detailed 
notes for a process   or object.   



 

Once the user has finished entering notes, the Notes Editor can be closed by 
selecting the Close Editor button on the BPM Studio tool bar.  

The object can then be checked in, and other users will be able to view notes on 
the object by clicking on the Notes icon in the Status Window for that object.   

When other users are viewing notes, a read-only version of the Notes Editor will 
be provided for them to view the information.  

 



The Notes icon will also change to the following icon to show that the notes 
are being viewed. By clicking on the Notes icon in the Status Window, users are 
able to switch back and forth between the "read-only" Notes Editor and the 
standard Preview mode for the object. 



Simulating Processes 

Simulation is a powerful tool which lets you thoroughly test the workflow 
application you have designed before you publish it from BPM Studio. BPM 
Studio allows you to simulate a process in two ways: 

1. By selecting a process in the Repository View window, and selecting 
Simulate from the Object Menu.  
 

 
  

2. When simulation is selected at this level, it can be performed on a process 
that is either checked in or checked out. Simulating at this level is limited 
in that switching to Data View and using the Watch Window is not 
supported. This is supported when using Simulation in the Build Editor. 

3. By editing a process in Build Editor, and selecting the Simulate option 
from this editor. 

For more information see the Simulation section in the Working with the Build 
Editor chapter.  



Publishing Processes 

This section describes how to publish processes and objects in Ultimus BPM 
Studio.  

Rules and guidelines for publishing: 

• Publishing is possible for processes, individual process objects, and 
external objects referenced in processes. 

• Processes or objects must be checked in before publishing 
• BPM Studio users can only publish processes and objects if they have 

access rights to the via the Publish Object Security privilege  
• BPM Studio users can only publish to BPM Servers that are specified by 

the administrator through the BPM Studio Configuration application 

Publishing a Process 

Right click a Process from the Repository Window View and select Publish from 
the menu or click Object from the main menu bar and select Publish. You will 
then be prompted to specify a BPM Server to which you will be publishing the 
process. 

 

Click OK. The following screen appears 

 

• Install New Version: Publishes a new version of the object or process to 
the target BPM Server. Note if a change is made to an individual process 
object (such as Event Conditions for a Step), and this object is selected for 



publishing, then the entire process version will be incremented on the 
target BPM Server. When Publishing individual objects, BPM Studio 
automatically optimizes client to server communication in that it will only 
send the necessary object changes to the server, and not the entire 
process 

• Upgrade Existing Version: This option is active if a process of a similar 
name is already published on the BPM Server. Selecting this option will 
update the latest version of the process, without incrementing the version 
number on the BPM Server. The major benefit of this functionality being 
that users will be able to benefit from changes to the process immediately 
in live incidents (without having to initiate incidents against the new 
process version to see the change). 

• Cancel: Exits the publishing window without publishing the process or 
object. 

Note: Ultimus users are advised to save process with major changes as 
New Versions rather than using the Upgrade Existing Version 
option.Examples of major changes would be the addition or removal of 
Steps and/or Workflow Variables. 

It is possible to publish external objects like .NET code, images, PDF files etc. by 
similar means used for processes. However the Publish dialog which appears for 
external objects is different and shown below; 

 

For example, .NET Code would go to the Resources folder on the target BPM 
Server, images used in Forms would go to the UltWeb directory, or you can 
specify a Custom Location in the Custom Path field which becomes active when 
the Custom Location radio button is selected. 



Exporting Objects 

Users have the ability to export entire processes from BPM Studio as a 
standalone process map (.WFL) file. This allows BPM Studio users to easily 
share processes with people outside their organization.  

To export a process, select a process from the Repository View Window and 
select Export from the Object menu.  

This option allows you to save the process. It defaults to the current working 
directory.  

 

Note that the process must be checked in in order for it to be exported 

The Export capability is also supported for FOL Objects, Documentation 
Templates, and external objects 



BPM Studio Tool Bar 

The BPM Studio Toolbar provides buttons for commands that you can access 
when using Ultimus BPM Studio. 

Button Name  Description  

 Check Out  Checks out objects 

 Check In  

Checks in objects and allows users to enter 
comments through a Comments Editor. The Status 
Window for the object will then display these 
comments and other important object information  

 Open Editor Opens an object that is checked out in its relevant 
editor 

 Close editor Closes the editor currently being used  

 Lock object  Locks objects so that no other users can make 
changes to that object  

 New  Creates a new object in the Repository View 
Window  

 Add  Adds an existing object to the process repository 
from the file system  

 Notes  

Allows users to add descriptive notes (through a 
Word-like editor) to BPM Studio objects. These 
notes can be used to provide a more detailed 
description about the role of a particular object for 
other users to review.  

 
Refresh 
Node  

Refreshes the repository to show changes made to 
objects by other users. Any changes not checked 
in will not be displayed.  

 
Simulate 
Process 
(Quick)  

Allows for quick Simulation of a process. For more 
details on Simulation, refer to the Simulating 
Process chapter.   

 
Show/hide 
Repository 
Window   

Shows/hides the dockable BPM Repository View 
window  

 Help  Opens BPM Studio Help  
 



Designing Process Maps 
Process maps can be designed and modified by either using the Build Editor or 
the Modeling Editor in BPM Studio. In order to design or modify a process map 
through one of these Editors, it must first be checked-out of the process 
repository. When a process is not actively being edited, clicking on any process 
in the Repository Window view will automatically display a read-only ‘preview’ of 
the process in the Editor Pane. For more information on the BPM Studio Editors, 
please view the Editor section in the BPM Studio User Interface chapter.  

Please note that when in Build Editor or Modeling Editor, there is certain 
functionality that will differ between the two editors when designing process 
maps. These differences are primarily found when providing details associated 
with the graphical process map.  The effort to design a process map is the same 
in both editors.  

A process map is a graphical representation of the sequence of steps that  make 
up a business process. A map is shown below; 

 

Every map must have a Begin and an End Step. Every step denotes a task to be 
performed at that stage. Steps are tied together by links, which denote the flow of 
the process. Steps  can be conditional or unconditional. Unconditional steps are 
always invoked.  Conditional steps are activated only if certain conditions are 
met.  

Rules About Process Maps   

• A map must have one Begin and one End Step .    
• A Begin Step cannot have any steps before it.    
• An End Step cannot have any step after it.    



• Each step must have a unique label which is used to identify it when 
reports are generated. 

   



The Process Map View 

The Map View consists of the Map View Toolbar and the Workspace, where the 
process map is created. The Map View is shown below. Note that BPM Studio 
automatically switches to Map View when a process is opened for editing in 
either the Build Editor or the Modeling Editor. 

 

 

The Map View Toolbar 

The Map View Toolbar contains command buttons and functions which are 
unique to the Map View and are defined below. 

Button  Name  Function  
 Arrow   Returns cursor to the arrow pointer mode.  
 User   Turns cursor into the user step insertion mode. 

 Flobot   Turns cursor into the Flobot step insertion 
mode.  

 Maplet   Turns cursor into the Maplet step insertion 
mode.  

 Junction   Turns cursor into the Junction insertion mode.  
 Text   Turns cursor into the text box insertion mode.  
 Link   Turns cursor into the link insertion mode.  

 Lock   Activates the lock mode. Click again to "unlock" 
it.  



 Grid   Displays grid lines on the workspace.  
 Snap   Activates/deactivates "snap to grid" mode.  

 Simulation  Initiates the Simulation mode. Available in Build 
Editor only.  

 Watch  Opens the Watch window during Simulation. 
Available in Modeling Editor only.  

 
Start 
Modeling  

Starts modeling a designed process. As you 
start modeling this button turns to a pause 
button. Click the pause button to pause and 
resume modeling. Available in Modeling Editor 
only.  

 
Stop 
Modeling  

Stops modeling. Available in Modeling Editor 
only.  

 
Pause 
Modeling  

Pauses modeling. Available in Modeling Editor 
only.  

 
Speed  
Control    

The speed control let's you change the speed of 
modeling flow. Available in Modeling Editor only. 

Other Tool Bars 

The Standard Toolbar 

The Standard Toolbar provides buttons for commands which you can access 
throughout the program. 

Button Name  Description  
 New  Clears the workspace and lets you open a new process. 
 Open  Open an existing process.  
 Save  Save the current process.  
 Print  Print the Map.  

 Print Preview  Preview what you will be printing before you commit it to 
paper.  

 Cut  Deletes selected items and places them in the Windows 
Clipboard.  

 Copy  Copies selected items into the clipboard.  
 Paste  Pastes contents of the Clipboard onto the workspace.  
 Undo  Repeals the last-performed function.  

   Zoom Combo 
Box  

Select a percentage to compress or enlarge the Map 
View display.  

The Formatting Toolbar 

The Formatting toolbar provides functions for formatting text. 



Button Name  Description  
   Font Selection Combo Box Select the text font.  
   Size Selection Combo Box Select the text size.  

 Bold  Change text to bold.  
 Italics  Change text to italics. 
 Underline  Underlines text.  
 Left Justify  Left justify text block. 
 Center Justify  Center text block.  
 Right Justify  Right justify text block. 

Note: The additional functions in the Formatting Toolbar are active only 
when you access the Thin Forms Designer. For information on these 
buttons and their functionality, see "The Thin Form Designer." 

The View Toolbar (Build Editor)  

When in Build Editor, the View Toolbar has three main views: Map View, Form 
View, and Data View. Each View has a set of buttons which are used only in that 
View.  
  

Button Name  Description  
 Map View  Switch to the Map View. 

 Form View Switch to the Form View. 
 Data View Switch to the Data View. 

The View Toolbar (Modeling Editor)    

When in Modeling Editor, the View Toolbar has two main views: Map View and 
Reports. Each View has a set of buttons which are used only in that View.  

Button Name  Description  
 Map View Switch to the Map View.  

 Reports  Switch to the Reports View. 
 



Adding Steps to a Process Map 

The following types of steps can be added to a workflow map: 

• User Steps: Denote tasks in a process that are performed by individuals.  
• Flobot Steps: Denote tasks in a process that are performed by third party 

applications, such as Microsoft Excel or Microsoft Word, or enterprise 
applications using Web Services or XML.  

• Maplet Steps: Denote tasks in a process which are performed by other 
Ultimus Maplets, or "sub-processes." Ultimus lets one  process call other 
processes. This gives you flexibility to design complicated processes by 
breaking them down into simpler sub-processes.  

• Junction Steps: Allow many links to merge into one, or one link to split 
into multiple.  

The Toolbar in the Map View contains buttons for each of these steps, as 
described previously. Whenever a button is activated, the cursor changes to a 
corresponding step insertion cursor. 

To insert steps in a map: 

1. Click the button for the desired step in the Map View Toolbar. The cursor 
changes to the corresponding insertion cursor.  

2. Click on the process map. A new step is inserted. The cursor changes 
back to the arrow pointer mode.  

Note: If you want to perform the same operation multiple times (such as 
inserting several User steps), click on the Lock button, either before or 
after clicking the step button. This locks the cursor in the step insertion 
mode and allows you to insert multiple steps. When you have inserted all 
the steps you need, click on the Arrow button and the cursor changes back 
to the arrow pointer. 

Note: You can also drag steps from other processes in the process 
repository into a new process map.  That will add a copy of that step to the 
map along with all of the contents of that step. 

Using Grid Lines 

You can display Grid Lines by clicking on the Grid button. Grid Lines make it 
easy for you to align the step boxes. 

To activate/deactivate Grid Lines: 

• Click on the Grid button in the Toolbar.  



Using Snap-to-Grid 

If you have already designed a map, activating Snap-to-Grid causes the steps 
and anchors to be repositioned so that each occupies the center of the nearest 
grid box. 

When you insert new steps, or when you drop them after dragging, the steps will 
occupy the grid box pointed to by the insertion or the drag cursor. If the grid box 
is not empty, the step will occupy the closest empty grid box. 

The "snap to grid" mode can be activated only if the gridlines are displayed. 

To activate/deactivate "snap to grid": 

• Click on the Snap to Grid button in the Toolbar.  

Working with Steps 

To select a step: 

• Click on the step with the arrow pointer. The step Label is highlighted in 
bright green.  

To move a step: 

• Click on the step, hold the mouse button down, and drag it to the new 
location.  When you drag a step, the cursor changes to a hand (drag 
cursor).  

Copying To and Pasting From A Workflow Snapshot 

When working in the Build Editor, in addition to dragging and dropping from the 
process repository window, you may use steps in more than one process via the 
Copy To and Paste From functions. Copy To allows you to copy a step, or group 
of steps, into a "workflow snapshot." This is a file containing only the copied 
steps, their spreadsheets, properties, links, and event conditions, instead of a full 
process map. The Paste From function is used to import these saved steps into 
other process maps. 

Note: This option is supported in the Build Editor only. 

To copy a step, or group of steps, into a workflow snapshot: 

1. Perform one of the following:  
o Select a single step.  



o Use the arrow cursor to draw a selection box around a group of 
steps.  

2. Select Copy To from the Edit Menu, or right-click on the step and select 
Copy To. The Save As window appears.  

3. Name the snapshot and click Save.  

To paste a workflow snapshot into a process map: 

1. Select Paste From in the Edit Menu, or right-click on the Workspace and 
select Paste From. An Open window appears. All workflow snapshots 
have the extension ".snp."  

2. Select the snapshot and click Open. An unnamed step (e.g., "Step 2") is 
pasted into the process map.  

Note: When copying and pasting from workflow snapshots, care should be 
taken to make sure the spreadsheets are identical if you wish to use global 
variables. If the spreadsheets do not match, the variables will have to be 
linked manually (see "The Data View"). 

Copying and Pasting Into A Step 

You may want to create a new step which is similar to an existing step. The best 
way to do this is to copy an existing step, paste it, and then make all the 
necessary modifications. When you copy a step, the properties, form, 
spreadsheet, event conditions, and links associated with the step are also 
copied. You can then paste it to make a new step, or Paste Into a previously 
mapped step. Paste Into allows you to design your workflow map first, then copy 
the forms, spreadsheets, and links from one step to another. You may also use 
the Paste Into Special function to only paste the form, spreadsheet, or properties 
for a particular step. Since the forms and spreadsheets require the most work to 
create, copying and Paste Into are great time-savers. The Modeling Editor allows 
complete information to be copied and pasted into a newly created step. 

Note: Copying and pasting into a existing step is not supported by the 
Modeling Editor, this functionality is only supported in the Build Editor. 

To Copy and Paste a step: 

1. Select the step and click the Copy button , or select Copy from the Edit 
menu.  

2. Click the Paste button , or select Paste from the Edit menu. A duplicate 
step is placed in the top left corner of the workspace.  

3. Drag the step to any point in the map.  
4. After you have placed the step, be sure to make the necessary links, label 

changes, and any other necessary changes.  



To Copy and Paste Into a step: 

1. Select the step and click the Copy button , or select Copy from the Edit 
menu.  

2. Select another step in the workflow map.  
3. Right-click on the step and select Paste Into, or select Paste Into from the 

Edit menu. The properties of the copied step are now associated with the 
current step.  

To Copy and Paste on the form, spreadsheet, or properties Into a step: 

1. Select the step and click the Copy button , or select Copy from the Edit 
menu.  

2. Select another step in the workflow map.  
3. Right-click on the step and select Paste Into Special, or select Paste Into 

Special from the Edit menu. The Paste Into Special window appears. 

          

4. Click the checkboxes to select the item(s) to be pasted into the step.  

Note: Event conditions tables are part of the step properties. 

5. Click OK. The selected properties of the copied step are now associated 
with the current step.  

All the options below are supported in both the Build and Modeling Editors. 

Deleting A Step 

When a step is deleted, its associated form and spreadsheet are also deleted. 

To delete a step: 

1. Select the step.  
2. Click the Cut button , select Cut from the Edit menu, or press the Delete 

key.  



Note: No warning is given when a step is deleted. However, a deleted step 
is placed in the Clipboard. If you delete a step by mistake, you can restore 
it by clicking the Paste button or selecting Paste from the Edit menu. A 
step referenced in an event condition table cannot be deleted. 

To undo a function in Ultimus BPM Studio: 

• Select Undo from the Edit menu. The last function performed will be 
undone. Ultimus offers ten levels of undo.  



Inserting and Deleting Links 

Inserting Links Between Steps 

Links in the map denote the "flow" of steps required for the completion of a 
business process. You can link as many steps as you want. The first step you 
click represents the output and second step the input. The step at the end of the 
link always has the arrow attached to its left side. 

 

If multiple links are tied to a step, multiple lines go to the step, as shown below. 

 

To link steps: 

1. Click on the Link button in the Toolbar. The cursor changes to the Link 
cursor.  

2. Click on a step, hold down the left mouse button, and drag to the next 
step. A line follows the cursor, indicating the path of the link.  

3. Release the mouse button to complete the link.  

Note: When linking multiple steps, it is helpful to engage the Lock button. 
This keeps the cursor from defaulting back to the arrow pointer after use. 

Deleting a Link 

To delete a link: 

1. Select the link line. The line turns green.  
2. Click the Cut button , select Cut from Edit menu, or press the Delete 

key.  

Anchors 



Anchors allow you to change the path of the links in the process map. You can 
insert up to 10 anchors on any link. Anchors appear as dots on the process map. 
At each anchor, you can change the path of the link. This enables you to route 
link lines gracefully across the process map from the source to the destination. 

 

To make it easy to place anchors, the following capabilities are provided: 

• An invisible mini-grid is available. Each major grid line on the map is 
subdivided into 8 mini-grids. If the Snap-to-Grid button is on, the anchors 
snap-to the mini-grids. This allows process designers to easily draw links 
with straight lines.  

• Map can be zoomed up to 200%. This allows designers to precisely 
position the anchors.  

• Anchors can be dragged around the map. If Snap-to-Grid is activated, 
users can see a shadow of the anchor to indicate the point on the grid to 
which it will snap.  

To insert and position anchors on a link: 

1. Select the arrow pointer .  
2. Click on the link and hold the mouse button down. The anchor appears on 

the link.  
3. Drag the anchor to its new location and release the mouse button. If Snap-

to-Grid is active, the anchor automatically snaps to the center of the mini-
grid. While dragging, a shadow indicates the position to which the anchor 
will snap.  

To delete an anchor: 

1. Select the anchor. It turns green.  
2. Click the Cut button , select Cut from the Edit menu, or press the Delete 

key.  



Using Descriptive Text 

You can insert descriptive text on the map, such as titles, comments, and 
captions. 

To insert descriptive text: 

1. Click on the Text button in the Toolbar. The cursor changes to the text 
cursor.  

2. Click on the map to insert a Text Box. All text boxes are initially displayed 
with the words "Sample Text."  

Note: If you want to insert multiple Text Boxes, click on the Lock 
button. When you have finished inserting all the Text Boxes, click on 
the Arrow button to change the cursor back to the arrow pointer. 

3. Select a Text Box, then right-click on it. The Step Properties window 
appears and displays the Text Attributes tab. 
 

 
  

4. Enter text in the Text edit field.  
5. Define the border for the text box:  

o Visible/Hidden Radio Buttons: Select one of these options to 
specify whether you want a frame to appear around the text.  

o Shadow: If this checkbox is activated, a shadow is displayed 
behind the text box.  

6. Define the colors:  
o Click on the Browse button beside the Text field. The Color window 

appears. Select a color and click OK.  
o Click on the Browse button beside the Background field. The Color 

window appears. Select a color and click OK.  



7. The text you entered is displayed in the Text Box. The size of the box 
increases or decreases automatically.  

Changing Text Formatting 

To change the formatting of the text in a Text Box: 

1. Select the Text Box.  
2. Select a Font from the Font menu.  
3. Select a Font Size from the Font Size menu.  
4. If you want to change the character properties, click on the Bold, Italics, or 

Underline button.  
5. If you want to change the paragraph properties, click on the Left Justify, 

Center, or Right Justify button.  
6. Click anywhere to deselect the text box.  

Moving Text Boxes 

To move a text box: 

• Click on a Text Box and drag it to a new location. When dragging, the 
cursor changes to a hand (drag cursor).  

Note: For help in positioning Text Boxes, you can display grid lines by 
clicking on the Grid button. 

Deleting Text 

To delete a text box: 

1. Select the Text Box.  
2. Click the Cut button , select Cut from the Edit menu, or press the Delete 

key.  

  



Printing Processes 

Previewing the Map 

Ultimus allows you to preview a map before you print it. Preview displays a 
preview of the first page of the map, and allows you to display other pages as 
well.  You can also use Page Setup to adjust the page orientation and other 
parameters. 

To preview a map: 

1. Click the Print Preview button in the Map View Toolbar or select Print 
Preview from the File menu. The Print Preview View appears. 
 

 
   

2. Use the Print Preview Toolbar as described:  
o Print: Print the map as displayed.  
o Next Page: Go to the next page.  
o Previous Page: Go to the previous page.  
o Two Page: Display two pages at one time.  
o Zoom In: Enlarge the view of the currently selected page.  
o Zoom Out: Decrease the view of the currently selected page.  
o Close: Return to the Map View.  

Printing the Map 



When you print the map, it appears as displayed in the Preview mode. For this 
reason, it is always best to preview the map first. 

To print the map: 

1. Click the Print button in the Toolbar, or select Print from the File menu. 
The Print window appears.  

2. Select the print specifications and click OK.  

  



Working with the Modeling Editor 
The goal of modeling is to ensure that the process will behave as expected and 
yield results that are consistent with the requirements of the business owners, 
and the expectations of the customers who are served by the process. Modeling 
is used to answer questions such as: 

• How many incidents of the business process can be completed in a week? 
• If new cases are coming in at a rate of 100 per day, how large a staff is 

required to ensure that every case gets processed within 3 days? 
• What is the cost of performing the order verification step in an order 

process? 
• If the number of claim appraisers is reduced to half, how long will it take to 

process a typical claim? 
• How long does it take the bank to process a loan?  
• How much more will it cost to reduce the time by 50%? 
• How much time does a person have to spend to perform a particular step 

in a business process? 
• Are any of the steps in the process potential bottleneck areas? 

Defining Modeling Scenarios 

Modeling begins by defining one or more “scenarios” and then applying a 
scenario to a business process and measuring how it will perform. A “scenario” is 
a set of assumptions about the resources used in a business process and the 
probabilities of various events that might occur during the course of a process. 
Some of the assumptions apply to individual steps, or tasks, in a process, while 
others apply to the process overall. You can create multiple scenarios for a 
process to test the impact that changing resources, time estimates, costs, or 
probabilities has on process execution. 

When a scenario is executed by the modeling engine, data is collected and made 
available in a series of reports on the process and each step. These reports can 
be printed or exported to Microsoft Excel for further analysis, manipulation, and 
comparison. 

Note: The scenarios you create are stored in separate scenario files with a 
.sio extension. These files contain all of the Process Level Scenario 
Settings, Scenario Variables, Step Scenario Properties, and Step Scenario 
Event Conditions that have been defined. 
  



Working with Steps 

The Modeling Editor uses the same graphical tools to develop process maps as 
the build editor as described in the Designing Process Maps section. Once the 
map has been developed, you can provide additional detail for each of the steps 
in a map. By right clicking on a step, you will be presented with a dialog box with 
four tabs: 

• Properties: This allows you to provide some basic design documentation 
including a label for the step, recipients, completion time, and a number of 
other parameters. 

• Conditions: This allows you to document actions that the automated 
process will take when specified conditions become true. This will help the 
developer provide robust exception handling capabilities for the automated 
process. 

• Scenario Properties: Every process step has a working scenario. A 
"Scenario" is defined as a set of assumptions that are used to model the 
process in an automated manner to evaluate expected outcomes. 
Scenario properties allow you to specify the assumptions for a particular 
step. For example you can specify average Lag time and Task Time for a 
step. 

• Scenario Condition: For every condition specified in the conditions table 
you can specify a scenario. Suppose you have specified a condition for 
some step in the map. The related scenario for this condition can be that 
the chances of this condition becoming true are sixty percent. You can 
specify this for a scenario using the scenario conditions table. 

The Properties and Conditions tabs can be used to provide design 
documentation for the step that can be used during the development of the 
automated process.  Scenario properties and conditions are used when running 
a modeling scenario to analyze the process.  Scenario Properties and Conditions 
are covered in detail in the  Executing Process Modeling Scenarios section. 



Documenting Step Properties 

The Step Properties window allows you to document key parameters for the step   

 

Label: The Label identifies the step.  It is shown in the graphical process map 
and used to identify individual steps during reporting. The label must, therefore, 
be unique.   

Recipient(s): Recipient is the individual who performs the task for a step. 
Provide a description of the person, or people, who perform this task.  In most 
cases, this should refer to a job function or group, rather than a specific person.  
This will provide more flexibility when the process is automated. 

Completion Time: The Completion Time is the time you allow the recipient to 
complete the task.  Provide a description of how long you want to allow people to 
take to complete their tasks. 

Extension Time: Like the Completion Time, you can specify the estimated 
Extension Time the user is allowed as a grace period over and above the 
Completion Time.  The Extension Time is used for automated processes to 
provide a second level of escalation for tasks that are late. 

Delay Time: The Delay Time is the time the BPM Server will delay invoking 
before invoking the step.  If you need to delay a step for some time period, 
provide a description of that delay time here. . 



Description: Specify any additional explanation or description of the step in this 
field. 

All the above fields excluding Label have a button associated with with it. This 
opens a text editor when clicked, allowing for detailed documentation.  

 

Properties for different type of steps are slightly different as follows: 

• Begin and Maplet type steps do not have Completion time, Extension 
Time and Delay Time properties.  

• Recipient for a Maplet step should indicate the process to be invoked.   In 
addition, you can specify whether you would like for the process to wait 
until the maplet has completed execution before continuing. 

• For a Flobot Step you also have to specify Flobot type. A Flobot can be of 
following types:   

o .NET Flobot 
o Acrobat Flobot 
o ASCII Flobot  
o Database Flobot 
o E-Mail Flobot  
o Exchange Flobot 
o File Flobot 
o Excel Flobot  
o Word Flobot  



o Web Services Flobot  
o XML Flobot  
o Custom Flobot 

• Junction steps have only the Label and Delay Time properties. 



Working with Conditions Tables 

In the following sections, we discuss how to define a Conditions Table. In the 
examples given below, we use the User step, which is the most common. For the 
other steps, such as Junctions, Flobots, and Maplets, there are some slight 
variations as to which events are available, which are discussed in the later 
sections. 

Opening the Conditions Table Window 

To open the Event Conditions Table for a step: 

• Right-click on the step and select Event Conditions. The map step 
Properties window appears and defaults to the Conditions tab. The 
window may be resized, maximized, or minimized. 
 

 

Specifying Actions in the Event Conditions Table 

The first column of the Event Conditions Table is the Actions column and is 
permanently labeled as such. Each cell in the Actions column is used to specify 
the action which will be taken. The second column is permanently labeled as 
Parameters. This is used to specify the step related to the action. 

To add an Action to an Event Conditions Table:  

o Open the Conditions Table you want to modify.  
Notes: If no condition is present, the Action is always performed.  

o Double-click on the first blank cell in the Actions coumn. The Actions 
window appears.  



 

 

o Select one of the following actions:  
o Activate Step: Activates the step specified in the Parameters 

column.  
o Abort Step: Aborts the step specified in the Parameters column.  
o Abort Incident: The entire workflow incident is aborted.  

The specified action appears under the Actions Column Header. 

To change or delete an Action: 

• Open the Event Conditions Table you want to modify.  
• Select the Actions cell you want to modify.  
• Right-click on the selected cell.  
• Select Delete from the submenu that appears.  
• The Action is deleted.  

Note: If you remove an Action cell, the entire row of conditions for the 
Action is also deleted. 

Insert, Copy, Paste and Delete Conditions 

When editing a Conditions Table, you may cut, copy and paste Event Conditions 
Table entries. Any condition may be copied and then inserted between existing 
conditions. 

To insert a row in an Event Conditions Table: 

• Open the Conditions Table you want to modify. 
• Select the cell in the Action column below where you want a row inserted. 
• Click on the Insert Row button  in the Event Conditions Table Toolbar or 

right-click on the cell and select Insert Row. A row is inserted above the 
selected cell. 

To copy a row or cell in an Event Conditions Table: 

Open the Conditions Table you want to modify.  



1. Select a cell or an entire row of cells. 
2. Click the Copy button in the Toolbar or right-click on the selection and 

select Copy. 

To paste a row or cell in an Event Conditions Table: 

1. After you have copied a row or cell, select the cell where you want the 
copied item to appear. If you are pasting an entire row, select the cell in 
the Action column. 

2. Click on the Paste button in the toolbar. 

To delete a row in an Event Conditions Table: 

1. Display the Conditions Table you want to modify.  
2. Select a cell or an entire row of cells. 
3. Click the Cut button in the Toolbar or right-click on the selection and 

select Cut. 

Specifying Steps in an Event Conditions Table 

For every Action that you define, there is a step that is affected. Under the 
Activate Tab, the current step is added automatically since the only Action is to 
activate the current step. However, under the Complete, Late, Return, and 
Resubmit Tabs, the steps are defined independently. 

To select or change a step in an Event Conditions Table: 

1. Open the Event Conditions Table you want to modify. Double-click inside 
the cell under the Parameters column header. The Select Step window 
appears. 
 

 

2. Select a step from the Step combo box. All steps created for the process 
map are listed.  

3. Click OK. The step name is added to the Step column. 

Event Conditions Tables for Junctions 



The Conditions Tables for Junctions are a subset of the Conditions Tables of 
normal steps. This is because there are no tasks associated with Junction steps 
and, therefore, a Junction step cannot be late, returned, resubmitted or have a 
Recipient. Thus, a Junction step only has Activate and Complete Conditions 
Tables. 

    



Documenting Event Conditions 

Exceptions and unique conditions are rampant in every organization. Even a 
process that looks very simple on the surface becomes complex as soon as you 
start dealing with all of the exceptions that must be handled efficiently.  Ultimus 
provides powerful exception handling capabilities in the Ultimus BPM Server.  
When working with the modeling editor, business users can describe the type of 
exceptions that are likely to occur and how they should be handled. 

Exception conditions are tested when specific events occur at the Ultimus BPM 
Server.  The following five events are available to the steps in an Ultimus process 
map: 

Activate: Occurs when the BPM Server determines that it is time to activate a 
step.  
Complete: Occurs when the step has been completed. 
Late: Occurs if the step becomes late.  
Return: Occurs if the step is returned by the user.  
Resubmit: Occurs if the step is resubmitted by the user. 
Recipient: Allows the BPM Server to dynamically change the recipient of the 
step based on conditions. 

For each of these events and for every step, Ultimus allows you to create an 
Event Conditions Table in a spreadsheet format. Each row in the table 
represents a condition for the step. The first column represents an action. 
Whenever an event occurs for a step, the Event Conditions Table is evaluated. If 
all the conditions in the row are matched, then the corresponding action is 
executed. As you can see, this is a simple, yet powerful means of handling all 
types of exceptions and unique conditions.  Event Conditions Tables and Actions 
are used to bypass the normal flow of a workflow process as represented by the 
map. Thus, this feature should be used only for handling exceptions, and the 
normal flow of the process is the one represented by the map. 

The Conditions window in the Modeling Editor contains a table with six tabs: 
Activate, Complete, Late, Return, Resubmit, and Recipient. Click on a tab to 
display the corresponding Event Conditions Table. 



 

 

Note: The recipient tab cannot be used in the modeling editor.  If your 
process needs to change recipients based on conditions, that information 
can be reflected in the recipients area of the properties window.  

The first column of an Event Conditions Table is reserved for the Action that will 
be taken if the condition is satisfied. The second column is reserved for the step 
that will be invoked by the Action. You can define one or more conditions using 
the event conditions table. For each condition you can specify notes in the 
Description field. The description for various conditions is used while creating 
documentation for the designed process.   

To specify an event condition: 

1. Choose the tab for that corresponds to the event that needs to occur 
before the condition is tested. 

2. Click in the first column of the first available row.  You will be presented 
with a dialog with three options:  

o Activate another Step 
o Abort another Step 
o Abort the entire incident 

3. Choose the action that you want to occur. 
4. If you chose to activate or abort another step, click in the second column.  

You will be presented with a dialog with a dropdown list of the steps in the 
process.  Choose the step that you want activated or aborted. 

5. Provide a description of the conditions that must be present for the desired 
action to occur. 



Continue these set of steps for every event condition you need to specify for the 
step. 

Since you can specify multiple condition rows and every row is evaluated, you 
can request that the process perform many different Actions. The Complete, 
Late, Return, and Resubmit Event Conditions Tables, therefore, give you 
tremendous flexibility in changing the course of the process based upon unique 
conditions. 

Ultimus also provides an advanced feature for Referencing External .NET 
Assemblies When Calling .NET Code 



Defining Step Inputs-Outputs-Actions 

Using the Modeling Editor you can specify details of different steps including a 
description of the steps required inputs, actions, and desired outputs. This 
information  is extremely helpful while building the process.. This also facilitates 
the design documentation  of a process as you can later use this information for 
converting the designed process into an electronic document. 

To specify Inputs-Outputs-Actions for a step, either double-click on the step or 
select the step and click on the  Input-Output View button. Inputs-Outputs-
Actions view for the selected step is shown below: 

 

In this view you specify design notes for the Inputs, Actions, and Outputs of the 
step. 

You can quickly switch between steps while staying in the input-actions-output 
view by  using the drop down step menu in the top right hand corner of the 
Modeling Editor window..  



Executing Process Modeling Scenarios 

When working in the modeling editor, you have the ability to define and run one 
or more "scenarios" against a process map.  When modeled, these scenarios 
allow you to predict process performance and costs, identify potential 
bottlenecks, and use the information to perform some process optimization 
before moving into the development stage of the project.  A “scenario” is a set of 
assumptions about the resources used in a business process and the 
probabilities of various events that might occur during the course of a process.  
Some of the assumptions apply to individual steps, or tasks, in a process, while 
others apply to the process overall. 

Note: Process Level Scenario Settings, Scenario Variables, and Step 
Scenario Properties are saved in .sio files.  As a result, you can have 
multiple different scenario files associated with a single process.  You can 
open and close scenario files by using the File menu when working in the 
modeling editor.  Scenario files are not stored within the BPM Studio 
repository. 

  



Process Level Resource Management 

A key aspect of scenarios is understanding the resources that are associated 
with a process. Within BPM Studio, you can create a list of named resources and 
associate a task rate with them. Then, you can simply specify the resource at 
later steps in the process rather than having to remember the rate at each step. 
Resources can be specified once and reused for all scenarios that are created 
for a particular process. 

You can access and update resources in two places. The first way is to select 
Tools, then select Resources from the main menu. The second way is to update 
resources as follows when working on steps 

1.    Right click on a step and select the Scenario Properties option from the 
menu. 

 

2.    Click the Manage Resources button. The following window appears (this is 
the same window that appears when you select Tools from the menu bar, and 
then select Resources from the menu option); 



 

Click Add or double-click a cell to add data in the following fields ; 

• Name 
• Cost ($/hr) 

A resource may also be edited or deleted if required by clicking the 
respective buttons. 

Click OK to save changes. 

Note: Process level resource definitions are saved with the process 
map definition and not with the Scenario (.sio) file. As a result, they 
can be reused across all scenarios that are developed for a 
process. 



Process Level Scenario Properties 

When developing a modeling scenario, there are a number of overall 
assumptions that are made for the business process as a whole. These are 
called "Scenario Settings." 

To define Scenario Settings (i.e. Process Level Scenario Properties):  

Right click on any step and select the option “Scenario Settings” or select the 
same option from File Menu. Following window is shown to you:  

 

Using this window you can specify:  

General 
On general tab you can specify:  



• Distribution: Ultimus BPM Studio allows you to specify the statistical 
distribution model for all steps in a process. If a Uniform Distribution is 
selected, Ultimus BPM Studio will ensure that the probability of generating 
values in simulations is evenly distributed between the Min and Max 
values specified. The likelihood of the time being at the Minimum or the 
Maximum is the same as every other intermediate value. If a Normal 
Distribution is chosen, the probability of randomly generated values is 
subject to the area covered by a normal curve. The Mean and Sigma 
values will allow the user to control the distribution of values along this 
normal curve. 

• Default Time Unit: The default time unit is in hours. When a default time 
unit is selected, the map defaults to that time unit for all steps in the 
process. You can override this setting at any step by simply specifying a 
different time unit for that entry in a particular step. 

• Rate: You can specify the rate at which incidents are initiated at Begin 
Step. If you specify a normal distribution, you have to specify the mean 
and standard deviation of the number of incidents initiated at Begin Step 
during a specified interval. If you have selected uniform distribution then 
incidents will be generated at a rate that is between the Min and Max 
values specified. For example: 

o With Normal Distribution, a Rate Mean value of 2, with Sigma value 
of 1, and unit as Hours, will mean that 1 incident is initiated for the 
process every 2 hours, with a standard deviation of 1 hour.  

o When using a Uniform Distribution for a model, a Rate Min. Value 
of 2, with a Max Value of 4, and unit as hours, will mean that 1 
incident is initiated for the process between every 2 to 4 hours. 

• Model Count: The purpose of statistical modeling is to run enough 
incidents of a process to predict how it will behave under a given set of 
assumptions. Some business processes are not resource constrained and 
will achieve steady state behaviors after only a few incidents. Other might 
be more complex and achieve steady state behavior after many incidents. 
And yet other may never reach steady state. The Model Count variable in 
a scenario specifies the number of incidents that will be completed in a full 
execution of the model. When executing models, more incidents than the 
model count may be executed, and completed, if you have conditional 
execution logic built into the model. In those cases, the engine continues 
to run all of the incidents numbers from 1o to the model count are 
completed. A default setting of a hundred incidents is recommended to 
obtain realistic conclusions. 

For example, if you have a model count of 100 and some conditional 
logic, the engine will continue to run until incident number 1 through 
100 have all completed. In this case, more than 100 incidents may be 
started and more than 100 may complete, but only the results from 
the first 100 incidents (after the pre-load) will be used in reporting.    



• Preload: You can specify the number of incidents to preload before 
beginning to collect modeling data. This allows you to measure the 
process when it is running continuously, rather than including the data 
when the process is ramping up. In many cases, processes tend to be 
sporadic rather than continuous day after day. For such cases, when a 
process is started (i.e. switched on) and the initial incidents begin to flow, 
the process has not begun to run at its typical level because all steps 
along the process have not yet been activated. Therefore, preloading 
provides an excellent method of analyzing process behavior realistically 
when it is operating in its typical state. 

• Task Priority: Specify the priority on which tasks are completed at a step. 
You can select the following options:  

• FIFO: At every step tasks are completed on first in first out basis.  
• Incidents: Tasks are completed based on incident number i.e., task of 

incident number one will be completed first and then tasks of later 
incidents.  

• Scenario Description: Specify any further details of the process scenario 
in this field.  

Calendar 

On the calendar tab, you can specify appropriate business/work hours including 
break times using Calendar. Calendar shows you a breakdown of 24 hours in 15-
minute increments allowing you to mark-off times where people are available for 
work. This feature, however, will not apply to Flobots. For aggregating data based on 
incidents not completed during one business workday, Ultimus BPM Studio adds in 
the hours an incident had to wait overnight before being processed the next day. 



 

By default the calendar highlights resources to be available from 9:00 am to 5:00 
pm. You can modify the default setting by simply clicking on the highlighted cells. 
Un-highlighted cells show the time resources are unavailable (shown in yellow) 
while highlighted cells show the available time (shown in green). 

Variables 
The Variables tab is used to create complex scenarios where the 
process follows different paths based on probabilities. Variables are 
covered in detail in subsequent sections. 
Modeless Dialogs 
Some of the dialogs provided by Ultimus BPM Studio are 
"modeless". This feature gives users the ability to open a dialog for 
one control, make changes to it, and then select the other control in 
the background to toggle to it's dialog and make changes to it. This 
saves the user from three separate mouse-clicks to move from one 
dialog to another. While editing a step property dialog if the 



background is clicked it will switch to process level dialog and vice 
versa. 



Using Variables 

Variables are used to enable you to distribute process flow when conditional logic 
is required (e.g. Route this purchase request to the Safety Committee Leader if it 
is for hazardous materials). Variables allow you to assign an Expression to an 
Action in the Scenario Conditions table. Using variables, you can specify varying 
scenario conditions for an event in different incidents. Since Process Designer 
executes only models, all of your expressions should be developed to return a 
logical value (either TRUE or FALSE). You may also have some variables that 
simply compute a random number to be used as a probability value. 

Defining and using Variables:  

• To define a variable, right click on a step and select the option “Scenario 
Settings” or select this option from File Menu. Following window is shown 
to you.  

 

• This window defaults to General tab. Select ‘Variables’ tab. 
• You can type the name of the variables in the name field and 

corresponding formula in the Formula field. 
• In the formula field, click on the cell and Press the F2 Key twice. The 

following window appears (with a sample expression shown): 



 

 

• Type the formula in this window and click OK. 

To see an example see the section Example of Using Variables  



Example of Using Variables 

The following example explains the usage of variables in a business process 
design. 

Suppose there is a process having three steps, as shown in the snap below. 

   

In this process work can flow in through three different paths as follows: 

Path1: Begin  Step2  End 
Path2: Begin  Step3  End 
Path3: Begin  Step4  End 

Based on our initial analysis, we estimate that Path1 is followed 10% of the time, 
Path2 is followed 40% of the time, and Path3 is followed the remaining 50% of 
the time. Using the variables we can define a logic based on which one of the 
above three paths will be followed. We will use a random number (between 0 and 
100) to simulate the probabilities we estimated: 

Path1: If random number is less than 10. 
Path2: If random number is between 10 and 50. 
Path3: If the random number is greater than 50. 

To implement this follow the steps given below: 

Open the Scenario Settings dialog and move to Variables tab. 

• Define a variable with the name RandomNumber.  
• In the corresponding formula field of this variable, type the following 

formula to generate a value between 0 and 100:  
=INT(RAND()*100) 

• Define another variable Path1. Set following formula for Path1: 
=IF(RandomNumber<10,TRUE,FALSE) 



Using this formula this variable is assigned TRUE if the value of 
RandomNumber is less than 10. 

• Define two more variables Path2 and Path3 and set the following two 
formulas respectively: 
=IF(RandomNumber>=10 & RandomNumber<50,TRUE,FALSE)  
=IF(RandomNumber>=50,TRUE,FALSE) 
 

 
• Close the scenario settings dialog. 
• Right click on Step2 and select the option Event Conditions. (Using 

Scenario Event Conditions is covered in more detail in an upcoming help 
section). 

• Double click on first row. Following dialogue is shown to you: 

 



• Select the option Activate and click OK. Step2 will appear in the 
Parameters field. 

 
• Select the Scenario Conditions tab and double click under the expression 

field corresponding to first condition. Following window is show to you: 

 
• Select Path1 from the value combo box and click Ok. 
• Similarly define activate condition for Step3 and Step4. 
• Save the process and click on Start Modeling button. 
• During modeling incidents will flow according to the desired logic.  

Note: In this scenario, we used variables to ensure that incidents flow 
down 1 and only one path. Ultimus also supports assigning basic 
probability values to scenario event conditions. This approach is useful 
when something either happens or it doesn't (and the occurrence does not 
impact other steps in the process). But it would not work for this scenario. 
Here is why: 

If we were using simple probabilities, rather than assigning the variables 
Path1, Path2, and Path3 to each step, we would have entered the values 10, 
40, and 50 in each steps scenario event condition table. However this 
would behave very differently. 

Using basic probabilities, the modeling engine would create a new random 
number (not stored in a variable, but just for probability purposes) when it 
was requested to activate each step. As a result, it is feasible that a single 
incident could follow all paths, or even no paths (effectively stalling).  

For example, when evaluating whether to activate Step 2 , the engine might 
generate a value of 8, causing that path to be followed. It would then 



prepare to active step 3, and generate a new value, say 30, causing Step 3 
to be activated; and so on. 

As this shows, simple probabilities can not be used when an incident 
follows different paths based on values. This also makes sense, because 
Ultimus, and business processes, often require paths to be routed in 
parallel, both conditionally and unconditionally. 



Step Level Scenario Properties and Conditions 

Every process step has scenario properties and scenario conditions. These can 
be defined as follows: 

Scenario Properties 

To define scenario properties for a step:  

• Right click on the step and select the option “Scenario Properties”. Step 
properties window is shown to you. 
 

 

Using this window you can specify:     

• Name of Resource: Select the name from the drop down combo box or 
type in a name. 

• Number of Resources: The Number of Resources  defaults to ‘1’ . Any 
other value has to be typed in manually. When you assign multiple 
resources to a step, the engine assumes that these resources can all work 
on the same task concurrently. You should take this into account when 
analyzing task, lag, and elapsed times. 

• Manage Resources:  Clicking this button, opens the Resource Manager 
screen where you can add/edit/delete resources as defined in Process 
Level Resource Management  section. 



• Task Rate: This information is used to compute the cost of the business 
process. The time taken to complete the task is multiplied by the task rate 
and the number of resources to calculate the cost of the step. By adding 
the cost of each step, Process Designer computes the cost of an incident. 
Over multiple incidents, Process Designer can compute statistical 
information about the cost of the business process. This value will 
automatically update to reflect the value of the Resource field. However a 
value may also be typed in directly. 

• Lag Time: This is an estimate of the minimum dead, or “away” time 
between tasks, for a single resource. This is the time the user or resource 
is not available to perform the task because he is busy with other tasks. 
The values used here will follow the format for the process level 
distribution method (normal or uniform). 

• Task Time: This is an estimate of the amount of time it takes to perform 
the task for a step. 

• % Returned: A certain number of tasks performed at a step may be 
returned for lack of information or some other factor. 

• Completion Time: The Completion Time is the time which you allow the 
recipient to complete the task. You can specify the Completion Time and 
the units of the time in days, hours, or minutes in the associated combo 
box.  

• Extension Time: Like the Completion Time, you can specify the 
Extension Time the user is allowed as a grace period over and above the 
Completion Time. 

• Delay Time: You can specify a time value here by which the step is 
delayed. While modeling the process,Ultimus delays invoking the step by 
this amount of time. This allows processes and steps to be synchronized.  

• Allow Resubmit: This function allows to Resubmit the completed step of 
an active incident. Multiple Resubmittable steps may be inserted in a 
process. For such steps you have to specify:  

o % Resubmitted and Resubmit Time: In real life situations, after a 
task has been completed, it is sometimes necessary to open and 
resubmit the same task again because of the availability of new 
information or some other external event. Under the section "Allow 
Resubmit" you can enter the percentage of tasks that may be 
resubmitted at a step. To formulate the distribution of resubmitted 
tasks at a step during given time, you also have to specify mean 
and standard deviation (if you want the resubmitted tasks to be 
normally distributed over the specified period) or minimum and 
maximum number of resubmitted tasks (if you want the resubmitted 
tasks to be uniformly distributed over the specified period). 

Modeless Dialogs 

Some of the dialogs provided by Ultimus Process Designer are "modeless". This 
feature gives users the ability to open a dialog for one control, make changes to 



it, and then  select the other control in the background to toggle to it's dialog and 
make changes  to it. This saves the user from three separate mouse-clicks to 
move from one dialog to another. While editing a step property dialog if the 
background is clicked it will switch to process level dialog and vice versa. 

Scenario Event Conditions 

For every condition specified in the conditions table you can specify an 
expression using a value or a variable. If you use a value, it will be interpreted as 
the probability of that event condition evaluating to true. If you use a variable, it 
should be a logical value that also represents the probability of the event 
condition occuring. Variables are used when more complex logic is required than 
simple probabilities. 

For example, suppose you have specified a condition for some step in the 
map. The related scenario for this condition can be that the chances of this 
condition becoming true are forty percent. You can specify this for a scenario 
using the scenario conditions table.  

To define Scenario Conditions:  

• Right click on the step and select the option “Scenario Event Conditions”. 
The dialog will show you any conditions you defined for the step. For the 
scenario, you need to add an expression so that the modeling engine can 
process the condition. 
 

 
• Using this window you can specify the related scenario for step conditions. 

To define scenario for a condition, double click on the corresponding cell 
under expression column. Following dialog is shown to you: 
 



   
 
In this dialog specify scenario probability of condition and click OK. You 
can also select a variable that can generate some value based on a 
formula. For details of using variables see the section, “Using Variables”. 

• When evaluating event conditions, the engine will test activate conditions 
until one evaluates to TRUE, then it will activate the step. If none of the 
activate conditions evaluate to TRUE, the step will not be activated. 

• For other conditions (complete, late, return, resubmit), the engine will test 
all event conditions and take the requested action if the condition 
evaluates to true (this could activate multiple other steps). If a step is 
activated because of one of these conditions, its activate conditions are 
ignored (i.e. they are not testedl; the step simply activates). 

Modeless Dialogs 

Some of the dialogs provided by Ultimus Process Designer are "modeless". This 
feature gives users the ability to open a dialog for one control, make changes to 
it, and then select the other control in the background to toggle to it's dialog and 
make changes to it. This saves the user from three separate mouse-clicks to 
move from one dialog to another. While editing a step property dialog if the 
background is clicked it will switch to process level dialog and vice versa. 



Running a Model  

After you have created a scenario for the process, Ultimus Process Designer 
allows you to run the process through its paces based on assumptions such as 
the rate at which new incidents are coming in, the task time and lag time of each 
step. To run a model, make sure the appropriate scenario file is open, then select 
Tools |Model Process from the Main Menu. You can also run a model by clicking 
on the on the toolbar.  Once you have started running a scenario, you can view 
the progress of the model execution by opening the Model Window. 

To open the Model Window, click on the  Model window button.    

 

Model window displays: 

• Incidents: Number of active and completed incidents at a given time. 
• Steps: Number of active and completed steps. 
• Day: Using the specified calendar, days taken to complete the specified 

number of incidents. 
• Display Workload: If you check this check box, workload for different 

steps is shown in the map view. When checked and a running model is 
stopped or paused, a value is displayed showing the total number of tasks 
queued under each Step. This number is shown in red color for a step with 
the highest number of queued tasks. It's displayed in yellow for the step 
with the second highest number of queued tasks. The workload for the 
remaining steps is displayed in green color.  



 

 

The Model window keeps on changing the displayed statistics as the modeling 
progresses. Using the speed control the modeling speed can 
be slowed down and the behavior of the process can be observed in detail.  

Every time a process is modeled the modeling details are stored in a log file 
named "UltimusModel.log". This file is stored in the same directory in which the 
process map has been stored. Once the process modeling has completed, this 
file can be used to review the process behavior in detail. 

Note: Every time a process is re-modeled the log file is cleared and most 
recent data is overwritten in the file. 



Modeling Reports  

When running a model based on a scenario in the Modeling Editor, Ultimus 
generates two different types of reports, the Process Level Reports and the Step 
Level Reports. The process level reports provide insights as to how a process is 
working as a whole. Step Level reports on other hand help in analyzing the 
performance of individual steps. A description of the Step Level and Process 
Level Reports is given below. 

Step Level Reports 

The following reports can be generated as Step Level Reports: 

• Task Time Report: Provides information on how much time was taken to 
complete tasks at a particular step. 

• Cost Report: Provides information on how much cost was incurred in 
completing tasks at a particular step.  

• Lag Time Report: Lag time is the time that the user is not available to 
perform a particular task, due to the fact that they are working on other 
tasks. It is the time spent on other tasks from the moment a user 
completes a task to the moment they are able to start on the next task. 
This report provides information on how much lag time was incurred for a 
particular step.   

• Elapsed Time Report: Elapsed time is the time a user takes to complete 
a task. It is from the time a task reaches user's desk to the time the user 
finishes the task and sends it to the next desk. This reports shows how 
much time was spent to do a task for a particular step. 

• Step Utilization Report: This reports demonstrates how the resources 
are being utilized at each step.  

Process Level Reports 

All of the above reports can be generated at process level as well. On a process 
level, the above reports provide the same information collectively for whole 
process. For example the Cost Report, when generated for a process as a 
whole, displays the break-down of cost as percentage in different steps. Besides 
the above reports, the following additional reports can be generated at the 
process level: 

• Process Balance Report: A process is said to be balanced if all incidents 
run through this process are taking the same time for completion over 
time. The Process Balance Reports displays, in a chronological order, the 
incident completion time for all the incidents run through the process. An 
upward moving graph in a process balance report is an indication that the 
process is not well balanced and needs to be modified. 



• Under Utilization Report: The Under Utilization Report displays the 
percentage underutilization at each step. The time spent  waiting for tasks 
at a step represents the under utilization for that step. 

Note: In Process Level Reports, if modeling is stopped before preloading is 
completed no incidents are shown. However if it stopped after preloading 
but before Model Count, only the completed incidents are displayed. 

  



Working with Reports View 

Once you have run at least one model using a scenario, you can view reports 

associated with that model.  To switch to the reports, view click on  Reports 
View button. This view shows you different reports for all the steps. Reports may 
also be accessed by right clicking on a Step after modeling has run, selecting 
Step Reports, and then the particular report. This will display step level reports. 
Similarly process level reports may be accessed by right clicking on a process 
map after modeling has run, selecting Process Reports, and then the particular 
report. Both Process and Step level reports can also be selected from the context 
menu.  

 

Selecting Steps 

You can view reports for a particular step by selecting that step’s corresponding 
tab from the report tabs at the bottom of the reports view. You can also view 
reports for the entire process by selecting the “Process” tab. 

Note: Ultimus  remembers the last viewed report and automatically 
displays it when the Reports View button is clicked.  

Changing Reports Type 

For each step in the process you can view following type of reports: 

• Task Time Report 
• Cost Report 



• Lag Time Report 
• Elapsed Time Report 
• Utilization Report 
• Balance Report 
• Under Utilization Report 

You can switch between different report types by using the Report Type 
Selection Combo Box. 

Note: The last two reports are only available at the process level and 
cannot be viewed for individual steps.  

Note: No report is generated for Junction Steps.  

Changing Report View 

Every report can be viewed in a tabular or graphical mode. You can toggle 
between the graphical and tabular views by using the  Report View button. 
Minimum, maximum, average and standard deviation for reports is also shown in 
tabular view. 

Exporting Reports to Microsoft Excel 

In tabular view, you can export the report data to Microsoft Excel as follows: 

• Select the report for export. 
• Change the report view to tabular.  
• From the Tools menu select the option ‘Export Report’.  
• The ‘Save As’ dialog appears, specify the name of file and click Save.  
• The report data is exported to the specified file. 

Rotating Graph 

In graphical view you can rotate graphs as follows: Press the Ctrl Key, click on 
the graph and drag it to reposition while keeping the Ctrl key pressed.  



Task Time Report 

Task Time represents the time taken to complete a task. This report provides 
information on how much time was taken to complete tasks at a step in different 
incidents. Since the Task Time for each step is one of the assumptions in the 
scenario, the Task Time report will closely match the Step Task Time specified in 
the scenario with variability introduced only by randomness. 

 

In tabular view, the task time for each incident is shown separately. Tabular view 
also shows average, minimum, maximum and standard deviation in task time for 
various incidents. 



 

Note: A Total column is also present in the tabular view for Process Level 
Reports, which gives the total of each row and the statistics section 
accurately calculates the total based on the number of incidents run.  



Cost Report 

This report provides information on how much cost was incurred in completing 
tasks at the step. The cost for a step is calculated by multiplying the task time 
with specified task rate. Wait time is also included in task time as it can be a 
major contributing factor towards cost. 

 

The cost can be either viewed for the entire process, or it can be viewed for each 
step in the process. This report allows business managers to determine the task 
or activities that contribute most to the overall cost of the process. 

 



By analyzing these costs, business managers may be able to redesign or modify 
the process with the goal of reducing the overall cost. For example, if the Incident 
Cost Report indicates that a significant percentage of cost is incurred by tasks 
that have to be performed by a senior executive, the process could be 
redesigned so that fewer tasks are assigned to the senior executive, or a new 
recipient for the step can be found that has a lower task rate. 

Note: A Total column is also present in the tabular view for Process Level 
Reports, which gives the total of each row and the statistics section 
accurately calculates the total based on the number of incidents run.  



Lag Time Report 

This report provides information about the lag or dead time for any step in the 
business process. It represents the time that a user is not able to work on a 
particular task, due to the fact that they are working on other tasks.  

 

For example, a particular task needs to be completed by persons ‘A’ and ‘B’.  
Once person ‘A’ has fully completed their part of the task, they will forward to 
person ‘B’. In this case Lag Time is the time from the moment person ‘A’ finishes 
their work, and submits the task  until the moment person ‘B’ starts working on 
the task.  



 

The lag time is a combination of the lag time specified in the scenario plus the 
unproductive time a user spends waiting for new tasks. The latter becomes the 
major factor in the lag time if the workflow process is not balanced. 

Note: A Total column is also present in the tabular view for Process Level 
Reports, which gives the total of each row and the statistics section 
accurately calculates the total based on the number of incidents run.  



Elapsed Time Report 

Elapsed time is the duration of time that it takes a user to complete a task. That 
is, it is the amount of time between a task being assigned to a user, and the time 
the user takes to complete and submit the task. 

 

This report provides information about the total time consumed by each step in 
the business process. It is a measure of how long it takes a task to be completed 
on average. 

 



The elapsed time is a combination of the task time and the lag time of the step. It 
measures the maximum throughput of the step. 

Note: A Total column is also present in the tabular view for Process Level 
Reports, which gives the total amount of time  it took from incident creation 
to completion and the statistics section accurately calculates the total 
based on the number of incidents run.  



Step Utilization Report 

This report displays the percentage ratio of the actual time spent performing a 
task to the actual time available to perform the task. 

 

This report provides business owners with a measure of how much extra 
capacity there is to perform a task. As an example, a step capacity utilization of 
25% indicates that the user for that step has 75% additional capacity that is not 
being leveraged. The Step Utilization report is not available in tabular view. 



Process Balance Report 

A process is said to be balanced if all incidents run through this process are 
taking the same time for completion. The Process Balance Reports displays, in a 
chronological order, the incident completion time for all the incidents run through 
the process. An upward moving graph in a process balance report is an 
indication that the process is not well balanced and needs to be modified. A 
suggested way to resolve this issue would be to then review the task times for 
individual steps in the process.  

 

If the tasks are backing up on one or more steps and if more resources are not 
added, the incident completion time will become unacceptably high. On the other 
hand if the elapsed time hovers around a particular value, it implies that the 
process is balanced and there are enough resources to perform the tasks. The 
example above illustrates an unbalanced process.  



Under Utilization 

This report is rendered as a pie chart where each section of the pie is the Wait 
Time of each step.  Wait Time represents the time that a resource assigned to a 
step was not performing the task, or was assigned to some other task.     

 

The Under Utilization report identifies steps that have the most available free 
time. The resources used at these steps can potentially be assigned to other 
tasks. The Under Utilization report is not shown in tabular view. 



Integration with the Build Editor 

The work you do in the Modeling Editor is not lost when you move into 
development mode.   Design  documentation and design instructions become 
specifications for input parameters required when using the Build Editor in 
Ultimus BPM Studio. While you are working in the Build Editor, design 
instructions specified in the Modeling Editor are available as notes. These notes 
are shown to you while you are working with Step Properties, Event Conditions 
and the Form View. These have been explained in the coming sections. 

Working with Step Properties Window 

Using the Modeling Editor  you might specify design instruction and notes about 
steps recipients, completion time, extension time and delay time as shown in the 
snap below: 

 

When you open this process in the Build Editor, the above specified instructions 
are shown to you in the form of notes as follows: 

1. Open a process using the Build Editor.  
2. Right click on a step and select the option properties. 



3. The properties window appears. 
 

 

4.  When you do a mouse click on recipient, completion time, extension time 
or label, the instructions specified in BPM Studio are displayed as shown 
in the snap below. For example if we click on completion time combo box, 
following instructions are shown: 
 

 

5. Using the instructions specified you can easily build a process is using the  
design documentation that was provided. 

Working with Event Condition Tables 

Using the Modeling Editor, you might specify design instruction and notes about 
event conditions as shown in the snap below: 



 

When you open this process in the Build Editor, the descriptions specified for any 
event condition is shown to you in the form of notes as follows: 

1. Open a process in the Build Editor.  
2. Right click on a step and select the option Event Conditions. 
3. The properties window appears. 

 

 
  

4.  When you click on an event condition row in this table, the description for 
the selected condition is shown to you as a tool tip.  

Working with Form View 

Using the Modeling Editor  you can specify design instructions and notes about 
the Inputs, Processing and Outputs of a step. This information proves very useful 
when you are designing the form for a step in the Build Editor.  

When you open a process in the Build Editor these notes are displayed as 
follows: 



1. Open a process in the Build Editor..  
2. Select a step and click on the Form View button to switch to the Form 

View.  
3. In the Form View Tool bar click on the button "Notes" and the 

instructions specified in the Modeling Editor are shown to you as follows: 
 

 
  

4. Using the Input-Output instructions specified in Ultimus BPM Studio you 
can create forms for different steps in a process.  



Creating Design Documents 

When working with the Modeling Editor, the information you provide for the 
process and steps can be easily incorporated into a Microsoft Word document for 
storage, printing, and distribution.    The user can create one or more 
documentation templates in Microsoft Word and then use these templates to 
produce  a Word file.  Thus, Ultimus BPM Studio provides the capability to take 
the process design and produce an electronic document that describes the 
model, its objects and requirements.   

Ultimus provides a list of pre-defined documentation variables that can be used 
in the documentation templates.  These variables can be broken down into three 
categories: Process-related, Step-Related, and Loop. 

Process-Related Variables 

Process-related variables deal with the entire process, and generally refer to one 
piece of data in a report. They are as follows: 

• Process Name: Name of the workflow process.  
• Process Description: Description of the process. 
• Process Creation Date: Date the process was created.  
• Process Modified Date: Date that the process was last modified.  
• Process Map: Image of the process map.  
• Total Number of Steps: Total number of steps used in the process.  
• Number of User Steps: Total number of user steps used in the process.  
• Number of Flobot Steps: Total number of Flobot steps used in the 

process. 
• Number of Maplet Steps: Total number of maplet steps used in the 

process. 
• Number of Junction Steps: Total number of junction steps used in the 

process.  

Step-Related Variables 

Step-related variables refer to specific steps in the workflow process, rather than 
the whole process. Step-related variables are generally used in a loop (see next 
section). The step-related variables are as follows: 

• Step Label: The label of the step.  
• Step Conditions Table: Conditions table for the step. 
• Step Recipient Notes: Notes about step recipients. 
• Step Completion Time Notes: Notes about step completion Time.  
• Step Extension Time Notes: Notes about Step Extension Time.  
• Step Delay Time Notes: Notes about delay time for the step.  
• Step Notes: Notes about the step.  



• Step Inputs: Details about step inputs.  
• Step Outputs: Details about step outputs. 
• Step Actions: Details about step actions.  

Loop Variables 

One of the most useful features of the process Documentation function is the use 
of the Begin Step Loop and End Step Loop variables. When you place a step-
related variable between the two loop variables, Ultimus provides the values of 
that step variable for every step in the process. Therefore, if you wish to know the 
Step User, Step Task Cost, Step Completion Time, and Step Delay Time for 
every step in the process, you insert the following variables: 

• Begin Step Loop 
• Step User 
• Step Task Cost 
• Step Completion Time 
• Step Delay Time 
• End Step Loop 

Ultimus automatically "loops" through all the steps and prints the values of the 
documentation variables for each. 

The loop variables are as follows: 

Begin Step Loop: Triggers the beginning of the loop.  

End Step Loop: Triggers the end of the loop. 

Creating a Documentation Template 

Ultimus allows you to create a Documentation Template that specifies the format 
and content of the documentation. You can create multiple Document Templates 
and use them for different purposes.. 

Creating a Documentation Template 

To create a Documentation Template: 



1.  Select Documentation from the Tools menu. The Documentation window 
appears 

 
2. Click on the New button to create a new report. The Enter the Report 

Name window appears. Type in the name of the Report. 

 
  

3. Click OK.  
4. Ultimus launches Microsoft Word and the Documentation variables list 

window appears on top of Word. You can now use all the capabilities of 
Word to create a report template. 
 

  
  



5. Type in the desired field labels on the report template and format them as 
you wish. 

6.  For each label, select a variable from the Documentation window and 
click the Insert button, or double-click on the variable.  

7. The code for the variable appears in the Word document.  
8. After you have inserted all the needed variables, click on the Done button 

in the Documentation window. 
9. Ultimus closes the Word document and the Documentation variables 

window.  
10. The name of the new report appears in the Documentation window.  
11. Click Done.  

Editing a Document Template 

To edit a Documentation report template: 

1. Select Documentation from the Tools menu. The Documentation window 
appears.  

2. Select a report template from the Reports list box.  
3. Click Edit.  
4. Modify the report template as described previously. 

Creating a Documentation Report 

To create a documentation report: 

1. Select Documentation from the Tools menu. The Documentation window 
appears.  

2. Select a report template from the Reports list box.  
3. Click on the Run button.  
4. Ultimus compiles the report and opens Microsoft Word to display the 

results. 

  

  

  



Working with the Build Editor 
The Build Editor allows you to automate business processes by adding business 
logic and forms to processes, and also allows you to perform integration with 
enterprise systems through robust integration components such as the Flobots. 
Processes can be designed from scratch in the Build Editor, or the Build Editor 
can use the output from Process Designer and the Modeling Editor as the 
foundation for automating a business process. 

The following topics will be discussed in this chapter: 

Defining Map Properties  
Editing Steps  
Working in the Data View  
Working With Forms  
Working With Flobots  
Reusing Process Objects  
Defining Inlets  
Simulation  
Working with Form Object Library Editor  
Advanced Design Features  



Defining Map Properties 

The Map Properties window contains information about the current process map, 
such as process owner, process description, e-mail notifications, controls for 
assigning databound variables to a database, and checking how much hard disk 
space is being used by the Ultimus Distributed Spreadsheets. 

To Preview Map Properties: 

In the Repository View Window, expand an existing Process node, and select 
Map Properties. The following screen appears: 

 

Editing Map Properties Object: 

Ultimus BPM Studio allows you to edit individual process objects without 
checking out the entire process. To edit the Map Properties Object, simply right 
click Map Properties on the Repository View Window, select Check Out, and 
then select Edit from the Object menu.  



         

Once you are done editing the object, you can save and close the object by 
selecting the Close Editor button on the BPM Studio Tool Bar. 

Map properties may also be edited from the Build Editor, by selecting File and 
then Map properties. The images below are examples of where the user is 
working with the Map Properties in the Build Editor. 

Defining the Process Owner 

A process owner may be assigned to each process as an option. The process 
owner receives e-mail notification (which you can define) for events which 
warrant an emergency notification, such as stalled processes. To see which 
messages the process owner receives, refer to the table in the section, "Defining 
E-Mail Notifications." 

To define the process owner: 

1. In the Build Editor select Map Properties from the File menu. The Map 
Properties window appears. 



 

 

2. Click on the Process Owner Type combo box and select either a user or a 
job function.  

3. Click on the Browse button beside the Process Owner field. The Select 
Recipients window appears. Depending upon which type you selected 
above, choose either a user or a job function as the process owner, then 
click OK.  

4. Click OK to close the Map Properties window.  

Process Completion Time 

Ultimus provides the ability to specify a Completion Time limit for the process. 
Like Completion and Extension Times for User steps, this can be a constant or a 
variable. If a process incident is not completed within the Process Completion 
Time limit, the BPM Server sends a Late Incident Notification to the process 
owner. 

To set the Process Completion Time: 

1. Enter a length of time in the Completion Time field, or select a workflow 
variable.  

2. Select a unit of time (Months, Days, or Hours).  

Note: The Process Completion Time can be expressed as an absolute time 
(e.g., 6/15/2001) or relative time (e.g., 3 Days). However, be aware that when 
using an absolute time, the process can only be used once and its 
flexibility is, therefore, limited. 

Help URL 



The user may type in the URL for an HTML process help file or select a main 
spreadsheet variable that contains the URL. This help file is then shown at the 
Client via a help button. The HTML process help file may be generated using any 
HTML authoring tool and saved on any web server. The step help file may be 
invoked by the Client user via button in the form toolbar or the Client task list 
menu. 

To define the Process Help URL: 

• Enter the URL in the Help URL field or select a workflow variable.  

Defining the Process Description 

The process description is a brief description of the Process. It is available for 
inclusion in process documentation, as described in "Outputting Technical 
Documentation" 

To enter a process description: 

1. Select Map Properties from the File menu. The Map Properties window 
appears as shown in Step 1 above.  

2. Enter a brief description of the process in the Process Description field.  
3. Click OK to close the Map Properties window.  

Defining E-Mail Notifications 

Ultimus sends e-mail notifications when certain events occur, such as a new 
task, a stalled incident, or an aborted step. Ultimus has default messages for 
these events, but they can also be customized for your specific needs. You can 
use any workflow variable to enter specific information in the e-mail message to 
make it more meaningful to the recipient. This is also beneficial if you are working 
in a language other than English so you can translate the message. 

The following table lists the events, their descriptions, and the message 
recipients:  

Event  Description  Message Recipient  

New Task  The recipient has a new task 
waiting.  Recipient(s)  

New Process 
Installed  A new process can now be initiated. All users named in the 

Begin Step  
Incident Stalled  An incident of a process has stalled. Process Owner  

Late Step  A task is late.  Recipient and the 
recipient's Supervisor  

Invalid User  An invalid user has been named in Process Owner  



a step.  
Aborted Step  A step has been aborted.  Recipient(s)  

Aborted Incident  An incident has been aborted.  
All users who have 
participated in the 
incident  

Step Failed  A Flobot step has failed to execute 
properly.  Process Owner  

Incident Time 
Limit Reached  

The Completion Time for the 
process incident has been reached. Process Owner  

Minimum 
Response Email  

A task has been performed by the 
minimum number of users specified. 

All group members 
assigned to the step  

Completion Time 
Expired  

The completion time for a step has 
expired.  Recipient(s)  

Using Variables In E-Mail Notification 

Ultimus allows you to use three types of variables when modifying e-mail 
notifications, key variables, system variables, and workflow variables. Workflow 
variables are any variables defined in the main and local spreadsheets. For more 
information on workflow variables, see "The Data View". 

Key variables are only used in e-mail notifications, and allow the user to specify 
incident-specific information, such as the label of the current step, the recipient of 
the current step, the direct URL for a form, and more. The following key variables 
may be used: 

• KEY_STEPLABEL: Inserts the label of the current step.  
• KEY_CLIENTNAME: Inserts the name of the recipient of the current step.  
• KEY_STEPNOTES: When a step is aborted in the Client, the Client user 

is prompted to enter a brief description. Likewise, if a Flobot fails, the 
workflow Manager is also prompted to enter a description of why the 
failure occurred. This variable inserts the description into the e-mail 
Notification.  

• KEY_CLIENTURL: Inserts the URL to access the Ultimus Client.  
• KEY_FORMURL: Inserts the URL to directly access the form for the 

current step, without accessing the Client. This is valid for a 7 day period 
after which the cookie expires and the form is removed.  

The following System variables may also be used: 

• SYS_PROCESSNAME: Inserts the name of the current process.  
• SYS_PRIORITY: Inserts the Priority of the current incident.  
• SYS_PROCESSINITIATOR: Inserts the name of the user who initiated the 

current incident.  
• SYS_SUMMARY: Inserts the Incident Summary.  



• SYS_INCIDENT: Inserts the Incident Number.  
• SYS_NOABORT: Inserts the setting of the Disable Abort System variable.  

For a more detailed description of System variables, see "Advanced Design 
Features". 

To define e-mail notifications: 

1. Select Map Properties from the File Menu. The Map Properties window 
appears.  

2. Click the Email Messages tab. The e-mail controls appear. 
 

 

3. Select one of the events, as described previously.  
4. Type the subject of the e-mail message in the Subject field. You may also 

click on the Browse button to insert a workflow variable or System 
variable. See "Advanced Design Features" for more information on 
System variables.  

5. Type the body of the message in the Message Body field. You may also 
click on the Browse button to insert a workflow variable or System 
variable.  

6. Click OK.  

To disable an e-mail message: 

• Click the checkbox next to the event in the Event pane.  

Note: You may also delete the contents of the subject field to disable e-mail 
messages. 



Linking to a Database Table 

In order to use databound variables (as described in "The Data View"), you must 
link the process map to a database table. 

To link the process map to a database table: 

1. Select Map Properties from the File Menu. The Map Properties window 
appears.  

2. Click the Databound Database tab. The Database controls appear. 
 

 

3. Type the user's name in the User ID field.  
4. Type the user's password in the Password field.  
5. Select a Data Source from the DSN combo box. When you have selected 

a Data Source, the Table combo box below becomes activated.  

Note: The first two columns in this database table must be "Name" 
(30 characters) and "Incident" (Type=Long). 
For date type fields, Ultimus does not support date value earlier than 
March 1900.  

6. Select a table from the Table combo box.  
7. Click OK.  

For further information about databound variables please see, "Working with 
Databound Variables" 

Defining Databound Variable Information 



The databound variable controls are covered in " The Data View". 

Checking the Size of Distributed Spreadsheets 

The Map Properties allow you to check the size of each spreadsheet used in the 
current process. It also displays the average size of the spreadsheets. 

To check the size of the Distributed Spreadsheets: 

1. Select Map Properties from the File Menu. The Map Properties window 
appears.  

2. Click the Spreadsheet Size tab. A listbox appears which lists each 
spreadsheet used in the current process and the size in KB (spreadsheet 
sizes are rounded up). The average size of all the spreadsheets is 
displayed at the bottom. 
 

 

3. Click OK.  



Defining Step Properties and Conditions 

The properties for each step in a workflow map consist of the properties for the 
particular kind of step, such as a User step or Flobot step, and the event 
conditions tables. The Step Properties window allows you to tab between these 
two. These windows are also modeless, so that you can modify the properties of 
one step, then click on another step to view its properties without closing the 
Step Properties window. Furthermore, these windows can be resized as needed 
and remember their size and position, even if you exit the Ultimus BPM Studio 
application. 

The following sections describe the properties for each type of step in detail. For 
a detailed description of event conditions tables, see "Documenting Event 
Conditions."  

Note: the remainder of this chapter assumes that you are working with Step 
Properties and Conditions from the Map View in Build Editor. These Step-related 
properties are also accessible from the individual Object Editors. For more 
information, see Editing Steps.  



Editing Steps 

Ultimus BPM Studio provides a variety of different ways to edit Step-related 
information in processes. At a high-level, Steps can be edited through two main 
editor interfaces: 

• Through the Map View when an entire process is being edited in the Build 
Editor 

• Through the individual Step Object Editors 

Depending on the Step type (User Steps, Flobot Steps, Junction Steps, Maplet 
Steps, and Text Areas), there are different Object Editors for each of these Step 
types.  

These Object Editors also behave in two different modes: 

• Preview Mode: When a Step Object is clicked on in the Repository View 
Window, and the object is not actively being edited, the Object Editor for 
that Step will display in Preview Mode in the Editor Window (on the right) 

• Edit Mode: When an object is Checked Out and the user selects Edit from 
the Object menu in the Repository View Window, then the Object Editor 
for that Step will display in Edit Mode, and changes can also actively be 
made to the object 

Below is a description of the different Object Editors for each Step type. These 
Object Editors can be accessed for individual Steps from the Steps node for 
Processes in the Repository View Window. 

  

There are four Step Object Editors for User Steps: 

• Properties Object Editor 
• Event Conditions Object Editor 
• Forms Object Editor 
• Thin Forms Object Editor 

Properties Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 



 

Properties Object Editor (edit mode): 

Right click the object and select Edit from the menu, the following appears; 

 

Event Conditions Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 



 

Event Conditions Object Editor (edit mode): 

Right click the object and select Edit from the menu, the following appears; 

 

Forms Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 



 

Forms Object Editor (edit mode): 

Right click the object and select Edit from the menu, the following appears; 

 

Thin Forms Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 



 

Thin Forms Object Editor (edit mode): 

Right click the object and select Edit from the menu the following appears; 

 

  

There are three Step Object Editors for Flobot steps: 

• Properties Object Editor 



• Trainer Object Editor 
• Event Conditions Object Editor 

Properties Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 

 

Properties Object Editor (edit mode): 

Right click the object and select Edit from the menu, the following appears; 



 

Event Conditions Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 

 

Event Conditions Object Editor ( edit mode): 

Right click the object and select Edit from the menu the following appears; 



 

Trainer Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 

 

Trainer Object Editor ( edit mode): 

Right click the object and select Edit from the menu, the following appears; 



 

  

There are two Step Object Editors for Maplet steps: 

• Properties Object Editor 
• Event Conditions Object Editor 

Properties Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 



 

Properties Object Editor (edit mode): 

Right click the object and select Edit from the menu, the following appears; 

 

Event Conditions Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 



 

Event Conditions Object Editor (edit mode): 

Right click the object and select Edit from the menu, the following appears; 

 

  

There are two Step Object Editors for Junction steps: 

• Properties Object Editor 



• Event Conditions Object Editor 

Properties Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 

 

Properties Object Editor ( edit mode): 

Right click the object and select Edit from the menu, the following appears; 

 



Event Conditions Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 

 

Event Conditions Object Editor ( edit mode): 

Right click the object and select Edit from the menu, the following appears; 

 

There is one Step Object Editors for Text steps: 



• Properties Object Editor 

Properties Object Editor (preview mode): 

In the Repository View Window select the object, the following appears; 

 

Properties Object Editor ( edit mode): 

Right click the object and select Edit from the menu, the following appears; 

 



Defining User Step Properties 

The User Step Properties window allows you to set the parameters for each User 
step. 
 

 

It contains the following: 

• Label: The Label identifies the step and is used by the Ultimus BPM 
Studio to report any errors pertaining to the step. It is also used in the 
workflow Reports. The label must, therefore, be unique. The label is 
displayed below the step icon in the process map. It possible to change 
the label when the process is checked-out in Edit mode. Changes will 
appear in the repository view only after the process has been checked-in. 

• Recipient Type and Recipient: These are used to specify the individuals 
to perform the task for the step. The recipient type combo box is used to 
specify the type of recipients who will receive the task. Based on the type 
you select, the recipient field lets you select the recipient(s). You may 
select one of the following recipient types, for which a detailed description 
of each is provided in the next section:  

o User  
o Job Function  
o Groups  
o Queue  
o Initiator of process  
o Supervisor of Initiator  
o Manager of Initiator  
o Cell Contents  
o Supervisor Cell Contents  
o Manager Cell Contents  
o Weighted Groups  



o Sequential Groups  
o Supervisor Previous Step  
o Manager Previous Step  
o Department  
o Relative Job Function (Initiator)  
o Relative Job Function (Previous Step)  
o Relative Job Function (Cell Contents)  

• Task Rate: This information is used to compute the cost of the workflow 
process. You can either enter the cost in $/hour of the individuals who will 
perform the task, or link it to a workflow variable using the combo box. If 
you choose to do the latter, you can change the rate based upon who is 
performing the task, or some other criteria. This allows the rate to be 
changed dynamically as the incident is in process. Depending on what you 
want to accomplish, the cost can be the labor rate or the fully burdened 
overhead rate of the individual(s). The use of this information is optional. If 
a non-zero task rate is specified, the Ultimus Client asks the user how 
much time was spent to complete the task. The time entered multiplied by 
the task rate is used to calculate the cost of the step. By adding the cost of 
each step, Ultimus computes the cost of an incident. Over multiple 
incidents, Ultimus can compute statistical information about the cost of the 
workflow process.  

• Completion Time: The Completion Time is the time which you allow the 
recipient to complete the task. You can specify the Completion Time and 
the units of the time in days, hours, or minutes in the associated combo 
box. You can specify a fixed Completion Time by typing a constant, or 
select a workflow variable from the combo box. The latter capability gives 
you the flexibility of changing the Completion Time based on the actual 
conditions as the workflow incident is in progress. For example, you can 
automatically change the Completion Time if the workflow is late. When 
the user receives the task, it is marked as Current in the Client task list. 
After the Completion Time has elapsed, the task status changes from 
Current to Overdue.  

• Extension Time: Like the Completion Time, you can specify the 
Extension Time the user is allowed as a grace period over and above the 
Completion Time. This, too, can be a fixed time if you type a constant, or 
variable if you select a workflow variable from the combo box. After the 
Extension Time has elapsed, the task status automatically changes from 
Overdue to Urgent. Thus, the task becomes Urgent after the Sum of the 
Completion Time and Extension Time has elapsed. An Urgent task is 
considered late and this situation triggers the late notification described 
below, as well as the late events described in "Documenting Event 
Conditions ."  
Note: Ultimus calculates the completion and extension time based 
on the actual working hours. For example if completion time for a 
task is 2 hours and it arrives in the inbox at 12:00 PM, given its a 
break from 1:00 PM to 2:00 PM, the task completion time will expire 



at 3:00 PM.  
The working hours for an organization can be specified using 
Ultimus administrator. For details see Ultimus Administrator Manual.  

• Delay Time: The user can specify a constant or variable value that the 
step is delayed. The BPM Server delays invoking the step by this amount 
of time. This allows processes and steps to be synchronized. The Monitor 
View in the Administrator also reflects a Delayed step in Orange.  

Note: The Completion Time, Extension Time, and Delay Time can be 
expressed as an absolute time (e.g., 6/15/2001) or relative time (e.g., 3 
Days). However, be aware that when using an absolute time, the process 
can only be used once and its flexibility is, therefore, limited. 

• Help URL: The user types in the URL of a HTML Step Help File or selects 
a global variable that contains the URL. This Help file is shown in the 
Client via a Help button. HTML Step Help Files may be generated using 
any HTML Authoring tool and saved on any web server. Step Help files 
are invoked by the Client user via a button in the form toolbar or the Client 
task list menu.  

Note: If the Help URL entered begins with "http://," then the Help URL will 
reference an Internet page. Otherwise, the Help URL will reference a page 
on the machine from which the process is running. 

• Default Form: The default form allows you to specify the Form Type that 
will be loaded by the Ultimus Client. When a user clicks on the Step/Task 
in their inbox, Ultimus checks the Default Form type, and automatically 
loads that Form for the user. This gives the Client the ability to load 
multiple Form types, based on the value specified in this field. By default 
this field value is set to Standard Form.  

• Completion Time Expired: An e-mail message may be sent to the 
recipient and his Supervisor whenever the Completion Time for a step has 
expired. This is in addition to any actions specified in the Late event 
conditions tables described in "Documenting Event Conditions ." Users do 
not have to design a special step just to handle late notifications.  

o Notify Recipient: Active this checkbox to send an e-mail message 
to the user named in the step to notify them that the Completion 
Time has expired.  

o Notify Supervisor: Sends an e-mail message to the Supervisor of 
the user named in the step.  

• Extension Time Expired: An e-mail message may be sent to the 
recipient and his Supervisor whenever the Extension Time for a step has 
expired. This is in addition to any actions specified in the Late event 
conditions tables described in "Documenting Event Conditions ." Users do 
not have to design a special step just to handle late notifications.  



o Notify Recipient: Active this checkbox to send an e-mail message 
to the user named in the step to notify them that the Extension 
Time has expired.  

o Notify Supervisor: Sends an e-mail message to the Supervisor of 
the user named in the step.  

• Security: Ultimus offers the following Security features for user steps, 
activated via checkboxes:  

o Private: A step marked as private may not be viewed by any one 
other than the recipient and persons with rights to Archive. This is 
to handle confidential tasks.  

o Non-Assignable: A step marked as non-assignable may not be 
assigned by the user to someone else. Only a person with access 
to the Ultimus Administrator may assign it to another individual.  

• Miscellaneous: The following miscellaneous functions are provided, 
activated via checkboxes:  

o Archive: Whenever a user completes the step during actual 
execution of the workflow, the record for the completed form in the 
BPM Server database is marked as Archived. The user cannot 
delete the record from the database. However, an auditor with 
Access Rights to the Archive, as assigned in the Ultimus 
Administrator, can open and review the completed forms for any 
workflow incident.  

o Allow Resubmit: This function allows a user to open a completed 
step of an active incident and resubmit it. It is configurable on a per-
step basis. If an event occurs after the completion of the step, the 
user can re-open the task and send new information to the BPM 
Server which can change the flow of the process based upon the 
new information and the current status of the process. The 
"resubmit step" can, therefore, be used as a "controller" for the 
incident and implement process rollback to a known state. Multiple 
resubmitable steps may be inserted in a process.  

To define or edit User step properties: 

1. Right-click on the User step and select Properties. The Step 
Properties window appears and defaults to the User Step Properties tab.  

2. Define the User step properties as described previously.  
3. Click OK. Ultimus returns to the Map View.  



Detailed Description of Recipient Types 

Recipients are individuals or groups assigned to perform the task for the step. 
Based on the type you select, the recipient field lets you select the recipient(s). 
The following recipient types are available for User steps: 

• User: A named user. Use the Browse button to select the user from a tree 
list. Note that it follows the reporting hierarchy of users as defined in the 
Ultimus Org Chart. 
 

 

Note: A boxed + sign in the tree list indicates that there are additional users 
under that entry. To view these users, click on the + sign and the tree list 
expands. Conversely, click the boxed - sign to collapse the tree list. 

• Job Function: Specify a job function as the recipient. Use the Browse 
button next to the recipient field to select the job function from a tree list. 
Note that it follows the reporting hierarchy of users as defined in the 
Ultimus Org Chart. Each time the task is activated, Ultimus gets the user 
from the Org Chart, which makes this recipient dynamic.  

• Groups: Specify a group as the recipients. Use the Browse button to 
select a group from the list.  

Note: Groups are defined in the Ultimus Organization Chart. If you select a 
group as the recipient, the task is assigned to all members of the group in 
parallel. This is useful if you want more than one individual to fill out a 
form, such as a survey. 

• Group Voting: When you select groups, the Minimum Response field 
next to the recipient type field is activated. The user can specify the 



number of responses needed from a group before it can proceed. As soon 
as the specified number of responses is reached, the process moves 
forward. The non-responsive members of the group will have the tasks 
removed from their in-boxes and an e-mail notification sent to them.  

• Queue: Specify a queue as the recipient. Each queue is associated with a 
group of users who can become recipients of the queue. Use the Browse 
button to select a group from a tree list. A queue allows a process 
designer to declare any step as a "queue" step. Tasks go into a queue. 
Members of the recipient group request tasks, which are pulled from the 
queue on a first-in, first-out basis.  

Note: Queues are an excellent means of distributing workload among a 
group of users based on the pace at which they perform the work. It 
provides a means of not having to specify a pre-defined user to perform a 
step task when multiple users are capable of performing it. 

• Initiator of Process: Assign the step task to the individual who initiated 
the incident. The recipient field is not used. This is an excellent way of 
automatically routing the workflow back to the individual who initiated it.  

• Supervisor of Initiator: Assign the step task to the immediate Supervisor 
of the individual who initiated the incident. The recipient field is not used. 
The Supervisor is the person who occupies the highest position in the 
cluster of job functions to which the initiator belongs.  

• Manager of Initiator: Assign the step task to the Manager of the 
individual who initiated the incident. The recipient field is not used. By 
definition, the Manager is the person who occupies the highest job 
function in the sub-chart to which the initiator belongs.  

• Cell Contents: Assign the step task to an individual(s) or job function 
specified by a workflow variable (named cell in the main spreadsheet). 
Use the recipient combo box to select the workflow variable. This allows 
users to specify the recipient on an ad hoc basis, since the contents of the 
main spreadsheet cell may be changed during the course of an incident 
via a form, a database action, or some other means. The workflow 
variable can also be a range, which allows a group to be declared 
dynamically as the recipient. Ad hoc recipients and dynamic groups are 
described in detail in "Advanced Design Features." Dynamic groups can 
also set a value for the minimum number or responses required.  

• Supervisor Cell Contents: Assign the step task to the Supervisor(s) of 
the individual(s) specified by a workflow variable. The recipient combo box 
is used to select the workflow variable.  

• Manager Cell Contents: Assign the step task to the department 
Manager(s) of the individual(s) specified by a workflow variable. The 
recipient combo box is used to select the workflow variable.  

• Weighted Groups: When you select a group with this recipient type, the 
step is assigned to one member of the group based on assigned weights. 
Use the Browse button to select a group from a tree list.  



Note: Weights for the group are assigned in the Org Chart. A detailed 
description of weighted groups is provided in the next section. 

• Sequential Groups: When you select a group with this recipient type, the 
step is assigned to the users sequentially, rather than in parallel. Use the 
Browse button to select a group from a tree list. The step is assigned to 
the first member in the group. If the member does not perform the task in 
the allotted time, the step is automatically re-assigned to the next member 
of the group.  

Notes: The group sequence is defined in the Ultimus Organization Chart. 

• Supervisor Previous Step: Assign the step task to the immediate 
Supervisor of the individual who performed the previous step. The 
recipient field is not used.  

• Manager Previous Step: Assign the step task to the Manager of the 
individual who performed the previous step. The recipient field is not used.  

• Department: Assign the task to everyone in a particular Department (sub-
chart). This behaves like the group recipient type described above, except 
that this group consists of all members of the Department. This does not 
include sub-departments.  

• Relative Job Function (Initiator): Assign the task to a job function which 
is closest to the Initiator of the process incident in the Org Chart. See the 
Detailed Description of Relative Job Functions in this chapter for more 
information.  

• Relative Job Function (Previous Step): Assign the task to a job function 
closest to the person who completed the previous step. See the Detailed 
Description of Relative Job Functions in this chapter for more information.  

• Relative Job Function (Cell Contents): Assign the task to a job function 
closest to the person named in a cell in the main spreadsheet. See the 
Detailed Description of Relative Job Functions in this chapter for more 
information.  

Conditional Recipients 

You can also select a recipient on a conditional basis. A conditional recipient is 
selected based upon a set of conditions listed in the event conditions table. This 
is a powerful feature, because a step can be automatically assigned to any 
recipient based upon a set of conditions. Conditional recipients are described in 
"Documenting Event Conditions." 



Detailed Description of Relative Job Functions 

The relative job function allows a task to be routed to a job function relative to a 
user in the organization. Conventional, role-based routing requires an absolute 
job function to which the task is always assigned. Relative job functions allow you 
to design processes with task recipients that are assigned relative to the location 
of another individual in the organization. 

For example, there are two Departments, A and B, in a company and both A and 
B have a departmental secretary. A workflow process requires that the 
departmental secretary enter an account number on a capital appropriations 
request before it is sent to the department head. With role-based routing, the 
workflow design will have to specify either Departmental Secretary A or 
Departmental Secretary B as the recipient of the step. This means that a 
company will either need two copies of the same process (one for each 
Department), or the process will involve branching based on some logic as to 
where the process initiated. With the Ultimus relative job function capability, the 
job functions for both secretaries is simply Departmental Secretary. In the 
process design, the named recipient is the relative job function named 
"Departmental Secretary." If the process is initiated by anyone in Department A, 
it goes to the Departmental Secretary for Department A, and likewise for 
Department B. This capability greatly simplifies the design, management, and 
administration of complex workflow processes. 



Detailed Description of Groups 

As noted previously, you can assign a group to be the recipient of a step. In this 
case, all members of the group will receive the step in parallel. This is ideal for 
creating tasks such as surveys, since you do not have to change the process if 
the members of the group or the number of members change. 

Ultimus also has two special types of groups: sequential and weighted. groups 
are defined in the Ultimus Org Chart. The following are detailed descriptions of 
how these groups may be used in the Ultimus BPM Studio. 

Sequential Groups 

Sequential groups are ideally used when a task can be performed by more than 
one person, but it is important to complete it within a certain time frame. They 
ensure that the process will not remain in one person's in-basket while the 
person may not even be working that day. 

If a step recipient is a sequential group, the step is assigned to the first member 
in the group. If the member does not perform the task in the allotted time, the 
step is automatically re-assigned to the next member of the group. This process 
continues until someone performs the task, or the task reaches the last member 
of the group. The task stays with the last member until it is completed. The 
following important points should be noted about using sequential groups: 

• Any group defined in the Ultimus Org Chart may be used as a sequential 
group as long as it consists only of user names or job functions. You 
cannot name Departments or other groups as members of a sequential 
group.  

• The "sequence" of a group (i.e., the order in which the task is assigned to 
the members) is specified in the Org Chart while defining or editing 
groups.  

• The allotted time to perform the task is the Completion Time only. There is 
no Extension Time for sequential groups.  

• The Completion Time expires after the cumulative time for all members of 
the group (e.g., if there are five members of the group and the Completion 
Time is set for one hour, the Completion Time expires in five hours). Late 
warnings are sent after the cumulative time has elapsed.  

Example 

A group called Approvers consists of John, David, and Linda, in that order. This 
group is named as the recipient in the Approve step of a process, and the 
recipient type is sequential group. The Completion Time for the step is 1 Hour 
and 20 minutes. When a process incident occurs it is first assigned to John. If 
John completes it in 1 hour and 20 minutes, it goes on to the next step. 



Otherwise, it is automatically re-assigned to David. If David also does not 
compete it in 1 hour and 20 minutes, the step goes to Linda. It stays with Linda 
until it is completed or manually re-assigned to someone else. If Linda does not 
complete the step in time, the late event for the step is triggered. 

Weighted Groups 

A weighted group is an easy method provided by Ultimus to distribute tasks to 
individuals using a simple load balancing algorithm. If a step recipient is a 
weighted group, the step is assigned to one member of a group based on 
weights. Over many incidents of the workflow process, the number of times each 
member performs the step task equals their "weight." The weights are assigned 
in the Organization Chart. 

The following important points should be noted about using weighted groups: 

• Weights may be assigned to groups in the Ultimus Org Chart.  
• Weighted groups may consist only of user names or job functions. You 

cannot name Departments or other groups in a weighted group.  
• If the group members are assigned equal weights (e.g, four group 

members are each assigned a weight of 25), the tasks are assigned in a 
round robin fashion. For example, if one user has a task, the next task 
goes to one of the users that doesn't. Once each user has a task, the 
assignment process starts over.  

Weighted groups are a good way to assign a step task to one member of a group 
and ensure that the workload is distributed based on management input. If the 
weights are changed, the workload distribution also changes. For example, a 
weighted group called Buyers has 3 members, John, Susan, and Jill, and their 
weights are 30, 50, and 20, respectively. This group is named as the recipient of 
the "Buy" step in a workflow process whose recipient type is weighted group. 
When a process incident occurs, the BPM Server determines how many previous 
tasks were assigned to each individual. It then assigns the new task to one 
individual so that the percentage of tasks assigned to each is closest to 30%, 
50%, and 20%, respectively. The BPM Server, therefore, tries to distribute the 
workload based upon the weights.  



Defining Begin Step Properties 

The Begin Step is used to "launch" an incident of the process. The properties of 
the Begin Step are slightly different from the User step. These differences are as 
follows: 

• The Begin Step does not have a Completion Time or Extension Time, 
since it is the first step of the workflow process.  

• It has an event conditions table only for Complete and Resubmit events.  
• The Begin Step can be initialized periodically. This means that a process 

can be initiated either by a user, or automatically at some periodic interval 
specified by Ultimus BPM Studio. 
 

 

The following properties are unique to the Begin Step: 

• Launch Type: Specify how the process will be launched. The Launch 
type selected determines which combo boxes and fields are activated 
below. Select one of the following choices:  

o By Client: Enable a user to launch the process. If this choice is 
selected, the Recipient Type and Recipient combo boxes are used 
to select the user(s) who can launch the process. The Task Rate 
field is used to determine the cost per hour.  

o Every Sunday-Every Saturday, First or Last of Every Month, 
Day of the Month, Every Day, or Every Hour: These selections 



enable the process to be launched automatically for the day and 
time specified. If selected, the Frequency combo box is used to 
specify the launch frequency. When "Day of the Month" is selected, 
the Day of Month and Time combo boxes are also activated.  

Note: Time is specified in 24 hour "military" time. 

o Maplet Only: Designates that the process can only work as a 
Maplet. In order to be launched, it must be called by another 
process. When Maplet Only is selected, all of the combo boxes 
below, with the exception of Incident Start, are deactivated.  

• Recipient Type: This combo box contains the following selections that 
are not found in the User step properties:  

o Groups: Enables the process to be launched by any member of a 
group defined in the Ultimus Administrator. This function allows you 
to control who is allowed to initiate incidents of the process.  

Note: When changes are made to a group or department named as the 
recipient for a Begin Step, only the users affected by the change are 
notified. For example, if a group of 300 users is named as the recipient for a 
Begin Step, and the org chart is changed so that another 25 members can 
now initiate the process, only those 25 are notified, rather than all 325 
users. Notifications are sent when Housekeeping runs (for information on 
setting the Housekeeping interval, see the Ultimus Administrator manual). 

o Anonymous User: Enables processes to be launched by any user 
via the ActiveX Client or the Thin Client. The URL for the Thin 
Client can be set up as a link from any web page. Anonymous 
users can also launch a process using a thin form from any web 
page (for complete details, see "The Thin Form Designer"). Ultimus 
tracks these users as "anonymous users." You may also provide 
your own access security.  

• Day of Month: This combo box is active only if the Launch type is "Day of 
the Month." Select the date.  

• Time: This combo box is active only if the Launch type is periodic and a 
day of the week selection. Select the time in 24 hour, "military" time.  

• Frequency: This combo box is active only if the Launch type is periodic, 
i.e., any type other than By Client. In this case, the Frequency combo box 
is used to specify a launch frequency between 1 and 10. For example, if 
the Launch type is specified as Every Friday and the Frequency is 3, the 
process is launched automatically every 3rd Friday.  

• Incident Start: This combo box is used to insert the Seeded Incident 
Number. Every Ultimus process has an incident number. The Seeded 



Incident Number allows the Ultimus Engine to generate incident numbers 
starting from a certain value. Seeded incident numbers are numeric only.  

To define Begin Step properties: 

1. Right-click on the Begin Step . The Step Properties window appears 
and displays the Begin Step Properties tab.  

2. Define the Properties as described previously.  
3. Click OK. Ultimus returns to the Map View.  



Defining Flobot Step Properties 

Defining Flobot step properties is described in "Working With Flobots." Please 
refer to that chapter to learn how Flobots are defined, trained and used. 



Defining Maplet Step Properties 

Maplets are in-line sub-processes which allow a large process map to be broken 
down in to smaller "chunks" to be designed and tested independently.  

A main process can view the Maplet, but cannot change it. A main process can 
transfer data to the Maplet, and also receive data from the Maplet. Furthermore, 
Maplet activities can be monitored in the Monitor view and statistics can be 
incorporated into the statistics of the main process. 
 

 

The Maplet step contains the following properties: 

• Label: Enter the label for the step. This label identifies the step and is 
used by the BPM Studio if it has to report any errors pertaining to the step. 
It is also used in the workflow Reports. The label must, therefore, be 
unique.  

• Maplet Name: Specify the name of the Maplet that you want to launch. 
Select one by clicking the Browse button which displays a list of the 
processes already defined.  

• Repeat Count: A Maplet step can be repeated multiple times. The Repeat 
Count combo box specifies a workflow variable which must contain the 
number of times the Maplet is launched. If the Repeat Cell is not specified, 
the Maplet is launched only once. More details on Repeat Count are 
provided in "Advanced Design Features."  

• Wait for Completion: Enable this checkbox to force the workflow process 
to wait until the launched Maplet has completed. Thus, you can design a 
workflow process which calls a Maplet and waits until it is completed, or 
proceeds to the next step as soon as the Maplet is initiated.  

• Transfer Global Variables: Enable this checkbox to transfer the global 
variables in the current process to the Maplet specified in the Launch 



Process field. Data is also returned to the parent process when the Maplet 
process is completed.  

To define or edit Maplet Step Properties: 

1. Right-click on the Maplet step and select Properties. The Step 
Properties window appears and defaults to the Maplet Step Properties tab.  

2. Define the Maplet properties as previously described.  
3. Click OK. Ultimus returns to the Map View.  



Defining Junction Step Properties 

A Junction step allows many links in a map which are going to the same 
destination to be merged into one link (join). Otherwise, in certain situations, you 
would have a confusing web of links connecting one group of steps to another 
group, as shown in the illustration below. 

 



A Junction step simplifies this arrangement with links going to and from the 
Junction step, as shown below. 

 

A Junctions step also serves the following purposes: 

o Since Junction steps have Activate and Complete event conditions 
tables, you can use the Junction step to consolidate the conditions 
for activating a number of steps into one event conditions table.  

o It enables a group of steps to be executed on a conditional basis 
without having to repeat the conditions for each step in the group.  

o Junctions enable a group of steps to be followed by another group 
of steps without having to draw a large number of individual links 
from each step in the first group to each step in the second group.  

o Junctions allow users to implement a group of steps as a "sub-
program." The group can be called iteratively from different points 



in the process map. 

 

The Junction step contains the following properties: 

• Label: This identifies the step and is used by the Ultimus BPM Studio if it 
has to report any errors pertaining to the step. It is also used in the 
workflow reports. The label must, therefore, be unique.  

• Delay Time: The user can specify a constant or variable value that the 
step is delayed. The BPM Server delays invoking the step by this amount 
of time. This allows processes and steps to be synchronized. The Monitor 
View in the Administrator also reflects a delayed step in blue.  

To define or edit Junction Step Properties: 

1. Right-click on the Junction step and select Properties. The Step 
Properties window appears and defaults to the Junction Step Properties 
tab.  

2. Modify the Junction step properties as described previously.  
3. Click OK. Ultimus returns to the Map View.  



Event Conditions Rules and Guidelines  

1. Event Conditions Tables and Actions are used to bypass the normal flow 
of a workflow process as represented by the map. Thus, this feature 
should be used only for handling exceptions, and the normal flow of the 
process is the one represented by the map.    

2. Every step in the workflow map, with the exception of the End Step, has 
two or more of the following Events associated with it: Activate, Complete, 
Return, Resubmit, Late, and Recipient.    

3. Every Junction step in the workflow map has two Events associated with 
it: Activate and Complete. Thus, you can also use Junction steps to 
conditionally branch to a group of steps, or branch out from a group of 
steps.    

4. For each Event there is an Event Conditions Table which you can define, 
along with the Actions which you want to take if a condition is satisfied.    

5. If a step has a blank Event Conditions Table, it means that workflow will 
follow the normal progression as represented by the map.    

6. You can specify up to 255 workflow variables as columns of the Event 
Conditions Tables, and up to 9999 rows. Columns are ANDed and rows 
are ORed.    

7. For each row you can also specify an Action. Supported Actions include 
the following:    

o Activate Step    
o Abort Step    
o Abort Incident    
o Call .NET Code  
o Call Web Service  

   

8. The Conditions Table for User steps allow you to specify a Recipient on a 
conditional basis. Thus, you can decide who will perform the step based 
upon any condition.    

9. Jump To can occur on Complete, Return, Re-Submit, and Late Event 
Conditions. However, please note the following exceptions:    

o When Complete conditions are present for a step, normal links are 
ignored when the step is complete.    

o When Return conditions are present for a step, normal links are 
ignored when the step is returned.    

o When a step is Jumped To (activated through Event Conditions), 
Activate conditions are ignored.    

o Jumping to a delayed step (using Event Conditions) immediately 
activates the step.    

o Returning a task sends it back to the user of the previous step who 
originally performed the task. This is also true for Queue steps.    



o Any step with multiple recipients from a group or dynamic group 
cannot return the task.  

Note: Conditions Tables are very powerful. While they give you a lot of 
flexibility, they must be used with caution because it is easy to define 
conditions and actions which are contradictory or can lead to workflow 
processes which "stall."  



The Event Conditions Tables Window 

The Event Conditions Tables window contains a spreadsheet with six tabs: 
Activate, Complete, Late, Return, Resubmit, and Recipient. Click on a tab to 
display the corresponding Event Conditions Table. 
 

 

The first column of an Event Conditions Table is reserved for the Action that will 
be taken if the condition is satisfied. The second column is reserved for the step 
that will be invoked by the Action. 

All other columns represent workflow variables from the Main Spreadsheet which 
you can use to define the conditions. You select these variables while defining 
the conditions tables and the name of the variable is displayed as the column 
heading. You can select up to a maximum of 255. 

Each row consists of a unique condition which you define. The first column of a 
row represents the Action that will be taken if the condition is satisfied. All other 
columns for the row contain either a blank, in which case the variable is ignored, 
or contains an expression against which the variable is compared. Thus, in the 
Event Conditions Table shown below, the Order Entry workflow step is activated 
if "Customer" is "Medium sized," "Dept." is "Engineering," "Plant" is "A-9," and 
"Approve" is "Yes." 
 

 

Activate Event Conditions Table 

Every step, other than the Begin or End Step, has an Activate Event Conditions 
Table. This table is used if you want to activate the step on a conditional basis. It 
is evaluated by the Ultimus BPM Server when a step is to be activated. If the 



Activate Event Conditions Table for a step is empty, the step is always activated. 
However, if there is one or more entry in the table, Ultimus performs the actions 
listed in the Event Conditions Table if the corresponding conditions are satisfied. 
The Action is the following: 

• Activate the step.    

An example of the Activate Event Conditions Table is shown below: 
 

 

In this example, the Engg step is activated only under two conditions. For the first 
condition, the step is activated if the Total Expense is 1000, the Department is 
Sales, and the value of the Tax variable is "Y." For the second condition, the step 
is activated if the Total Expense is 10000, the Department is Manufacturing, and 
the expense has been approved. 

Note: The Activate Event Conditions Table is evaluated one row at a time, 
starting with the first. As soon as a row evaluates as true, the step is 
activated, and no further rows are evaluated. If none of the rows evaluate 
true, the step is not activated.   

Complete, Late, Return, and Resubmit Event Conditions Tables 

The Begin Step, User steps, Flobot steps, and Maplet steps contain two or more 
of the following Event Conditions Tables: Complete, Late, Return, and Resubmit. 
These tables are evaluated by the Ultimus BPM Server as follows:   

• Complete: Evaluated when the step is completed.    
• Late: Evaluated if the step becomes late (i.e., it goes past its Completion 

Time and Extension Time).    
• Return: Evaluated by the Ultimus BPM Server if the step is returned.    
• Resubmit: Evaluated by the Ultimus BPM Server if the step is re-

submitted.   

If any of these Event Conditions Tables are empty, the BPM Server does the 
following:   

• Complete: The BPM Server activates the next step(s)in the process map.  
• Late: The BPM Server does nothing.    
• Return: The BPM Server activates the previous step performed by a user 

in the process.    
• Resubmit: The BPM Server does nothing.   



However, if there is one or more entry in a Table, the BPM Server does not follow 
the process map. Instead, it performs the actions listed in the Event Conditions 
Table if the corresponding conditions are satisfied. The Actions can be any of the 
following:   

• Activate another step.    
• Abort another step.    
• Abort the entire workflow incident.    

Since you can specify multiple condition rows and every row is evaluated, you 
can cause it to perform many different Actions. The Complete, Late, Return, and 
Resubmit Event Conditions Tables, therefore, give you tremendous flexibility in 
changing the course of the workflow based upon unique conditions.   

Recipient Conditions Table 

User steps and Flobots steps have a Recipient Event Conditions Table. In the 
first column of the Table, you select the Type of Recipient, then choose the 
Recipient based on that Type. 

 

The following Recipient Types are available (for complete definitions of these 
Recipient Types, see "Designing Process Maps."):   

• Users    
• Job Functions    
• Groups    
• Queue    
• Cell Contents    
• Supervisor Cell Contents    
• Manager Cell Contents   

If the Recipient Conditions Table for a step is empty, or none of the condition 
rows are satisfied, the Recipient is as named in the step Properties. However, if 
there are one or more rows in the table, the BPM Server selects a Recipient 
listed in the table when the corresponding conditions are satisfied. Since the 
BPM Server evaluates the conditions from the top, the first row for which the 
conditions are true specify the Recipient for the step. 

The Recipient Conditions Table, therefore, gives you tremendous flexibility in 
assigning workflow tasks based upon unique conditions, such as the skill level of 
users and the complexity of the task. 



Note: When combined with the Activate Conditions Table, this feature 
allows you to decide not only if a step will be activated, but also who will 
do it under different conditions. 

Ultimus also provides an advanced feature for Referencing External .NET 
Assemblies When Calling .NET Code 



Working with Conditions Tables 

In the following sections, we discuss how to define a Conditions Table. In the 
examples given below, we use the User step, which is the most common. For the 
other steps, such as Junctions, Flobots, and Maplets, there are some slight 
variations as to which events are available, which are discussed in the later 
sections. 

Opening the Conditions Table Window 

To open the Event Conditions Table for a step: 

• Right-click on the step and select Event Conditions. The map step 
Properties window appears and defaults to the Conditions tab. The 
window may be resized, maximized, or minimized. 
 

 

Specifying Actions in the Event Conditions Table 

The first column of the Event Conditions Table is the Actions column and is 
permanently labeled as such. Each cell in the Actions column is used to specify 
the action which will be taken. The second column is permanently labeled as 
Parameters. This is used to specify the step related to the action. 

To add an Action to an Event Conditions Table:  

o Open the Conditions Table you want to modify.  
Notes: If no condition is present, the Action is always performed.  

o Double-click on the first blank cell in the Actions coumn. The Actions 
window appears.  



 

 

o Select one of the following actions:  
o Activate Step: Activates the step specified in the Parameters 

column.  
o Abort Step: Aborts the step specified in the Parameters column.  
o Abort Incident: The entire workflow incident is aborted.  
o Call .NET code: Calls .NET Code in the Parameters column.   
o Call Web Service: Calls Web Services in the Parameters column.   

The specified action appears under the Actions Column Header. 

To change or delete an Action: 

• Open the Event Conditions Table you want to modify.  
• Select the Actions cell you want to modify.  
• Right-click on the selected cell.  
• Select Delete from the submenu that appears.  
• The Action is deleted.  

Note: If you remove an Action cell, the entire row of conditions for the 
Action is also deleted. 

Insert, Copy, Paste and Delete Conditions 

When editing a Conditions Table, you may cut, copy and paste Event Conditions 
Table entries. Any condition may be copied and then inserted between existing 
conditions. 

To insert a row in an Event Conditions Table: 

• Open the Conditions Table you want to modify. 
• Select the cell in the Action column below where you want a row inserted. 



• Click on the Insert Row button  in the Event Conditions Table Toolbar or 
right-click on the cell and select Insert Row. A row is inserted above the 
selected cell. 

To copy a row or cell in an Event Conditions Table: 

Open the Conditions Table you want to modify.  

1. Select a cell or an entire row of cells. 
2. Click the Copy button in the Toolbar or right-click on the selection and 

select Copy. 

To paste a row or cell in an Event Conditions Table: 

1. After you have copied a row or cell, select the cell where you want the 
copied item to appear. If you are pasting an entire row, select the cell in 
the Action column. 

2. Click on the Paste button in the toolbar. 

To delete a row in an Event Conditions Table: 

1. Display the Conditions Table you want to modify.  
2. Select a cell or an entire row of cells. 
3. Click the Cut button in the Toolbar or right-click on the selection and 

select Cut. 

Specifying Steps in an Event Conditions Table 

For every Action that you define, there is a step that is affected. Under the 
Activate Tab, the current step is added automatically since the only Action is to 
activate the current step. However, under the Complete, Late, Return, and 
Resubmit Tabs, the steps are defined independently. 

To select or change a step in an Event Conditions Table: 

1. Open the Event Conditions Table you want to modify. Double-click inside 
the cell under the Parameters column header. The Select Step window 
appears. 



 

 

2. Select a step from the Step combo box. All steps created for the process 
map are listed.  

3. Click OK. The step name is added to the Step column. 

Event Conditions Tables for Junctions 

The Conditions Tables for Junctions are a subset of the Conditions Tables of 
normal steps. This is because there are no tasks associated with Junction steps 
and, therefore, a Junction step cannot be late, rejected, or have a Recipient. 
Thus, a Junction step only has Activate and Complete Conditions Tables. 

 



Working in the Data View 

The collection and distribution of information is the essence of any workflow 
process. Information is collected and distributed either because it is the very 
purpose of the process, or because the information is used in making decisions 
about how the process will flow to its conclusion. A good workflow process 
collects raw data and converts it into useful information on which decisions can 
be made and actions taken, and then enables users to make the decisions or 
take the actions.  

This section describes how the Data View can be used to move process 
variables through a business process as it executes in the real world.  

The Data View for each process can be accessed by expanding the nodes under 
any process in the Repository View Window, and editing the Workflow Variables 
object under the main process node. 

The Data View for a particular process can also be accessed through the Build 
Editor 

  

  



Distributed Spreadsheets 

Ultimus uses spreadsheets to collect and distribute data in the course of a 
workflow process. Since the participants in a business process are not located at 
one place, we use the model of "Distributed Spreadsheets." The Patented 
Distributed Spreadsheet Model (#6,157,934) is one of the most powerful feature 
of Ultimus which provides you flexibility and ease in designing and implementing 
workflow processes. The "Distributed Spreadsheet" Model is shown in the 
following illustration: 

 

Each step in an Ultimus workflow process has a form and a local spreadsheet 
which is invoked by the user. The process also has one main spreadsheet. 
Information (data) moves from the form to the local spreadsheet. When a step is 
complete, the information is transferred from the local spreadsheet to the main 
spreadsheet of the process. In the main spreadsheet, it is combined and 
synchronized with data coming from other steps in the workflow. From there it 
moves to the local spreadsheets of other steps, if required. 

An Ultimus workflow process uses two types of spreadsheets: 

• Main Spreadsheet: This is the primary spreadsheet used by a workflow 
process. For every process there is one main spreadsheet. The main 
spreadsheet is used to consolidate the data received from all the steps in 
the process and perform centralized calculations. The main spreadsheet is 
located on the BPM Server.  

• Local Spreadsheet: There are many local spreadsheets; one for each 
step in the process. Local spreadsheets also have cells which contain 



data, text, or formulas. Some of these cells are linked to "forms" which the 
user uses to enter data. Other cells are linked to cells in the main 
spreadsheet. When the user gets a task, the contents of linked cells in the 
local spreadsheet are updated with the data from the main spreadsheet. 
When the user performs the task, the form shows data from the local 
spreadsheet. When the user enters data, it goes into the local 
spreadsheet which recalculates and shows new values on the form 
instantaneously. This allows users to design intelligent forms without 
programming. When the user is finished with the task, the contents of the 
linked cells in the local spreadsheet are sent back to the main 
spreadsheet. The main spreadsheet, thus, collects data from all the users 
involved, and performs calculations on this data. The results of these 
calculations are passed on to the next stage of the process and may also 
be used to make decisions regarding which steps will be executed.  

Note: Many users are already familiar with popular spreadsheets, such as 
Microsoft Excel and Lotus 1-2-3. If you are not familiar with these, we 
strongly recommend that you learn about one of them before proceeding. 
Since the spreadsheets used in Ultimus are functionally most similar to 
Microsoft Excel, we recommend that, if you have a choice, you should 
familiarize yourself with Excel. 

Rules About Spreadsheets and Variables 

1. Ultimus spreadsheets are functionally a subset of Microsoft Excel. Many of 
the mathematical and logical functions of Excel are available in the 
Ultimus spreadsheets. A description of these functions is provided in 
Ultimus document "Spreadsheet Functions," which is included on the 
Ultimus CD as an Adobe Acrobat PDF file.  

2. There is one main spreadsheet for each process.  
3. There is a local spreadsheet for every step in the process.  
4. A cell in the local spreadsheet may be linked to one or more Controls in 

the form for that step.  
5. A cell in the local spreadsheet may also be linked to one cell in the main 

spreadsheet.  
6. If a local spreadsheet cell is linked to a main spreadsheet cell, the 

contents of the main spreadsheet cell are transferred to the local 
spreadsheet cell before the step is invoked, and are transferred back to 
the main spreadsheet cell after the step is completed.  

7. The background color of the spreadsheets are coded as follows:  
o Main Spreadsheet: Variable color (determined by the user).  
o Local Spreadsheets: White  

8. Main spreadsheet cells and cell ranges may be named. Named main 
spreadsheet cells or ranges are called workflow variables. Local variables 
are named cells in a local spreadsheet. By naming cells, you do not have 
to remember the Row-Column address of important cells.  



9. Workflow variables can be used as arguments in creating Event 
Conditions Tables. They can be used for powerful evaluation of conditions 
and performing activities based upon those conditions. Event Conditions 
Tables are described in "Documenting Event Conditions".  

10. Global variables are automatically linked to new and current steps in the 
process, which makes it much easier to define variables and links. A 
global variable is linked to the same cell as in the main spreadsheet and 
the name of the cell is defined automatically in the local spreadsheets. 
Global variables are linked bi-directionally to the same cell in each step of 
the workflow process.  

11. Workflow variables can be used as databound variables, which are tied to 
a database field. Before a workflow variable can be declared a databound 
variable, the process map must be linked to a database table in the Map 
Properties (see "Designing Process Maps"). During the execution of the 
workflow, whenever a workflow Incident is initiated and executed, the 
Ultimus BPM Server automatically updates the database after every step. 
All system variables can also be linked to this database table. Thus 
Incident Name, Summary, Priority, and more may all be saved in the user 
database. For further information about databound variables please see, 
"Working with Databound Variables".  

12. Only single cell variables can be used as databound variables.  
13. Workflow variables may be used as arguments for Cell Content Recipient 

Types for steps. This allows you to assign recipients dynamically and also 
create dynamic groups.  

14. Variables are used to pass arguments to Flobots.  
15. Workflow variables can be linked with local spreadsheets cells of 

individual steps. This allows you to control which pieces of information are 
shared with specific steps.  

16. When passing date values to a Databound database, the Main 
Spreadsheet cell linked to the date value must be formatted as "date". For 
passing date type values to database fields, Ultimus does not support date 
value earlier than March 1900.   



Data View 

The Data View has a set of menu options and buttons which are identical to all 
other views, with the exception of the View Toolbar and the spreadsheet tabs. 
 

 

The View Toolbar contains command buttons and functions which are unique to 
the Data View. The spreadsheet tabs are used to select the main spreadsheet 
and the local spreadsheets. 

The View Toolbar 

The toolbar consists of the following:  

Button Name  Description  

   Font Combo 
Box  Select the cell font.  

   Font Size 
Combo Box  Select the font size.  

 Bold  Bolds selected cell text.  
 Italic  Italicizes the selected cell text.  
 Underline  Underlines selected cell text.  
 Align Left  Left justify cell data.  
 Align Center  Center cell data.  
 Align Right  Right justify cell data.  
 Cell Format  Access the Format Cells window.  

 
Show 
Formulas  View cell formulas. Toggle on/off view  

   Cell Number Displays the location of the currently selected cell.  



Pane  
   Cell Edit Field Use this field to edit the content of cells.  

   
Workflow 
Variables 
Combo Box  

When a cell has been named, this combo box displays the 
workflow variable when the cell is selected. If the workflow 
variable is global, a globe icon appears to the right. The 
combo box is also used to move the cursor to a named 
cell.  

Going to the Data View 

To access the Data View from the Map View: 

1. Select a step in the process map.  
2. Click the Data View button or select Data from the View menu.  

Note: If you click the Data View button without selecting a step, the main 
spreadsheet appears. 

To access the Data View from the Form View: 

• Click the Data View button . The program switches to the Data View 
and shows the spreadsheet for the selected step.  

  



Working with Spreadsheets 

Creating the Spreadsheets 

When you make a new process map, a main spreadsheet is automatically 
created along with a spreadsheet for the Begin Step. Whenever you add a new 
step in the process map, a spreadsheet for that step is also created. If you name 
the step, the spreadsheet assumes the name of the step. If you delete a step, the 
spreadsheet for that step is also deleted. 

Therefore, to make or delete spreadsheets, you do not have to do anything other 
than define the steps in the process. The program takes care of maintaining the 
appropriate number of spreadsheets. 

Changing the Main Spreadsheet Color 

The main spreadsheet background color can be changed by the user. This is to 
differentiate it from the local spreadsheets, for which the background color 
cannot be changed. 

To change the background color of the main spreadsheet: 

1. Select Main Spreadsheet Color from the Tools menu. The following 
window appears. 
 

 
2. Select the color from the Main Spreadsheet Color combo box.  
3. Click OK.  

Moving Among Spreadsheets 

In the Data View, the main spreadsheet is identified with a tab labeled main and 
each local spreadsheet is identified by a tab labeled with the name of that step. 



The selected spreadsheet is designated by a white tab. 

To switch to another spreadsheet: 

• Click on the tab for that spreadsheet.  

If there are many spreadsheets, there may not be enough room to display 
all of them. The program provides tab controls which let you move either 
left or right one step per click. You can use the tab controls to scroll the 
tab list. 

Saving Spreadsheets 

Spreadsheets are saved automatically whenever you save the workflow process 
as described in "Designing Process Maps," section. 

Selecting Cells 

You can select a cell or a range of cells. 

To select an individual unnamed cell: 

• Click on the cell. The cursor appears in the cell and its address appears in 
the Cell Number pane.  

To select an individual named cell: 

• Select its name from the Workflow Variables combo box.  

To select a range of cells: 

• Click on the cell at the top left corner of the range and drag to the bottom 
right corner of the range. The entire range is selected.  

To select an entire row of cells: 

• Click on the label for the row.  

To select an entire column of cells: 

• Click on the label for the column.  

Text in a Cell 

To enter text in a cell: 



1. Select the cell and type in the text. The text appears in both the cell and 
the Cell Edit field.  

2. Press ENTER or any of the cursor keys to record the value.  

Note: If you make a mistake while typing and would like to cancel what you 
have entered, press the ESC key. 

To edit previously entered text in a cell: 

1. Select the cell. The text in the cell appears in the Cell Edit field.  
2. Click in the Cell Edit field and edit the text or press the F2 key to directly 

edit the cell.  
3. Press ENTER to accept the changes.  

Note: If you make a mistake while typing and would like to cancel what you 
have entered, press the ESC key. 

Entering a Formula in a Cell 

Entering and editing a formula in a cell is exactly the same way as text is 
entered, except that formulas must always be preceded with the "equal to" (=) 
character. 

The mathematical and logical functions are very similar to those provided by 
Microsoft Excel. A list of valid functions which you can enter in the spreadsheet is 
provided in the Ultimus document "Spreadsheet Functions," which is included on 
the Ultimus CD as an Adobe Acrobat PDF file. 

Formatting Cells 

You can format a cell or a range of cells. Formatting cells is done the same as in 
Microsoft Excel. Details of cell formatting are in the Ultimus document 
"Spreadsheet Formatting," which is included on the Ultimus CD as an Adobe 
Acrobat PDF file. 

To format a cell or range of cells: 

1. Selecting the cell(s).  



2. Click the Format button . The Format Cells window appears. 
 

 
3. Select the format.  
4. Click OK.  

Copying Cells 

To copy an individual cell: 

1. Select the cell.  
2. Click the Copy button or select Copy from the Edit Menu.  
3. Select a new cell.  
4. Click the Paste button or select Paste from the Edit Menu. The contents 

of the clipboard are pasted in the cell.  

To copy a range of cells: 

1. Select the range of cells.  
2. Click the Copy button or select Copy from the Edit Menu.  
3. Select a new cell.  
4. Click the Paste button or select Paste from the Edit Menu. The contents 

of the clipboard are pasted in the range, with the selected cell being the 
top left corner of the range.  

Deleting Cells 



To delete a cell or range of cells: 

1. Selecting the cell or range of cells.  
2. Click the Cut button or select Cut from the Edit Menu. The contents of 

the cell or range are deleted.  



Naming Cells as Variables 

In this section, we describe how to name and label workflow variables. When 
naming variables, you can use Ultimus' Auto Labeling function to place the name 
of the cell as a label in the cell on the left or above the named cell. If the workflow 
variable is declared global, the label appears on every spreadsheet. Duplicate 
names or cell address conflicts produce a warning message and cancel Auto-
linking. 

Note: Auto-labeling only works for steps that have already been created. In 
order to use auto-labeling for steps that were placed after the workflow 
variables were created, you must open each workflow variable and save it 
again. You can also copy and paste labels from one spreadsheet to 
another. 

To declare a main spreadsheet cell, or range of cells, as a workflow 
variable: 

1. Select the cell, or range of cells.  

Note: For a single cell, you may also double-click the cell. 

2. Right-click the selected cell(s) and select Cell Name. The Main Variable 
window appears. 
 

 

3. Type the name of the workflow variable in the Name field.  
Note: It is strongly recommended that you do not use any numeric or 
special characters while naming a cell. Its also recommended that 
the name of workflow variables should not begin with "SYS", since 
this word is reserved for "System Variables".  

4. If you wish to use auto labeling, click the Auto Label checkbox, then select 
the Left or Above radio button to determine the location.  

5. Click Save. The name appears in the Workflow Variables combo box in 
the Toolbar. If you selected auto labeling, the label also appears in the cell 



on the left or above in the main spreadsheet. The label also appears in the 
local spreadsheets for all steps created up to this point.  

Databound Variables 

To name a main spreadsheet cell, or range of cells, as a databound 
variable: 

1. Select the cell, or range, and access the Main Variable window, and name 
the cell, or range, as described above.  

2. Select a database column from the Bound Column combo box.  

Note: Only single variables can be declared as databound variables. 
Ultimus does not support range variables to be declared as 
databound variables. To create a databound variable, the process 
must be linked to a data source table in the Map Properties. For more 
information, see "Linking to a Database Table." 

3. Click Save.  

For further information about databound variables please see, " Working with 
Databound Variables" 



Declaring Local Variables and Linking to Main Spreadsheet 
Variables 

Linking local spreadsheet cells to the main spreadsheet is separate from using 
global variables. Global variables are linked bi-directionally to the same cell in 
each step of the workflow process. Linking local variables to main spreadsheet 
(not global) variables requires more work, but offers more flexibility in controlling 
which spreadsheets receive particular pieces of workflow data, the flow of the 
data (in or out), and also allows you to link non-corresponding cells in the 
spreadsheets, for complex workflow calculations. 

Local variables may be linked to workflow variables as you create them. Linking 
variables allows the workflow BPM Studio to accomplish the following tasks: 

1. Link a workflow variable to a local variable.  
2. For each link, specify if the data flow between the workflow variable and 

the local variable is unidirectional or bi-directional.  
3. Delete or change the links.  

Link Types: Data Flow 

When you link a workflow variable with a local variable, Ultimus allows you to 
specify the type of "data flow." This allows you to control whether data flow is 
unidirectional or bi-directional for each link. The data flow choices are described 
below. Each choice is associated with a symbol, which is displayed on the step 
along with the name of the variable. This allows you to graphically determine not 
only if the step is linked, but also the direction of data flow. 

• Input: Specifies that data will flow from the main spreadsheet to the 
local spreadsheet. The symbol indicates that data is flowing into the step.  

• Output: Specifies that data will flow from the local spreadsheet to the 
main spreadsheet. The symbol indicates that data is flowing out of the 
step.  

• Input + Output: If both input and output are selected for a link, the 
data is transferred from the main spreadsheet at the start of the step and 
transferred back to the main spreadsheet at the conclusion of the step.  

• Output Indexed: Output Indexed is used to transfer data from the local 
spreadsheet to the main spreadsheet when the recipient of the step is a 
group. If the step recipient is a group, the form and local spreadsheet of 
the step is distributed to all the members of the group. The same task is 
done by multiple individuals. If there are three members in a group and the 
cell A1 of the main spreadsheet is linked to cell A1 of the local 
spreadsheet, when the first member sends data to the main spreadsheet, 
it is placed in cell A1. If the link is Output, when the second member sends 
the data to cell A1 of the main spreadsheet, it overwrites the data from the 
first member, already in A1. If the link type is Output Indexed, the row 



number of the main spreadsheet cell is automatically incremented and the 
data from the second member goes into cell A2. For the third member, the 
row number is incremented once again and the data is placed in cell A3. 
This provides an efficient way of collecting data for a step performed by a 
group. Note that the output arrow in the symbol for Output Indexed is 
colored red, in contrast to the green colored arrows for all other symbols.  

• Input Indexed: Input Indexed works the same as Output Indexed, 
except that data flows to the local spreadsheet, and from the main 
spreadsheet.  

To declare a local spreadsheet cell, or range of cells, as a variable: 

1. Create workflow variables (not global) in the main spreadsheet as 
previously described in this chapter.  

2. Click on the tab for the local spreadsheet.  
3. Select the cell, or range of cells.  

Note: For a single cell, you may also double-click the cell. 

4. Right-click the selected cell(s) and select Cell Name. The Local Variable 
window appears. 

 
5. Type the name of the local variable in the Name field.  
6. If you wish to use auto labeling, click the Auto Label checkbox, then select 

the Left or Above radio button to determine the location.  
7. Select the main spreadsheet variable from the Main Variable combo box.  

Note: Even if you selected a main spreadsheet range for linking, you 
only need to select a cell in the local spreadsheet. This cell is the top 
left corner of the range in the local spreadsheet that is linked to the 
range in the main spreadsheet. The size of the linked range is 
dictated by the size of the range in the main spreadsheet. 



8. Click on the Standard, Indexed, or None radio button to determine the 
Input data flow. The appropriate symbol appears below the Main Variable 
combo box.  

Note: Linked variables in the Begin Step spreadsheet should only 
have Output data flow. 

9. Click on the Standard, Indexed, or None radio button to determine the 
Output data flow. The appropriate symbol appears below the Main 
Variable combo box.  

10. Click Save. The name appears in the Workflow Variables combo box in 
the Toolbar. If you selected Auto Labeling, the label also appears in the 
cell on the left or above in the local spreadsheet.  

Note: If you have not selected any of the Data Flow check boxes and click 
the Save button, the link defaults to Standard Input and Output. 

To modify a link: 

1. In the local spreadsheet, double-click on the named cell. The Local 
Variable window appears.  

2. Select a new main spreadsheet variable or change the data flow.  
3. Click Save.  

To delete a link: 

1. In the local spreadsheet, double-click on the named cell. The Local 
Variable window appears.  

2. Click the Delete button. A message window appears, asking if you want to 
delete the local variable.  

3. Click Yes. The variable and link are deleted.  



Viewing Variable Links 

Once you have created and linked local variables to workflow variables, you can 
view the links graphically in the workflow map. The Variable Link View provides a 
quick overview of all steps connected to the main spreadsheet through linking. It, 
therefore, gives you a bird's eye view of the step where a variable originated, 
where it is modified, and where it is used, but not modified. 

In the Variable Link View, the process map provides the following information: 

• The name of the local spreadsheet cell linked to the current workflow 
variable is listed above each highlighted step.  

• The Data Flow indicator is displayed above each highlighted step and 
specifies the direction of data flow between the local spreadsheet and the 
main spreadsheet.  

To display links which you have already created: 

• Select a workflow variable from the Workflow Variables combo box in the 
Toolbar. The process map displays the links. The name of the local 
spreadsheet variable to which it is linked and the data flow indicators are 
displayed above each step. 

 

Note: Global variables do not appear in the Workflow Variables combo box. 

In the above illustration, the Variable Link View indicates that the workflow 
variable "Name" is linked to the following steps:  

Step  Flow Indicator Link Description
Employee  Output from step 
Payroll   Input to step  
Manager   Input to step  
Flobot   Input to step  
 



Example of Using Global Variables 

The following simple example demonstrates how spreadsheets are used by 
Ultimus. 

We create a workflow process where an employee enters meal and hotel 
expenses for her travel report. The report goes to the departmental Secretary, 
who enters the air fare for the trip. This information then goes to the Manager for 
final approval. A process map for this example appears as follows: 
 

 

For this simple example, the main and local spreadsheets are designed as 
follows using global variables: 
 

 

The Sub-Total cell has a formula which computes the Sum of Hotel and Meals. 
The form for the Employee step consists simply of the fields labeled Name, 
Meals, and Hotel. The Sub-Total is automatically calculated. Each of these form 
fields are linked to their respective cells in the local spreadsheet. The Total cell 
has a formula which computes the sum of Ticket and Sub-Total. 

The form for the Secretary step consists of the fields labeled Name, Meals, Hotel, 
Sub-Total, Ticket, and Total. Each of these form fields are linked to their 
respective cells in the local spreadsheet. The Ticket field is used by the 
Secretary to enter the air fare. 



In a similar fashion, we can design the form and the spreadsheet for the Manager 
step. An additional signature and approval field is added for the Manager to 
provide his signature and approve or disapprove the expense report. 

This simple process works as follows. When the Employee starts an Expense 
Report, a form such as the following is displayed. 
 

 

The Employee enters her name, the meals, and hotel expenses. The Sub-Total 
is computed automatically. When she "sends" the form, the name, meals, hotel, 
and Sub-Total values are transferred to the main spreadsheet. The Ultimus BPM 
Server then sends this information to the local spreadsheet of the Secretary step 
and tells her that she has an Expense Report task to perform. When the 
Secretary invokes the task, she sees the following form: 



 

 

The Secretary enters the ticket information and the total is computed 
automatically. When she "sends" the form, the Ticket and Total information are 
sent to the main spreadsheet. The Ultimus BPM Server then sends all the 
information to the local spreadsheet of the Manager and the Manager is notified 
that he has an Expense Report to approve. When the Manager invokes the task, 
he sees the following form: 



 

 

The Manager signs the form using his password, and either approves or 
disapproves the expenses. This information may also be sent back to the main 
spreadsheet for further processing by subsequent steps in the process. 

This simple example demonstrates how data is routed in an Ultimus workflow 
process. It shows how Ultimus uses spreadsheets and forms to enable you to 
develop sophisticated workflow applications without the need for programming. 



Working With Forms 

Forms are the "user interface" of a workflow process. Users who participate in 
the workflow use the forms to input and receive information, make decisions, and 
review the work of others. 

Ultimus lets the BPM Studio make forms unique to each step of the process. In 
this way, the Ultimus BPM Studio controls what information the user can see or 
input at each step, and what decision the user can make. The process is, 
therefore, fine-tuned and optimized for the needs of each step.  

Note: Third party forms cannot be trained through a child node. 



Working with Standard Forms 

For every Step in a workflow process, Ultimus BPM Studio allows designing two 
different types of forms, the Standard Forms and the Thin Forms. This section 
describes how to design Standard Forms. For details about Thin Forms see the 
section "The Thin Form Designer".  

The Standard forms are viewed in Ultimus Standard Client. Ultimus Standard 
Forms allow the users design sophisticated and powerful front end of a workflow 
process. The Standard Forms provide the users with a very simple and quick 
means of designing web based front ends without doing any scripting. Using the 
Standard Forms a user can visually create forms that connect with databases 
and performs complex queries or uses customized ActiveX Controls. While the 
Ultimus Standard Client and forms provide sophisticated capabilities, they use 
ActiveX or Java controls that may not function in every browser. Ultimus 
Standard Client and Forms are more appropriate for users that are participating 
in a workflow process over the intranet OR a high speed internet.  

When using Standard Forms, Ultimus provides FCO methods that control data 
transfer between the Controls in an Standard Form and a Step’s Local 
Spreadsheet. Most of these FCO methods are Ultimus internal methods that are 
not intended for general usage by Ultimus customers and partners. Those 
methods that are supported for customer and partner usage are listed in Chapter 
6 of the Ultimus EIK, “Using Third-Party Controls in Ultimus Forms”. Please note 
that Ultimus does not support usage of any FCO methods that are not 
documented in the EIK. 



Designing and Editing the User Interface 

The Ultimus BPM Studio provides a powerful graphical form Designer which 
produces web-based forms used in the Ultimus Client. Forms are made up of 
fields, such as text boxes, edit fields, radio buttons, grids, and more. These fields 
are also called controls. Each control in the form is linked to cells in the local 
spreadsheet. When the form is painted, the contents of the controls are updated 
with the contents of the local spreadsheet operating behind the scenes. When 
the user enters data, the data goes directly into the local spreadsheet, where it is 
calculated immediately. These calculations are reflected in other controls linked 
to cells which receive the results of the calculations. Linking with the local 
spreadsheet gives the Ultimus forms a lot of power and flexibility for computation 
and decision making. When the user has finished the form and clicks the Send 
button, the local spreadsheet cells linked to the main spreadsheet are sent to the 
main spreadsheet, whose contents are then updated and recalculated. 



Rules and Guidelines About Forms 

1. Each step must have a form. A blank form is created automatically when a 
step is entered in the process map.  

2. Ultimus forms use Dynamic HTML and ActiveX controls. However, the 
forms Designer is graphical and does not require any scripting or macros.  

3. Ultimus forms can also use HTML controls in addition to Java Beans or 
ActiveX controls. HTML controls are "lighter" and faster; however, their 
functionality is limited by HTML. Java Beans and ActiveX controls are 
"heavier" and slower, but provide much more functionality.  

4. Controls in the forms must be linked to cells in the local spreadsheet or to 
a database. If a control is not linked, the data entered in the control is lost 
after the user completes the form. Linking controls to databases and using 
databases is described in "Using Databases with Forms."  

5. Default values for each control can be defined by placing the value in the 
spreadsheet cell linked to the field. Defaults make it easier for users to 
work with the forms.  

6. While designing a form, you can immediately test the appearance and 
logic in the test mode.  

7. Ultimus forms support digital signatures through a password. You can 
insert a signature control on any form. When the user "signs" it using her 
password, her name appears in all subsequent forms with a special bit 
pattern.  

8. Ultimus forms allow you to attach documents. These documents, or 
"attachments," are routed with the workflow just like other pieces of data. 
However, the attachments are downloaded only when needed in order to 
avoid unnecessary network traffic.  

9. After you have designed a form, you can easily copy the entire form or a 
control to other steps. This saves a lot of time in designing workflow 
processes.  

10. Ultimus also provides a powerful Form Object Library that enables you to 
share and reuse controls that you have defined in the form. The Form 
Object Library is described in "Working with Form Object Library Editor."  

11. In addition to the variables which users can define, Ultimus provides a 
number of pre-defined "system variables" which are common to all steps 
in the process. Instead of the user having to define and link these 
variables for each step, Ultimus enables you to select these fields from a 
list and takes care of all the linking of this information. System variables 
are defined in "Advanced Design Features"  

12. Ultimus also provides a "Placeholder" control which allows you to use your 
own third-party ActiveX or Java Bean controls for specialized functions.  

13. Ultimus supports right-to-left text in forms and the ActiveX Client for use 
with Arabic and Hebrew languages.  

14. Ultimus does not support training of third-party forms through the child 
node. 



The Form View 

The Form View Toolbar contains command buttons and functions unique to the 
Form View. The HTML Controls Palette contains standard lightweight controls 
that can be used in forms. The Advanced Controls Palette contains ActiveX 
controls for advanced functions. The Alignment Aid Toolbar provides various 
alignment and sizing aids. It is also covered later in this chapter.  

 

The Form View Toolbar 

The Form View Toolbar contains the following buttons and controls:  

Button Name  Function  

 Test Mode  Preview the form to see how it will behave when the 
process is running.  

   Page Selection 
Combo Box  

Displays the selected page and allows you to change 
the page.  

 New Page  Creates a new page for a multi-page form.  

 Delete Page  Deletes the selected form page.  

 Spreadsheet Links 
Display/Hide the local spreadsheet for the form and 
Control Links. Also enables linking controls with 
spreadsheet cells.  

 Recordset Links  Open/close the Recordset pane and display links. Also 



enables linking controls with database columns.  
 Spreadsheet  Display/Hide the local spreadsheet for the form.  
 Recordset  Open/close the Recordset pane.  
 Notes Toggle 

Button  Display/Hide BPM Studio Notes.   

 Alignment Grid  Show/Hide the alignment grid.  

   Step Select 
Combo Box  Switch to the form for another step.  

 



Creating a Form 

When you add a new step in the process map, a blank spreadsheet and a blank 
form for that step are automatically created. If you name the step, the 
spreadsheet and the form assume the name of the step. If you delete a step, the 
spreadsheet and the form for the step are also deleted. 

Thus, it is easy to make or delete spreadsheets and forms. You do not have to 
do anything other than define the steps in the process map. The program takes 
care of maintaining the appropriate number of forms and spreadsheets. 

Invoke the Form View 

From the Map View: 

1. Select a step in the process map. The Form View button is activated.  
2. Click on the down arrow beside the Form View button and select Form 

View. The form for the step appears.  

Note: 

You can also double-click on a step to display its form, or right-click on the 
step and select Form. 

From the Data View 

1. Select the Spreadsheet tab for the step.  
2. Click on the down arrow beside the Form View button and select Form 

View. The form for the step appears.  

Moving Among Forms 

When you are in the Form View mode, a form page is displayed in the 
workspace. 

To switch to another step's form: 

• Select the step from the Step Select combo box in the Toolbar. The form 
for the selected step appears.  

Creating a Form With Multiple Pages 

Ultimus allows you to create a form with multiple pages. This allows you to 
design forms in which related information is grouped together on one page. Each 



page can have its own name. Also, a page can be declared as a subform, which 
can be invoked by a button on another page. 

Note: The first page in a form cannot be declared as a subform. 

To create and delete pages in a form: 

1. Select Pages from the Edit menu. The Pages window appears. 
 

 
2. To add a page, click on the New button . A new page appears in the 

Pages list box. The software assigns a default name to the new page, 
which you can change, as described in the section "Page Properties".  

3. To delete a page, select the page in the Pages list box and click the 
Delete button . The page is deleted.  

4. To move a page, select the page and move it using the Up and Down 
arrow buttons .  

5. Close the window.  

Editing Pages using the Toolbar Functions 

You can also add, delete, and move between pages using the Toolbar. 

To create a new page for a form: 

• Click the Insert page button . A new, blank page is inserted behind the 
current page. The software assigns a default name to the new page, 
which you can change, as described in the section "Page Properties".  



To delete a page: 

1. Go to the page.  
2. Click the Delete Page button .  

To switch between pages: 

• Use the Page Select combo box.  



Form Properties 

When a new step is added to a workflow process, a blank form is attached to that 
step. You can change the size of the form and also change its properties, such 
as enabling and disabling Return, Send and Printing hence defining the actions 
performed when the form is loaded, sent, and returned, and adding custom 
HTML code, such as META tags, or scripts. A form can also have multiple pages. 

To change the size of a form: 

1. Click on an empty space in the form to select it. Eight "handles" appear on 
the border of the form as small square boxes.  

2. Click on a handle and drag to resize the form.  

Enabling and Disabling Return, Send and Print Buttons 

When the form is painted in the Client, the Send, Return, Memo and Print buttons 
are always displayed in the Toolbar at the top. The user can click the Send 
button to complete the form and send it forward or, in the case of missing or 
incomplete information, click the Return button to return the process to the 
previous step. The user may click the Print button to print the form. However, 
under certain circumstances you may want to disable the Send,  Return and Print 
buttons based upon some logical conditions. 

Using local Spreadsheet cells or workflow variables, you can enable and disable 
the Return, Send and Print buttons on the form. If the linked cell or local variable 
is either empty or has a 0, the Button is disabled. If the linked cell has a 1 the 
Button is enabled. You can use these functions to enable or disable the Return, 
Send and Print buttons, based on the data in the local Spreadsheet. 

To enable and disable Return, Send and Print: 

1. Right-click in the Workspace of the form and select Form Properties. The 
Form Properties window appears and defaults to the General tab. 



 

 
2. Type the cell address in the Send Enable/Disable Cell field or select a 

workflow variable.  
3. Type the cell address in the Return Enable/Disable Cell field or select a 

workflow variable.  
4. Type the cell address in the Print Enable/Disable Cell field or select a 

workflow variable. 
5. Click OK.  

Defining Actions for a Form or Page 

 Ultimus allows you to define various actions based on form and 
page events. First you select an event, then you select the action 
that takes place. Based on the action selected, additional 
parameters may need to be defined. Form events and actions only 
apply to the first page in a form. If you wish to define events and 
actions for multiple pages in a form, you must define them in the 
properties for each specific page. Page actions are defined in the 
exact same way as form actions. 



 

 

The following combo boxes are available for forms and pages: 

• Available Events: This combo box lists following events available for use 
with the form:  

o Form Load: Occurs when the form is loaded in the browser.  
o Form Send: Occurs when the form is sent by the user.  
o Form Return: Occurs when the task is returned by the user.  

• The following events are available for use with pages:  
o Clicked: The user clicks on the page.  
o Double-Clicked: The user double-clicks on the page.  
o Loaded: The page is loaded.  
o Unloaded: The page is closed.  

• Assigned Action: This combo box lists the following actions that can be 
performed when the selected event occurs:  

o No Action: No action takes place.  
o Invoke SubForm: Select a subform from the SubForm Name 

combo box. A subform must be an additional page in the current 



form, and defined as a subform (see the "Declaring Pages as 
SubForms" section in this chapter). When the selected event 
occurs, the subform is opened in the Client.  

o Load Page: Select a page from the Page Name combo box. The 
page should be an additional page in the current form. This action 
allows you to move between pages without declaring them as 
subforms.  

o Go to Specified URL: Type the URL in the URL to Open field. 
When the selected event occurs, the specified URL is opened in 
the Client.   

o Set Value of a Local Spreadsheet Cell: Type the cell address in 
the Local Spreadsheet Cell combo box or select a local or system 
variable. If you wish to apply a formula to the cell value, type the 
formula in the Formula field. When the selected event occurs, the 
value calculated by the formula is transferred to the local 
spreadsheet cell.  

o Execute Specified Script: Type the script in the Script edit box. 
The script can be used to invoke a custom control or perform some 
other action. When the selected event occurs, the script is 
executed. 
 
Note: Load Page is not available on Form Event actions. 

• Set Button: After you have selected an event and an action, this button is 
used to set the properties.  

To define form or page actions: 

1. Perform one of the following:  
o Right-click in the work area of the form and select Form Properties. 

The Form Properties window appears.  
o Right-click in the work area of the form and select Properties. The 

Page Properties window appears.  
2. Click the (Page) Event Actions tab.  
3. Select an event from the Available Events combo box.  
4. Select an action from the Available Actions combo box.  
5. Modify the fields that appear as described previously.  
6. Click the Set button.  
7. Click OK.  

Defining Scripts for a Form or Page 

Since Ultimus forms are actually an HTML page, Ultimus allows you to add 
custom scripts and custom HTML code to the HTML code for the page. These 
scripts can be JavaScript, VB Scripts, or HTML Scripts to add additional 
functionality to the page. You can specify whether the script is inserted within the 
BODY tag or outside of the BODY tag. 



To define a form or page script: 

1. Open the Form or Page Properties window and click on the Custom 
HTML/Scripts tab. 
 

 
2. Select the location of the script (in or outside of the BODY tag) from the 

combo box at the top.  
3. Type the code or script in the edit box.  
4. Click Set.  
5. Click OK. 



Page Properties 

Forms can have multiple pages. The following properties of a page can be 
modified using the Page Properties window: 

• Name the page.  
• Select a background color or image.  
• Make the page a subform.  
• Define page event actions. This is covered in the previous section. See 

"Defining Actions for a Form or Page" for more information.  
• Customize HTML codes and scripts for the page. This is covered in the 

previous section. See "Defining Scripts for a Form or Page" for more 
information. 

To modify the Page Name and Background Color or Image: 

1. Right click on the form and select Properties, or select the form and 
choose Properties from the Edit Menu. The Page Properties window 
appears and defaults to the General Tab. 
 

 



2. Type a name for the form page in the Name field. Each page of the form 
can have a distinct name.  

3. If you wish to change the background color (the default is White) select a 
new color from the Color combo box.  

4. If you prefer to use a background image, select it using the Background 
Picture browse button. The image can be in GIF or JPG format.  

5. Close the window. 

Modeless Dialogs 

Some of the dialogs provided by Ultimus BPM Studio are "modeless". This 
feature gives users the ability to open a dialog for one control, make changes to 
it, and then select the other control in the background to toggle to it's dialog and 
make changes to it. This saves the user from three separate mouse-clicks to 
move from one dialog to another. 

Declaring Pages as SubForms 

Ultimus allows you to declare a page to be a subform that can be called from 
another page. You can invoke a subform by clicking a button on the main form 
and close it by clicking a button on the subform. Furthermore, a subform can 
cause a cell or range of cells to be transferred to another cell or range. When a 
subform is invoked, it remembers the cell where the cursor is located. When a 
subform is closed, if you are transferring a single cell value from the subform to 
the parent form, the value is simply transferred from one cell to another. 
However, if you have specified a range (such as for a grid control), the value of 
the first cell in the range is transferred to the top-left cell of the grid control, and 
the rest of the cells are populated accordingly. 

Subforms can be invoked when a page is opened, sent, or returned, as 
described previously. However, you can also use button controls to invoke 
subforms from within the parent form, and specify whether or not data is 
transferred when the subform is closed. 

When you define the Button on the parent form, you can configure it to open 
another page that has been declared as a subform or switch to another page. 
You can also place a button control on the subform itself, and transfer data when 
the form is closed, or close without transferring data. For more information on 
defining button controls for use with subforms, see "Ultimus Form Controls." 

To create a subform: 

1. Right click on the form and select the Properties, or select the form and 
select Properties from the Edit Menu. The Page Properties window 
appears and defaults to the General Tab. 



Note: Single page forms cannot be declared as subforms. 

2. Click the subform tab. 
 

 

3. Click in the subform check box to define the page as a subform. The 
Value Cell(s) field is activated.  

4. Enter a Cell Name or Address in the Value Cell(s) combo box, or select a 
local variable. You may also click on the Select button and select a cell or 
range from the spreadsheet that appears. This field specifies the cell 
range that contains the result of the subform. The contents of this cell or 
range are transferred to the control from where the subform was invoked. 
The transfer takes place when the subform is closed.  

5. Close the window. 



Working with Controls 

A form is made up of a number of objects, called "controls." Controls have 
properties, attributes, and perform specific functions. In this section, we explain 
how controls are used in general and define the actions common to all controls. 
In  "Ultimus Form Controls" we focus on the specific properties of individual 
control types. 

The HTML Controls Palette and Advanced Controls Palette 

 

The Ultimus Forms Designer has two Control Palettes: the HTML Controls 
Palette and Advanced Controls Palette. The HTML Controls Palette allows you to 
insert standard HTML controls, such as text, fields, buttons, images, and more. 
These are "lightweight" controls that offer higher speed and should be used 
whenever possible. 

 

The Advanced Controls Palette allows you to insert advanced Ultimus controls, 
such as a spreadsheet grid, attachment controls, and signature controls. The 
advanced controls are ActiveX and offer advanced functionality. The browser 
used for the Client (Netscape or Internet Explorer) determines which control 
appears when the form is loaded. 

By default, the HTML Controls Palette and Advanced Controls Palette appear on 
the right side of the Form View. However, you can move the Palettes below the 
Main Toolbar or make them floating windows. Each button is associated with a 
"control," which performs a certain function and behaves in a certain way. You 
make forms by placing these controls on a blank form, link some controls with the 
local spreadsheets, and define the properties of the controls. 

The HTML Controls Palette buttons are as follows:  

Button Name  Function  
 Arrow Cursor  Return cursor to arrow mode.  

 Lock  When placing multiple controls, activate the Lock 
button to keep the cursor in the current control mode. 



 Text Box  Insert a text box control.  
 Edit Box  Insert an edit box control.  
 List Box  Insert a list box control.  
 Combo Box  Insert a combo box control.  
 Push Button  Insert a push button control.  
 Check Box  Insert a check box control.  
 Radio Button  Insert a radio button control.  
 Frame Control  Insert a frame control.  
 Image Control  Insert an image control.  

 
Custom Control 
Placeholder  Insert a custom control placeholder.  

The Advanced Controls Palette buttons are as follows:  

Button Name  Function  
 Edit  Insert an advanced edit control.  
 List Box  Insert an advanced list box control.  
 Combo Box  Inserts an advanced combo box control. 
 Grid Control  Insert a grid control.  
 Signature Control  Insert a signature control.  
 Attachment Control Insert an attachment control.  

To move a Palette: 

• Click on one of the divider lines in the Palette and drag it to the new 
location. If you drag it to the Main Toolbar, it switches to a horizontal 
configuration. If you drag it to the workspace, it becomes a floating 
window.  

To insert controls in the form: 

1. Click the button for the control in the Palette. The cursor changes to the 
insertion cursor for the selected control.  

Note: To insert multiple copies of the same control, click on the Lock 
button. 

2. Click on the form where you want to insert the control. The control 
appears on the form and the cursor returns to its normal state. The 
control's X/Y coordinates are displayed in the bottom right-hand corner of 
the message bar. This makes it easier for form designers to precisely 
place controls on the forms. If the Lock button is enabled, click on the 
Arrow button.  



Aligning and Sizing Controls 

 

Before you perform any operation on a control, you must first select it. You can 
select multiple controls to perform an operation on all of them simultaneously. 

To select multiple controls: 

 

• Hold down the SHIFT key and select the controls. You may also use the 
cursor to "lasso" the controls. The last control is the "reference control," 
and is referenced for sizing and alignment, described below.  

To delete one or more controls: 

• Select the controls, then click Cut or press DELETE.  

To move a control: 

• Click on the control and drag it to the new location.  

Note: You can move multiple controls by selecting them and moving them 
as a group. 

To change the size of a control: 

• Select the control. Click on one of the handles that appear and drag it to 
resize the control. The location of the handle determines how the control is 
resized, such as height and width. Corner controls adjust the size 
proportionally.  

Aligning and Sizing Controls with Each Other 

 



Ultimus provides a powerful Alignment Aid Toolbar that contains functions for 
aligning and sizing controls. Controls can be aligned along the left, right, bottom, 
and top edges. They can be centered vertically and horizontally, and distributed 
horizontally and vertically. They can be resized to match the height, width, or 
overall size of the reference control, and can also be positioned in front of or 
behind one another on the page. 

When you select multiple controls, one of them has handles on the selection box. 
This is the reference control. All other controls are aligned to this control. Make 
sure that this control is in the correct location. If you prefer to use another control 
as the reference control, SHIFT-Click on it.  

Button Name  Function  

 Align Left  Aligns selected controls to the left boundary of the 
reference control.  

 Align Right  Aligns selected controls to the right boundary of the 
reference control.  

 Align Top  Aligns selected controls to the top boundary of the 
reference control.  

 Align Bottom  Aligns selected controls to the bottom boundary of 
the reference control.  

 Align Vertical Center Aligns the center of a control to the vertical center of 
the form.  

 
Align Horizontal 
Center  

Aligns the center of a control to horizontal center of 
the form.  

 
Evenly Space 
Horizontally  Evenly spaces the controls horizontally.  

 
Evenly Space 
Vertically  Evenly spaces the controls vertically.  

 
Same Size 
Horizontally  

Resizes the controls to the same width as the 
reference control.  

 Same Size Vertically Resizes the controls to the same height as the 
reference control.  

 Same Size  Resizes the controls to the same height and width 
as the reference control.  

 Move Forward  Moves the selected object forward one layer.  
 Move Backward  Moves the selected object backward one layer.  

 Move to Front  Moves the selected object in front of all other 
objects.  

 Move to Back  Moves the selected object behind all other objects. 
 

To align or size controls to each other: 



1. Select the controls you want to align and the reference control.  
2. Align the controls to the reference control using the Alignment buttons 

described above.  

Copying and Pasting Controls 

You can copy controls and paste them on the same form, or on another form. 

To copy and paste a control: 

1. Select the control or a group of controls.  
2. Click the Copy button , or select Copy from the Edit menu. The control 

is copied to the clipboard.  
3. Click the Paste button , or select Paste from the Edit menu. The cursor 

changes to a replica of the clipboard contents.  
4. Click on the form to paste the item(s) in the new location.  

Note: To paste the item(s) on another form, go to the new form, then click 
the Paste button. 

Viewing Grid Lines on the Form 

The adjustable grid line display option makes it easier to design forms. The scale 
of the grid can be changed from 0 to 100. When the grid is activated, objects 
placed on the form automatically snap to the grid coordinates. 

To view and change the grid line display: 

1. Click the Grid button in the Form View toolbar. The grid is displayed and 
defaults to the 0 setting. 
 

 
2. Adjust the scale of the grid with the Grid Size slide bar.  



Defining Control Properties 

Controls have Properties which define how they behave or appear. Every control 
has some properties which are common with others, and some that are unique. 

To change the properties of a control: 

• Double-click on the control. The Properties window for the control 
appears. 
 

 

Note: You may also select the control and right-click on it, then select 
Properties, or select the control and choose Properties from the Edit menu. 

To change the properties of multiple controls in sequence: 

1. Open the properties for the first control.  
2. When you have finished modifying the properties for the first control, 

select the next control. The properties in the window change to those of 
the new control.  

Notes: If you are changing the properties of several identical controls and 
you want them to share the same properties, you can select all the controls 
and change the properties at one time. 

Ultimus remember the last font type, size, and color when inserting 
controls. When you modify a control, the next controls inserted will have 
the same basic properties. 



Description of Common Controls Properties 

Properties that are common to all controls are defined below. The properties that 
are specific to a control are defined later in the next chapter under each control's 
section. The following are common tabs in the Properties windows for controls for 
properties that are unique to each control, see "Ultimus Form Controls". 

General Tab 

Use this tab to set general Control Properties. The following are General Tab 
properties common to most controls. 

 

• Caption: This is the label for the control. On certain controls, it is 
displayed on the form. In other controls, the label is not visible. For 
example, the caption in a button is displayed as the button label.  

Colors Tab 

You can change either the foreground or the background colors of any control in 
the form. 

 



• Foreground Color: Select the color of the control. In most cases, this is 
the color of the text placed in the control.  

• Background Color: Select the color for the background of the control. 
Generally, you will want the background color to match the color of the 
form. In this case, you can select the Default/Transparent color.  

Fonts Tab 

The Fonts Tab is used for setting the text font characteristics of a control. The 
following functions are available: 

 

• Font Properties: This combo box is not used.  
• Font: Select a system registered font, such as Arial or Times New 

Roman.  
• Font Style: Select the font style, such as Regular, Bold, Italic, or Italic 

Bold.  
• Size: Select the font size, from 8 to 48 points.  
• Strikeout: Enable or disable the strikeout property of a font.  
• Underline: Enable or disable the underline property of a font.  
• Sample: The selected font and properties are displayed.  

Border Tab (Advanced Controls Only) 



The advanced controls (with the exception of the attachment control) allow you to 
define the following types of borders: 

 

• Border  
• 3D  

Identification Tab 

This tab contains the Control Name field. Ultimus assigns each control its own 
unique name, but you can change it. The control name is used if you wish to 
access the control from a script. 

 

• Control Name: Type in the unique name of the control to change it from 
the default name.  

Miscellaneous Tab 

This tab allows you to change the order in which the controls gain focus as the 
user tabs between them. Some controls also have an edit field for a Status 



message. 

 

• Tab Order: Allows you to set and change the tab order for the form 
controls.  

• Status Message: Text placed in the Status Message will appear in the 
Status Bar at the bottom of the form when the focus is on the control. It is 
used to guide the user who is filling out the form. This text is also 
displayed in a message window if the Field is required and the user tries 
to send the form without entering data in the Field.  



Description of Control Links 

All controls have Control Link properties that specify how they are linked to the 
local spreadsheet or database. Control Link properties are defined below. These 
may not be the same for all controls. When we describe the various types of 
controls, we list which of these properties apply to that control. 

To change the Control Links for a control: 

• Select the control and right-click on it, then select Control Links, or select 
the control and choose Control Links from the Edit menu. The Control 
Links window appears and defaults to the Spreadsheets tab. 
 

 

Using the Control Links property page you can change following settings for a 
control: 

• Spreadsheet Links: The Spreadsheet Links allow you to link the control 
to spreadsheet cells and workflow variables. 

• Scripts: When a control is placed on the form and its Properties modified, 
Ultimus automatically generates a script for that control. The Scripts tab 
allows you to view the script and change it manually. 

• Recordset: Ultimus allows you to link popular databases with the forms 
for each step in a workflow process. The Recordsets tab provides the 
capabilities to link the controls to database columns. Details of this feature 
are discussed in "Using Databases with Forms." 



• Data Validation: The properties in this tab define the limits for the data 
being entered in a field. 

• Event Actions: The Event Actions tab allows you to select an Event, such 
as clicking a button or getting focus, and assigning a specific action to that 
Event. 

Modeless Dialogs 

Some of the dialogs provided by Ultimus BPM Studio are "modeless". This 
feature gives users the ability to open a dialog for one control, make changes to 
it, and then select the other control in the background to toggle to it's dialog and 
make changes to it. This saves the user from three separate mouse-clicks to 
move from one dialog to another. 



Spreadsheet 

The Spreadsheet Links allow you to link the control to spreadsheet cells and 
workflow variables to perform the following functions: 

 

• Destination Cell(s)/Variable: Enter the local spreadsheet cell address 
which will receive the data from the control. This can be a single cell, such 
as for a combo box or list box controls, or a range of cells, such as for a 
multi-line edit box or grid controls. You can also select one of the following 
system variables as the destination:  

o Priority  
o Incident Summary  
o Disable Abort  

Thus, by entering data in the control, the user can change the value of the 
system variable. System Variables are discussed in detail in "Advanced 
Design Features." 

• Source Cell(s)/Variable: Enter the local spreadsheet cell address, 
workflow variable, or Recordset column which will be the data source for 
the control. Local spreadsheet cells and workflow variables can represent 
a single cell or a range of cells. For list box or combo box controls, a range 
of cells provide the data list.  



The following System Variables are available for the Source 
(system variables are discussed in detail in "Advanced Design 
Features"): 

• Process Name  
• Priority  
• Initiator  
• Incident Summary  
• Incident No.  
• Disable Abort  

Ultimus also provides the following list of user information variables 
for the Source (see the "Description of User Information Variables" 
section of this chapter): 

• User Name  
• User's Job Function  
• User's Department  
• User's E-Mail Address  
• User's Supervisor  
• User's Manager  
• Group Members  

• Enable/Disable Cell: Depending on the value in this cell, the control can 
be enabled or disabled. If the linked cell is either empty or has a 0, the 
control is disabled. If the linked cell has a 1, the control is enabled. You 
can use this function to enable or disable the control, based on the data in 
the local spreadsheet.  

• Show/Hide Cell: Depending on the value in this cell, the control can be 
shown or hidden. If the linked cell is either empty or has a 0, the control is 
hidden. If the linked cell has a 1, the control is shown. You can use this 
function to show or hide the control, based on the data in the local 
spreadsheet.  

Modeless Dialogs 

Some of the dialogs provided by Ultimus BPM Studio are "modeless". This 
feature gives users the ability to open a dialog for one control, make changes to 
it, and then select the other control in the background to toggle to it's dialog and 
make changes to it. This saves the user from three separate mouse-clicks to 
move from one dialog to another. 



Scripts 

When a control is placed on the form and its Properties modified, Ultimus 
automatically generates a script for that control. The Scripts tab allows you to 
view the script and change it manually. The use of scripts can also be toggled on 
and off. 
 

 

• Use Scripts: There are two options through which the FCO (Form Control 
Object) can communicate with the controls present in the form.  

o Directly using COM in Internet Explorer : The Use Scripts 
checkbox is not activated (this is the default setting). In this case, 
the FCO talks with the control directly using COM in Internet 
Explorer. This makes it much faster since no scripts are involved. 
The drawback of this is that users can't customize a control's 
behavior, since customization is handled through scripts.  

o Via Ultimus-generated scripts: The Use Scripts checkbox is 
activated. In this case, the FCO talks with the controls using the 
scripts. Users can customize the scripts by writing their own or 
customizing the existing script.  



Note: When using Ultimus Standard Forms, Ultimus provides FCO methods 
that control data transfer between the Controls in the Standard Form 
and the Step's Local Spreadsheet. Most of these FCO methods are Ultimus 
internal methods that are not intended for general usage by Ultimus 
customers and partners. Those methods that are supported for customer 
and partner usage are listed in the following chapter  of Ultimus EIK , 
"Using Third-Party Controls in Ultimus Forms". Please note that Ultimus 
does not support user manipulation of undocumented FCO methods in 
Ultimus Scripts.  

Note: Make sure that you write the scripts for the target browser. The 
default scripts that appear in the Tab are based on IE with the Standard 
FCO. 

• Reset Button: Resets a modified script back to the default.  
• Set Button: When you have completed changes to the Script, the Set 

button confirms the changes, which are reflected in the final HTML code 
for the form.  

Notes: Please use caution when changing the script. Misuse of this 
function may cause the form to behave abnormally. 

The control must be linked to a spreadsheet cell in order to view the script. 



Data Validation  

The properties in this tab define the limits for the data being entered in a field. 

 

• Read Only: If checked, this field is for display only. Data cannot be 
entered.  

• Required: If checked, this control must be manipulated in order to send 
the form. For example, if you wanted to require that a user sign a form 
before sending it, you would make the signature control required.  

The following options are available only on select controls when they are 
relevant: 

• Normal: The control (typically an edit field) has no special formatting. You 
may, however, define the maximum number of characters allowed in the 
field provided.  

• Numbers Only: If an edit control is to be used for entering numbers only, 
this property prevents the user from entering any characters other than 0-



9. You may also enter the minimum and maximum range in the fields 
provided.  

• Valid Date: If the edit control is used to enter a date, this option verifies 
that it is in the correct format. Ultimus gets the date format from the 
Windows regional settings.  

Modeless Dialogs 

Some of the dialogs provided by Ultimus BPM Studio are "modeless". This 
feature gives users the ability to open a dialog for one control, make changes to 
it, and then select the other control in the background to toggle to it's dialog and 
make changes to it. This saves the user from three separate mouse-clicks to 
move from one dialog to another. 

  



Event Actions 

The Event Actions tab allows you to select an Event, such as clicking a button or 
getting focus, and assigning a specific action to that Event. This powerful 
capability allows you to perform a specific action when an Event occurs, and 
enables you to create scriptable forms. 

 

• Available Events: This combo box lists the following Events available for 
use with the selected control:  

o Clicked: The user clicks the control.  
o Double-clicked: The user double-clicks on the control.  
o Set Focus: The control gains focus.  
o Lose Focus: The control loses focus.  

• Available Actions: This combo box lists the following actions that can be 
performed when the above selected Event occurs:  

o No Action: No action takes place.  
o Form Related Actions: Form actions such as Send Form, Return 

Form etc.  
o Recordset Action: Recordset actions such as Move to Next 

Record, Move to First Record etc.  
o Spreadsheet Action:  
o Call .NET Code  Calls .NET Code when some event takes place.  
o Call Web Services: Calls Web Services when some event takes 

place.  
o Refresh Recordset: When clicked, this function refreshes the 

linked recordset if the table is changed.  



o Execute SQL Action(s): When clicked, this function executes SQL 
Action(s).  

o Execute Specified Script: When clicked, this function executes 
the Specified Script.  

Modeless Dialogs 

Some of the dialogs provided by Ultimus BPM Studio are "modeless". This 
feature gives users the ability to open a dialog for one control, make changes to 
it, and then select the other control in the background to toggle to it's dialog and 
make changes to it. This saves the user from three separate mouse-clicks to 
move from one dialog to another. 



Form Related Actions 

Following form actions can be executed when some control event takes place. 

• Send Form: The form is sent.  
• Return Form: The form is returned to the last user who completed a step. 
• Invoke SubForm: Select a SubForm from the SubForm Name combo 

box. A SubForm must be an additional page in the current form, and 
defined as a SubForm (see the "Declaring Pages as SubForms" section in 
this chapter). When the selected Event occurs, the SubForm is opened in 
the Client.  

• Close SubForm with Data Transfer: The SubForm is closed, and the 
value of the cell or range defined in the Page Properties of the SubForm is 
transferred to the parent form. For information on defining the Value 
Cell(s) of a SubForm, see the "Declaring Pages as SubForms" section of 
this chapter.  

• Close SubForm without Data Transfer: The SubForm is closed, but the 
data contained in the Value Cell(s) is not transferred to the parent form.  

• Load Page: Select a page from the Page Name combo box. The page 
should be an additional page in the current form. This action allows you to 
move between pages without declaring them as SubForms.  

• Go to Specified URL: Type the URL in the URL to Open field. When the 
selected event occurs, the specified URL is opened in the Client. You may 
also enter a cell address (e.g., B1), which allows you to specify the URL 
dynamically.  

• Set Value of a Local Spreadsheet Cell: Type the cell address in the 
Local Spreadsheet Cell field. If you wish to apply a formula to the cell 
value, type the formula in the Formula field. When the selected event 
occurs, the value calculated by the formula is transferred to the local 
spreadsheet cell.  



Recordset Actions 

Ultimus uses the concept of "recordsets" for segregating a group of form controls 
that work with a database table. A recordset consists of one or more variables 
linked to a table. Any action performed on the database is reflected on the 
recordset as a whole. For details see the section "Using Databases with Forms". 
You can execute following recordset actions when some control event takes 
place: 

• Move to the First Record in the Recordset: Populate the control with 
the value of the first record in the Recordset.  

• Move to the Next Record in the Recordset: Populate the control with 
the value of the next record in the Recordset.  

• Move to the Previous Record in the Recordset: Populate the control 
with the value of the previous record in the Recordset.  

• Move to the Last Record in the Recordset: Populate the control with the 
value of the last record in the Recordset.  

• Create new Record in the Recordset: Populate the control with the 
value of the new, empty record in the Recordset.  

• Update the current Record in the Recordset: Update the current record 
in the Recordset with the value contained in the control.  

• Delete current Record in the Recordset: Delete the value contained in 
the current record of the Recordset.  

• Clear Controls linked to the Recordset: Clear the value of the controls 
that were populated by values obtained from the Recordset.  

Note: These recordset actions do not work with "Custom Recordsets". 



Calling .NET Code 

You can run .NET Code when some event takes place on a form (for example 
Button click event). This provides a mechanism for executing .NET Code on 
demand and makes Ultimus Workflow much more flexible. To execute .NET 
Code on a control event, follow the steps given below: 

1. Right click on the control and select the option Control Links. Control Links 
property page is shown to you. This page defaults to Spreadsheet tab. 
Select the Event Actions tab.  

2. Select the suitable event from Available Events combo box and select the 
action Call .NET Code from Assigned Action combo box. 

3. Click the browse button to select the file from the directory 
4. Select the Object to Call from the drop down combo box 

 

 
5. Click the properties button. The Object property dialog appears 



 

8. Select Object Property and Workflow Variable from the drop down menus. 
9. Select the Set radio button 
10. Click OK 
11. To Set methods for the .NET Code. Click the methods button 

 

 
12. Select Method name from the drop down menu 
13. A list comes up initially of all the .NET Code method parameters, the 

Workflow Variables column is blank. Click twice on the rows in the 
Workflow Variables column, a pop up list box appears.  



14. Select workflow variables from the list box and link them to the 
corresponding .NET Code variable in that row. 

15. Click OK 

Ultimus also provides an advanced feature for Referencing External .NET 
Assemblies When Calling .NET Code 

Note: Structures and Classes are not supported by .NET Code.  

Due to the limitation in Spreadsheets, Ultimus does not currently support 
the following data types for Web Services and .NET Code. 

• System.Byte  
• System.Decimal 
• Timespan  
• All reference types (e.g. System.UIntPtr and System.IntPtr)  
• System.Int64 signed/unsigned 
• Arrays of all the above 
• Enumeration 
• Overloaded Methods 



Calling Web Services 

You can run Web Services when some event takes place on a form (for example 
Button click event). This provides a mechanism for executing Web Services on 
demand and makes Ultimus Workflow much more flexible. To execute Web 
Services on a control event, follow the steps given below: 

1. Right click on the control and select the option Control Links. Control Links 
property page is shown to you. This page defaults to Spreadsheet tab. 
Select the Event Actions tab.  

2. Select the suitable event from Available Events combo box and select the 
action Call Web Services from Assigned Action combo box. 

3. Type in the URL path for WSDL location. An example of a WSDL URL is 
http://<machine>/plwebservices/processname.asmx?WSDL  

Note: Ultimus supports the consumption of Web Services that 
comply with the following standards: 

i) SOAP 1.1 - defined at http://www.w3.org/TR/SOAP 

ii) WSDL 1.1 - defined at http://www.w3.org/TR/wsdl 

Due to the limitation in Spreadsheets, Ultimus does not currently support 
the following data types for Web Services and .NET Code. 

• System.Byte  
• System.Decimal 
• Timespan  
• All reference types (e.g. System.UIntPtr and System.IntPtr)  
• System.Int64 signed/unsigned 
• Arrays of all the above 
• Enumeration 
• Overloaded Methods 



4. Click Connect 
 

 
5. Click the methods button 



6. Select Method to execute from the drop down menu 
 

 
7. A list comes up initially of all the Web Services variables.  
8. Select Ultimus Variable and select Web Service Parameters.  
9. Click Link. The linked variables appear below. 
10. Click OK. 

Note: Ultimus does not support consumption of Web Services that contain 
multi-dimensional parameter arrays. Arrays of structures and Classes are 
not supported in Web Services called from the Forms. 



Execute Database Actions 

Ultimus allows you to execute Database Actions when some event takes place. 
Database Actions allow the users to execute any SQL statement including 
complex queries that work on multiple tables. For example you may want to 
delete a record from a database table when user clicks on a button. This can be 
easily accomplished by executing database action on a control event. This 
section illustrates the linking of Database Actions with control events. For details 
on creating database actions see the section, "Creating Database Actions". To 
execute database action on a control event: 

• Right click on the control and select the option Control Links. Control Links 
property page is shown to you. This page defaults to Spreadsheet tab. 
Select the Event Actions tab.  

 

• Select the suitable event from Available Events combo box and select the 
action Execute SQL Action from Assigned Action combo box.  

• Available actions list box shows all the recordset actions.  
• Select the database action and click on the Add button.  



• The Action is added to the right side column.  
• Click on the set button. 

Modeless Dialogs 

Some of the dialogs provided by Ultimus BPM Studio are "modeless". This 
feature gives users the ability to open a dialog for one control, make changes to 
it, and then select the other control in the background to toggle to it's dialog and 
make changes to it. This saves the user from three separate mouse-clicks to 
move from one dialog to another. 

Note: SQL Actions cannot be executed against form events, like Form Sent 
etc. 



Description of User Information Variables 

User information variables allow you to use data specific to your process Incident 
and use it in your forms. The values of these variables change with each Incident 
and, in fact, with each step. 

The following user information variables are available: 

• User Name: Name of the user performing the step.  
• User's Job Function: The current user's job function, as defined in the 

Ultimus Org Chart.  
• User's Department: The Department in the Ultimus Org Chart to which 

the current user belongs.  
• User's E-Mail Address: E-Mail address for the current user.  
• User's Supervisor: Supervisor of the current user.  
• User's Manager: Manager of the current recipient.  
• Group Members: If the step recipient is a group, this variable lists all of 

the members in the group. When you select the group members variable, 
the Group combo box appears below and lists all of the groups which 
have been defined in the Org Chart. Select the specific group from the 
Group combo box.  



Linking Controls with Spreadsheet Cells 

As described previously, you can link controls on a form to local spreadsheet 
cells by using the Control Links. Ultimus also allows you to link controls 
graphically. You can link a control, such as a single-line edit field, to an individual 
cell or, in the case of a multi-line edit field, to a range of cells. 

To link a control to a single cell or a range of cells: 

1. In the Form View, click the Spreadsheet Link button . The local 
spreadsheet appears on the right.  

2. Select the control.  
3. Click on the cell of the local spreadsheet, or select a range of cells. The 

control displays the Source and Destination cells as a Tooltip. 

 

Note: When you link a control to a local spreadsheet cell, the cell border 
turns blue. When you select another control, the cell border turns red. This 
gives you a visual indication of which cells have been linked. 

Linking Controls to Separate Source and Destination Cells 

The linking process described above assumes that the Destination Cell(s) and 
the Source Cell(s) are the same. However, some controls, such as Combo and 
List Boxes, require the Source Cell(s) to be different from the Destination Cell. 
You may also want Edit Fields and other controls to have different Source and 
Destination cells. For more detailed information on the linking controls to local 
spreadsheets, see the "Description of Control Links" section in this chapter. 

To link separate Source Cells and Destination Cells: 

1. In the Form View, click the Spreadsheet Link button . The local 
spreadsheet appears on the right.  

2. Select the control.  
3. Right-click on the control and select Control Links. The Control Links 

window appears and defaults to the Spreadsheet tab.  
4. Enter the address of the Destination Cell in the Destination Cell combo 

box.  
5. Close the window.  

Note: When using a range of cells as the Source Cells, they must be 
contiguous. The Destination Cell does not have to be contiguous to the 
Source Cells. It can be anywhere on the spreadsheet. This allows you to, 
for example, use the same Source Cells with many list boxes. 



To graphically link separate Source Cells and Destination Cells: 

1. In the Form View, click the Spreadsheet Link button . The local 
spreadsheet appears on the right.  

2. Select the control.  
3. Hold down the CTRL key and click on the cell(s) in the spreadsheet pane. 

A tool tip appears over the control listing only the Source Cell(s). Release 
the CTRL key.  

4. Click on the Destination cell(s) in the spreadsheet pane. The Destination 
cell(s) appear in the tool tip over the control.  

Note: If you link a control (without pressing the CTRL key) to a cell or range 
and the source cell(s) have already been defined, only the destination 
cell(s) are linked. 



Linking Controls to Workflow Variables 

As described previously, you can name spreadsheet cells as variables and link 
controls on a form to these variables. You can link a control, such as a single-line 
edit field, to a single cell variable, or in the case of a multi-line edit field, to a 
range type multi-celled variable. 

To link a control to a single cell or a range variable: 

1. In the Form View, right click the control and select the option "Control 
Links". The control links property page appears: 

 
2. Select the desired destination variable from the combo box labeled 

'Destination Cell(s)/Variable'.  
3. Select the desired source variable from the combo box labeled 'Source 

Cell(s)/Variable'.  
4. Close the Control Links property page.  
5. The selected control is linked to the specified variables.  

Modeless Dialogs 

Some of the dialogs provided by Ultimus BPM Studio are "modeless". This 
feature gives users the ability to open a dialog for one control, make changes to 
it, and then select the other control in the background to toggle to it's dialog and 
make changes to it. This saves the user from three separate mouse-clicks to 
move from one dialog to another. 



Ultimus Form Controls 

Ultimus forms support all standard controls found in web-based forms, such as 
edit fields, combo boxes, and check boxes. In addition, Ultimus also provides 
proprietary controls, such as a signature control, an attachment control, a 
spreadsheet grid, and a placeholder for use with custom or third-party controls. 
Controls are linked as described in the previous chapter. In this chapter, each 
control and its unique functions are discussed in detail. 



Advanced Combo Box Control 

The advanced combo box control is like the standard combo box, but offers 
greater functionality. A combo box displays a list of choices to the user and 
allows him to select one. The advanced combo box control allows you to 
determine which type of combo box is displayed in the form, sort its contents, 
and check for duplicates. 

Advanced combo box controls in a form must be linked to the local spreadsheet 
or a recordset. Combo boxes require separate Destination and Source cell(s). 
The procedure for linking combo boxes is explained in the previous chapter. 

Advanced Combo Box Control Properties 

In addition to the standard properties for all controls discussed previously, the 
advanced combo box control has the following unique properties. 

General Tab 
 

 

• Type: Select the type of combo box to be used from the following:  
o Simple: A combo box for which the choice list does not drop down, 

it is always displayed below.  
o Dropdown: Standard combo box for which the choice list drops 

down.  
o Dropdown Editable: Allows the user to select an item from the 

dropdown list as well as enter a value in the edit field.  
• Sort: Select whether or not you want to sort the List Box contents in 

ascending or descending order.  
• No Duplicates: If checked, this function checks for and eliminates 

duplicates from the List Box contents.  



Advanced Edit Control 

The advanced edit control is like the standard edit control, but offers greater 
functionality. Advanced edit controls are used for entering data in forms. Each 
advanced edit control must be linked to a cell in the local spreadsheet or a 
recordset. When the form is displayed, each advanced edit control displays the 
contents of the cell to which it is linked. When a User enters data, the contents of 
the linked cell are updated. Validation for maximum characters is performed as 
the user types. 

Every advanced edit control in a form should be linked to a local spreadsheet 
cell(s) or a recordset column. A local spreadsheet cell may be linked to multiple 
edit controls. When the form is created, the contents of the spreadsheet cell are 
used as default values in the advanced edit control. When the user enters data in 
the field, it is transferred to the spreadsheet cell where it is processed and 
forwarded to other forms via the Main spreadsheet. Advanced edit controls are 
linked to local spreadsheet cells just like any other control as described in the 
previous chapter. 

Advanced Edit Control Properties 

In addition to the standard properties for all controls discussed previously, the 
advanced edit control has the following unique properties. 

General Tab 

 

• Multi-line: Ultimus allows you to configure an advanced edit control to 
have multiple lines of text and link it to more than one cell. You must link 
the multi-line advanced edit control to a range of cells in a single column. 
For each linked cell, the advanced edit control can accommodate one line 
of 255 characters.  

• Password: If you use an advanced edit control for password entry, you 
can use this property to display "*" instead of the characters entered by 
the User. The linked local spreadsheet cell contains the correct data.  



• Filter: Select one of the following:  
o Numeric: Prevents the user from entering any characters other 

than 0-9.  
o Alphabetic: Restricts the user from entering any characters other 

than letters.  
o Upper Case: Forces the text to upper case characters.  
o Lower Case: Forces the text to lower case characters.  
o Mask: Select this to put a character mask in the Mask field below. 

The following masks are available (all other characters appear as 
they are):  

Mask Description  
a  Lowercase alphabetic characters. 
A  Uppercase alphabetic characters. 
X  Alphanumeric characters.  
9  Numeric characters only  

o For example, if you have an advanced edit control in which the user 
enters a phone number. The mask for the advanced edit control 
would be as follows: 

o (999) 999-9999 
o When the user fills out the form, the result is as follows: 
o (919) 678-0900. 
o Date: If the advanced edit control is used to enter a date, this 

option verifies that it is in the correct format. Ultimus gets the date 
format from the Windows regional settings.  

o Valid Time: If the advanced edit control is used to enter a time, this 
option verifies that it is in the correct format. Ultimus gets the time 
format from the Windows regional settings.  

• Alignment: Select from Left, Right, or Center.  



Advanced List Box Control 

The advanced list box control is like the standard list box, but offers greater 
functionality. The advanced list box control allows you to select multiple items, 
check for duplicates, and sort the contents. 

Advanced list box controls in a form can be linked to the local spreadsheet. They 
require a destination cell(s) and source cell(s). The procedure for linking 
advanced list box controls has been explained previously in this chapter. 

Advanced List Box Control Properties 

In addition to the standard properties for all controls discussed previously, the 
advanced list box control has the following unique properties. 

General Tab 
 

 

• Multiple Selection: If checked, this function allows you to select multiple 
items in the list box control.  

• No Duplicates: If checked, this function checks for and eliminates 
duplicates from the list box contents.  

• Sort: Select whether or not you want to sort the list box contents in 
ascending or descending order.  



Attachment Control 

Ultimus offers an advanced attachment control which allows users to attach 
documents to workflow forms. When a document is attached to a form, the 
attachment control shows the icon for the file. Attachments can be files of any 
type. The Ultimus attachment control works much like attaching a file to an e-mail 
message. However, unlike e-mail, attached files are only downloaded on 
demand. Files selected to be viewed are downloaded to a temp directory on the 
user's PC. 

The number of files attached to a form depends on the number of cells linked to 
the attachment control. A designer should link the attachment control to a 
number of cells equal to the number of documents to be attached through that 
control. If users attach more documents than there are linked cells, excess 
documents will not be passed to the next step. Ultimus recommends notifying 
your users of the maximum number of documents that can be attached to a 
control. 

Attached files are stored in a directory labeled "Attachments" in the Ultimus 
installation directory. Each attached file is also stored in a subdirectory based on 
the process name. While the workflow incident is active, the names of attached 
files are prefixed with an incident number to prevent them from being overwritten. 
For example, an attachment for a process named "ECO" is named 
"05561e9d278e11d5951b00a0d21a4a92~ECO.doc." 

Attached files are "checked in" and "checked out." When a file is checked out, 
other Client users of the process can only read the file, but cannot make 
changes. When the user who has made changes saves them, the file is "checked 
in" and another Client user is free to make changes. 

Attachment controls are inserted into a form in the same manner as other fields. 
You can perform the variety of operations for attachment controls which have 
been described in previous sections. The following are additional properties that 
are unique to an attachment control. 

Attachment Control Properties 

In addition to the standard properties for all controls discussed previously, the 
attachment control has the following unique properties. 

General Tab 



With the General tab, you name the Source Directory for the attachment control. 
 

 

• Caption: The text for the Attachment Control button.  
• Source Directory: The default directory that comes up when the control is 

clicked. Selecting a default directory is not required. Also, if you do select 
a default directory, the user may still browse to another directory.  

Attachment Type Tab 
 

 

• Attach Files of Type: Ultimus allows you to attach files to the forms. This 
field lets you select all or a specific file type. You can select a file type by 
clicking on its icon from the list. You may select all by clicking on the 
empty space in the list box showing different file icons.  



Note: Selecting a file type creates a default file type, hence making it 
possible to attach that file type only .  The user cannot select .wfl type as it 
is not supported by Ultimus. 

Attachment Control Links Properties 

In addition to the standard Control Link properties described in the previous 
chapter, attachment controls also have the following properties. 

Attachment Validation Tab 
 

 

• View Only: Similar to Read Only, If this property is checked, attachments 
can be opened, but not edited, no new attachments can be added and no 
existing attachments can be deleted.  

• View Attachment Required: Similar to Required, the user must open the 
attached file before sending the form. A message is displayed if the user 
tries to send the form without opening the attached document.  



• Attachment Required: The user must attach a file before sending the 
form. A message is displayed if the user tries to send the form without 
attaching a document.  

Adding Attachment Controls 

The following steps demonstrate inserting an attachment control for a single 
document and multiple documents: 

To configure an attachment control: 

1. Place an attachment control on the form.  
2. Right-click on the control and select Properties. The Properties window 

appears.  
3. Define the properties as described previously, and click OK.  
4. Perform one of the following:  

o If the attachment control is for a single document only, link the 
control to a cell in the local spreadsheet.  

o If the attachment control is for multiple documents, link the control 
to a range of cells in the local spreadsheet.  

Note: You must link the attachment control to more than one cell if allowing 
users to attach more then one file. The number of cells selected represents 
the maximum number of documents that can be attached. If the attachment 
control is linked to a single cell, the first attachment is the only one that will 
go to the next step in the workflow process. 

Using Attachments 

The following steps demonstrate the use of the attachment control in a form as it 
appears in a web browser: 
 

 

To attach a document: 

1. Click the "Attach Files" button on the control, or right-click on the control 
and select Attach. The Open window appears.  

2. Select the file and click Open. The file name and its icon appear in the 
attachment control.  

To remove an attachment: 

• Right-click on the attachment and select Remove.  



To open an attached document: 

• Right-click on the document and select Open. This launches the 
document's application or viewer. You can also open the document by 
double clicking on the document icon.  

Note: To successfully open an attached document, you must have the 
correct viewer or application registered with Windows. If the viewing 
program is not available, Ultimus displays an error message. 



Check Box Control 

Check boxes allow users to make choices and select options. Thus, a typical 
result of a check box selection is represented by either 0 or 1, with 0 representing 
no selection and 1 representing a selection. The results are placed in the cells 
linked to the check boxes. 

When a check box is placed on the form, its caption reads, "Check Box" by 
default (this text can be changed). After you have placed a check box on the 
form, you can perform a variety of operations for controls as described in 
previous sections. 

Every check box must be linked to a local spreadsheet cell or a recordset. A 
spreadsheet cell may be linked to multiple check boxes. When the form is 
created, the value of the local spreadsheet cell is used as the default value for 
the check box. If the cell content is 0, the default check box selection is "off." If 
the cell content is 1, the default check box selection is "on." When the User clicks 
on the check box, its status is immediately transferred to the local spreadsheet 
cell (i.e., the cell is set to 0 if the check box is off, or set to 1 if the check box is 
on). 

Check Box Control Properties 

The check box control does not have any properties other than the standard 
properties discussed previously.  



Combo Box Control 

A combo box displays a list of choices to the user and allows him to select one. 
Once you have placed a combo box on the form, you can perform a variety of 
operations for controls as described in previous sections. 

Every combo box control in a form must be linked to the local spreadsheet or a 
recordset. Combo boxes require separate Destination and Source cell(s). The 
procedure for linking combo boxes is explained in the previous chapter. 

Combo Box Control Properties 

The combo box control does not have any properties other than the standard 
properties discussed previously. 



Control PlaceHolder 

A "PlaceHolder" control allows users to allocate real-estate on the form for 
custom or third-party controls. It also allows you to specify the script to be used 
by the control. Sophisticated users can, therefore, design custom controls to 
implement unique functions or capabilities which are not being offered by 
Ultimus. These controls can also interact with the Ultimus workflow variables 
though the javascript specified as a part of the control. The controls may be 
developed in Visual Basic, C, or Java. This capability, therefore, provides 
practically unlimited means for expanding the Ultimus user interface. 

Inserting a PlaceHolder Control on a Form 

Ultimus provides two methods for inserting third-party controls on a form: 
inserting a registered control or a user-defined control. When inserting a 
registered control, the control is mostly pre-configured. User-defined controls are 
completely configured by the user. 

To insert a PlaceHolder control: 

1. Click the button for the PlaceHolder control in the HTML Controls Palette. 
The cursor changes to the cursor for the PlaceHolder control.  

2. Click on the form where you want to insert the PlaceHolder control. The 
Insert Custom Control window appears. 

 
3. Perform one of the following:  



o To insert a registered control, click the Insert Registered Control 
radio button (this is the default setting).  

o To insert a user-defined control, click the Insert User Defined 
Control radio button.  

4. Click OK. The PlaceHolder control appears on the form. In some cases, 
the look of the control changes to reflect the type of control inserted.  

5. Adjust the size of the PlaceHolder to fit the selected control.  

Note: You may need to use the preview mode to adjust the PlaceHolder to 
the correct size. 

Registered PlaceHolder Control Properties 

Registered PlaceHolder controls are pre-configured for the control's unique 
properties. However, some registered controls require additional information, 
such as a URL to a referenced file (such as a sound file) or font and color 
configuration. Each registered control has its own unique requirements. You 
should be familiar with working with controls of a particular type before inserting 
them in an Ultimus form. 

To modify the registered PlaceHolder control properties: 

1. Right-click on the PlaceHolder control and select Control Properties. The 
properties window for the control appears.  

2. Modify the properties of the control as required.  
3. Click OK.  

User-Defined PlaceHolder Control Properties 

In addition to the standard properties for all controls discussed previously, the 
user-defined PlaceHolder control has the following unique properties. 

General Tab 

The PlaceHolder Properties window allows you to associate an OBJECT Tag or 
a custom script to the custom control. You may enter values in the fields to insert 



HTML code into the OBJECT tag, or add a custom script. 

 

• Object Tag: Inserts an object, such as an image, document, applet, or 
control, into the HTML document. The type of control being used (such as 
Applet or ActiveX) determines which of the fields are used. The 
parameters are as follows:  

o Class ID: ID of the ActiveX control. Identifies the object 
implementation. The syntax of the URL depends on the object type. 
For registered ActiveX controls, the syntax is: CLSID:class-identifier 
(e.g., CLASSID=CLSID:E9DF2E07-761B-11D2-A5FB-
00104B098B7B).  

o Code: When using an Applet, the Code tag contains the name of 
the file containing the compiled Java class (e.g., 
CODEBASE="http://NT40SRVR/UltWeb/FormControlObject.class")
.  

o Codebase: Identifies the location of the object. The syntax of the 
URL depends on the object (e.g., 
CODEBASE="http://NT40SRVR/UltWeb/Applets/." You may also 
identify a cab file after the path).  

o Codetype: Specifies the Internet media type for code (e.g., 
CODETYPE="application/x-oleobject").  

• Parameters: Additional OBJECT parameters, such as ALIGN, BORDER, 
and their associated values. For example, ALIGN="left" and 
BORDER="1."  



• Custom: Write a custom script for the control.  

To modify the PlaceHolder control properties: 

1. Select the PlaceHolder control, right-click on it, and select Properties. The 
control Properties window appears.  

2. Click on the <OBJECT> tag radio button if it is not selected by default.  
3. Enter the Class ID, Code, Codebase, and Codetype in the appropriate 

fields.  
4. Click the New button to create a new parameter. Editable fields for the 

Parameter and Value appear below.  
5. Enter the parameter name and value in the appropriate fields, the click 

inside the pane to confirm.  
6. Close the window.  

To add a custom script to a PlaceHolder control: 

1. Select the PlaceHolder control, right-click on it, and select Properties. The 
Control Properties window appears.  

2. Click on the Custom radio button.  
3. Type a custom script in the edit pane below.  
4. Close the window.  



Edit Control 

Edit controls are used for entering data in forms. Each edit control must be linked 
to a cell in the local spreadsheet or a System Variable. When the form is 
displayed, each edit control displays the contents of the cell to which it is linked. 
When a User enters data, the contents of the linked cell(s) are updated. 
Validation for maximum characters is performed as the user types. 

Every edit control in a form should be linked to a local spreadsheet cell(s). A local 
spreadsheet cell may be linked to multiple edit controls. When the form is 
created, the contents of the spreadsheet cell are used as default values in the 
edit control. When the user enters data in the control, it is transferred to the 
spreadsheet cell where it is processed and forwarded to other forms via the main 
spreadsheet. Edit controls are linked to local spreadsheet cells just like any other 
control as described in the previous chapter. 

Edit Control Properties 

In addition to the standard properties for all controls discussed previously, the 
edit control has the following unique properties. 

General Tab 

 

• Multi-line: Ultimus allows you to configure an edit field to have multiple 
lines of text and link it to more than one cell. You must link the multi-line 
edit field to a range of cells in a single column. For each linked cell, the 
edit field can accommodate one line of 255 characters.  

• Password: If you use an edit control for password entry, you can use this 
property to display "*" instead of the characters entered by the User. The 
linked local spreadsheet cell will contain the correct data.  



Frame Control 

The frame control is used for drawing lines on a form to separate different 
sections. It can also be used to draw boxes to enclose various sections and 
controls. Lines and boxes make a form clear and user-friendly. 

Frame Control Properties 

In addition to the standard properties for all controls discussed previously, the 
frame control has the following unique properties. 

Borders Tab 

 

• Border Type: Select the type of border for the frame.  
• Border Width: Select the width of the border.  

Creating Boxes with the Frame Control 

The frame control can be used for drawing boxes on a form. 

To insert a box on a form: 

1. Insert a frame on the form.  
2. Select the frame and right-click on it. Select Properties.  
3. Click on the Colors tab. Change the Background Color to the box color 

desired.  
4. Click on the Borders tab. Select a Border Type and Width.  
5. Close the frame control Properties window.  
6. Change the length and the width by using the handles on the selected 

frame.  



7. De-select the frame by clicking on another control or empty space on the 
form to see the completed box. 

 



Grid Control 

The grid control provides powerful capability of inserting a spreadsheet into a 
form. This is an excellent way of displaying or entering tabular data. It has all the 
calculation capabilities of a regular spreadsheet program, such as Microsoft 
Excel. By placing formulas in the local spreadsheet cells to which the grid control 
is linked, the grid can be used to perform functions on user data entered into the 
grid. 

Grid Control Properties 

In addition to the standard properties for all controls discussed previously, the 
grid control has the following unique properties. 

General Tab 

 

• No. of Rows: Select the number of rows in the grid control.  
• No. of Columns: Select the number of columns in the grid control.  
• Show Row Headings: Enable/disable grid row headings.  
• Show Col. Headings: Enable/disable grid column headings.  

Cell Properties 

In addition to grid control and grid control links properties, the grid has Cell 
Properties. Cell Properties are modified using the Activate function. Normally, 
you move the grid control on the form by clicking and dragging. Activate allows 
you to select a range of cells without moving the grid control. Once Activate is 
enabled, you can right-click on the select cells and modify their properties. The 
following Properties can be changed for individual cells or a range of cells: 

• Alignment  
• Formatting  
• Fonts  
• Border  



• Patterns  
• Protection  

To access the cell Properties: 

1. Select the grid control.  
2. Right-click on it and select Activate.  
3. Select a cell or range of cells.  
4. Right-click on the selected cell(s) and choose Formatting. The Format Cell 

window appears.  

Number Tab 

The Number tab allows you to format how numbers are displayed in the cell. For 
example, if you format the cell for Currency and enter "317", it is automatically 
displayed as "$317.00." 

 

To format numbers displayed in the cell: 

1. Access the Format Cells window as described previously.  
2. Select a number category from the Category menu. The Category 

selected determines the choices displayed in the Type list box.  
3. Select a number type from the Type list box. The selected type appears in 

the Type field above, and a sample is displayed below.  
4. Click OK.  

Alignment Tab 



The Alignment Properties determine how the cell data is aligned in the cell. For 
example, if Center Horizontal and Bottom Vertical are both selected, then the 
data is centered at the bottom of the cell. 

 

• Horizontal: Set the horizontal alignment.  
• Vertical: Set the vertical alignment.  
• Wrap Text: Wraps the data within the cell.  
• Merge Cells: This function is not used by Ultimus.  

Border Tab 

You can place borders around a single cell or a range of cells using this property. 
It can outline all of the cell or any individual side. The color and the type of border 



can also be changed. 

 

Pattern Tab 

The Pattern tab is used to change the background of a cell or range of cells. You 
have the choice of changing the style of pattern, plus the foreground and 
background colors. 

 

Protection Tab 

You can lock any cell or range of cell(s) in a grid. When a cell is locked, the user 
is unable to change the contents of that cell. For example, a cell that contains a 



formula should be locked. The Hidden checkbox is not used by Ultimus. 

 

Validation Tab 

The fields in this tab are not used by Ultimus. 

Linking a Grid to Local Spreadsheet Cells 

Every grid should be linked to a range of local spreadsheet cells or recordset 
columns. Local spreadsheet cells may be linked to multiple grids on a form. 
When the form is created, the contents of the cells are used as default values for 
the grid. If the user changes the grid, the local spreadsheet is updated when the 
focus is removed. The changed cells in the spreadsheet are used for further 
processing and forwarded to other forms. Grids are linked to local spreadsheet 
cells in range-to-range fashion. 

Note: When linking a grid control to the local spreadsheet, the cells must 
be contiguous and have the same number of rows and columns. 

Using Formulas with a Grid 

In many cases, you will want to use a spreadsheet grid to perform calculations on 
the data entered. For example, in a purchase order process, you will want the 
figure in a quantity column to be multiplied by the figure in a cost column to 
produce the result in a line total column. Formulas are placed in the local 
spreadsheet cells to which the spreadsheet grid is linked. Calculations are then 
performed when a cell loses focus. The mathematical and logical functions are 
very similar to those provided by Microsoft Excel. A list of valid functions which 
you can enter in the Spreadsheet is provided in the Ultimus document 



"Spreadsheet Functions," which is included on the Ultimus CD as an Adobe 
Acrobat PDF file. 

Linking a Grid to Recordset Columns 

You may also link a spreadsheet grid to a recordset table. When you launch the 
form, the cells of the grid are populated by the recordset data. By adding Buttons 
and defining them for database Actions, you can use the form as a "front end" for 
entering and modifying data in the database. For more information on defining 
database Event Actions for Buttons, see the previous chapter. For detailed 
information on working with databases, see "Using Databases with Forms." 



Image Control 

The image tool allows you to place images on your form. Since the Ultimus form 
is a web page created with Dynamic HTML and Java, form images work much 
the same as standard web images. GIF, Animated GIFs, and JPEG images can 
all be used on Ultimus forms. 

Image Control Properties 

In addition to the standard properties for all controls discussed previously, the 
image control has the following unique properties. 

General Tab 

 

• Image: Use the browse button to select a GIF, Animated GIF, or JPEG 
image to appear on the form.  

Notes: Images do not need to be resized. They resize automatically when 
you select an image. 

Only the first frame of Animated GIFs appear in the form Designer. 
Animated GIFs can only be previewed in Test Mode or Simulation. 

Using an Image in a form 

To place and use an image in a form: 

1. Insert an image control on the form.  
2. Select the image control, right-click on it and select Properties.  
3. Click on the General tab.  
4. Use the Browse button to select a web-compatible image.  
5. Close the image control Properties window. The image control resizes 

itself automatically and previews the selected image.  



List Box Control 

A list box is used to display several choices to the user of a form. List box 
controls are inserted in a form using the form design Toolbar as described earlier 
in this chapter. 

Every list box in a form can be linked to the local spreadsheet. List boxes require 
a destination cell(s) and source cell(s). The procedure for linking list boxes has 
been explained previously in this chapter. 

List Box Control Properties 

In addition to the standard properties for all controls discussed previously, the list 
box control has the following unique properties. 

General Tab 

 

• Multiple Selection: If checked, this function allows you to select multiple 
items in the list box control.  

Note: When using the list box for multiple selection, you must link the 
Destination cells to a range of cells. The number of cells in the range 
represents the maximum number of items that can be selected. 



Push Button Control 

Buttons enable users to perform pre-defined actions. They can be placed 
anywhere in the form. In addition to database functions, buttons can be used to 
invoke subforms, return from a subform, or invoke custom scripts. 

Once you have placed a button on the form, you can perform a variety of 
operations for controls as described in previous sections. 

Push Button Control Properties 

The push button control does not have any properties other than the standard 
properties discussed previously. 



Radio Button Control 

Radio buttons are used to prompt users to select one of several options. Thus, 
they are generally placed in groups. When a radio button is placed on the form, it 
displays the words "Radio Button" by default (this text can be changed). Once 
you have placed a group of radio button on the form, you can perform a variety of 
operations as described in previous sections. 

Every radio button in a form must be linked to a local spreadsheet cell. When the 
form is created, the content of the spreadsheet cell is used as the default value 
for the radio button. If the cell content is 0, the default radio button selection is 
"Off." If the cell content is 1, the default radio button selection is "On." When the 
user checks the radio button, the status is immediately transferred to the 
spreadsheet cell. 

Radio Button Control Properties 

In addition to the standard properties for all controls discussed previously, radio 
buttons have the following unique properties. 

General Tab 

 

• Caption: The label placed next to the button. The label is always left 
justified.  

• Group: The name of the Group with which the radio button is associated. 
For example, you have a form with two sets of radio buttons. The first set 
is for the user to select which type of computer he is using. The second 
set is for the user to select which operating system is installed. Thus, in 
order for the Buttons in each set to work correctly, all the radio buttons in 
the first set would have "Computer" in the Group field, and all the radio 
buttons in the second set would have "OS."  



Note: Once the radio buttons are grouped, the buttons will work together 
and only one may be selected at any given time. You can have multiple 
groups of radio buttons in a form. 

To make a group of radio buttons: 

1. Place two or more radio buttons together.  
2. Select both, right-click on them and choose Properties, or select 

Properties from the Edit Menu. The control Properties window appears.  
3. Type a Group name in the Group field. The Group name will apply to all 

selected radio buttons. 

 

Notes: You can repeat this process to create multiple groups of radio 
buttons.  



Signature Control 

Ultimus provides an advanced signature control that allows users to "sign" forms. 
When a form containing a signature control is used by the Client, the user clicks 
the sign button, which opens the signature verification window. The window 
prompts the user to enter her password. If the user enters a valid password, the 
user's name is entered in the signature field with a "signature" bitmap image. The 
signature field with the name of the Client user and the signature image may be 
displayed in the forms for subsequent steps in the process for the benefit of other 
users. The other users will then know who has signed the document. 

Double clicking on a signature control in a form brings back the signature 
verification window. The user can remove the signature by checking the Remove 
Signature box. 

Ultimus uses Directory passwords for simple signature verification. However, if 
customers wish to implement advanced signature verification and display using 
their own or third party algorithms, Ultimus allows them to replace the Ultimus 
Security DLL with their own signature verification DLL. This allows users to 
implement any signature scheme of their choice within the Ultimus framework. 

Every signature field in a form should be linked to a local spreadsheet cell. When 
the user signs the form, the data is transferred to the local spreadsheet cell 
where it is used for further processing and forwarded to other forms through the 
main spreadsheet. 

Signature Control Properties 

The signature control does not have any properties other than the standard 
properties discussed previously. 

Using Signature Controls 

The following demonstrates the use of a signature control in a form as it appears 
in the web browser. 

To sign a form: 



1. Click the button in the control. The Validation for User <UserName> 
window appears. 

 
2. Type the password in the Password field and click OK.  
3. The signature is entered and the custom "signature" pattern appears in 

the background. 

 

To remove a signature: 

1. Double-click the signature control. The Validation for User <UserName> 
window appears.  

2. Click the Remove Signature check box and click OK.  
3. The signature is removed.  

Note: Event Actions only execute after the control has been signed. 

Custom Signature Images 

You may use the default signature image or create unique signature images for 
each workflow user who will sign a form. Custom signature images must be in 
GIF format and stored in "C:\InetPub\wwwroot\ultweb\signatures" on the Web 
Server. The name of the file must be in the following format: 

Client Name.gif 

"Client Name" must match the Client login name of the user. For example, if a 
user logs into the Client as "Fred Heflin," then the file name of his custom 
signature image must be "Fred Heflin.gif" (spaces are allowed). The default 
dimensions of the signature image are 150 pixels x 47 pixels, but you can make it 
any size. Realize, however, that if the signature image is too small for the control, 
the image is tiled. Animated GIFs can also be used. 



Testing Your Form Design 

When you enable the test mode in the forms Designer, the form is displayed in 
your web browser just as it will when deployed. You can enter data, make 
selections from list boxes, and operate all the other controls. While in the test 
mode, you can also display the local spreadsheet window. This lets you see, 
interactively, how the actions you take on the form affect the data in the local 
spreadsheet. 

To invoke the Test Mode in the forms Designer: 

1. Click on the Test Mode button . The form appears as it will in the web 
browser.  

2. Click the "View Spreadsheet" button to view the local spreadsheet.  
3. Click the appropriate tab to view other pages in the form.  
4. You can perform any action on the form to test its behavior and interaction 

with the local spreadsheet.  

To exit the Test Mode: 

• Click the Test Mode button again to return to the forms Designer.  



Text Control 

Text controls are used in forms to provide headings, titles, labels, instructions, 
and comments. Text is for display only. When a User uses the form to enter data, 
he cannot change the text. Once you have placed a text control on the form, you 
can perform the variety of operations described in previous sections. Properties 
which are unique to the text control are described below. 

Text Control Properties 

In addition to the standard properties for all controls discussed previously, the 
text control has the following unique properties. 

General Tab 

 

• Text: Data entered in the text field is displayed in the text control. You can 
use text controls as labels for other controls.  

• Alignment: Align the text to the left of the control, the right of the control, 
centered in the control, or Justified on the left and right.  

Text Control Link Properties 

The text controls are mostly used for display purposes. Control Links properties 
have limited usage. In addition to the standard control Link properties described 
in the previous chapter, text boxes also have the following properties. 

HTML Tab 



The HTML Tab allows you to define any text control as an HTML link. It also 
allows you to configure the link to open in a new window. 

 

• HTML Link: Type a URL into the field. You can only type a fully qualified 
URL address for example 'http://www.ultimus.com'.  
Clear: Click to clear the field.  

• Open in New Window: Click this checkbox if you want the browser to 
open a new window when the URL is opened.  



Using Databases with Forms 

Ultimus allows you to link popular databases with the electronic forms for each 
step in a workflow process. This allows you to make "intelligent" forms which can 
do several things for the user: 

• Fields in a form may be filled automatically from a database table or a 
query.  

• Contents of form fields can be automatically saved in a database for future 
use.  

• Choice lists in list boxes and combo boxes may be automatically filled 
from a database.  

• Users may be given the option of browsing or deleting a record in a 
database for maintenance purposes.  

You can design forms which perform complex database operations. For 
example, you can search one database table using a value entered by the 
user. The result of the search may be used to search another database 
table and fill the contents of other fields in the form. 



How Databases Are Used 

Ultimus provides powerful forms connecting to databases even though the form 
is browser-based. All connections with the database are real-time over a TCP/IP 
link and do not require the form to be submitted. This means that the form is 
"alive" with a connection to the database just as a true client/server application. 
On the server-side, a single ODBC connection has to be made to a datasource. 
Ultimus supports widely-used enterprise databases which include the following: 

• Oracle  
• SQL Server  

Note: For the examples seen in this chapter, we have used the sample 
"Northwind" database. 

Database Rules, Definitions, and Guidelines 

1. Before using a database, you must first define a datasource using the 
ODBC Configuration in the Microsoft Windows Control Panel. A DSN to be 
used in Database Flobot must not contain "/" or "\" in its name.  

2. Ultimus allows users to specify a user name and password for accessing a 
database. This feature allows Ultimus to use datasources which are 
secure.  

3. Ultimus uses the concept of database "Connection" for communicating 
with databases. Every connection is a combination of Datasource and 
Login/Password. Datasource determines the database with which form will 
communicate and Login/Password determines the rights/roles that have 
been granted to different users on the database server. This enables 
Ultimus to provide different levels of security for different users.  

4. Under every database connection, you can define one or more than one 
"Recordsets" or "Actions".   

5. Recordsets allow users to link workflow variables to a single database 
table, database query, or "set of records." Any action performed on the 
database is reflected on all of the variables linked to this database. By 
defining a number of recordsets, the user can create a form whose various 
parts work independent of each other. Ultimus recordsets use an 
independent ISAPI DLL for scalability and performance.  

6. A Recordset can be based either on a database table or a database 
query. Recordsets based on a database table can communicate with a 
single table while the recordsets based on database query communicate 
with all the tables included in the query.  

7. Each recordset can be associated with a filter. A filter allows you to specify 
a simple or complex SQL statement to query the data or subset of records 
which are associated with the recordset. You may use local spreadsheet 
cells as arguments in the SQL statement. Since local spreadsheet cells 
can be linked to controls and populated by accessing recordsets, or to 



other local spreadsheet cells, you can use this capability to create 
powerful database user interfaces with multiple layers of filtering which 
can work with a large number of records.  

8. Recordsets have three loading options from which to choose: they can be 
downloaded as the form loads, after the form loads, or on-demand. This 
allows recordsets to be available when the form is loaded with slower form 
load times, not available until after the form is loaded with faster fast form 
load times, or only loaded when selected.  

9. Recordset fields can be linked with form controls or workflow variables.  
10. Certain controls in the form may be linked to fields in a Recordset. The 

controls which can be linked are edit fields, combo boxes, list boxes, 
check boxes, buttons, advanced edit controls, advanced list boxes, and 
advanced combo boxes.  

11. Grid controls can be linked to recordset tables, but only the entire table 
and not to individual fields.  

12. If a control is "linked" to a database field, the control is updated with the 
contents of the database field when data is read, and vice versa when 
data is saved. 

13. If a recordset is created to add records or update records, you must also 
link all of the controls linked to this recordset to the local spreadsheet in 
order for the updates to work.  

14. A recordset must be linked to a destination cell in the local spreadsheet if 
the value is to be used as a filter for a recordset.  

15. Actions allow the users to execute any SQL99 compliant statement 
including complex queries that work on multiple tables. Workflow variables 
can be inserted into the SQL statement, allowing the values of those 
workflow variables to be sent/retrieved to/from the target database.   

16. With the ability to execute any SQL99 compliant statement, actions such 
as executing SQL Triggers and Stored Procedures can be easily 
accomplished.   

17. Actions also give users the flexibility to use powerful database functions 
supported by Structured Query Language (SQL) such as SUM, DIFF etc.   

18. An action can execute a single SQL statement. For executing more than 
one SQL statement multiple actions can be created.   

19. An action can only be linked to workflow variables.   
20. Actions cannot be used to execute Data Definition (DDL) commands like 

DROP_TABLE, CREATE_TABLE etc.  
21. Depending upon the specified settings, actions are executed against form 

event actions or control event actions.  
22. A form can be linked to multiple database connections. Each database 

connection may have multiple database tables.  
23. For passing values to date type database fields, Ultimus does not support 

date value earlier than March 1900.   
24. Changes made to the Table, Database, Connection etc. will only be visible 

once refreshed.  



Creating Database Connections 

Ultimus uses the concept of database "Connection" for communicating with 
databases. Every connection is a combination of Datasource and 
Login/Password. Datasource determines the database, with which form will 
communicate, and Login/Password determines the rights/roles that have been 
granted to different users on the database server. This enables Ultimus to 
provide different levels of security for different users. 

Note: 

Before attempting to create connections, you must first define a 
datasource using the ODBC Configuration in the Microsoft Windows 
Control Panel. 

To link to a datasource and define connections: 

1. Click the Recordsets button in the Form View. The recordsets pane 
appears on the right hand side of form view as shown below. If no 
database connection has already been created, the "Create New 
Connection" dialog is also shown to you: 
 

  
 
Note: If you have already defined some database connections and 
want to create another one, in the recordset pane, click on any of the 
already defined database connections and then click on the new 
button : 
   



2. To create a new database connection you have to specify following 
information in the "New Connection" dialog: 
 

 
o Data Source Name: From this combo box, select the name of valid 

data source. 
o User ID: Specify a valid login name for the selected DSN. 
o Password: Specify password for the selected DSN. 

3. The created database connection appears in the recordsets pane as 
follows: 
 

 



Working with Recordset Pane 

In form view, as you click on the Recordset button , Recordset Pane is shown 
to you on the right hand side of form view. Recordset Pane shows you all the 
database connection, recordset and actions created in a Repository Window 
View. Every node in the Repository Window View has '+' or '-' sign attached to it. 
The sign '+', means that you can expand this node. Every database connection 
that you create has by default two nodes, Recordset and Action, under it.  
Recordset node lists all the recordsets created under a database connection 
while Action lists the actions.  

 

Using the Recordset Pane you can perform following actions: 

• Create New Database Connections. 
• Modify/Delete already defined database connections. 
• Under any database connection create new Recordset. 
• Modify/Delete already defined recordsets. 
• Under any database connection create new Actions. 
• Modify/Delete already defined Actions. 

You can perform these options by either using the Tool bar show at the top of 
Recordset Pane or by using the Pop up Menu shown against different nodes in 
Repository Window View. Both of these have been explained separately below. 



Working with the Tool Bar 

Tool bar in the Recordset Pane contains following buttons: 

Button Name Description 

 
New 
Button 

New button allows you to create a new Database Connection, 
Recordset or Action. The button works intelligently to 
determine what actually do you want to create from the above 
three. You can create a Database Connection, Recordset or 
Action by first clicking on the respective node in the 
Repository Window View and then clicking on the new button. 
For example if you want to create a new database connection, 
you can do it as follows:  

• To create a new database connection, click on any of a 
database connection node shown in the tree and click 
on the New Button. 

 
Delete 
Button 

Delete button allows you to delete Database Connection, 
Recordset or Action. The Delete button also works just like the 
New button to determine what do you want to delete. For 
example if you want to delete a Recordset, click on the 
recordset node and then click on the delete button. 

 
Properties 
Button 

Properties button allows you to modify already created 
Database Connections, Recordset or Actions. Again this 
button works the same way as the New or Delete Button. 

 



Creating Recordsets 

Ultimus uses the concept of "recordsets" for segregating a group of form controls 
that work with a database table. A filter or query may also be associated with the 
recordset. A recordset consists of one or more variables linked to a table. Any 
action performed on the database is reflected on the recordset as a whole. By 
defining a number of recordsets, the user can create a form whose various parts 
work independently of each other. 

Note: Before attempting to create recordsets, you must first define a 
Database Connection. 

To define recordsets: 

1. Perform one of the following:  
o Click on a Recordset Node in the Recordsets Pane and then click 

on the New button.  
o Right-click inside the Recordsets pane and select the option New 

and then Recordsets. The Recordsets window appears. 
 

 
2. Type the name of the new recordset in the Recordset Name field.  
3. A recordset can either be based on a database table or a database query. 

By default the option Table is selected. If you want to base your recordset 
on a table, select the desired table from the Table Combo box. Details 
about creating recordsets based on database query see the section 
"Creating Custom Recordsets".  

4. Select one of the following Load Options:  
o After Form is Displayed: The recordset is loaded while the form is 

being displayed. This allows the user to quickly view the form as it 
is being loaded, however, the controls associated with the 
recordset are disabled until the recordset is fully loaded  

o Before Form is Displayed: The form is displayed after the recordset 
is loaded. This increases the form load time, but, the form is ready 
for use as soon as it is displayed.  



o On Demand: The recordset is loaded only when its controls are 
displayed. If the form has only one page, or the controls of that 
recordset are on the first page, the recordset will be loaded every 
time the form is loaded. This defeats the purpose of this option. If 
this recordset controls are on any other page, the recordset is 
loaded only when that page is displayed. This allows the user to put 
all rarely used recordset controls on a separate page for faster load 
time in most cases. 

5. Click OK. The new recordset appears in the Recordsets Pane.  
6. Click Close.  

Linking Recordset Fields to Variables 

After you have defined all the recordsets needed, you can link Spread Sheet 
variables to the database fields as follows: 

• In Recordsets pane, click on the '+' sign to expand the recordset you want 
to link to variables. The recordset fields are shown to you in the tree. 

• Right click on the field you want to link and select the option Link. Link 
Variable dialog is shown to you: 
 

   
• From the combo box select the variable you want to link to this field and 

click OK. 
Note: For date type fields, Ultimus does not support date value 
earlier than March 1900.   

• The field is linked to the specified variable and the fetched in this field is 
stored in the linked variable. 

Note: Recordset use the concept of Row Indexing for passing/retrieving 
data to/from workflow variables. It is strongly recommended that you link 
only those variables to database recordsets that do not have any other 
variable declared below them on the spreadsheet. For example on the 
spread sheet you have declared two variables as follows: 



 

Cell B2= VarOne 
Cell B4= VarTwo 

In the example given above, linking the variable VarOne can result in 
abnormal functionality of recordsets since another variable, VarTwo, has 
been defined on the spread sheet below this variable. 

• From the combo box select the variable you want to link to this field and 
click OK. 
Note: For date type fields, Ultimus does not support date value 
earlier than March 1900.   

• The field is linked to the specified variable and the fetched in this field is 
stored in the linked variable. 

To delete a recordset: 

1. In tool bar click on the Recordsets button. The Recordset pane is shown 
to you on the right hand side of form view.  

2. Select the Recordset in the Recordset Pane.  
3. Click the Delete button . A warning window appears.  

 

 
4. Click Yes. The recordset is deleted.  



Creating Custom Recordsets 

Recordsets allow you to easily design web-based forms that can perform 
complex database actions. While the table based recordsets allow you to fetch 
data from one table at a time, Custom Recordsets allow you to link to a database 
and fetch the most desired data from multiple tables. You can specify the data 
requirements using structured query language. 

Note: Custom recordsets are read only and cannot be used to update, 
delete or insert records. 

To define recordsets: 

1. Perform one of the following:  
o Click on a Recordset Node in the Recordsets Pane and then click 

on the New button.  
o Right-click inside the Recordsets pane and select the option New 

and then Recordsets. The Recordsets window appears. 

 
2. Type the name of the new recordset in the Recordset Name field.  



3. Select the option Query and click on the Build button. Recordset Query 
dialog is shown to you:  

 
4. The Build Query dialog allows you to create an SQL query on which you 

want to base your custom recordset as follows:  
o You can type in the query in the Query text area.  
o You can also use any workflow variables in the query. For 

convenience the workflow variables are shown to you in the 
variables list box. You can type in the name of the variable in the 
query text area are double click on its name in the Variables list 
box.  
Note: For date type fields, Ultimus does not support date value 
earlier than March 1900.  

o Name of all the available columns are shown to you in the combo 
box. As you select a table from this combo box, all of its fields are 
shown to you in the list box below. 

o In your query statement you can use the name of table field by 
simply typing it or you can insert it in the query statement by double 
clicking on it in the table fields list box. 
Note:  
Enclose field names/table names in square brackets if they 
contain a blank space in name. All field names used in the 
query statement must be prefixed with a corresponding table 
name for example "[My Table1].[My Field1]" 
SQL joins can be used in specified SQL Statements only with 
MS SQL Server.  

5. Once you have entered the complete text of desired query, click the OK 
button, you would return to main recordsets window.  

6. Select one of the following Load Options:  



o After Form is Displayed: The recordset is loaded after the form is 
displayed for faster form load time.  

o Before Form is Displayed: The recordset is loaded as the form is 
being displayed for slower form load time.  

o On Demand: The recordset is loaded only when the form or control 
is selected for faster form load time.  

7. Click OK. The new recordset appears in the Recordsets Pane. Under 
custom recordsets the names of table fields are shown in the format 
"TableName.ColumnName". 

 
8. Click Close.  

Modifying Custom Recordset 

After you have defined all the recordsets needed, you can link Spread Sheet 
variables to the database fields as follows: 

• In Recordsets pane, click on the '+' sign to expand the recordset you want 
to link to variables. The recordset fields are shown to you in the tree. 

• Right click on the field you want to link and select the option Link. Link 
Variable dialog is shown to you: 

 
• From the combo box select the variable you want to link to this field and 

click OK.  
• The field is linked to the specified variable and the fetched in this field is 

stored in the linked variable. 

To delete a recordset: 



1. In tool bar click on the Recordsets button. The Recordset pane is shown 
to you on the right hand side of form view.  

2. Select the Recordset in the Recordset Pane.  
3. Click the Delete button . A warning window appears.  

 
4. Click Yes. The recordset is deleted.  



Modifying Recordset Properties 

After the recordset has been created, Ultimus allows you to modify the properties 
to perform various functions. In addition to changing the general properties, you 
can create data "Filters" with multiple layers and arguments, and define "Event 
Actions" to be performed when the form is sent or returned. 

To edit a recordset: 

1. Select the Action in the Recordsets Pane and click on the properties 
button in the recordset tool bar or right click on the Action you want to 
modify and select the option "Properties" from the popup menu. The 
Action Properties window appears.  

 
2. Modify the Properties as described previously.  

Note: If you modify an action  and change the database table or 
database query, all the links of database fields and variables/controls 
are removed. 

3. Click OK to close the Properties window.  
4. Click Close. 



Defining Recordset Event Actions 

You can define actions performed on the recordset when the form is sent or 
when it is returned. 
 

 

The following combo boxes are available: 

• On Form Send: Select one of the following Actions to be performed when 
the form is sent:  

o No Action: No action is performed.  
o Add record(s) in the Recordset: Add value(s) contained in the 

control as a new record(s) in the linked database table.  
o Update record(s) in the Recordset: Update linked database table 

with value(s) contained in the control.  

Note: If Add or Update Recordset fails on send, the send operation is 
aborted and an error message is displayed. The user must take some 
corrective action before continuing. 



o Delete record(s) in the Recordset: Delete the database record(s) 
linked to the control.  

• Abort on Fail: Click the checkboxes to abort the recordset Send or 
Return actions if the actions fail. This prevents the process from stalling 
and allows the workflow to move forward.  

• On Form Return: Select one of the following Actions to be performed 
when the form is returned:  

o No Action: No action is performed.  
o Add record(s) in the Recordset: Add value(s) contained in the 

control as a new record(s) in the linked database table.  
o Update record(s) in the Recordset: Update linked database table 

with value(s) contained in the control.  
o Delete record(s) in the Recordset: Delete the database record(s) 

linked to the control.  
• Refresh Recordset when record Updated or Added or Deleted in the 

Recordset Table: When clicked, this function refreshes the linked 
recordset if the table is changed. If this checkbox is not selected any 
changes that are made to the table will reflect only by refreshing the 
recordsets manually.  

To define a recordset's event actions: 

1. Open Recordsets View window.  
2. Select the recordset in the Recordset Name column.  
3. Click the Properties button . The Properties window for the selected 

recordset appears. Click the Event Actions tab.  
4. Select an Action from the On Form Send combo box. This action takes 

place when a form is completed and sent.  
5. Select an Action from the On Form Return combo box. This action takes 

place when a form is returned.  
6. Click OK.  



Defining Recordset Filters 

Ultimus allows you to associate a filter, or query, with each recordset. You can 
create a simple filter, or define a complex filter using workflow variables. This 
powerful feature means that you can define dynamic queries based on workflow 
values. The queries result in a sub-set of records that are associated with the 
recordset. Furthermore, the result of one query may be used to define another 
query. 

To define a recordset filter: 

1. Click on the Recordset Button in tool bar. The Recordset Pane appears on 
the right hand side of Form View.  

2. Select the recordset in the Recordset Pane.  
3. Click the Properties button . The Properties window for the selected 

recordset appears. Click the Filters tab.  
4. Select either the Filter or Custom Filter radio button. Using these two 

options, you can either define a simple filter or complex filter involving 
workflow variables.  

5. Click the New button . The fields for a new filter appear. 

 
6. Select the database column from the Column Name combo box.  
7. Select the operator from the Operator combo box.  



8. Type the name of the local spreadsheet cell or select a global workflow 
variable from Step SS Cell combo box.  

9. Click anywhere in the window. The formula appears in the Query 
Expression pane below.  

10. Repeat steps 5-9 as needed to add other statements.  

Note: The first Operator combo box is disabled until you add a 
second statement. When adding another statement, select AND or 
OR from the first Operator combo box. 

11. Click OK.  

To edit the query filter: 

1. Open the Properties window for the recordset as described above.  
2. Select the statement you wish to edit.  
3. Click the Edit button . The combo boxes for the columns in the selected 

statement are activated.  
4. Make the changes as described previously.  
5. Click OK.  

Defining Custom Filter Expressions 

Ultimus also allows you to define custom filter expressions. This requires a 
thorough knowledge of SQL statements. You can use the filter functions above to 
create a basic filter and then edit it to your specific needs, or create the filter from 
scratch. 

To edit the filter manually: 

1. Open the Properties window for the recordset and create a filter as 
described above.  

2. Click inside the Filter Expression pane.  
3. Make the desired changes to the formula.  
4. Click OK.  

To define a custom filter expression: 

1. Open the Properties window for the recordset as described above.  
2. Click the Custom Filter radio button.  
3. Use the Available Table Columns window to add table columns. To insert 

a table column in the custom filter statement, double click on the name of 
table column in "Available Table Columns" list box.   

4. Operators and Cell Numbers must be entered manually.  
5. You can use workflow variables in the custom filter statement. To insert 

workflow variables or linked cells in the custom filter statement click on the 



button labeled "Variable". Variable insertion dialog is shown to you. 
Double click on the variable you want to insert and the variable is inserted 
at the current cursor position in the filter expression. The name of 
workflow variables must be enclosed in "[]". 
Note: For passing values to date type database fields, Ultimus does 
not support date value earlier than March 1900.   

6. Click OK.  



Linking Form Controls to Database Tables 

Linking form controls to database tables allows users to read and write 
information to the database when using the form. You can fill form fields, such as 
List Boxes and Combo Boxes, from database tables, and update tables based on 
the actions performed in the form. You can also link a spreadsheet grid and use 
the grid to modify the contents of the database. 

To link a form control to a database table: 

1. Click the Recordset Links button in the Form Designer Toolbar. The 
Recordset pane appears and displays all recordsets.  

2. Select the form control.  
3. Select the recordset field. The link appears as a tool-tip on the control and 

is listed beneath the recordset field. 
 

 

To unlink a control from a recordset: 

1. Click the Recordset Links button . The Recordset pane and Link tool-
tips appear over the controls.  

2. Click on the "+" signs of the Recordsets directory tree so that the Links 
appear.  

3. Right-click on the Recordset Link in the directory tree and select 
Delete/Unlink. The link is deleted.  

Linking a Grid Control to a Recordset 



Linking the grid control to a recordset involves two different actions. First you link 
the control to a recordset which creates an association between the control and 
the recordset. Afterwards, you can link columns in the control to columns in the 
recordset. 

To link a grid control to a recordset: 

1. Click the Recordset Links button in the Form Designer Toolbar. The 
Recordset pane appears and displays all recordsets.  

2. Select the grid control, then the recordset. The link appears as a tool-tip 
on the control and is listed beneath the recordset table.  

3. Close the Recordset pane .  
4. Link the grid control to a contiguous range of cells in the local 

spreadsheet. The number of rows and columns linked in the spreadsheet 
should match those of the grid control, and the link should be uni-
directional -- to Destination cells only.  

To link grid columns to recordset columns: 

1. Open the Control Links window for the grid control and click on the 
Recordset tab which is now available. The numbers under grid column 
equate with the columns in the grid control. For example, A=1, B=2, and 
C=3. 



 

 
2. Select the column under grid column.  
3. Click on the selection under Column Name. A combo box appears.  
4. Select the Recordset field.  
5. Repeat steps 2-4 for each grid column.  
6. Close the window.  

Notes: You can also add buttons and define them for actions, such as 
"Update the current record in the Recordset" and "Create new record in the 
Recordset." These are the primary actions you will use because the other 
actions relating to moving to records do not affect the grid control. 

You can link buttons to the same recordset as the grid control, as in the 
note above, but you cannot link other controls, such as edit fields, list 
boxes, or combo boxes. These must be linked to a separate recordset. 

If the number of rows in the grid control is greater than those contained in 
the recordset table, you can use the grid control to add a record to the 
bottom of the database. 



Creating Database Actions 

Actions allow the users to execute any SQL statement including complex queries 
that work on multiple tables. Workflow variables can be inserted into the SQL 
statement, allowing the values of those workflow variables to be sent to/from the 
target database. With the ability to execute any SQL statement, actions such as 
executing SQL Triggers and Stored Procedures can be easily 
accomplished. Actions also give users the flexibility to use powerful database 
functions supported by Structured Query Language (SQL) such as SUM, DIFF 
etc. An action can execute a single SQL statement. For executing more than one 
SQL statement multiple actions can be created.   

Note: Actions cannot be used to execute Data Definition (DDL) commands 
like DROP_TABLE, CREATE_TABLE etc. 

To define database actions: 

1. Perform one of the following:  
o Click on a Actions Node in the Recordsets Pane and then click on 

the New button.  
o Right-click inside the Recordsets pane and select the option New 

and then Actions. The Actions window appears. 

 



2. Type the name of the new action in the Action Name field and Click Next, 
Build Query dialog appears. 

 
3. The Build Query dialog allows you to create an SQL query as follows:  

o You can type in the query in the Query text area.  
o You can also use any workflow variables in the query. For 

convenience the workflow variables are shown to you in the 
variables list box. You can type in the name of the variable in the 
query text area are double click on its name in the Variables list 
box.  
Note: For date type fields, Ultimus does not support date value 
earlier than March 1900.  

o Name of all the available columns are shown to you in the combo 
box. As you select a table from this combo box, all the fields of this 
combo box are shown to you in the list box below. 

o In your query statement you can use the name of table field by 
simply typing it or you can insert it in the query statement by double 
clicking on it in the table fields list box. 
Note:  
Enclose field names/table names in square brackets if they 
contain a blank space in name. All field names used in the 
query statement must be prefixed with a corresponding table 
name for example "[My Table1].[My Field1]" 
SQL joins can be used in specified SQL Statements only with 
MS SQL Server. 

4. Once you have entered the query text, Click "Next".   
o If you have specified a "Select" query, the field linking dialog is 

shown to you. Using this dialog you can link workflow variables with 



database fields. Output of the specified query is stored in the linked 
variables. Moreover you can specify the maximum number of rows 
to be fetched from the database.  

 
To link a workflow variable to a database field, click under the 
column labeled variable in front of the desired column name. A 
combo box appears showing the names of available workflow 
variables. Select the variable you want to link to this column. Click 
any where else on this dialog and the variable gets linked to the 
database column.  

Retrieving Database Records to Workflow Variables: 
The Database Actions use Row Indexing to store data in workflow 
variables. 

Example: 
Lets suppose using a  Database Action, we want to read all records 
from Table A to the workflow variables. Tables A is shown below. It 
has two fields ID and Name and contains the data as shown below: 
Table A 

ID Name 
1 Marsha Barrett
2 Ann Puck 
3 George Taylor



We want to retrieve the data from fields ID and Name to the 
workflow variables WorkflowID and WorkflowName respectively. 
Both WorkflowID and WorkflowName are single cell variables. 
However, the Database Action will return three records. Row 
Indexing allows the Database Action to automatically increment 
rows to store all returned values in the linked variables as follows: 

 

If we declare the variables WorkflowID and WorkflowName as 
multiple cell variables comprising of four cells each, as shown 
below: 

 

Using "Row Indexing", the database flobot will increment rows 
taking each chunk of four cells as a single cell. This is shown 
below: 

 

Notes:    

The Database Actions use the concept of "Row Indexing" for 
reading and writing data to workflow variables. It is strongly 
recommended that only those variables that do not have any 
other variable declared below them on the spreadsheet be 
used with Database Actions. For example, on the spread sheet 
two variables are declared as follows: 
 



 
Cell B2= VarOne 
Cell B4= VarTwo  

Linking the variable VarOne with the database Action can 
result in abnormal functionality since another variable, 
VarTwo, has been defined on the spread sheet below this 
variable.     

o If an Update, Delete or Insert Query is specified the above dialog is 
not shown since such SQL statements do not have any output. 



5. Once you have specified the query and linked the columns to workflow 
variables, the action is created and finishing screen is shown to you.  

 
6. Click on the button labeled "Finish" and the new action appears is in the 

recordsets pane. 
7. A recordset can either be based on a database table or a database query. 

By default the option Table is selected. If you want to base your recordset 
on a table, select the desired table from the Table Combo box. Details 
about creating recordsets based on database query see the section 
"Creating Custom Recordsets".  

8. Select one of the following Load Options:  
o After Form is Displayed: The recordset is loaded after the form is 

displayed for faster form load time.  
o Before Form is Displayed: The recordset is loaded as the form is 

being displayed for slower form load time.  
o On Demand: The recordset is loaded only when the form or control 

is selected for faster form load time.  
9. Click OK. The new recordset appears in the Recordset Pane.  
10. Click Close.  

To delete a database action: 

1. In tool bar click on the Recordsets button. The Recordset pane is shown 
to you on the right hand side of form view.  

2. Select the Action you want to delete, in the Recordset Pane.  



3. Click the Delete button. A warning window appears.  

 
4. Click Yes. The action is deleted.  



Modifying Actions Properties 

After the action has been created, Ultimus allows you to modify the properties 
and perform various functions. Action properties allow renaming actions, 
modifying SQL Statements and variable links. 

To edit an action: 

1. Select the Action the Recordsets Pane and click on the properties 
button in the recordset tool bar or right click on the action and select the 
option "Properties" from the popup menu. The Action Properties Window 
appears:  
 

 
2. To rename an action modify the action name in the Action Name field and 

click the button Apply.  
3. To change the SQL Statement of an action, select the tab Specify SQL 

Statement and modify the SQL statement. 
 



 
 
Having modified the SQL Statement, click the Apply button to apply the 
specified settings. If in the modified SQL statement, selected fields are 
different from the previously specified ones, following warning message is 
displayed and all the filed links are deleted. 
 

 
 
Note: Action Properties dialog box does not allow changing the 
query types. For example if you modify the type of an SQL Statement 
from 'Select' to 'Insert' following warning message box is displayed: 
 

 
4. To modify the links of a database action, open the properties window for a 

database action and select the SQL Action Linking tab. 
 



 
 
On this tab modify the links as desired and click the Apply button.  



Examples of Using Recordsets in Forms 

Using a Recordset Filter 

This example shows the process of linking controls to a recordset and using the 
filter. In this form, the user selects a country from a combo box. The form extracts 
and displays the client name, company, and city from the database. The steps 
below take you through the process of building and linking the example form to a 
database. 

In this example, we use the "Customer" table from the sample "Northwind" 
database. We assume that you are connected to a datasource and are familiar 
with creating forms and recordsets. 

To define the form using recordset filters: 

1. Define the following cells and auto labels in the local spreadsheet: 
 

 

2. Switch to the Form View and create the form as shown below. 
 

 

3. Select Recordsets from the Edit menu. The Recordsets Pane appears.  



4. Create a database connection to work with the Northwind Database. 
 

 

5. Under this database connection, create three recordsets named 
"ClientList1," "ClientList2," and "ClientList3," respectively. In this example, 
we used the "Customers" table from the "Northwind" database. Refer to 
the directions for creating recordsets at the beginning of this chapter, if 
needed. 
 

 

6. Click the Properties button to modify the Properties for ClientList2. 
Configure "Country=B1" as the filter.  



 

 

7. Configure "City=B2" as the filter for ClientList3 and close the Recordsets 
window.  

8. Click the Spreadsheet Links button and link each control to its 
corresponding spreadsheet cell.  

9. Click the Recordset Links button . The Recordset Links pane appears 
on the right and lists the three recordsets.  

10. Link the Country list box control to the Country table of ClientList1. This is 
the first filter.  

11. Link the City List Box to the City table of ClientList2.  
12. Link the ContactName Field to the ContactName table of ClientList3.  
13. Test the form. Select different countries in the Country List Box. The data 

in the City List Box changes accordingly. Select a City and the contact 
person appears in the Contact field. You can define multiple layers of 
filters throughout the forms. 



 

 

Using Buttons for Database Actions 

Ultimus allows you to use buttons for navigation, search, and creation and 
maintenance of records in a database. Each button can perform one task and 
can be linked only to one recordset. You can have multiple buttons linked to the 
same recordset. 

This example shows the process of linking a button to a recordset and using the 
button to move from one data record to the next. In the following steps, we 
assume that you have connected to a datasource and defined your recordsets as 
described in previous sections. 

To use a button with a recordset: 

1. Create the form as shown below as well as a "Customer Information" 
recordset. The text in the button reads "Next." 



 

 

2. Link the Name and Company fields to the appropriate recordset fields.  
3. Link the button control to the entire recordset (i.e., click on the Customer 

Information node at the top). The link will appear at the bottom, under the 
Fax node.  

4. Close the Recordsets pane.  
5. Select the button control, right-click and select Control Links. The Control 

Links window appears.  
6. Click the Event Actions tab. Use the default "Clicked" in the Available 

Events combo box.  
7. Select "Move to next record in the Recordset" from the Assigned Action 

combo box.  
8. Click Set and close the window. The button will now perform the specific 

function for the recordset.  
9. Test the form. When you click the Next button to move through the 

records in the recordset. 



 

 

Using Buttons and a Grid Control 

This example shows the process of linking a grid control to a recordset and using 
buttons to manipulate the data. The recordset is used to populate the cells of the 
grid. The buttons are used to modify records in the database and create new 
records. 

We assume that the user is familiar with the process of creating controls and 
linking them to the local spreadsheets. We will only cover the process of linking 
the database to the forms. 

To define the form using a grid and buttons: 

1. For this example, we created the following database table and configured 
it as an ODBC datasource named "Tools." 
 

 



2. Create the form as shown below. 
 

 

3. Select Recordsets from the Edit menu. The Recordsets window appears.  
4. Create a recordset named "Tools." In this example, we used the 

"Products" table from our database. Refer to the directions for creating 
recordsets at the beginning of this chapter, if needed.  

5. Click the Recordset Links button . The Recordset Links pane appears 
on the right and lists the recordset.  

6. Link the grid control and the buttons to the Product List table. Make sure 
that you do not link them to individual fields.  

7. Close the Recordset links pane.  
8. Open the Control Links for the grid and, under the Spreadsheet tab, enter 

"A1:F20" in the Destination Cell(s)/Variables combo box.  
9. Click on the Recordset tab and link the grid columns to the recordset fields 

as shown. 



 

 

10. Select the Add button. The Control Link properties for the Add button 
appear.  

11. Click on the Event Actions tab.  
12. Select "Clicked" from the Available Events combo box and "Create new 

record in the Recordset" from the Assigned Action combo box, then click 
the Set button.  

13. Select the Update button and change the Event to "Clicked" and the 
Action to "Update the current record in the Recordset," then click the Set 
button and close the window.  

14. Test the form. In row nine, enter the following data:  
o ID=9  
o ProductID=120  
o ProductName=Drill  
o QPerUnit=1  
o UnitPrice=65  
o InStock=102  

15. Click the Add button to add this newly added row to the database. 
Likewise, you can modify the data in one of the other rows and/or add a 



new row by clicking the Update button. After you have used the form, you 
can verify the contents of the database to see that the values have 
changed. 
 

 

Working with Query Based Recordsets 

This example demonstrates how to create recordsets that work on multiple 
tables. It also shows how to use SQL functions in recordset queries. Query 
based recordsets allow you to execute any SQL command and include SQL 
function in the query statement. This allows you to easily handle complex query 
statements. In this example we assume that on a workflow step, we want to find 
out the name of Top 20 customers whose purchases amount more than $1000. 
We also want to find the total purchase made by these customer in a descending 
order.   

Note:  

Extended Query only allows you to execute only SELECT SQL statement. 

To understand this query you need to know the structure of Northwind 
database. Since the example given here, works on multiple tables its 
important to know how they are linked. For easy reference, mapping 
diagram of the tables used in this query is given below: 



 

 

To execute this query, we create a recordset as follows: 

1. Create a new recordset under as shown below: 
 

 
Select the option Query and click on the build query button .  

2. As you specify the information on "New Recordset" window and click OK 
button following dialog is shown to you. On this dialog you can specify the 
SQL statement you want to run. In our example we want to search for the 
top 20 customer based on the amount of purchases they have made. This 
is done using the following SQL statement: 
Select [Customers].CompanyName, Sum([Products].UnitPrice) as 
TotalPurchases from 
[Products], [Customers], [Orders], [Order Details] Where 
[Customers].CustomerID= [Orders].CustomerID AND 
[Orders].OrderID= [Order Details].OrderID AND  



[Products].ProductID=[Order Details].ProductID 
Group By [Customers].CompanyName 
Having Sum([Products].UnitPrice)>1000 
Order By Sum([Products].UnitPrice) Desc 
This query fetches the name of customers with their respective purchases 
in descending order 
 

 

3. On this dialog link the output columns or the specified query as shown 
below. In the Maximum Rows, specify 20, since we only want top 20 
customers to be fetched from the database. 



 

 

On execution, this recordset fetches the desired data from Northwind database to 
the linked columns. 

Working with Actions 

Using Actions you execute any SQL statement. In this example we assume that 
we want to delete the "lost" customers from database. "Lost" customer are 
defined as those customers who have not placed any order since January 1998. 
This action can be defined as follows: 



1. Define an action as follows: 
 

 

2. In the query list box we specify following query: 
DELETE FROM [Customers] WHERE [CustomerID] IN  
(Select [Customers].CustomerID FROM [Orders] WHERE 
[Orders].OrderDate={d '1999-08-01'}) 



 

 

When this action is executed, all such customers who have not placed any order 
since August 1999 are deleted from the database. 



Working with Thin Forms 

Ultimus Thin Forms use pure HTML to provide lightweight forms as user interface 
that can be used in any HTML 3.2-compliant browser, such as UNIX, Macintosh, 
Linux, and PDAs. While the Ultimus standard Client and forms provide 
sophisticated capabilities, they use ActiveX or Java controls that may not function 
in every browser. Thin forms do not support all the functionality of the standard 
Ultimus forms, but are lightweight, fast, and the ideal solution for users who need 
to deploy workflow solutions in a true cross-platform environment. 



The Thin Form Designer 

The Thin Forms Designer is a simple HTML editor that works just like a standard 
word processor. For every user step in a workflow process, you may create a thin 
form using the Thin Forms Designer. This form can work in conjunction to a 
standard form for a step, or be the only form associated with the step, depending 
upon the needs of your process and the requirements of your users. 

Ultimus Thin Forms use pure HTML to provide lightweight forms as user interface 
that can be used in any HTML 3.2-compliant browser, such as UNIX, Macintosh, 
Linux, and PDAs. While the Ultimus standard Client and forms provide 
sophisticated capabilities, they use ActiveX or Java controls that may not function 
in every browser. Thin forms do not support all the functionality of the standard 
Ultimus forms, but are lightweight, fast, and the ideal solution for users who need 
to deploy workflow solutions in a true cross-platform environment. 

Users familiar with HTML can extend the functionality of thin forms by inserting 
their own HTML code. You can also use third party tools to design custom HTML 
pages and include them in thin forms. Thin Forms also allow the users using the 
Active Server Pages (ASP) as Thin Forms. While the Standard Forms provide 
sophisticated capabilities matching most of the workflow automation 
requirements, Thin Forms allow the users create highly customized front ends. 
By allowing the users import custom ASP pages, Thin Forms allow the workflow 
designers create powerful forms that can work with popular databases at the 
backend or run advanced ActiveX controls or connect to third party applications.  

Note: While we expect all HTML 3.2 compliant content to function with 
Ultimus Thin Forms, we cannot guarantee or provide technical support for 
content generated outside the Ultimus Thin Forms Designer. Ultimus will 
fully support the standard HTML controls provided in the Thin Forms 
Designer. 



The Thin Form View 

The Thin Form view for a step allows you design Thin Form for a step. You can 
switch to the Thin Form as follows: 

To Invoke the Thin Form View: 

From the Map View: 

In map view you can view thin form designer for a step by using any of the 
following methods: 

1. Select a step in the process map. The Form View button is activated. Click 
on the down arrow beside the Form View button and select Thin Form 
View. The thin form for the step appears. OR  

2. Right-click on the step and select Form menu and then the Thin Form 
Menu. The Thin Form for the step appears. OR  

3. Select a step and from the View Menu select the option Thin Forms. The 
Thin Form for the step appears. 

From the Data View 

In data view you can view thin form designer for a step by using any of the 
following methods: 

1. Select the Spreadsheet tab for the step. Click on the down arrow beside 
the Form View button and select Thin Form View. The thin form for 
the step appears.  

2. Select the Spreadsheet tab for the step. From the View Menu select the 
option Thin Forms. The Thin Form for the step appears.  



 

Thin Form View has following toolbars: 

Thin Form View Toolbar 

The Thin Form View Toolbar contains command buttons and functions unique to 
the Form View. The Formatting Toolbar contains functions for formatting text 
within the form, and the form itself. The Controls Palette contains standard HTML 
controls that can be used in forms, in addition to two Ultimus controls for 
attachments and electronic signatures. 
 
The Thin Form View Toolbar contains the following buttons: 

Button Name  Function  

 Test Mode  Preview the thin form to see how it will behave when 
the process is running.  

   Page Selection 
Combo Box  

Displays the selected page and allows switching 
between different pages.  

 New Page  Create a new page for a multi-page thin form.  

 Delete Page  Delete the selected thin form page.  

 Save HTML File  Save page as an HTML file that can be modified with 
a third-party HTML editor.  

 Load HTML File  Load an HTML file created with a third-party HTML 
editor.  

 Properties  Display the properties of the selected control.  
 Show/Hide Details Show or hide HTML tags.  
 Edit HTML  Display the HTML code for the thin form so that it can 



be edited within Ultimus.  
 Spreadsheet  Display the local spreadsheet for the thin form.  

 Spreadsheet Links 
Display the local spreadsheet for the thin form and 
control links. Also enables linking controls with 
spreadsheet cells.  

 Form Tags  
Click this button to include Form Tags. A Page having 
form tags can pass and receive data from the Thin 
Server.  

   Step Selection 
Combo Box  

Displays the selected step and allows switching 
between Thin Forms of different steps.  

The Formatting Toolbar 

The Formatting Toolbar contains the following buttons and controls specific to the 
Thin Forms Designer:  

Button Name  Function  
 Decrease Indent  Decrease the paragraph indentation. 
 Increase Indent  Increase the paragraph indentation.  
 Bullet List  Create a bulleted list.  
 Numbered List  Create a numbered list.  
 Paragraph Break  Insert a paragraph break.  
 Line Break  Insert a line break.  

   Background Color Combo Box Change the color of the form page.  

   Text Color Combo Box  Change the color of the selected text. 
 



Rules and Guidelines  

• The Thin Forms Designer is a simple HTML Editor that works like a 
standard word processor. 

• While designing a form, its appearance and logic can be immediately 
tested in Test Mode.  

• The Thin Forms designer allows creating a Thin Form that contains more 
then one page. 

• A Thin Form can also consist of Persistent Pages. Persistent pages are 
not processed by the Thin Server, rather these pages are once extracted 
and stored in the 'Ultweb' folder on the server. Whenever a call for a 
Persistent page is received by the Thin Server, the page is displayed 
without any processing.  

• Controls of a Persistent page cannot be linked with the workflow variables 
or spreadsheet cells. 

• When using multiple pages in a Thin Form, one page must be set as the 
Default Page. The Default Page of a Thin Form is the page that is shown 
before all the other pages.  

• The Default Page may contain links to other pages included in the Thin 
Form of a Step. Ultimus sets the first page created in Thin Forms as the 
Default page. A different page can be set as the Default Page using Page 
Properties. 

• When using multiple pages in a Thin Form, one of the pages must contain 
Ultimus  
Submit Button that submits tasks on the BPM Server. 

• When using multiple pages in a Thin Form, a user can design only one 
page at a time. 

• A Thin Form can also include Active Server Pages (ASP). ASP pages 
allow the workflow designers create customized forms that can work with 
popular databases at the backend or run advanced ActiveX controls or 
connect to third party applications.  

• The Thin Forms Designer does not allow visually modifying the look and 
feel of ASP pages. An ASP page can only be created/modified by 
pasting/modifying its code in the Edit HTML window. 

• ASP pages are included as Static Pages and the controls of an ASP page 
cannot be linked to workflow variables. 

• The Test Mode only works for HTML forms. ASP forms cannot be 
executed in Test Mode. 

• ASP Pages are not executed during simulation of a process. 
• The Thin Forms Designer allows using HTML pages that contain frames. 

A page containing frames can only be created by copying its code in the 
Edit HTML window. For details see "Working with Frame Pages".  

• The Thin Forms Designer does not allow visually modifying the frame 
page, or the pages referenced in its frames. 



• Any page of a Thin Form that has to submit data to the BPM Server must 
include Form Tags. All the controls must be placed between Form Start 

and Form End tags.  
• Ultimus does not support using tables in Thin Form pages.  



Creating Thin Forms 

For every user step in a workflow process, you may create a thin form. This form 
can work in conjunction to a standard form for a step, or be the only form 
associated with the step, depending upon the needs of your process and the 
requirements of your users. The text and background color of a Thin Form can 
be modified as follows: 

Modifying Text and Form Colors 

Ultimus allows you to change the color of any text within a thin form, as well as 
the background color of the form itself. 

To change the color of text in a thin form: 

1. Select the text in the thin form.  
2. Select a color from the text color combo box .  

To change the background color of a thin form: 

• Select a color from the background color combo box .  

Working with Multiple Pages in a  Thin Form 

Every Thin Form is a collection of HTML Pages. As you switch to Thin Form 
View, one page is added to the Thin Form by default and is also set as the Main 
Page. The Main Page of a Thin Form is the page that is shown before all the 
other pages. More pages can be added to the Thin Form using the New Page 
button.   

To modify the properties of a page, double click any where on the page, following 
properties dialog appears:  



 

On this dialog specify:  

• Page Name: Name of the page. Ultimus uses this name to identify a 
page. 

• Page Extension: From the editable combo box, select .asp extension if 
asp is being used or .aspx extension if asp.net is being used. By default 
the extension would be .html. The save as persistent page checkbox also 
needs to be checked for these pages. This has to be done before  editing 
the code in the edit html window.  

• Default Page: Check this checkbox, to make this page as the Default 
Page of the Thin Form. The Default Page of a Thin Form is displayed 
before all of the other pages. It is the entry point of a user accessing a 
multiple-page Thin Form. Any Thin Form can have at the most one 
Default. To make other pages of a Thin Form accessible to a user, links to 
other pages must be included on the Default Page. 

• Save as persistent page: To create a Persistent page check the 
checkbox labeled "Save as Persistent Page". Persistent pages are not 
processed by the BPM Server, rather these pages are once extracted and 
stored in the Ultweb folder on the server. Whenever a call for a Persistent 
page is received by the BPM Server, the page is displayed without any 
processing. Controls of a Persistent page cannot be linked with the 
workflow variables or spreadsheet cells. All ASP pages are saved as 
Persistent Pages. For details see the section "Including ASP Pages in 
Thin form". 

A page added to Thin Form can be deleted using the Delete Page Button.  



Working with Controls 

A thin form is made up of a number of objects, called "controls". Controls have 
properties, attributes, and perform specific functions. In this section, we explain 
how controls are used in general and define the actions common to all controls. 
In subsequent sections, we focus on the specific properties of individual control 
types. 

The Thin Forms Controls Palette 

 

The Thin Forms Controls Palette allows you to insert standard HTML controls, 
such as text fields, radio buttons, combo boxes, and more. These are standard 
HTML controls that work in any web browser. The Thin Forms Controls Palette 
also offers two Ultimus-specific controls, the signature control and attachment 
control, which also work in any web browser. 

By default, the Thin Forms Controls Palette appears on the right side of the Thin 
Form View. However, you can move the Palette below the Main Toolbar or make 
it a floating window. Each button is associated with a "control" which performs a 
certain function and behaves in a certain way. You make forms by placing these 
controls on a blank form, link some controls with the local spreadsheets, and 
define the properties of the controls. 

The Thin Forms Controls Palette buttons are as follows:  

Button Name  Function  
 Edit Box  Insert an edit box control.  
 Multi-Edit Box  Insert a multi-line edit field control.  
 Check Box  Insert a check box control.  
 Radio Button  Insert a radio button control.  
 Combo Box  Insert a combo box control.  
 List Box  Insert a list box control.  
 Signature Control  Insert a signature control.  
 Attachment Control Insert an attachment control.  

 Image Control  Insert Image in Thin Form.  

 Submit Button  Insert Button that submits Workflow Task. 

To move the Palette: 



• Click on one of the divider lines in the Palette and drag it to the new 
location. If you drag it to the Main Toolbar, it switches to a horizontal 
configuration. If you drag it to the workspace, it becomes a floating 
window.  

To insert controls in the form: 

• Click the button for the control in the Palette. The control appears at the 
cursor position.  

To change the size of a control: 

• Select the control. Click on one of the handles that appear and drag it to 
resize the control. The location of the handle determines how the control is 
resized, such as height and width. Corner controls adjust the size 
proportionally.  

Deleting a Control:   

To delete a control: 

• Right click on the control and select the option "Delete" or “Cut”. 
• Select the control and press "CTRL+X" keys from key board.  
• Select the control and click on the button “Cut” in shortcut toolbar.    
• Click on the workspace next to the control to be deleted and press the 

backspace key. 



Linking Thin Form Controls with Spreadsheet Cells 

You can link controls on a thin form page to local spreadsheet cells graphically or 
by using the Control Links. You can link a control, such as a single-line edit field, 
to an individual cell or, in the case of a multi-line edit field, to a range of cells. All 
the controls must be placed between the Form Start and Form End 
Tags in order to enable them to send/receive data from the local spreadsheet.  

To link a control to a single cell or a range of cells: 

1. In the Thin Form View, click the Spreadsheet Link button . The local 
spreadsheet appears on the right and a tree list of all controls in the thin 
form appears on the left.  

2. Select the control in the form.  
3. Click on the cell of the local spreadsheet, or select a range of cells. The 

Source and Destination cells appear beneath the control in the tree list 
with icons indicating the type of link. 
 

 

Notes: When you link a control to a local spreadsheet cell, the cell border 
turns yellow. When you select another control, the cell border turns blue. 
This gives you a visual indication of which cells have been linked. 

When graphically linking controls to spreadsheet cells, the cell address is 
displayed in the tree list. When linking controls via the Control Links 
properties (described below), the variable name appears in the tree list. 

Link Types: Data Flow 

When you link a workflow variable with a local variable, Ultimus allows you to 
specify the type of "data flow". This allows you to control whether data flow is 



unidirectional or bi-directional for each link. The data flow choices are described 
below. Each choice is associated with a symbol, which is displayed beneath the 
control name in the tree list on the left. This allows you to graphically determine 
not only if the step is linked, but also the direction of data flow. 

• Input: Specifies that data will flow from the local spreadsheet to the 
control. The symbol indicates that data is flowing into the control.  

• Output: Specifies that data will flow from the control to the local 
spreadsheet. The symbol indicates that data is flowing out of the control.  

Linking Controls to Separate Source Cells and Destination Cells 

 The linking process described above assumes that the destination cell(s) and 
the source cell(s) are the same. However, some controls, such as combo and list 
boxes, require the source cell(s) to be different from the destination cell(s). You 
may also want edit fields and other controls to have different source and 
destination cells. 

To link separate source cells and destination cells: 

1. Link the control to a spreadsheet cell as described previously.  
2. Select the control.  
3. Right-click on the control and select Properties. The Properties window for 

the selected control appears.  
4. Click on the Control Links tab. 

 

 



5. Enter the cell address of the destination cell in the Destination Cell combo 
box, or select a workflow variable.  

6. Click OK.  

Note: Source cells are a range of cells in the spreadsheet. Thus, they must 
be contiguous. The destination cell does not have to be contiguous to the 
source cells. It can be anywhere on the spreadsheet. This allows you to, for 
example, use the same source cells with many list boxes. 



Linking Thin Form Controls to Recordsets 

Linking thin form controls to database tables allows users to read and write 
information to the database when using the thin form. You can link list boxes and 
combo boxes to database tables. 

To link a combo box or list box to a database table: 

1. Link the control to a spreadsheet cell as described previously.  
2. Select the control.  
3. Right-click on the control and select Properties. The Properties window for 

the selected control appears.  
4. Click on the Control Links tab. 

 
5. Click the Datasource check box. The Datasource fields are activated.  
6. Enter the user name and password for the database in the Login and 

Password fields.  
7. Select a database DSN from the Recordset combo box.  
8. Select a table from the Table Name combo box.  
9. Select a column from the Column Name combo box.  
10. Click OK.  

To unlink a combo box or list box from a recordset: 

• Click the Datasource checkbox. The datasource links are deactivated.  



Description of Thin Form Controls 

Ultimus thin forms support common HTML controls as well as two Ultimus-
specific controls for form design. Each control and its properties are described 
here. 

Button Control 
Check Box 
Combo Box 
Edit Field 
Image Control 
List Box 
Multiline Edit Control 
Radio Button 
Signature Control 

Button Control 

Every Thin Form must have a Submit Button on at least one of its pages. The 
Submit Button is used to submit the completed task to the BPM Server.  The 
Ultimus Button Control can be trained to perform four different function, including 
Submit Form, as follows: 

     

• Value: This is the text that appears on the face of the button. 
• Submit: Select this option to configure the submit Button to submit the 

Workflow Task.  



• Return: Select this option to set the button to Return the Workflow Task to 
the previous step. 

• Refresh: Select this option to configure the button to refresh the form 
contents. 

• Other: Select this option to set custom action against a Submit Button. 
Click OK. Right-Click and select View Properties. When this option is 
selected the Properties change as follows: 
 

 
 
Specify the Name of the Submit Control in the text box labeled 'Name'. 
Name of a submit control is used for identifying the control on a page. 
 
Note: If the option "Other" is selected for a Submit Button, you must 
click "Edit HTML" and write your custom code in the HTML Pane to 
set an action to be taken against this button.  

Check Boxes 

Check boxes allow users to make choices and select options. Thus, a typical 
result of a check box selection is represented by either 0 or 1, with 0 representing 
no selection and 1 representing a selection. The results are placed in the cells 
linked to the check boxes. 

Every check box must be linked to a local spreadsheet cell. A spreadsheet cell 
may be linked to multiple check boxes. When the thin form is created, the value 
of the local spreadsheet cell is used as the default value for the check box. If the 
cell content is 0, the default check box selection is "off". If the cell content is 1, 
the default check box selection is "on". When the User clicks on the check box, 



its status is immediately transferred to the local spreadsheet cell (i.e., the cell is 
set to 0 if the check box is off, or set to 1 if the check box is on). 

Check boxes have the following properties: 
 

      

• Name: This is the name used by Ultimus to distinguish the control from 
other controls in the thin form.  

• Initial Value: Initial value of the control.  

Combo Boxes 

A combo box displays a list of choices to the user and allows him to select one. 
Once you have placed a combo box on the form, you can perform a variety of 
operations for controls as described in previous sections. 

Every combo box control in a form must be linked to the local spreadsheet or a 
recordset. Combo boxes require separate destination and source cell(s). The 
procedure for linking combo boxes is explained in the "Linking Controls to 
Separate Source Cells and Destination Cells" section of this chapter. 



Combo boxes have the following properties: 
 

       

• Name: This is the name used by Ultimus to distinguish the control from 
other controls in the thin form.  

Edit Fields 

Edit fields are used for entering data in forms. Each edit field must be linked to a 
cell in the local spreadsheet or a system variable. When the form is displayed, 
each edit field displays the contents of the cell to which it is linked. When a user 
enters data, the contents of the linked cell(s) are updated. An edit field consists 
of one line of text with up to 255 characters. Validation for maximum characters 
is performed when the user sends the form. 

Every edit field in a thin form should be linked to a local spreadsheet cell(s). A 
local spreadsheet cell may be linked to multiple edit fields. When the thin form is 
created, the contents of the spreadsheet cell are used as default values in the 
edit field. When the user enters data in the field, it is transferred to the 
spreadsheet cell where it is processed and forwarded to other forms via the main 
spreadsheet. Edit fields are linked to local spreadsheet cells just like any other 
control as described in the "Linking Thin Form Controls with Spreadsheet Cells" 
section of this chapter. 



The thin form edit field has the following properties. 
 

       

• Name: This is the name used by Ultimus to distinguish the control from 
other controls in the thin form.  

• Initial Value: Initial value of the control.  
• Length of Characters: Set the width of control.  
• Password: Check this checkbox to make it a signature field. For details 

about signature field see "Signature Control".   

  

Image Control 

Image control allows inserting images on Thin Form pages. Using the image, an 
image can be browsed and embedded in a Thin Form page.  



The image control has following properties: 
 

       

• Name: Name of the image control. 
• Image: Use the browse button to specify the image to be displayed in the 

image control. 

  

List Boxes 

A list box is used to display several choices to the user of a form. List box 
Controls are inserted in a form as described earlier in this chapter. 

Every list box in a form can be linked to the local spreadsheet. List boxes require 
a destination cell(s) and source cell(s). The procedure for linking list boxes has 
been explained previously in the "Linking Controls to Separate Source Cells and 
Destination Cells" section of this chapter. 



List boxes have the following properties. 
 

      

• Name: This is the name used by Ultimus to distinguish the control from 
other controls in the thin form.  

• Height: The line height for the field.  
• Multiple Selection: If the Yes radio button is selected, this function allows 

you to select multiple items in the list box.  

Note: When using the list box for multiple selection, you must link the 
destination cells to a range of cells. The number of cells in the range 
represents the maximum number of items that can be selected. 

Multi-line Edit Fields 

Multi-line Edit fields are used for entering data in forms. Each multi-line edit field 
must be linked to a cell in the local spreadsheet or a system variable. When the 
form is displayed, each edit field displays the contents of the cell to which it is 
linked. When a user enters data, the contents of the linked cell(s) are updated. A 
multi-line edit field consists of multiple lines of text with up to 255 characters per 
cell. Therefore, if you link the multi-line edit field with three cells, it can 
accommodate 765 characters. Validation for maximum characters is performed 
when the user sends the form. 

Every multi-line edit field in a thin form should be linked to a local spreadsheet 
cell(s). When the thin form is created, the contents of the spreadsheet cell are 



used as default values in the multi-line edit field. When the user enters data in 
the field, it is transferred to the spreadsheet cell where it is processed and 
forwarded to other forms via the main spreadsheet. Multi-line edit fields are 
linked to local spreadsheet cells just like any other control as described in the 
"Linking Thin Form Controls with Spreadsheet Cells" section of this chapter. 

The thin form multi-line edit field has the following properties. 
 

      

• Name: This is the name used by Ultimus to distinguish the control from 
other controls in the thin form.  

• Initial Value: Initial value of the control.  
• Length of Characters:  Set the width of control.  
• Number of Lines: The maximum number of lines allowed in the multi-line 

edit field.  

Radio Buttons 

Radio buttons are used to prompt users to select one of several options. Thus, 
they are generally placed in groups. Every radio button in a thin form must be 
linked to a local spreadsheet cell. When the thin form is created, the content of 
the spreadsheet cell is used as the default value for the radio button. If the cell 
content is 0, the default radio button selection is "off". If the cell content is 1, the 
default radio button selection is "on". When the user checks the Radio button, the 
status is immediately transferred to the spreadsheet cell. 



The radio button has the following properties: 
 

      

• Group Name: The name of the group with which the radio button is 
associated. For example, you have a thin form with two sets of radio 
buttons. The first set is for the user to select which type of computer 
he/she is using. The second set is for the user to select which operating 
system is installed. Thus, in order for the buttons in each set to work 
correctly, all the radio buttons in the first set would have "Computer" in the 
group field, and all the radio buttons in the second set would have "OS".  

Note: Once the radio buttons are grouped, the buttons will work together 
and only one may be selected at any given time. You can have multiple 
groups of radio buttons in a thin form. 

Signature Control 

Ultimus provides a signature control that allows users to "sign" thin forms. When 
a thin form containing a signature control is used by the client, the user enters a 
network password, which is displayed as asterisks. If the user enters a valid 
password, the password acts as a digital "signature".  

Ultimus uses Directory passwords for simple signature verification. However, if 
customers wish to implement advanced signature verification and display using 
their own or third party algorithms, Ultimus allows them to replace the Ultimus 



Security DLL with their own signature verification DLL. This allows users to 
implement any signature scheme of their choice within the Ultimus framework. 

Every signature field in a thin form should be linked to a local spreadsheet cell. 
When the user signs the form, the data is transferred to the local spreadsheet 
cell where it is used for further processing and forwarded to other forms through 
the main spreadsheet. 

The signature control has the following properties. 

      

• Name: This is the name used by Ultimus to distinguish the control from 
other controls in the thin form.  

• Initial Value: Initial value of the control.  
• Length of Characters:  Set the width of control.  
• Password: Uncheck this checkbox to make it an edit field. For details 

about an edit control see "Edit Field".  

Note: 

• "Length of Characters" property will not work for a control, once its 
size is changed manually. 

• As you view the properties of a control by invoking the properties 
window, it becomes disabled. Once you are finished setting 
properties of the control and have clicked OK button on the 



properties window, you must click once on the form to enable the 
selected control on form. 

• When the  Domain Prefix is enabled, it is mandatory to create a 
\DOMAIN NAME directory in the \ULTWEB\SIGNATURE folder, 
furthermore the folder must also include its signature images. 



Attachment Control 

Ultimus offers an attachment control which allows users to attach documents to 
thin forms and works in much the same way as e-mail attachments. When a 
document is attached to a thin form, the attachment control shows the file name 
and path to the file. Attachments can be files of any type. Like the ActiveX 
Attachment Control, the thin form can send multiple attachments, one for each 
cell to which the control is linked. 

Attachment controls are inserted into a thin form in the same manner as other 
fields. The Attachment Control has the following properties. 
 

     

• Name: This is the name used by Ultimus to distinguish the control from 
other controls in the thin form.  

• Size: The length of attachment control.  

Using Attachments 

The following steps demonstrate the use of the attachment control in a thin form 
as it appears in a web browser: 

 

To attach a document: 



1. Click the Browse button on the control. The Open window appears.  
2. Select the file and click Open. The file name and its path appear in the 

attachment control field.  

To attach multiple documents: 

1. Attach the first file as described above. 
2. Click Refresh Button. 
3. The form data is “saved” without submitting the form. The path for the 

attached document appears as a hyperlink below the attachment control. 
You may attach as many files as there are cells linked to the control.  

4. Attach another file as described previously.  

To remove an attachment: 

To remove an attachment, click the "Remove" button that appears next to every 
attachment. 

To open an attached document: 

• Click on the document's hyperlink below the attachment control. This 
launches the document's application or viewer.  

Note: To successfully open an attached document, you must have the 
correct viewer or application registered with Windows. If the viewing 
program is not available, Ultimus displays an error message. 



Viewing Thin Form's HTML Code 

Every Page designed in Thin Forms Designer is an HTML page. Just like 
standard HTML Editor, while the page is being visually created in Thin Forms 
Designer, its HTML is automatically generated. While designing a page it may 
sometime become necessary to manually edit the HTML. Ultimus allows this by 
displaying the editable HTML code of a Thin Form page. Using the Edit HTML 
Pane the functionality of a Thin Form can be extended to include: 

• Dynamic Pages based on ASP 
• Frame Pages 

To view the HTML code for a thin form: 

1. Click the Edit HTML button in the Thin Form Toolbar. The Edit HTML 
Pane  
appears and displays the HTML code for the form. 
 

 
      

2. Modify the HTML code.  
3. Click Edit HTML button. The Edit HTML Pane is closed and the form is 

updated with the changes.  

You may edit the HTML code of the thin form within Ultimus, or export the form to 
an external file. This allows you to modify the form in any HTML editor, such as 
FrontPage. You can then re-import the file back into Ultimus. You can also create 
forms in another HTML editor and import them into Ultimus. 



To save/export a thin form as HTML file: 

1. Click the Save HTML File button . The Save As window appears.  
2. Name the thin form and save it to the desired location. The form can now 

be opened with any HTML editor for further modification.  

To import an HTML file as a thin form: 

1. Click the Load HTML File button . The Open window appears.  
2. Select the HTML file and click Open. The HTML file is loaded into the thin 

form view.  

Notes: When you load an external HTML file, it will replace anything 
currently in the thin form view. These items cannot be retrieved once the 
thin form has been saved. 

With Thin Forms, Ultimus only supports the controls provided by Thin 
Forms Designer (see Working With Controls). Other controls included in the 
imported HTML files may or may not work. 

When you save a thin form as an HTML file and import it back into the same 
step, any links previously created are lost.  



Including ASP Pages in Thin Forms 

Thin Forms Designer allows including ASP based Dynamic Pages in a Thin 
Form. Dynamic pages allow the creation of pages that are customized for each 
user on the fly. The Dynamic page can be designed to use Advanced ActiveX 
controls, connect to Databases or work with a third party application to perform 
customized actions.  

To create a Dynamic ASP Page: 

An ASP Page can be included in a Thin Form in any of the following two ways: 

• Click the Edit HTML Button . The Edit HTML Pane appears. Paste the 
complete code of ASP Page in the HTML Pane window, replacing the 
already displayed in the Pane. Click again the Edit Button to close the Edit 
HTML Pane. The ASP based Dynamic page is added to the Thin Form. 

• Click the import HTML Page button. Browse to select the ASP Page you 
want to include. Click OK and the selected ASP page is included in the 
Thin Form. 

Note: ASP Pages are saved as Persistent Pages. An ASP page cannot be 
visually modified in Thin Forms Designer. The Control Palette and 
Formatting Tool Bars are disabled when an ASP page is imported. Controls 
on the ASP page cannot be linked with the workflow variables. 

ASP Pages are not executed during Simulation or Test Mode. It is therefore 
recommended to include an ASP page in a Thin Form, only after it has been 
tested for all the errors. 



Working with Frame Pages 

Thin Forms Designer allows creating pages that use frames. A frame page can 
only be created by pasting its HTML code in the Edit HTML Pane. 

To Create a Frame Page: 

1. Open Thin Form for a Step and select the page that requires to be frame 
based. 

2. Click the Edit HTML Button. 
3. The HTML Code is displayed in the Edit HTML Pane. 
4. Paste the following HTML Code replacing the already displayed HTML 

Code: 
<HTML><HEAD><TITLE>Ultimus Frame Page</TITLE> 
</HEAD> 
<FRAMESET cols=257,69%> 
<FRAME name=contents src="C:\workflow.htm" scrolling=yes 
target="main"> 
<FRAME name=main src="http://www.google.com"> 
<NOFRAMES> 
<body> 
<p>This page uses frames, but your browser doesn't support them.</p> 
</body> 
</NOFRAMES> 
</FRAMESET> 
</HTML> 
 
Note: The frame page source can be a valid Local Path, Network Path 
or internet path. The file specified here is automatically saved with 
workflow process. 

5. Click again the Edit HTML Button to apply the changes. The Frame 
Page is displayed in Thin Forms Designer as follows: 
 



 
 
Note: The Frame Page cannot be visually modified in Thin Forms 
Designer. 

Creating Frame Page that Uses Ultimus Designed Forms 

This section describe how you can create a Frame Page whose Frames 
reference other HTML pages included in the same Thin Form. Suppose we have 
created a Form that has three pages, Page1, Page2 and Page3. We want Page1 
to be a Frame based page that has two Frames namely FrameA and FrameB. 
We want FrameA to display Page2 and FrameB to display Page3. This is done 
as follows: 

1. Switch to the Thin Forms View. 
2. Click the New Page button twice to include two new Pages. Thin Forms 

Designer displays the following: 



 

 
3. Note the name of this page as displayed in the status bar (as indicated 

above). 
4. Using the Switch Page Combo box, switch to Page2 and Note the name of 

this page as well. 
5. Enter text on Page2 as shown below: 

 

 



6. Switch to Page3 and enter text as shown below: 
 

 
7. Switch to Page1.  
8. Click the Edit HTML  button. The HTML Pane appears. Delete the existing 

HTML code and paste following: 
 
<html> 
 
<head> 
<title>New Page 1</title> 
</head> 
 
<frameset cols="370,*"> 
<frame name="contents" target="main" src="Page2.htm"> 
<frame name="main" src="Page3.htm" scrolling="auto"> 
<noframes> 
<body> 
 
<p>This page uses frames, but your browser doesn't support them.</p> 
 
</body> 
</noframes> 
</frameset> 
 
</html> 

9. Click again the Edit HTML button. Thin Forms Designer displays the 
following: 



 

 
10. Note that the Frame Pages does not allow directly modifying the 

referenced pages. To modify the referenced pages you have to switch to 
the referenced page. For example to modify Page2, switch to Page2. 
Place two text boxes as shown below: 
 

 
11. Move back to Page1 and Thin Forms designer displays the updated 

Page2 in its respective frame. 



 

 



Testing Your Form Design 

When you enable the test mode in the thin forms designer, the thin form is 
displayed just as when viewed in your web browser. You can enter data, make 
selections from list boxes, and operate all the other controls. While in the test 
mode, the local spreadsheet is also displayed at the top. This lets you see, 
interactively, how the actions you take on the thin form affect the data in the local 
spreadsheet. Thin forms can be tested, but not used in simulation. Only Standard 
Forms can be simulated. 

To invoke the test mode in the thin forms designer: 

• Click on the Test Mode button . The thin form appears as it will in the 
web browser.  

To exit the test mode: 

• Click the Test Mode button again to return to the thin forms designer.  



Using with PDF Forms 

Ultimus allows using PDF forms as the front end of a user step. This allows 
designing powerful PDF forms and incorporating them in the workflow process. 
The controls of a PDF form can be linked to the workflow variables and the data 
specified in the PDF form is passed to the workflow variables.  

Note: When using Acrobat Forms, the user must have Acrobat Reader 5.0 
or 6.0 installed on the client machine 



Working with PDF Forms 

To use a PDF form at a step in the workflow process follow the steps given 
below: 

1. Switch to the map view in Ultimus BPM Studio. 
2. Right click on the user step, select the option Form and Adobe PDF from 

the popup menu. The following dialog appears: 
 

 
 
On this dialog you can specify the following: 

3. Select PDF: Click the browse button and select a valid PDF Form file. As 
a form is selected, the form fields appear in the Acrobat Form Fields list 
box. 
 
Note: The specified PDF form must include: 
A Submit button added manually in Acrobat.  When configuring this 
button in Acrobat, The name of the button should be SubmitForm; 
the action, on mouse up, should be “SubmitForm”; The URL to 
submit to should be  
http://WorkflowServerName/ultweb/ultisapi/ultpdfsapi.dll?#FDF  
Where the WorkflowServerName is to be replaced with the Ultimus 
BPM Server Name. This name must exactly be the same as the one 
that is specified in Ultimus Client. Contact your network 
administrator if you do not know the BPM Server Name. 

4. Link Variables: To link the workflow variables to PDF Form fields:  
1. Click the variable to select it. 



2. Click the Acrobat Form Field. 
3. Click the link button. The specified variable is linked to the form 

field. The link appears in the Links List box. 
5. Unlink Variables: To unlink a variable from a Form Field, select its link 

entry in the Links List box and click the Unlink button. The variable is 
unlinked from the form field. 
Note: After linking the workflow variables, if a different PDF file is 
specified, the Form Trainer checks the PDF File and all the links are 
broken except for the controls that still have the same name. 

6. Clicking the Unlink All button removes all the links. 
7. Click the OK button when finished. 
8. Right click on the User Step and select Properties 
9. Set the Default Form value to "Acrobat Form". This will ensure that when 

process participants click on the task in the Ultimus Client, the Client will 
correctly invoke the Acrobat Form. 

This completes specification of PDF Form on a step.  



Working with InfoPath Forms  

To use a InfoPath form at a step in the workflow process follow the steps given 
below: 

1. Switch to the map view in Ultimus BPM Studio. 
2. Right click on the user step, select the option Form and InfoPath from the  

menu. The following dialog appears: 
 

 
 
On this dialog you can specify the following: 

3. Select InfoPath Form: Click the browse button and select a valid 
InfoPath (.xsn) Form from a file. The InfoPath Schema for the form 
appears. 
 
Note: The specified InfoPath form must include: 
A Submit button added manually to InfoPath.  When configuring this 
button in Infopath, The name of the button should be SubmitForm; 
the action, on mouse up, should be “SubmitForm”; The URL to 
submit to should be  
http://WorkflowServerName/ultweb/ultisapi/ultpdfsapi.dll?SubmitInfo
pathForm  



Where the WorkflowServerName is to be replaced with the Ultimus 
BPM Server Name. This name must exactly be the same as the one 
that is specified in Ultimus Client. Contact your network 
administrator if you do not know the BPM Server Name.  

4. Link Variables: To link the workflow variables to InfoPath Schema fields:  
1. Click the variable to select it. 
2. Click the InfoPath Schema Field. 
3. Click the link button. The specified variable is linked to the form 

field. The link appears in the Links List box. 
5. Delete Variables: To delete a linked variable from a InfoPath Schema 

Field, select its link entry in the Links List box and click the delete button. 
The link is deleted from the form field. 

6. Click the OK button when finished. 
7. Right click on the User Step and select Properties 
8. Set the Default Form value to "InfoPath Form". This will ensure that when 

process participants click on the task in the Ultimus Client, the Client will 
correctly invoke the InfoPath Form. 

Note: When defining your InfoPath Forms which will be linked to Ultimus, 
make sure that the forms have default values for any of the following field 
types in the form schema;     

1. Date  
2. Time 
3. Number (double) types 

These data types must have default values due to a .NET Framework 
limitation. 

This completes specification of InfoPath Form on a step.  

Note: to change a previously published InfoPath form, follow the steps 
given below; 

i) Using InfoPath, re-publish the changed (new version) form  

ii) In Ultimus, retrain the InfoPath Form linkages for the User Steps where it 
is leveraged 

iii) Re-publish the process 

Failing to do so will result in the older form being opened in Ultimus Client. 

  



Working With Flobots 

Business workflow involves people and applications, such as databases, ERP, 
accounting, word processors, and spreadsheets. People perform tasks and make 
decisions. They also use business applications to produce reports, search for 
information, do analysis, and produce charts and graphs. To automate workflow 
processes, it is important that the software provide a seamless interface between 
the workflow and commonly used business applications, and allow the 
applications to be used in the workflow without human intervention. 



How Flobots Are Used 

Ultimus Flobots provide a powerful means of using third-party applications to 
perform specific tasks as steps in a workflow process. Flobots are to business 
workflow automation as robots are to an automated factory. Hence the name 
"Flobots," which stands for "workflow robots." A robot is a flexible machine. It can 
be trained to do a variety of different tasks, depending on the work at hand. 
Before a robot is used to perform a task, it must be trained for that task. A robot 
may be trained, or programmed, for many different tasks. When it is instructed to 
run program A, it performs one set of tasks, and when it is instructed to run 
program B, it performs a different set of tasks. Likewise, desktop applications, 
such as word processors, spreadsheets, or modern databases, are flexible, 
general purpose applications that can do many different things. Ultimus Flobots 
allow users to "train" an application to perform a specific task as a step in the 
process. When that step is invoked during the actual execution of a workflow 
incident, the Flobots cause the application to perform the specific task. Like a 
robot, the application may be "trained" to perform many different tasks for 
different steps in the process, or for steps in different workflow processes. 

Ultimus Flobots consists of two parts: Trainer Flobots and Real Time Flobots. 
Trainer Flobots are used during the design of a process to train the application to 
perform a specific task. Real Time Flobots, on the other hand, are used in the 
actual execution of the workflow to make the application perform the task. 

Some examples of the use of Flobots are as follows: 

• At a certain step in the workflow, a report has to be printed. The process 
designer creates a Word template document as the skeleton of the report 
during the training. He inserts fields in the template document and links 
them to variables in the workflow process. During the execution of the 
process, when the workflow reaches the Word Flobot step, the template is 
filled with information gathered during the process and the report is 
generated automatically.  

• A business process for monthly forecasting requires the printing of a graph 
which shows forecasted bookings as compared to departmental budgets. 
The process designer creates a spreadsheet and a macro for printing the 
graph during the training. Each month, the process is automatically 
initiated and the departmental managers are asked for their forecasts. At 
the next step, departmental forecasts are fed into the spreadsheet and a 
macro is executed to create and print the graph.  

• A business process requires that employee information be read from a 
database for annual performance review. The Database Flobot is trained 
to pull out the appropriate information from the employee database, such 
as current salary, grade, and date of last review. This information is used 
in subsequent steps of the workflow to complete the performance review.  



Ultimus FloStation 

The Ultimus FloStation hosts the Flobots. It can be used as a stand-alone 
application or as a service. Multiple FloStations may be configured for 
convenience and scalability. A Flobot task may be routed dynamically to a 
FloStation based upon run-time conditions and data. Furthermore, FloStations 
may be configured locally on a LAN, or at a remote location where they connect 
with the BPM Server via HTTP or HTTPS. In the latter configuration, the Flobots 
can be used to interact with external vendors, partners, and customers. 

Inline Flobots 

A flobot can either be hosted at a flostation or it can be made an Inline Flobot. 
Inline Flobots differ from standard Flobots in following ways: 

• Inline Flobots work directly with the Ultimus BPM Server and no FloStation 
is required to host them.  

• Inline Flobots are much faster than Flobots run on the Flostation because 
they run instantly, while the Flostation polls periodically for new Flobot 
tasks. 

Inline Flobots are trained just like other Flobots. While training the flobot you can 
specify whether you want to host the flobot on some FloStation or you want to 
make it Inline Flobot. 
 
Note: Following Flobots cannot be run as Inline Flobots: 

• Word Flobot 
• Excel Flobot 
• Acrobat Flobot 
• Exchange Flobot 
• Custom Flobots 
• Web Services Flobot 

Rules and Guidelines for Using Flobots 

1. Flobots are run from the FloStation. You may install the FloStation on the 
same server as the BPM Server, or a dedicated PC. You may also install 
multiple Flostations on different PCs or declare them a "group" for 
scalability.  

2. A Flobot must be added on the FloStation before it can be used in the 
workflow. Ultimus Flobots are automatically installed when you install the 
software.  

3. A step for the Flobot must be included in the process map.  
4. The Form for the Flobot step must be created which lists all the variables 

used by the Flobot.  



5. The Flobot must be trained in the BPM Studio to perform the tasks 
required. The training information is automatically sent to the FloStation, 
where the Flobot runs.  

6. Ultimus also provides a Flobot API that enables advanced users to 
develop Flobots for other applications and integrate Ultimus workflow 
tightly with their environment.  

7. A Flobot fails after predefined time-out interval but the executable does 
not terminate.  

8. System variable Step name does not appear in Word ,Excel and 
Exchange Flobots.  

9. Parallel Flobots cannot be run as Inline Flobots. 

Adding Custom Flobot in BPM Studio 

You can place flobot steps in a process using Ultimus BPM Studio. In real time 
these Flobots are executed at the FloStation specified while designing the 
process. At design time if you simulate a process to test its working, the Flobots 
used in it run locally on the machine on which BPM Studio is installed. For details 
of process simulation see "Workflow Simulation". BPM Studio has a copy of all 
flobot's application files. These Flobots are executed during process simulation. 
All Flobots available to BPM Studio for simulation testing of a process are shown 
to you in the properties window of a flobot step. If you want to add a new flobot in 
BPM Studio to be available for simulation follow the steps given below: 

• Place your new Flobot’s exe into the Flobots folder in the ULTIMUS 
WORKFLOW directory 

• Start Ultimus BPM Studio. 
• Select Tools/Options from the main toolbar. The following dialog 

appears.  



 

 

• Select the Flobots tab and click the Add Flobot button. Following dialog 
appears: 
 

 
• Double click on the sign shown on left side of flobot. The  sign  should 

change to a green check mark . 
• You can change the name of this flobot by clicking on its name in the Add 

Flobot window shown above. 
• Click OK to close the dialog boxes. 

Desired flobot is added to the Ultimus BPM Studio.  



Note: Please ensure that a custom flobot is added with the same name at 
BPM Studio and FloStation.  



Defining Flobot Steps 

Inserting Flobot Steps in a Workflow Map 

A Flobot step is like any other step in the workflow map. You can link a Flobot 
step to other steps, create the local spreadsheet for the Flobot step, and link data 
from the local spreadsheet of the Flobot step to the main spreadsheet. 

When a Flobot step is first inserted in the workflow map, its icon has a red robot, 
which indicates that it hasn't been trained. After the Flobot has been trained, the 
icon changes to reflect the application with which it works. The icons for the 
various Flobots are shown below. 

Icon  Name  Function  

 
Acrobat 
Flobot  Flobot for integrating acrobat forms with workflow.   

 ASCII Flobot  Flobot for ASCII file output for legacy applications  

 

Custom 
Flobot 
(Yellow)  

Custom Flobot created with Flobot API. This icon can be 
changed by clicking the browse button beside the icon and 
selecting a graphic from the directory.  

 
Database 
Flobot  Flobot for ODBC databases.  

 E-Mail Flobot  Flobot for sending e-mail messages  

 Excel Flobot  Flobot for Microsoft Excel  

 
Exchange 
Flobot  

Flobot for Microsoft Exchange Server and Outlook 
automation.  

 File Flobot  Flobot for common file operations  

 
Web Services 
Flobot  Flobot for calling Web Services  

 .NET Flobot  Flobot for calling .NET code.  

 

Untrained 
Flobot 
(Red)  

The Flobot must be trained before the workflow can be 
executed.  

 Word Flobot  Flobot for Microsoft Word  

 XML Flobot  Flobot for exchanging information with XML-compliant line-
of-business applications.  

Defining Flobot Step Properties 



To define or edit Flobot step properties: 

1. Right-click on the Flobot step and select Properties. The Step Properties 
window appears and defaults to the Flobot Step Properties tab. 
 

 

2. Define the following properties:  
o Label: Enter the label for the step. This label identifies the step and 

is used by the BPM Studio if it has to report any errors. It is also 
used in the workflow Reports. The label must, therefore, be unique. 
The label is displayed under the step icon in the process Map.  

o Flobot Name: Select the Flobot to be used at that step in the 
process.  

o Inline: Check this checkbox if you want to make this flobot an Inline 
Flobot. For details about Inline Flobots please see "Inline Flobots".  

o PC Name: Select the name of the individual Flostation or Flostation 
Group on which the Flobot will run. If you select a FloStation group, 
the Flobot will run on the first available FloStation PC in the group. 
This field is disabled if you select the option of Inline Flobots.  

Note: You must first use the Ultimus Administrator to specify the 
PCs on which FloStations have been installed. 

o Completion Time, Extension Time, and Delay Time: These fields 
are identical to those in the User Step Properties window and 
perform the exact same functions as described in "Designing 
Process Maps."  

o Time Out: Its the time interval for which flostation (server in case of 
Inline Flobots) waits before marking an active flobot failed.   

3. Click OK.  



Creating a Spreadsheet for a Flobot Step 

Creating a local spreadsheet for a Flobot step is identical to creating a 
spreadsheet for a User step. Similarly, you can use workflow variables and local 
variables to pass information to the Flobots, just like for any other step (for more 
information, see "The Data View"). 

Creating a Flobot Variable List for the Flobot Step 

Flobot steps enable third-party applications to perform a specific task in the 
workflow. Thus, instead of a Form, Flobot steps have a Flobot Variable List. This 
is a list of variables in the local spreadsheet of the Flobot step. The list specifies 
the spreadsheet variables (cells) which the Flobot passes to the application and 
receives from the application. When the workflow is executed, the contents of the 
variables are passed to the application. The application uses the values for 
whatever it is "trained" to perform, and updates the values. The new values are 
passed back to the local spreadsheet, and on to the next step in the process. 

Note: For passing values to date type fields, Ultimus does not support date 
value earlier than March 1900.  

To create the Flobot Variable List: 

1. Select the Flobot step and click the Form View button, or right-click on the 
step and select Form. The Flobot Form View appears. On the left is an 
empty list box labeled "Flobot Variables for Step_Label," where 
Step_Label is the label for the Flobot step. On the right is the local 
spreadsheet. 
 

 



2. Click the Link button in the Form View toolbar. The cursor changes to the 
link cell cursor.  

3. Select a cell in the local spreadsheet.  
4. Click in the Flobot Variable list box. The cell address appears in the list 

box. If the cell has been named, the name is listed next to its address. The 
border of the cell turns red.  

5. Repeat steps 3-4 as needed.  
6. Click the Link button. The cursor returns to the normal cursor mode.  

Notes: We strongly recommend that you name all the cells to be used as 
variables for Flobot steps. Since these cells are used for "training" a third-
party application, it is very useful to have a descriptive name during the 
training to remind you what the variable is. 

After you have placed a cell in the Flobot Variable List and exit the Link 
mode, whenever you select a variable in the list, the program highlights the 
variable and the cell to which it is linked. Likewise, if you select a linked 
cell in the local spreadsheet, if the cell is in the Flobot Variable List, it is 
also selected in the list. 

If you click on a cell which is already linked, a highlight cursor is placed on 
the Flobot Variable List showing the name of the cell in the list. If you 
attempt to link it again, the software will simply beep. 

To delete variables from the Flobot Variable List: 

1. Select the cell in the local spreadsheet or the variable name in the Flobot 
Variable Form. The cell address and variable name are highlighted.  

2. Click the Cut button. The variable name and Link are deleted.  

Note: If a local Spreadsheet variable say A1 is linked and later unlinked it 
will still appear in the flobot trainer window, because when a local variable 
is linked it is declared on the Spreadsheet. After deleting it from the 
Spreadsheet it will cease to appear in the trainer window.  

Training the Flobots 

Before Flobots can be used in a workflow process, they must be "trained." 
Flobots are trained in the BPM Studio as you design a workflow process. Flobots 
can also be invoked during Simulation. This allows you to completely develop 
your application and test it before deploying it to multiple users. When you install 
the workflow process, the information regarding the training is automatically 
forwarded to the FloStation from where the Flobot will run. 

To train a Flobot: 



1. Create the Flobot Variable List as described previously.  
2. Click the Train button. This invokes the Flobot training session. Train the 

Flobot as described below in the section dedicated to the particular Flobot 
you wish to train.  

3. After you have trained the Flobot, return to the Map View. The Flobot icon 
changes to indicate the application for which it was trained (see table at 
the beginning of this section). This indicates that the Flobot has been 
trained and is ready to be used.  

You can re-train the Flobot at anytime by going to the Form View for the Flobot 
step and clicking the Train button. More details of the steps involved in training 
the different Flobots are provided in the following sections of this chapter. 

Note: A Flobot must not contain workflow variables not listed in the 
Variables field. This may happen if you have redesigned a process and are 
now using a different set of variables with the same Flobot step. If a 
workflow variable is present in the document but not in the Variables list 
box, the Word Flobot will not know what value to assign it during the actual 
execution of a workflow incident. To prevent this, use the Scan button to 
get a list of the workflow variables in the document template. When you 
click the Train button, the Flobot button searches the document template 
for variables not in the Variables list box. If it finds one or more such 
variables, it displays them in a window. Training is not allowed to proceed 
unless you remove all such variables from the document template. 

Invoking a Flobot in Simulation 

Flobots can be invoked in the simulation mode to test their behavior just like any 
other step. However, you must first have trained the Flobot as described 
previously. 

To invoke a Flobot step during Simulation: 

• When the process reaches a Flobot step, the step turns light green. Click 
the Flobot step to invoke the Flobot, just like any other step during 
Simulation. When the Flobot is invoked, it performs the actions for which it 
was trained.  

When the Flobot step is complete, you can go to the local spreadsheet for the 
Flobot step and check the values of the variables used by the Flobot. 

Running the Flobot in Test Mode 

A Flobot can be tested for its real time working using the Test Mode run. The 
Test Mode allows you pass local spreadsheet values to a trained flobot and see 
the results produced by trained flobot using the specified spreadsheet values.  



     

For example after training an email flobot you may like to test its working when 
some specific values are passed to it. You can do it in following the steps given 
below: 

• Train the Email Flobot. For details on training an Email Flobot see the 
section "Training Email Flobot". 

• Close the Email Flobot Trainer window and open the local spreadsheet for 
Email Flobot. 

• Specify some values on the local spreadsheet in the linked 
fields/variables. 

• Switch to the map view and then double click the Email Flobot to switch to 
the Form View. 

• In the tool bar, click on the Test Mode Button. 
• The Flobot Application is executed and the flobot values are passed to the 

Flobot. During Flobot execution a progress bar is shown to you. 



         

  

• On successful run, the trained email flobot sends mail to specified address 
and a message is shown to you. 

Note: In test mode, the flobot does not return any values to the local 
spreadsheet. In test mode if a flobot fails to perform the specified task, you 
can check the  flostation log for details about the causes of failures.  

  



Word Flobot 

The Word Flobot allows you to use Microsoft Word to perform tasks as 
a step in a workflow process. You can use all the word processing capabilities of 
Microsoft Word to format, produce, print, and fax reports, forms, documents, and 
tables. 

How the Word Flobot is Used 

The Word Flobot provides the following capabilities: 

• Run a Word macro which you can program. This macro is run before any 
data transfer takes place.  

• Insert variables from your workflow process as fields in a Word document 
template.  

• Print or save the document.  
• Run another Word macro after the workflow variable fields have been 

updated.  
• Fax the document.  

Training the Word Flobot 

To train the Word Flobot: 

1. Create the Flobot Variable List as described previously.  
2. Click the Train button. This invokes the Word Flobot training session. 

Ultimus launches Microsoft Word and the Word Trainer window appears 
on top of it. The variables that you included in the Variable List appear in 
the Variables field. The Process Name and Step Name are shown at the 
top. 



 

 

Note:  When the train button is clicked, Word opens a blank document.  
To create a new template, begin typing and inserting variables in the 
blank document.  To add variables to an existing document, do not close 
the default document.  Go to File/ open in Word without closing the 
default document 

3. Use Word to format and create a document template.  
4. When you want to insert a variable from the workflow as a field in the 

document template, select it in the Word Trainer window.  
5. Move the cursor to where you want the variable to appear in the Word 

document.  
6. Click the Insert button in the Word Trainer window. The variable appears 

in the Word document.  
7. Click the Scan button in the Word Trainer window to search for all 

workflow variables that have been inserted. The Ultimus Trainer window 
appears, listing workflow variables found in the document template.  

8. Repeat steps 6-7 as needed.  
9. Click the Train button. The Training Complete window appears.  



 

Notes: A workflow variable may be inserted multiple times. Furthermore, 
you can use all the formatting capabilities of Word to format the fields and 
the document template. 

10. Use the Training Complete window to specify the Actions you want 
performed when the Word Flobot is invoked:  

o Save As: Check if you want the resulting document saved as a 
Word file. Specify the path and file name in the Filename edit box. 
You may type it in, or use the combo box to select a workflow 
variable that contains the file name. If you choose the latter, you 
can specify a different file name for each incident of the workflow.  
Note: It is recommended that the specified "Save As" path 
must not be a mapped drive path.  

o Print: Check if you want the resulting document to be printed.  
o Run Before: Check if you want to run a macro before any of the 

above operations are performed. Use the Macro Name combo box 
to select a previously-defined macro.  

o Run After: Check if you want to run a macro after any of the above 
operations are performed. Use the Macro Name combo box to 
select a previously-defined macro.  

o Fax: Check if you want to fax the document. This feature works 
only with Microsoft Exchange. Specify the Profile and Fax Number. 
Either type in the values, or select workflow variables from the 



combo boxes. If you use the latter, the values can be changed 
dynamically depending on each workflow incident.  

o Error Status: Select a workflow variable in which to store error 
messages from the Error Status combo box.  

11. Click OK. This closes Word and ends the training session.  

Note: You do not have to save the document template created during the 
Flobot training. It is stored with the process Map and is sent to the 
FloStation when the process is installed. 

Error Status Codes Returned by the Word Flobot 

When you train the Word Flobot for an action, you can specify a workflow 
variable to record the Error Status Code. After the execution, a code (integer) is 
returned to the workflow variable. The codes are as follows: 

Error Code  Message 
0  Successful Completion  
1  Unspecified Error  
2  Cannot create ActiveX control for MS Word  
3  Unable to print Document  
4  Unable to Send Fax  
5  Unable to run Macro  
6  Unable to Save As  
7  Unable to Save File, File Name Cannot be Empty  
8  Unable to Start Word Application  
9  Unable to Open Template Document  

Word Flobot in Operation 

When the Word Flobot step is invoked as a step during the actual execution of a 
workflow incident, the following events take place automatically: 

1. Word Flobot starts Microsoft Word and loads the document template 
created during the training.  

2. If Run Before was checked during training, the specified macro is 
executed.  

3. The actual values of the variables are transferred to the fields in the 
document template.  

4. If Run After was checked during training, the specified macro is executed.  
5. If Save As was checked during training, the document template is saved 

as a Word document.  
6. If Print was checked during training, the document is printed.  
7. If Fax was checked, the document is faxed.  
8. The document template is closed and Word terminated.  
9. The workflow proceeds to the next step.  



Notes: Ultimus Word Flobot does not support nested objects.  



Web Service Flobot 

The Ultimus Web Services Flobot enables the Ultimus BPM Studio to invoke web 
services in external applications in an automated manner. When Ultimus Web 
Services is installed, the Web Services Flobot will automatically be added to the 
list of available Flobots in Ultimus BPM Studio. 

Training the Web Services Flobot 

1. Create the Flobot Variable List. 
2. Click the Train button. The Web Services Trainer window appears. The 

Process Name and Step Name are shown at the top. 

           

3. Click the New button  to create a new Action. The Name of Action 
window appears. 

       

4. Type in a name for the Action and click OK. The Action window appears. 



  

5. Type in the URL path for WSDL location. An example of a WSDL URL 
is http://<machine>/plwebservices/processname.asmx?WSDL 
 
Note: Ultimus supports the consumption of Web Services that 
comply with the following standards: 

i) SOAP 1.1 - defined at http://www.w3.org/TR/SOAP 

ii) WSDL 1.1 - defined at http://www.w3.org/TR/wsdl 

6. Click connect 
7. Select the Web Services Method from combo box.  
8. In the Ultimus Variables selection list, select the variables that you want to 

link to the Web Services Parameters. 
9. In the Web Services Parameters selection list, select the parameters that 

you want to link to the Ultimus variables. 
10. Click the Link button. The Web Services Parameter to Ultimus Variable 

link appears in the list box below. 



     

Note: This  represents that it is an In and Out or Out Parameter i.e. 
return type while  represents that it is an In Parameter i.e. Method 
Parameter. 

11. Linking variables to a Web Services repeating array can be accomplished 
through linking a variable that spans a continuous range of cells to the 
particular Web Services parameter. At run-time, Ultimus will cycle through 
the range of cells linked to the variable, and link the values in each cell to 
the Web Services array parameters until it encounters an empty cell, or 
reaches the end of the cell range. 

12. As an optional step, select a workflow variable in the Error Status combo 
box. At run time, this variable will capture the Error Status Code returned 
by the Web Services Flobot. For the complete list of Error Status Codes 
and their definitions, see the following section, "Error Status Codes 
Returned by the Web Services Flobot." 

13. Click OK. The defined Action appears in the Web Services Flobot Trainer 
window. You can now train subsequent Actions for the Flobot. 

14. Click the Train button to save your changes and close the window. The 
training is now complete. 



Notes: Ultimus does not support consumption of Web Services that 
contain multi-dimensional parameter arrays. User has an option to set the 
value in the destination spreadsheet cell as an Ascii value or as a character 
for the following types System.SByte, System.UInt16 or System.Char.  

Notes: Repeated arrays in Nested structure are not supported. Nested 
structures with repetitions at more than one level are not supported. If we 
have a structure DeptSalary having another nested structure Emp which is 
repeated. Then only Emp can repeat. If we want to repeat both Employee,  it 
wont be supported. 
If a function parameter is of type structure and that structure has an array 
of another structure inside it (Arrays in Nested Structure) like : 
 
Suppose a structure has the following definitions; 

Public Structure Emp 
Public strName As String 
Public iSal As Int32 
End Structure 
 
Public Structure DeptSalary 
Public iID As Integer 
Public strName As String 
Public stdeptEmps() As Emp 
Public iSal As Int32 
End Structure 

Due to the limitation in Spreadsheets, Ultimus does not currently support 
the following data types for Web Services and .NET Code. 

• System.Byte  
• System.Decimal 
• Timespan  
• All reference types (e.g. System.UIntPtr and System.IntPtr) 
• System.Int64 signed/unsigned 
• Arrays of all the above 
• Enumeration 
• Overloaded Methods 

While reading from the spreadsheet, Web Services Flobot does not verify 
the value, therefore, it must be ensured that the value used is within the 
specified data type's range. 

When a call to any web service is about to execute the proxy assembly of 
the web service is generated and cached in the folder 
"UltimusInstallFolder\Resources\AssemblyCache.  Errors may occur when 



a previously cached web service is changed at the web server. For example 
some method parameter has been modified, that had been trained 
previously. Perform the following tasks 
1.Train that Web Service method again 
2.Remove the cached assembly from the cache folder.  

Unlinking Workflow Variables and Web Services Parameters 

Select the previously linked Web Services Parameter. The Unlink button will then 
be enabled. Click the Unlink button and the link will disappear. 

Working with Web Services Flobot Actions  

After you have created several Web Services Flobot actions in the Web Services 
Flobot Trainer window, you can re-arrange the order in which they occur, edit 
Actions, and also delete Actions.  

 To change the order of Actions: 

1. Select an Action. 
2. Use the Up and Down arrow buttons  to move it in the list. 

To edit an Action: 

1. Double-click on the Action. The Properties window for the Action appears. 
2. Make the desired changes and click Done. 
3. Click the Train button to close the window and save your changes. 

To delete an Action: 

1. Select the Action. 
2. Click the Delete button . The Action is removed. 

Error Status Codes Returned by the Web Services Flobot 

When you train the Web Services Flobot for an action, you can specify a 
workflow variable to record the Error Status Code. After the execution, a code 
(integer) is returned to the workflow variable. The codes are as follows:  

   
Error Code  Message  

0  Action executed successfully  
1  Action not executed successfully  
2  Unable to Connect To Remote Server  



  



.NET Code Flobot 

.NET Code Flobot can be used to call .NET Code i.e. C# or VB.NET Code in an 
intuitive point-and-click manner.  

Training the .NET Code Flobot 

To train the NET Code Flobot: 

1. Create the Flobot Variable List as described previously.  
2. Click the Train button. The .NET Code Flobot Trainer window appears. 

The Process Name and Step Name are shown at the top.  

 

3. Click the New button to create a new Action. The Name of Action 
window appears. 

 

4. Type in a name for the Action and click OK. The Action window appears.  



 

5. Click the browse button to add .C# or VB.NET Code file from the directory. 
6. Click the drop down to select the object. 
7. Click the properties button. 

 

Note: An Object type is not of simple type and therefore it will not 
appear in the trainer window. 



This dialog can be used for maintaining state across multiple separate 
Actions in the. NET Code Flobot (where each action may call a different 
method in the .NET Code). 

8. Select Object Property and Workflow Variable from the drop down menus. 
9. Select Get or Set radio button 
10. Select an Error Status code 
11. Click OK 

A class can have methods and attributes. A method can be invoked and 
properties/fields/attributes can be Set or Get. 

12. To Set methods for the .NET Flobot. Click the methods button 
 

 

13. Select Method name from the drop down menu 
14. A list comes up initially of all the .NET Code variables, the Workflow 

Variables column is blank. Click twice on the rows in the Workflow 
Variables column, a pop up list box appears.  

15. Select workflow variables from the list box and link them to the 
corresponding .NET Code variable in that row. 

16. Select Error Status from the drop down menu 
17. Click OK 



Ultimus also provides an advanced feature for Referencing External .NET 
Assemblies When Calling .NET Code  

Notes: Structures and Classes  are not supported by .NET Code Flobot. If 
Sbyte data type is being used, hard code 0 into the destination field to 
obtain a numeric return value. 

Due to the limitation in Spreadsheets, Ultimus does not currently support 
the following data types for Web Services and .NET Code. 

• System.Byte  
• System.Decimal 
• Timespan  
• All reference types (e.g. System.UIntPtr and System.IntPtr)  
• System.Int64 signed/unsigned 
• Arrays of all the above 
• Enumeration 
• Overloaded Methods 

While reading from the spreadsheet, the .NET Code Flobot does not verify 
the value, therefore, it must be ensured that the value used is within the 
specified data type's range. 

To change the order of Actions: 

1. Select an Action.  
2. Use the Up and Down arrow buttons to move it in the list.  

To edit an Action: 

1. Click the Edit Button. The Properties window for the Action appears.  
2. Make the desired changes and click Done.  
3. Click the Train button to close the window and save your changes.  

To delete an Action: 

1. Select the Action.  
2. Click the Delete button . The Action is removed.  

Error Status Codes Returned by the .NET Code Flobot 

When you train the .NET Code Flobot for an action, you can specify a workflow 
variable to record the Error Status Code. After the execution, a code (integer) is 
returned to the workflow variable. The codes are as follows:    



Error Code  Message  
0  Action executed successfully  
1  Action not executed successfully  

 



Excel Flobot 

The Excel Flobot allows you to use Microsoft Excel to perform tasks as 
a step in a workflow process. You can use the extensive capabilities of Microsoft 
Excel to analyze, graph, plot, and chart data used in your workflow. 

How the Excel Flobot is Used 

The Excel Flobot provides the following capabilities: 

• Link local variables from a workflow process to cells in an Excel workbook. 
This allows you to read and write data from Excel cells.  

• Run a pre-defined Excel macro before data is written to Excel, and a 
different pre-defined macro after data is written. In both cases, you define 
the macro using Excel's powerful macro programming capabilities.  

• Print or save the Excel workbook as a new file, or update the contents of 
the existing workbook.  

Thus, the Excel Flobot allows you to transfer information collected as a part of 
the workflow incident into an Excel workbook, run Excel macros to perform pre-
defined tasks which can include analysis, graphing, and plotting, and read data 
from the Excel workbook. You can also automatically print a graph or a report. 

Train The Excel Flobot 

To train the Excel Flobot: 

1. Create the Flobot Variable List as described previously.  
2. Click the Train button. This invokes the Excel Flobot training session. 

Ultimus launches Microsoft Excel and the Excel Trainer window appears. 
The variables that you moved to the Variable List appear in the Variables 



field. The Process Name and Step Name are shown at the top. 

 
3. Use Excel to create and format worksheets for the task to be performed. 

You can also define the two macros to be executed when the Excel Flobot 
is invoked.  

4. To link a variable from the workflow to a cell in the workbook, select it in 
the Excel Trainer window.  

5. Select the direction in which the data will flow by clicking on the 
appropriate radio button: Variable to Excel, Excel to Variable, or Both.  

6. Select a cell in the spreadsheet.  
7. Click the Link button in the Excel Trainer window. The worksheet name 

and the name of the linked cell appears in the Trainer window with an 
arrow indicating the direction of the Link. The Link button changes to 
"Unlink."  

8. Repeat steps 6-9 as needed.  



9. Click the Train button. The Training Complete window appears. 

 
10. Use the Training Complete window to specify the Actions you want 

performed when the Excel Flobot is invoked:  
o Save As: Check if you want the file saved as a different Excel 

workbook. Specify the path and file name in the Filename edit box. 
You may type it in, or use the combo box to select a variable that 
contains the file name. If you choose the latter, you can specify a 
different file name for each incident of the workflow.  
Note: It is recommended that the specified "Save As" path 
must not be a mapped drive path.  

o Print: Check if you want to print spreadsheets in the workbook. 
Select the spreadsheets by clicking on them.  

o Execute Macro Before Updating: Check if you want to run a 
macro before updating the spreadsheet. Use the Macro combo box 
to select a previously-defined macro.  

o Execute Macro After Updating: Check if you want to run a macro 
after updating the spreadsheet. Use the Macro combo box to select 
a previously-defined macro.  

11. Click OK. This closes Excel and ends the training session.  

Error Status Codes Returned by the Excel Flobot 



When you train the Excel Flobot for an action, you can specify a workflow 
variable to record the Error Status Code. After the execution, a code (integer) is 
returned to the workflow variable. The codes are as follows: 

Error Code  Message  
0  Successful Completion  
1  Unspecified Error.  
2  Active X control for MS Excel could not be created.  
3  Unable to print doc.  
4  Unable to run to pre macro.  
5  Unable to run post macro.  
6  Unable to Save As.  
7  Unable to start Excel Application.  
8  Unable to Open Template Document.  
9  Unable to update template Document.  

Excel Flobot in Operation 

When the Excel Flobot step is invoked as a step during the actual execution of a 
workflow incident, the following events take place automatically: 

1. Excel Flobot starts Microsoft Excel and loads the workbook created during 
the training.  

2. If the Execute Macro Before Update check box was checked during 
training, the specified macro is run.  

3. The actual values of the workflow variables for which the data direction is 
specified as "Both" or "Variable to Cell" are transferred to the cells in the 
workbook.  

4. If the Execute Macro After Update check box was checked during training, 
the specified macro is run.  

5. Contents of the Excel workbook cells linked to variables are transferred to 
the workflow variables for all variables for which data transfer is specified 
as "Both" or "Cell to Variable."  

6. If the File Save As check box was checked during the training, the 
workbook is saved in the specified file.  

7. If the Print check box was checked during training, the selected 
worksheets are printed.  

8. Excel is closed.  

Note: Microsoft does not support of MS Office applications with FloStation 
Service.  



ASCII Flobot 

The ASCII Flobot allows you to export workflow data into ASCII files. 
Since ASCII files can be imported by a large number of "legacy" applications, this 
Flobot is useful for transferring workflow data to almost any application. 

How the ASCII Flobot is Used 

The ASCII Flobot provides the following capabilities: 

• Output variables from your workflow process to fields in an ASCII file.  
• Either use a fixed filename for the output file, or make it a workflow 

variable so that it can be changed for each workflow incident.  
• Specify the field prefix.  
• Specify the field suffix.  
• Specify the field separator.  
• Specify if a Header Record is to be created. A Header Record is created 

for a new file. It consists of the variable names written in the ASCII file. 
The variable names use the same prefix, suffix, and separators specified 
for the data.  

• Specify if variable data from each incident is to be written into a new file, 
or appended to an existing file.  

• Indicate how many fields will be written based on the value of the workflow 
variable selected in the Row Count combo box.  

Thus, the ASCII Flobot transfers information collected as a part of the workflow 
process into a new ASCII file, or appends it to an existing one. 

Training the ASCII Flobot 

To train the ASCII Flobot: 

1. Create the Flobot Variable List as described previously.  
2. Click the Train button. The ASCII Flobot Trainer window appears. The 

variables that you moved to the Variable List appear in the Variables list. 
The Process Name and Step Name are shown at the top. 



 

 
3. Specify the following options:  

o ASCII File: Specify the name of the output file. You may type it, or 
use the combo box to select a workflow variable that contains the 
file name. If you choose the latter, you can specify a different file 
name for each incident of the workflow.  

o Append/Overwrite: Specify if you want to append the file each 
time the step is invoked or overwrite it with a new ASCII file.  

o File Header: Check if you want the Flobot to write a new file 
header as the first record every time a new file is created.  

o Row Count: Select a workflow variable that contains a numerical 
value. The Flobot writes multiple records, incrementing one at a 
time, until the Row Count value is reached.  

Note: The contents of this workflow variable are used by the ASCII 
Flobot to determine the number of fields written to the ASCII file. For 
example, we select the workflow variable "Row_Count." Let's say 
that the fields are linked to workflow variables which represent cells 
A1 through C1. If the value of Row_Count = 5, the first fields written 
to the file contain the data in A1 through C1. The ASCII Flobot then 
increments the row count by 1 and writes the data contained in A2 



through C2. This is repeated until the row count is reached. In this 
case, the last entry contains data from cells A5 through C5. 

o Field Prefix: Specify the prefix for each field. The prefix 
character(s) are added before the field data.  

o Field Suffix: Specify the suffix for each field. The suffix 
character(s) are added after the field data.  

o Field Separator: Specify the character(s) to appear between fields. 
Type in a character or use the combo box to select a Tab or a 
space.  

4. Determine the variables to be inserted as fields in the ASCII document. 
Select the variables in the Variables list, then use the Add or Add All 
button to add them to the Fields in ASCII File list.  

Note: The order in which the variables appear in the list dictates the 
order in which they will appear in each row. 

5. Select a workflow variable from the Error Status combo box.  
6. Click the Train button. The training is now complete.  

Error Status Codes Returned by the ASCII Flobot 

When you train the ASCII Flobot for an action, you can specify a workflow 
variable to record the Error Status Code. After the execution, a code (integer) is 
returned to the workflow variable. The codes are as follows: 

Error Code  Message  
0  Successful Completion  
1  Missing Out Put File Name  
3  Invalid Path / Write permission failed  

ASCII Flobot in Operation 

When the ASCII Flobot step is invoked as a step during the actual execution of a 
workflow incident, the following events take place automatically: 

1. The ASCII Flobot opens the ASCII file specified during the training. If this 
is the first incident of the workflow process, or if the Overwrite option is 
specified during training, the ASCII Flobot creates a new file and writes 
the Header record if the File Header check box is marked during training. 
The header record has the following format:  

#Variable1$/#Variable2$/............. 



Where #, $, and / are the prefix, suffix, and separator characters specified 
in the training. "Variable 1" and "Variable 2" are the names of the variables 
in the order they appear in the Field in ASCII File column in the Trainer. 

2. The ASCII Flobot then creates a data record and writes it to the ASCII file, 
or appends it to an existing file if the Append option is selected. The 
format of the data record is as follows:  

#Data1$/#Data2$/............. 

Where #, $, and / are the prefix, suffix and separator characters specified 
in the training. "Data 1," "Data 2" are the values of the workflow variables 
in the order they appear in the Field in ASCII File column in the Trainer. 

3. The ASCII Flobot closes the file and sends a message to the BPM Server 
that the Flobot step is complete.  

Notes: ASCII flobot does not transfer more then 256 characters. The ASCII 
Flobot fails after predefined time-out interval but the executable does not 
terminate. 



Database Flobot 

The Database Flobot is the next generation of ODBC Flobot, and provides 
much greater functionality. This flobot can read, write, update, delete and query 
ODBC compliant databases. It can also execute any valid SQL statement. The 
Database Flobot will accept valid SQL commands for every action. These SQL 
commands are executed when the flobot is executed in real time.  

Database Flobot Vs ODBC Flobot 

The Database flobot provides a number of features that are not supported by the 
ODBC flobot including:  

• Execute ANY Valid Data manipulation (DML) command for example 
SELECT, INSERT, DELETE etc.  

• Use any of the powerful functions supported by SQL like sum(), Diff(), 
Avg() etc. 

• Execute nested SQL statements. 
• Graphical linking of workflow variables to SQL or Oracle Databases. 
• Execute SQL Stored Procedures. 
• Call database triggers. 
• Perform database search operation based on multiple tables.  
• Graphically create complex query statement. 



Rules about Database Flobot 

• Database flobot does not support the execution of Data Definition (DDL) 
commands like CREATE_TABLE, ALTER_TABLE etc. 

• A Login Name containing blank spaces (e.g., "My DSN User Name") can 
be specified as follows:   

o For a Datasource configured with an Oracle database, enclose the 
Login Name in single quotes like 'Oracle DSN User Name'.  

o For a Datasource configured with SQL server database, enclose 
the Login Name in square brackets like [SQL DSN User Name]  

• A DSN to be used in Database Flobot must not contain "/" or "\" in its 
name. 

• Define at least one action under every database connection. If a database 
connection is created with no action under it, this connection will not be 
stored with the flobot training 

• For passing values from a workflow variables to FBIT type database field, 
use TRUE for 1 and FALSE for 0. If the value passed is zero or one, 
Ultimus variables consider it as integer type values. To pass Boolean type 
values, the value of a workflow variable must be set as TRUE or FALSE 
on the spreadsheet.  

• The Database Flobot cannot be linked to "Binary" or "Var Binary" type 
database fields.  'Binary' and 'Var Binary' fields are not shown on the 
variable linking page. 

• Database Flobot does not support passing/retrieving date values earlier 
than March 1900.  

• Ultimus does not allow using following field types in filter statements:  
o FTEXT and NTEXT on SQL Database Server 
o FLONG on Oracle Database Server. 

• To retrieve data from database field to workflow variables, range type 
workflow variables can only be used if character/text type data is to be 
retrieved to the workflow variable. 

• In the Database flobot, parameters are passed separately. The % used as 
part of the query should be in the variable itself  e.g. 
SELECT CustomerName, Address from Customers where CustomerID 
LIKE [VariableName] ensuring that VariableName itself contains a value 
like "CID%" 

• If the first cell of a range of cells is left empty at real time, the data will not 
be concatenated and no record will be made to the database. 

• If invalid data like " hagsfdh " is added to numeric fields, 0 will be added to 
the database instead of null. 

• To fetch any record and filter through Unique ID field the value has to be 
in the correct format e.g {EB220616-FA3F-4581-BA62-592156CF22C1} 

• If some invalid value is added to the Date time field a default date will be 
added and when it is retrieved,  it will return 0 in  the date field instead of 
default date. 



  



Database Flobot Actions 

Using the Database flobot you can define six different action types. Each action 
type has its own usage and benefits. The action types are: 

• Read: This action uses Select statements to fetch data from a single 
database table. You can also fetch filtered data based on a specified filter. 
Output of a Select Statement is stored in linked variables. 

• Add: This action adds new records to a table. The Flobot reads data from 
workflow variables and stores them in a database table. 

• Delete: This action deletes records from a database table. A filter can be 
specified to delete specific records. 

• Update: This action updates one or more existing records in a database 
table. A filter can be specified to update specific record(s). 

• Custom Query: This action allows any SQL “SELECT” statement to be 
executed by the Flobot. Custom Query supports data retrieval from 
multiple tables. This statement can also include SQL functions like sum() 
and diff(). Example of a custom query: “Select Name,Count(Customers) 
From CustomerTable”   

• Execute SQL: This action allows the Flobot to execute any SQL 
statements other than Select statements. This provides the process with 
the capability to execute statements that cannot be specified using the 
standard Database Flobot actions (Read, Add, Update). Workflow 
variables can be inserted into the SQL statement, allowing the values of 
those workflow variables to be sent to/from the target database. With the 
ability to execute any SQL statement, actions such as executing SQL 
triggers and Stored Procedures can be easily accomplished.  
 
The SQL statement must contain the correct Syntax. In the event of 
incorrect syntax, Database Flobot returns an error message. (See New 
Actions dialog/Error Description for additional information on SQL error 
reporting.) 



Training the Database Flobot 

To train the Database Flobot: 

1. Create the Flobot Variable List as described previously.  
2. Click the Train button. The Database Flobot Trainer window appears. The 

Process Name and Step Name are shown at the top. 
 

  
 
This window allow you to: 
a) Create new database connections/actions . 
b) Delete database connection/actions . 
Note: If a connection is deleted, all the actions defined under that 
connection will also be deleted.  
c) Edit existing connections/actions . 
d) Change the execution order of connections/actions. 

Click the New button to create a New Connection. The New 
Connection window appears. 
 



 
 
Ultimus uses the concept of database "Connection" for communicating 
with remote databases. Every connection is a combination of Datasource 
and Login/Password. Datasource determines the database Ultimus is 
connected to and Login/Password determines the rights/roles that have 
been granted to different users on the database server. This allows 
different levels of security to be set for different users. In the new 
connection window specify the following:  
Datasource: From the given combo box, select a datasource. 
Login User: Specify the Login Name. 
 
Note:   

• To specify a Login Name containing blank spaces (e.g., "My 
DSN User Name") as follows:   

• For a Datasource configured with an Oracle database, 
enclose the Login Name in single quotes like 'Oracle 
DSN User Name'.  

• For a Datasource configured with SQL server database, 
enclose the Login Name in square brackets like [SQL 
DSN User Name]  

• Define at least one action under every database connection. If 
a database connection is created with no action under it, this 
connection will not be stored with the flobot training 
 
Login Password: Specify the Password and confirm the password. 

3. Click OK on the New Connection window.  The connection name appears 
in the list view of Database Flobot Actions window. 



 

 
4. Using this window add new actions under a connection or create new 

database connections as follows: 
1) and then click on the new button. The new connection window 
appears. Using this window create multiple actions. 
2)To create a new action click the Actions Node and then click the new 

icon.  
5. The Database flobot supports multiple actions under a single database 

connection. To create an action under a database connection, click the 
Actions node under that database node, then click New . The New 
Action window appears: 
 



 
 
                        
New Action Dialog  

• Action Name: Specify the name of the action in this 
text box. 

• Action Type: Specify the type of the action you want 
to create. You can select from following options 
shown to you in this combo box:  

o Read: To read records from a database table. 
o Add: To add records to a database table. 
o Delete: To delete records from a database 

table. 
o Update: To update records in a database 

table. 
o Custom Query: To read records from multiple 

database tables and process the information 
using SQL functions. 

o Execute SQL: To execute any complex SQL 
statement including stored SQL procedures. 

• Table Name: Specify the table name on which to 
perform some database operation. This combo box is 
disabled for Custom Query and Execute SQL, since 
these actions can effect multiple tables. 

• Error Status: The database flobot returns an error 
code for any error that may occur while executing the 



specified action. From this combo box, select the 
variable in which the error code will be returned. 

• Error Description: The database flobot also returns 
the description of the error that may occur while 
executing the specified action. From this combo box 
select the variable in which the error description will 
be returned 

• Enable Variable: Enable variable specifies how to 
proceed if an error has occurred in an action. An 
Action is only executed if Enable Variable is blank or 
0.  Any other value will prevent the action from being 
executed.  

Note: Ensure that the tables being used are those whose decimal scales 
have been defined. 

Read:  

To read from a database table: 

1. In the "New Action" dialog, select Read, specify the other required 
information and click OK. The Output specification dialog appears:  
 

  
 
On the output tab, specify the variables in which the retrieved database 



records will be stored. Do not specify any variable in the output that has 
another variable defined below it on the spread sheet. See the Note given 
above. 

2. To link a field to a workflow variable, click once on the table field name 
under "Table Columns" and then click to the right, under the column 
labeled "Variable Names". A combo box will appear listing all available 
workflow and system variables.   

3. Select the desired variable. The database field is now linked to this 
workflow variable.  
 

 
 
 
Note: Data is retrieved only from the linked database fields. Unlinked 
fields are not included in the query.  

4. To unlink a linked variable:  
1. Click once on the linked variable name to select it. 
2. Click on it once more and a blank combo box appears. 
3. Click on the drop down button of the combo box to see the list.  
4. With out selecting any entry from the list, click again on drop down 

button of the combo box to close the shown list. An empty combo 
box will appear. 

5. Click any where else on the dialog and the linked variable is 
removed from the link. 

5. The data read can be filtered.  
 



 
 
 
For details about creating filters see "Working with Filters"  

Add 

If you want to add some new records to a database table, follow the steps given 
below:  

1. To add new records to a database table, follow the steps given below. 
 



 
 
Linking Table Columns to Workflow Variables 
Use this page to specify the variables from which to transfer the data to a 
database table. To link a database column to a workflow variable, click 
once on the name of a database column, then click to it’s right, under the 
column labeled "Variable Names", a combo box appears, select the 
variable to link to the table column. Once specified, at runtime, the Add 
action will be executed, and the contents of each respective workflow 
variable will be transferred into the associated database column.  
 
Multiple Rows 
By default, the Add function of the Database Flobot adds only one record 
into a linked database table. It passes data only from the first row of linked 
variables. If the "Multiple Rows" check box is selected, data from each row 
of the variable will be passed to the database table until a NULL row is 
encountered.  A Null row is defined as containing no data.  This function of 
the Database Flobot uses Row Indexing, retrieving multiple rows from the 
linked variables incrementally 
 
Notes: Numeric field precision can only be set up to to a maximum of 
18. 

Delete 
To delete records from a database table: 

1. On the "New Action" dialog, select DELETE, specify other required 
information and click OK. The filter specification dialog appears. 
 



 
 
Use this dialog to configure a filter.  For details about creating filters see 
"Working with Filters"  

Update  

1. On the "New Action" dialog select UPDATE, specify the required 
information and click OK. The Input specification page appears. 
 



 
 
This dialog has two tabs. On the Input tab, specify the workflow variable 
from which to the flobot will pass the data to the database columns. On 
filter tab, specify a filter for the records returned. For details about creating 
filters see "Working with Filters"  

Custom Query 
To retrieve data from multiple database tables, use "Custom Query". For 
advanced users, the Ultimus Database Flobot provides the option to execute 
complex and multi-table SELECT SQL statements. This allows the users to 
select data from multiple tables or base the filter expression on multiple tables. 
The extended Query action provides the power of Structured Query Language 
(SQL).  Use any SQL function like sum(), diff() etc. in the SQL statements 
specified under this action. 

To select data from multiple tables: 

1. On the "New Action" dialog, select EXTENDED QUERY, specify other 
required information and click OK. The Query specification dialog appears 
 



 
 
Enter the required SQL statement in the Query text box. All available 
workflow variables and table columns are displayed. Column names are 
shown in the "[TableName.ColumnName]" format. Include the names of 
workflow variables or columns fields in an SQL statement by entering 
them in the Query text box or auto insert them by double clicking on their 
name in the respective list box. 
 
Note: Table name must be defined in the SQL statements, as it 
cannot be chosen from the New Action dialog when the Action Type 
is set to Custom Query. If the table name contains blank spaces, it 
must be enclosed in square brackets like [My Table]. When using the 
like operator ensure that % sign is used in the workflow variable 
name. 

2. Type in the desired query and click NEXT. The Output specification 
window appears. 
 



 
 
Link the workflow variables to the database columns. 
Note: For DSN configured on Oracle database server, the table 
names for selected fields are not shown on the variable linking 
window.  

3. Specify the maximum number of rows to be retrieved from the database.  

Execute SQL 
 "Custom Query" allows only the execution of SELECT statements. "Execute 
SQL" permits the execution of SQL statements other than Select. This includes, 
for example, executing Stored SQL Procedures. This makes the Database 
Flobot, a perfect front end for supported databases. 

To execute an advanced SQL statement: 

1. On the "New Action" dialog, select Execute SQL, specify other required 
information and click OK. The Query specification page appears: 
 



 
 
Enter the required query in the list box labeled "Query". All of the available 
workflow variables and table columns are displayed. The column names 
are formatted like "[TableName.ColumnName]". Include the names of 
workflow variables or columns fields in the SQL statement by directly 
typing them in the Query text box or auto insert them by double clicking on 
their name in the respective list box. The column/workflow variable names 
must be enclose in "[]".  

2. Once finished, click OK. The action appears in the Actions List box.  

Note: If an attempt is made to enter some invalid statement like 'abc' and is 
checked in at real time, the flobot will fail and return the following error, 
"Could Not Find Stored Procedure "abc". 



Using Workflow Variables with Database Flobot 

Workflow variables can be used for passing/retrieving data to/from database 
fields. The Database Flobot uses Row Indexing to store data in workflow 
variables. 

Example: 
Lets suppose using Database Flobot, we want to read all records from Table A to 
the workflow variables. Tables A is shown below. It has two fields ID and Name 
and contains the data as shown below: 
Table A 

ID Name 
1 Marsha Barett 
2 Ann Puck 
3 George Taylor
We want to retrieve the data from fields ID and Name to the workflow variables 
WorkflowID and WorkflowName respectively. Both WorkflowID and 
WorkflowName are single cell variables. However, the Database Flobot will 
return three records. Row Indexing allows the Database Flobot to automatically 
increment rows to store all returned values in the linked variables as follows: 

 

If we declare the variables WorkflowID and WorkflowName as multiple cell 
variables comprising of four cells each, as shown below: 

 



Using "Row Indexing", the database flobot will increment rows taking each chunk 
of four cells as a single cell. This is shown below: 

 

Notes: 

The Database flobot uses the concept of "Row Indexing" for reading and 
writing data to workflow variables. It is strongly recommended that only 
those variables that do not have any other variable declared below them on 
the spreadsheet be linked to the Database flobot. For example, on the 
spreadsheet two variables are declared as follows: 
 

 
Cell B2= VarOne 
Cell B4= VarTwo  

Linking the variable VarOne with the database flobot can result in abnormal 
functionality of database flobot since another variable, VarTwo, has been 
defined on the spreadsheet below this variable.    

For passing values from a workflow variables to FBIT type database field, 
use TRUE for 1 and FALSE for 0. If the value passed is zero or one, Ultimus 
variables consider it as integer type values. To pass Boolean type values, 
the value of a workflow variable must be set as TRUE or FALSE on the 
spreadsheet.  



Forms can also be linked to databases via server-side ODBC. The purpose 
of the Database Flobot is that, in many cases, a process may need to 
perform database operations without having a person involved with a Form 
on the screen. To support human interaction when reading or writing to a 
database, use the Form. Otherwise, use the Database Flobot.  

Ultimus has tested the Database Flobot to work with Oracle and SQL 
Server. Other databases are not supported and may or may not work with 
the Database Flobot.  

If we link a workflow variable with any table field which has been declared 
as auto number the Database flobot will fail to execute and will return the 
following error: 
 
[Microsoft][ODBC SQL Server Driver][SQL Server]Cannot insert explicit 
value for identity column in table 'Categories' when IDENTITY_INSERT is 
set to OFF. 



Working with Filters 

A Filter can be created in one of the following two ways: 

1. Filter: This is the first radio button on this dialog. If you select this option 
you can specify a filter as follows:  

I. Click on the new button . 
II. The filter condition appears in the list box as shown below: 

 

 
III. Select the column on which to create a filter from the Column name 

combo box.  
IV. From the combo box under the column labeled Operator, select the 

filter operator. 
V. From the combo box labeled Workflow Variable select the variable 

whose value to compare with the linked field. 
VI. Click any where outside those columns and the specified filter 

appears in the list box: 
 

 
VII. Created filter also appears in the Filter Expression list box: 

 

 
VIII. To edit an existing filter click on it and then click on the edit button. 
IX. To delete a filter, click on it and then click delete. 

2. Custom Filter: For advanced users, the Database flobot provides the 
option to simply type in the filter. Specify you’re a custom filter by selecting 
the Custom Filter radio button. As "Custom Filter" is selected, the 
"Available Columns" and "Filter Expression" list boxes are enabled. 



 
 
In the "Filter Expression" type the desired filter statement. Include the 
names of table fields in the filter statement. For convenience, names of all 
the available table fields are shown in the "Available Table Columns" list 
box. Enter the name of a table field by enclosing it in square brackets or 
insert it by double clicking it. To insert workflow variables or linked cells in 
the custom filter statement, click "Variable".  The Variable insertion dialog 
appears. Double click on the variable to insert and the variable is inserted 
at the current cursor position in the filter expression. Workflow variable 
names must be enclosed in square brackets"[]". 



Working with Database Flobot Actions 

After creating several Database Flobot Actions in the Database Flobot Trainer 

window, actions can be edited, deleted and the order of execution can be 
changed. 

To change the order of Actions: 

1. Select an Action.  
2. Use the Up and Down arrow buttons to move it in the list.  

To edit an Action: 

1. Select an action and click Edit .   
2. Make the desired changes and click Done.  

To delete an Action: 

1. Select the Action.  
2. Click Delete . The Action is removed.  

Error Status Codes Returned by the Database Flobot 

When training the Database Flobot for an action, specify a workflow variable to 
record the Error Status Code. After execution, a code (integer) is returned to the 
workflow variable. The codes are as follows: 

 

Error Code  Message  
0  Successful Completion  
1  Ultdb2 initialization Fail.  
2  Unable to Connect to Database  
3  Due to some syntax error, unable to execute the query.  
4  Unable to parse the query.  
5  Unable to proceed, Enable Variable is not equal to zero.  



Database Flobot Examples 

This section provides examples on different database actions. These examples, 
use the "Northwind" sample database included with SQL Server 7.0. 

Read Operation 

The following example illustrates how to use a database query as a step in a 
process. In this example, a Database Flobot step is defined to search an 
employee database and retrieve the names of all employees who joined the 
company during the current month. This information is used to launch 
Performance Review processes in the subsequent step of the process. For this 
step, we define a Flobot Variable List that contains the following variables: 

• LastName: Last name of the employee.  
• FirstName: First name of the employee.  
• Title: Job title of the employee  
• Anniversary: Month and day the employee was hired.  
• Status: The employee status. If employment was terminated, the status 

returns the character "T."  
• Term_Symbol: The constant "T."  
• Month_First: First day of the current month, such as 7/1.  
• Month_Last: Last day of the current month, such as 7/31.  

The employee information is contained in a datasource called Northwind, in a 
database table called EMPLOYEE. This database table has several columns, 
which include the following: 

• LAST_NAME: Last name of the employee.  
• FIRST_NAME: First name of the employee.  
• EMP_TITLE: Job title of the employee.  
• HIRE_DATE: Month and day employee was hired.  
• NOTES: Notes about employee. If the employee no longer works for the 

company, this column contains the letter "T."  



 

A new action is created in the Database Trainer window as follows: 

Step 1: 

• Create a New action: 
 

 

Step 2:  



• On the output tab link the table columns to workflow variables: 
 

 

Step 3: 



• Specify the filter: 
 

 

When the Database Flobot step is executed, the Flobot finds all records that 
match the specified filter. For each matching record found, the first name, last 
name, anniversary date, title, and status are returned. Since each table column is 
linked to a workflow variable, the result of the query for the variable is returned in 
the range of cells starting from the linked cell. For example, if the column 'Last' is 
linked to cell B3, the value of column 'Last' from the first record goes to B3, the 
value from second record goes to B4, and so on. 

Add Operation 

In this example, a Database Flobot step is defined to add records to an employee 
database whenever a new employee joins the organization. This information is 
received by the database from the Employee Recruitment Process. For this step, 
a Flobot Variable List is defined containing the following variables: 

• LastName: Last name of the employee.  
• FirstName: First name of the employee.  
• Title: Job title of the employee  
• HireDate: Month and day the employee was hired.  
• Address: Address of the employee.  
• City: City of the employee.  
• PostalCode: Postal Code of the employee.  



• Country: Name of the country, to which the employee belongs.  
• HomePhone: Residential contact number of the employee.  
• Extension: Extension number if applicable.  
• Notes: Any other notes related to the employee.  
• Reports: Name of the supervisor for the employee.  
• PhotoPath: Directory path of employee's photo.  

Under the same connection created above, add a new connection and link 
workflow variables to the table columns as follows: 

Step 1:  

• Create an action: 
 

 

Step 2: 



• Link the workflow variables: 
 

 

When the Database Flobot step is invoked and this action is executed, all 
records in the linked variables are transferred to the respective linked fields.  

Delete Operation 

In this example a database flobot step is defined that deletes discontinued 
products from the database. Under the same connection created above, a new 
action is added and trained: 

Step 1: 



• Create a new connection: 
 

 

Step 2:  

• Link the spreadsheet cell A1 to the database column 'Discontinued':  
 

 



In Step 2 cell A1 is linked to the “Discontinued” column. Cell A1 contains the 
value 1. On execution of this action, the Database Flobot will search and delete 
all products in the products table whose discontinued column has been marked 
YES. 

Update Operation 

In this example we define a database flobot step that updates an employee's 
contact number and address in the database. Under the same connection 
created above, we add a new action and train it as follows: 
 
Step 1:  

• Create a new action: 
 

 

Step 2: 



• Link the workflow variables: 
 

 

Step 3: 



• On the filter tab, create a filter: 
 

 

On execution of this action, the database flobot updates the address and contact 
number of the employees whose name matches the specified first and last name. 

Custom Query Operation 

The Database Flobot’s Custom Query Operation executes any SELECT 
command that has to work on multiple tables. This allows Ultimus to easily 
handle complex query statements. In this example, assume that on a workflow 
step, we want to find out the name of Top 20 customers whose purchases 
amount to more than $1000. We also want to find the total purchase made by 
these customers in descending order.  

Note:  

Custom Query allows you to execute only SELECT SQL statements.  

To understand this query you need to know the structure of the Northwind 
database. Since the example given here, queries multiple tables its 
important to know how they are linked. For easy reference, a mapping 
diagram of the tables used in this query is provided: 



 

 
To execute this query: 

Step 1:   

• Create a new action: 

 

Step 2:  



• Specify the information on the "New Action" window. Click OK . The 
following dialog appears. Specify the SQL statement to run. In our 
example, we want to search for the top 20 customers, based on the 
amount of purchases they have made. This is done using the following 
SQL statement: 
Select [Customers].CompanyName, Sum([Products].UnitPrice) as 
TotalPurchases from 
[Products], [Customers], [Orders], [Order Details] Where 
[Customers].CustomerID= [Orders].CustomerID AND 
[Orders].OrderID= [Order Details].OrderID AND  
[Products].ProductID=[Order Details].ProductID 
Group By [Customers].CompanyName 
Having Sum([Products].UnitPrice)>1000 
Order By Sum([Products].UnitPrice) Desc 
This query fetches the name of customers with their respective purchases 
in descending order.  
 

 

Step 3: 

• Link the output columns or the specified query as shown below. In 
Maximum Rows, specify 20, since we only want top 20 customer records 
to be fetched from the database. 



 

 

On execution of this action, the Database flobot fetches the desired data from 
Northwind database to the linked columns. 

Execute SQL 

Execute SQL allows the flobot to execute SQL99 compliant statements. In this 
example, we assume that we want to delete the "lost" customers from the 
database. "Lost" customers are defined as those customers that have not placed 
an order since January 1998. This query can be defined as follows: 

Step 1: 



• Define an action: 
 

 

Step 2: 

• In the query list box, specify the following query: 
DELETE FROM [Customers] WHERE [CustomerID] IN  
(Select [Customers].CustomerID FROM [Orders] WHERE 
[Orders].OrderDate={d '1999-08-01'}) 



 

 

When this action is executed, the Database flobots deletes all such customers 
from the database who have not placed any order since August 1999.  



File Flobot 

The File Flobot allows you to perform basic file manipulation functions 
as a part of the workflow. Variables from the workflow process, usually file 
names, are passed to the File Flobot. The File Trainer Flobot can be trained to 
perform actions such as Copy, Delete, Rename, and Run files. 

How the File Flobot is Used 

Like other Flobots, the File Flobot is used as a step in the workflow to 
automatically perform file operations. The File Flobot performs the following file 
operations: 

• Copy: Copy the contents of one file to another.  
• Rename: Rename a file.  
• Delete: Delete a file.  
• Run: Run an executable file.  

Training The File Flobot 

To train the File Flobot: 

1. Create the Flobot Variable List as described previously.  
2. Click the Train button. The File Flobot Trainer window appears. The 

Process Name and Step Name are shown at the top. The Help Prompt 
field at the bottom displays instructions during training. 

 
3. Select one of the following actions from the top Action combo box: Copy, 

Rename, Delete, or Run.  



4. Specify the first argument for the file operation. You may type it in, or use 
the combo box to select a variable which contains the argument as 
determined by the workflow.  

5. Specify the second argument for the file operation. You may type it in, or 
use the combo box to select a variable which contains the argument as 
determined by the workflow. This argument is disabled for the Delete 
operation.  

6. Specify the variable to return the error status of the file operation with the 
Error Status combo box.  

7. Click the Train button. The Flobot saves this information and the training is 
complete.  

Use of Arguments 

The following table describes the use of the arguments for each of the actions in 
the File Flobot Trainer window:  

Action  Argument 1  Argument 2  
Copy  Name of source file  Name of destination file  
Rename Current name of file  New name of file  
Delete  Name of file to delete None  
Run  Name of file to execute Command line argument (optional) 
The error status codes are as follows:  

Error Status Significance  
0  Action completed successfully.  
1  Copy failed. Argument 1 does not exist.  
2  Copy to Argument 2 failed.  
3  Rename failed. Argument 1 does not exist.  
4  Rename failed. Argument 2 already exists.  
5  Rename failed. Source & target drives should be same. 
6  Delete failed. Argument 1 does not exist.  
7  Unable to attach file.  
8  Flobot Failed. See Error Log for details.  

File Flobot in Operation 

When the File Flobot step is invoked during the execution of a workflow incident, 
it automatically causes the actions for which it was trained to be performed. If any 
errors occur during these actions, it returns an error message. 



E-Mail Flobot 

The Ultimus E-Mail Flobot allows you to design workflow processes 
which can easily send e-mail messages with attachments at any stage in the 
workflow. For example, the E-Mail Flobot can notify a user that a document 
request has been approved and send a copy of the document as an attachment. 

How the E-Mail Flobot is Used 

The E-Mail Flobot provides the following capabilities: 

• Send e-mail using any MAPI- (Exchange) or SMTP-compliant mail 
system.  

• Use fixed information for sender, recipient, subject, message, and file 
attachments, or make them workflow variables so they can be changed 
dynamically for each workflow incident.  

• Send workflow data to any individual as an e-mail message.  

Training the E-Mail Flobot 

To train the E-Mail Flobot: 

1. Create the Flobot Variable List as described previously.  



2. Click the Train button. The E-Mail Flobot Trainer window appears. The 
Process Name and Step Name are shown at the top. 

 
3. Specify MAPI or SMTP mail system using the radio buttons.  
4. Depending upon which mail system you choose, perform one of the 

following:  
o MAPI: Specify the required Profile in the Use Profile field.  
o SMTP: Specify the Host Server and Sender in the appropriate 

fields. If you select this option you also have to specify following 
information:  

 Authentication: Using this combo box, select one of the 
following options:  

 No Authentication: If you select this option the Email 
Flobot sends email messages without any 
authentication. 

 Authentication Using POP: If you select this option, 
the Email flobot sends email messages using POP 
authentication. For this option to work you also have 
to specify a valid Login Name and Password. 

 Authentication Using SMTP (Clear Text Only): If you 
select this option, the Email Flobot sends emails 
messages using SMTP authentication. For this option 



you also have to specify a valid Login Name and 
Password. 

Note: Except the Password field, in all of the fields, you can either type in 
the information or insert a workflow variable. This capability allows you to 
specify unique information for each workflow incident. 

5. Specify the following information:  
o To: Specify recipient(s) for the e-mail message. Multiple recipients 

should be separated by a semi-colon (;).  
o Subject: Specify the subject of the e-mail message.  

6. Enter the body of the e-mail message in the Message field. You can use 
the Insert Variable button to insert a workflow variable that contains the 
entire message, or insert multiple variables to provide conditional text for 
the body of the message.  

Note: To insert a workflow variable, click inside the edit field, then 
click the Insert Variable button. The E-Mail Flobot variables window 
appears. Select a variable and click Insert. The variable appears in 
the edit field. 

7. Specify any files that will be automatically attached to the e-mail message 
in the Attachments field. You may also insert a workflow variable to 
dynamically determine the attachment during execution of the workflow 
process.  

8. Select a variable to store any error messages that are returned from the 
E-Mail Flobot.  

9. Click Train. The training is complete.  

Error Status Codes Returned by the Email Flobot 

When you train the Email Flobot for an action, you can specify a workflow 
variable to record the Error Status Code. After the execution, a code (integer) is 
returned to the workflow variable. The codes are as follows: 



E-Mail Flobot in Operation 

When the E-Mail Flobot step is invoked during the execution of a workflow 

incident, the following events take place automatically: 

1. The E-Mail Flobot logs into the Mail System specified during the training.  
2. The E-Mail Flobot then creates an e-mail message from the information 

provided during training.  
3. E-mail message is sent and the Flobot disconnects from the mail system.  
4. The E-Mail Flobot closes and informs the BPM Server that the Flobot step 

is complete.  

Error Code  Message  
0  Successful Completion  
1  Unspecified Error  
2  MAPI DLL Initialization Fail  
3  MAPI Initialization Fail  
4  MAPI Logon Fail  
5  SMTP Initialization Fail  
6  Unable to Create SMTP Socket  
7  Unable to Connect to Mail Server  
8  File Name or Path not Found  
9  Unable to send mail. See error log for more details. 

10  SMTP authentication failed using the specified Login, 
Password and Server name.  



Exchange Flobot 

The Exchange Flobot automatically executes a Microsoft Exchange function 
as step in a workflow process. For corporate users that use Outlook as their 
client for Exchange server, the Exchange Flobot can send mails or meeting 
requests and set tasks in the task list. All this can be done based on the workflow 
routing and the values of workflow variables. 

How Exchange Flobot is Used 

Exchange Flobot provides the following functionality: 

• Send task assignments to recipients chosen from the Outlook address 
book or based on workflow variables. The Flobot will automatically place 
assignments in the task list and generate an email notification that action 
was taken. 

• Send meeting requests to recipients chosen from the Outlook address 
book or based on workflow variables. 

• Send an email to recipients chosen from the Outlook address book or 
based on workflow variables. Email content can also be based on 
workflow variables. Email may be sent to both MAPI and SMTP recipients. 

Training the Exchange Flobot 

To Train The Exchange Flobot: 

• In Ultimus BPM Studio create the Variable List and click on the button 
Train. The Exchange Flobot trainer window is displayed.  



 

 
• This window is used to:   

o Create new actions . 

o Delete existing Actions . 
o Edit existing actions by double clicking on them . 

o Change the execution of order of existing actions . 
• Click the new button and the "Name of Actions" dialogue box (shown 

below) appears.  
 

 
 
Specify the name of the action to be created and select the Action Type. 
Select from one of the following available action types:  

o Email: Train the Flobot to send emails to different users. 
o Task: Train the Flobot to set tasks in the users' task list. 
o Event: Train the Flobot to send meeting request to users. 



Select an action and click "Continue". The Trainer dialog box for the 
selected action is shown. The Trainer dialog for each action is 
explained below: 

• Email Trainer Window:   
 

 
 
 
On this dialog specify:  

o Use Profile: Enter a valid user profile configured on Exchange 
Server. Exchange Flobot uses this profile for sending mails.  

o To: Identify email recipients. This can be hard coded entering the 
profiles, can be specified using workflow variables OR can be 
specified using the list of available profiles on Exchange Sever. To 
see the list of addresses click the "To" button. The Recipient 
Selection Dialogue Box appears. From this dialogue box insert the 
required addresses. For details please see the section "Linking 
fields to workflow variables". 

o Subject: Specify the subject of the email. 
o Message: Specify the message for this mail. 
o Attachments: Attach files to the email as follows:  



 To attach a files click the "Open" button, the following 
dialogue box appears: 
 

 
 Select the file to attach and click Open. 

Note: Only files present on a network path can be 
attached. Attaching any other file shows following error 
message: 
 

 
 Detach Files: To detach a file attached with mail, select the 

file and click the  "Cut" button. The selected file is 
removed. 
 
Note: Multicell variables are not supported by the 
Attachment field. 

o Error Status: The Exchange Flobot returns an error code for any 
error that may occur while executing the specified action. From this 
combo box select the variable in which the error code will be 
returned. 

To link any field to a variable right click on the 
field OR click on the field and then click on the 
button "Variable". The variable insertion 
dialogue box appears. Select the desired 
variable from this field and click OK. For further 



details see the section "Linking fields to 
workflow variables". 

• Task Trainer Window: To train the Flobot to assign tasks to 
different users, select Task and click Continue. The Task Trainer dialog is 
displayed: 
 

 
 
On this dialog specify:  

o Use Profile: Enter a valid user profile configured on Exchange 
Server. The Exchange Flobot uses this profile to send the mail. 

o Assign To: Address of the user to which the tasks will be assigned. 
This can be hard coded,  specified as a workflow variable 
containing address OR selected from the exchange users list. To 
see the list of addresses click "Assign To" button and the "Select 
Address" Dialogue Box appears. 
 



 
 
 
Select the recipients and click OK. For details please see the 
section "Linking fields to workflow variables". 

o Subject: Specify the subject of the task to be set. 
o Due Date: Specify the Due Date for this task. 
o Start Date: Specify the Start Date for this task. 
o Priority: Specify the priority of this task. 
o Comments: Enter any tasks in the given text box. 
o Error Status: The Exchange flobot returns an error code for any 

error that may occur while executing the specified action. From this 
combo box select the variable in which you want the error code to 
be returned. 

To link any field to a variable right click on the field 
OR click on the field and then click on the button 
"Variable". The variable insertion dialogue box 
appears. Select the desired variable from this field 
and click OK. For further details see the section 
"Linking fields to workflow variables". 

• Event Trainer Window: To train the flobot to send meeting 
requests, select the Event Option and click Continue. The Event Trainer 
dialog appears. 
 



 
 
 
On this dialog specify:  

o Use Profile: Enter a valid user profile configured on Exchange 
Server. Exchange Flobot uses this profile to send meeting 
requests. 

o Attendee: Specify the addresses of the users to which the flobot 
will send meeting requests. This can be hard coded, specified using 
workflow variables or by using Exchange address list. To see the 
address list click the "Attendee" button. The Recipient Selection 
dialog box appears. Insert the required attendees. For details 
please see the section "Linking fields to workflow variables". 

o Subject: Specify the subject of meeting. 
o Location: Specify the location where meeting is to be held. 
o Start Date: Date on which meeting begins. Select a variable or type 

in a date. 
o Start Time: Time at which meeting begins. Start Time cannot be 

linked to any variable. You have to select from one of the options 
given in the combo box. 

o End Date: Date on which meeting ends. Select a variable or type in 
a date. 



o End Time: Time at which meeting ends.  Select an end time from 
the End Time combo box. 

o Priority: Specify the priority of this meeting. 
o Comments: Specify any comments for this event. 
o Error Status: The Exchange flobot returns an error code for any 

error that may occur while executing the specified action. From this 
combo box select the variable in which you want the error code to 
be returned. 

To link any field to a variable right click on the field 
OR click on the field and then click "Variable". The 
variable insertion dialogue box appears. Select the 
desired variable from this field and click OK. For 
further details see the section "Linking fields to 
workflow variables".  

Linking Fields to Variables  

Variable Insertion Dialog Box:  
You can link all fields, except "Priority", "Start Time" and "End Time", to workflow 
variables. To link a text box to a workflow variable, click the text box then click 
"Variable".  The Variable insertion window appears. 
 

 
 
 
From this window, select the variable to which you want to link this field and click 
“insert”. The variable will be inserted in the field with square brackets around it. 
 
Note: Exchange flobot does not support the linking of range variables 
(variables comprising of more than one cell) or ranges of cells. Therefore, 
passing data to exchange flobot only as single cells or single-cell 
variables.  
Exception: the MESSAGE or COMMENTS fields do accept variable ranges.  



Note: If there are multiple actions in the exchange flobot and the first action 
fails to execute due to any reason for e.g. invalid recipient specified, the 
flobot will fail and no further action will take place.  

Note: If no recipient is mentioned in the linked Workflow variable at run 
time the flobot will fail and return the following message, "Recipient List is 
empty or at least one of the recipient is null."   

Error Status Codes Returned by the Exchange Flobot 

A workflow variable can be trained to record the Error Status Code. After 
execution, a code (integer) is returned to the workflow variable. The codes are as 
follows:  

Error Code  Description  
0  Successful Completion.  
1  Flobot fail, see log for details.  
2  Recipient does not exist in the MAPI list.  
Note: The Flostation service is unable to complete Tasks and Events. For 
all such actions user will have to complete tasks using Flostation 
Application.  



Script Flobot (Read-Only) 

Note: In BPM Studio, Script Flobots are only available for processes 
created in earlier versions and cannot be edited.  

Viewing Action of Script Flobot 

Double-click on an existing Script Flobot in a process. The Action window 
appears. Flobot variables appear in the Variables list box. 

 

Click on the Script button. The Script Editor window appears.  

 

The Save As menu option and button is available so existing Scripts can be 
converted to .NET Code.  



Error Status Codes Returned by the Script Flobot 

When you train the script Flobot for an action, you can specify a workflow 
variable to record the Error Status Code. After the execution of the script, a code 
(integer) is returned to the workflow variable. The codes are as follows: 

Code  Definition  
0  Script Executed successfully  
1  Script File not extracted successfully  
5  Invalid procedure call or argument  
6  Overflow  
7  Out of memory  
9  Subscript out of range  
10  Array fixed or temporarily locked  
11  Division by zero  
13  Type mismatch  
14  Out of string space  
28  Out of stack space  
35  Sub or Function not defined  
48  Error in loading DLL  
51  Internal error  
53  File not found  
57  Device I/O error  
58  File already exists  
61  Disk full  
67  Too many files  
70  Permission denied  
75  Path/File access error  
76  Path not found  
91  Object variable or With block variable not set  
92  For loop not initialized  
94  Invalid use of Null  
322  Can't create necessary temporary file  
424  Object required  
429  ActiveX object can't create object  
430  Class doesn't support Automation  
432  File name or class name not found during Automation operation 
438  Object doesn't support this property or method  
440  Automation error  
445  Object doesn't support this action  
446  Object doesn't support named arguments  



447  Object doesn't support current locale setting  
448  Named argument not found  
449  Argument not optional  
450  Wrong number of arguments or invalid property assignment  
451  Object not a collection  
453  Specified DLL function not found  
455  Code resource lock error  
457  This key already associated with an element of this collection  
458  Variable uses an Automation type not supported in VBScript  
500  Variable is undefined  
501  Illegal assignment  
502  Object not safe for scripting  
503  Object not safe for initializing  
1001  Out of memory  
1002  Syntax error  
1003  Expected ':'  
1004  Expected ';'  
1005  Expected '('  
1006  Expected ')'  
1007  Expected ']'  
1008  Expected '{'  
1009  Expected '}'  
1010  Expected identifier  
1011  Expected '='  
1012  Expected 'If'  
1013  Expected 'To'  
1014  Expected 'End'  
1015  Expected 'Function'  
1016  Expected 'Sub'  
1017  Expected 'Then'  
1018  Expected 'Wend'  
1019  Expected 'Loop'  
1020  Expected 'Next'  
1021  Expected 'Case'  
1022  Expected 'Select'  
1023  Expected expression  
1024  Expected statement  
1025  Expected end of statement  
1026  Expected integer constant  
1027  Expected 'While' or 'Until'  



1028  Expected 'While', 'Until', or end of statement  
1029  Too many locals or arguments  
1030  Identifier too long  
1031  Invalid number  
1032  Invalid character  
1033  Non terminated string constant  
1034  Non terminated comment  
1035  Nested comment  
1037  Invalid use of 'Me' keyword  
1038  'Loop' without 'Do'  
1039  Invalid 'Exit' statement  
1040  Invalid 'For' loop control variable  
1041  Name redefined  
1042  Must be first statement on the line  
1043  Can't assign to non-By Val argument  
1044  Can't use parenthesis when calling a Sub  
1045  Expected literal constant  
1046  Expected 'In'  
32766  True  
32767  False  
32811  Element not found  
Any other error Unknown run time error  
 



XML Flobot 

The XML Flobot allows an Ultimus workflow process to exchange data with 
any XML-compliant application. It can read information from and write information 
to any XML schema and post it to an HTTP server. Therefore, the XML Flobot is 
an ideal means of exchanging workflow information with e-commerce, EDI and 
other applications that rely on XML. 

Training the XML Flobot 

To train the XML Flobot: 

1. Create the Flobot Variable List as described previously.  
2. Click the Train button. The XML Flobot Trainer window appears. The 

Process Name and Step Name are shown at the top. 
 

 
3. Click the New button to create a new Action. The Name of Action 

window appears. 
 

 
4. Type in a name for the Action and click OK. The Action window appears. 

Flobot variables and system variables appear in the Variables list box. 



 

 
5. Select one of the following radio buttons:  

o Read: Flobot reads data from an XML file and passes that to the 
next step. Read flobot reads data in an XML document or searches 
data (based on the value given in local spreadsheet) from an XML 
file and passes that to the next step. If no value is given in 
spreadsheet then the Flobot will bring all the data from XML 
document else it will search the data according to the value given in 
the sheet. 
Note: Search feature of XML flobot will only work if the XML 
document does not contain  repeated child nodes in any 
parent node. For example if there is an XML document with the 
following structure: 
<Schema> 
        <NodeA> 
                <SubA></SubA> 
        </NodeA> 
        <NodeA> 
                <SubA></SubA> 
                <SubA></SubA> 
        </NodeA> 
</Schema>  

o Submit: Flobot gets data and stores it in an XML file according to 
an XML schema, which is specified by the user, and then posts it to 



the server. Depending upon the training XML flobot can submit this 
document to an HTTP server path  
(http://MyServer/MyRootDirectory/XYZ.asp) or save it in a file on an 
UNC path (C:\MyXMLFile.xml ). In later case, you have to specify 
name of the file with XML extension.  

6. Enter a number or select a workflow variable in the Row Count combo 
box. The row count can be any number. It determines the number of 
nodes XML Flobot will read in an XML document or store in an XML 
document. 
Row count can be specified as a hard coded number or it can be a linked 
to some variable.  
Linking Row Count: 
To link a variable to row count, follow these steps  

1.  In case of “Read” action type, select the variable from the row 
count combo box to be linked as row count variable. 

2.  In case of “Submit” action type, you can specify different row count 
for different nodes. To do this just select the node for which you 
want to specify the row count and then selected a variable form row 
count combo box. The functionality of Row Count is different for 
“Read” and “Submit” flobot types. Its functionality in both cases is 
explained below: 
Read  
If flobot is of read type then row count specifies how many nodes 
flobot will search/read in the specified XML document. XML flobot 
searches/reads all the nodes of an XML document if row count 
value is specified zero. Row count also returns a value as 
explained below: 

Row Count Return 
If the flobot is of “Read” type then Row count 
returns the number of nodes read in the 
specified XML document. Row count returns 
the value in the linked variable. For examples if 
in a variable linked to row count we specified 
the value to be 5 and with the given criteria it 
read only three nodes then 3 will be returned to 
the linked variable as a return row count.   
Note: Row Count will only return a value if 
flobot type is set to “Read”. 

Submit 
In case of “Submit” type flobot, row count can be linked to 
multiple variables allowing you to specify different row count 
for different nodes. This gives you the capability to generate 
any type of XML document by passing data from the 



workflow variables while specifying how many times each 
node will be repeated in the resulting XML document.  

7. Click the browse button to select an XML Schema. The schema nodes 
appear in the Schema list box. The Flobot uses this schema to store the 
data in an XML file. The file is submitted to the XML. Ultimus XML flobot 
supports XDR and XSD standards for generating XML documents as 
follows:  

XDR (Extended Data Representation Standard): 
For an XML document based on XDR standard, XML flobot only 
reads the attributes “Name” and “Type” for every node. No other 
attribute is read for any node. 

XML Schema (XSD):  
For an XML document based on XSD schema, nodes of only 
following types are supported/read by the XML flobot: 

• Include 
• Sequence  
• Simple 
• Content 
• Extension 
• Choice  

XML flobot reads the above nodes but does not show them in 
the tree view of trainer window. Following nodes are read by 
XML flobot and shown in tree view window. Complex Type 

Simple Type Attribute 

Note: XML Files should not contain nodes with a space in the 
nodes names. 

Note:  

XML flobot does not use the specified schema for validation of 
generated XML document.  
Suppose in an XML schema, for node “Membership” you have 
specified the value of attribute ‘minOccurances =3’ and 
‘maxOccurance =5’ to specify the number of repetitions for 
this node. This means that node “Membership” should be 
repeated, at least 3 times and at most 5 times, in the generated 
document. You can control this repetition using row count of 
this node but flobot itself does not check for all the attributes 
of a node in schema for validating the generated document 
against specified values. It is therefore your responsibility to 



train the flobot so that it generates XML document as per the 
given the schema.    

In case of XSD based XML document, if an unsupported type 
of node is present in the specified XML schema then schema-
tree view may show an incorrect structure for the specified 
schema.  

For further details please see "XML Flobot Example".  

8. Specify the path and file name in the Source/Destination edit box. You 
may type it in, or use the combo box to select a variable that contains the 
file name. This can be a local or HTTP path.    
Notes: If using HTTP protocol with port 81 (where as default is set at 
80) the  destination path would be as follows : 
htp://localhost:81/ultweb/ultisapi/ultisapi.dll? 
If the action is of type Read, you have to specify the path of the 
source XML file that contains the data. If action is of type Submit, 
you have to specify the path of an XML server to which the XML 
document created by the Flobot will be submitted.   

9. Select a workflow variable in the Variables list box.  
10. In the Schema list box, select the XML node to which you want the 

variable linked.  



11. Click the Link button. The workflow variable to XML node link appears in 
the list box below. 

 
12. Select a variable to store any error messages that are returned from the 

XML Flobot.  
13. Click Done.  
14. The defined action appears in the XML Flobot Trainer window. You can 

now train subsequent actions for the flobot. Click Train to close the XML 
Flobot Trainer window and save the actions.  

To Unlink a variable: 

• Select the link, in bottom list box and click the Unlink button. The selected 
flobot variable and XML node return to their respective list boxes.  

To Unlink all variables: 

• Click the Unlink All button. The flobot variables and XML nodes return to 
their respective list boxes.  

Working with XML Flobot Actions 

After you have created several XML Flobot Actions in the XML Flobot Trainer 
window, you can re-arrange the order in which they occur, edit Actions, and 
delete unnecessary Actions. 



To change the order of actions: 

1. Select an action.  
2. Use the Up and Down arrow buttons to move it in the list.  

To edit an Action: 

1. Double-click on the action. The Properties window for the action appears.  
2. Make the desired changes and click Done.  
3. Click the Train button to close the window and save your changes.  

Note: If you click Cancel, even changes made in the XML flobot trainer 
window are not saved. 

To delete an Action: 

1. Select the Action.  
2. Click the Delete button . The action is removed.  

Error Status Codes Returned by the XML Flobot 

When you train the XML Flobot for an action, you can specify a workflow variable 
to record the Error Status Code. After the execution, a code (integer) is returned 
to the workflow variable. The codes are as follows: 

Error Code  Message  
0  Action executed successfully  
1  Destination XML value not given in spreadsheet  
2  Failed to get spreadsheet variables indices  
3  Failed to extract variable values from sheet  
4  Action not executed successfully  
5  Failed to save locally.  

10  Failed to load the document  
11  Failed to initialize UltFlo COM object.  

 



XML Flobot Example  

Generating XML Document with Different Repetitions:  

This example explains how to create an XML document using workflow data. 
Suppose there is a situation where you want to create an XML document based 
upon the schema shown in the picture below:  

 

This schema contains four nodes namely “MAIN” which is the parent node, under 
this node there are two child nodes “SUB1” and “SUB2”. Node “SUB1” has 
another sub node “CHILD”. Now we assume that based upon this schema we 
want to generate following XML document: 

<Schema>   
<Main> Main One  
    <Sub1>‘Sub1’ 1st in Main One</Sub1>  
</Main> 
<Main> Main Two  
    <Sub1>‘Sub1’ 1st in Main Two 
         <Child>Child 1st in Main Two</Child>  
         <Child>Child 2nd in Main Two</Child>  
     </Sub1>  
    <Sub1>‘Sub1’ 2nd in Main Two 
         <Child>Child 1st in Main Two</Child>  
         <Child>Child 2nd in Main Two</Child> 
    </Sub1>  
    <Sub2>‘Sub2’ 1st in Main Two</Sub2> 
</Main> 
<Main> Main Three 
          <Sub2>‘Sub2’ 1st in Main Three</Sub2> 
          <Sub2>‘Sub2’ 2nd in Main Three</Sub2> 
          <Sub2>‘Sub2’ 3rd in Main Three</Sub2> 
</Main> 
</Schema>  
In this XML document node “Main” is repeated 3 times with different values 
passed to it. Moreover you also want to specify that for each repetition of “Main” 
node, the sub nodes are repeated different number of times. For example in our 
case in the schema give above we need to have following structure of our XML 
document:   

    In first repetition of “Main” node we want: 
  Node “Sub1” is created once. 



     Node “Child” is not created. 
     Node “Sub2” is not created. 
   In second repetition of “Main” node we want: 
     Node “Sub1” is created twice. 
     Node “Child is created twice. 
     Node “Sub2” is created once. 
   In the third repetition of “Main” node we want: 
     Node “Sub1” is not created. 
       Node “Child” is not created.   
Node “Sub2” is created three times. 

Using the Row Count to Generate Required Document  

To generate the XML document specified in the example above you need to 
specify a different row count variable for different nodes. The criterion for linking 
different variables with different nodes has been specified above. To explain how 
various row counts will work for different nodes we assume that we have 
following row count variables: 

You can specify any single cell variable as row count for a parent. Row count 
variable specified for a sub node, whose parent node is to be repeated more than 
once, must conform to following restrictions: 

• The specified variable must be a multiple cell variable.  
• The variable must contain as many cells as many times the parent 

node is to be repeated. These cells must be in a column. (In our case 
since main node is to be repeated three times so every variable linked to 
any sub node as row count contains three cells in a column. See in the 
sheet shown above in table). Multiple cells in row count variables ensure 
that different value is passed as row count for every next repetition of main 
node.  

Setting Values in the Row Count Variable:    
To generate the desired XML document given in the above example we have to 
pass different values of row count for different nodes. We want the parent node 
(which is node “Main” in our example) to be repeated three times. For this we 
have to set the value of variable mainRowCount as “3”, see this in the sheet-

XML Node  Variable Linked 
as Row Count  

Linked Variables shown in Data 
Sheet  

MAIN mainRowCount 
SUB1 sub1RowCount 
SUB2 sub2RowCount 

CHILD childRowcount 
 



picture above. Now we take the case of  “Sub1” which is a child node. The row 
count variable specified for this node is “sub1RowCount” and contains three 
cells. Values in these cells have been specified as follows: 

Variable  Cell  Working  

First Cell 

First cell of this variable contains 
“1”. This means that in first 
repetition of parent node “Sub1” 
will be created once. 

Second Cell 

Second cell contains “2”. This 
means that in the second 
repetition of main node “Sub1” 
will be repeated twice” 

 

Third Cell 

Third cell contains “0”. This 
means that in the third repetition 
of main node “Sub1” will not be 
created, as row count specified 
for this repetition is zero. 

This way for each repetition of parent node you can specify different row count 
for child nodes by passing values in corresponding cells. It is same for other 
variables.  

Passing Data to Repeating Nodes:  

To pass data to an XML document, the workflow variable must be declared as 
per the rules given below:  

• You have to specify a multiple cell variable for a parent node if the 
row count specified for this node is greater than one. This variable 
must have more than one cell in column format. This variable is 
shown in the picture. 
  

Since the main node is to be repeated three times 
in desired XML Document, its data variable 
contains three cells in a column format. 

 

• For any sub node, whose parent node is to be repeated more than one 
time, linked variable must be two-dimensional multiple cell variable. 
This variable must have number of rows equal to the largest value 
specified in its row count variable. While it’s number of columns 
should be equal to the number of times its parent node is to be 
repeated.  All sub variables are to be declared in this way. Variables 
linked with Sub1, Sub2 and Child are shown below:  



Sub1    

Explanation Row Count 
Variable Data Variables 

Data variable for this node 
contains two rows since 
largest value in its row 
count variable is "2" (see 
the figure shown in next 
column. This variable has 
three columns as its main 
node is to be repeated 
three times.  

 

  

Child   

Explanation 
Row 
Count 
Variable  

Data Variable 

Data variable for this node 
contains two rows since 
largest value in its row count 
variable is two (see the figure 
shown in next column. This 
variable has three columns as 
its main node is to be 
repeated three times. 
Note:Incase of childDataVariable there are three columns but 1st and 
3rdcolumns are blank, this is so because we have specified that in first and 
thirdrepetitionofMainnode, child nodewillnotbecreated but still we need to have 
thesecolumns present for the variable. 

  

Sub2   

Explanation 
Row 
Count 
Variable  

Data Variable 

Data variable for this node 
contains three rows since 
largest value in its row 
count variable is three 
(see the figure shown in 
next column. This variable 
has three columns as its 
main node is to be 



repeated three times. 

Inthis way you can generate any type of XML document that contains 
varyingrepetitions of different nodes using XML flobot. 

Note:Though you can use row count variable to generate XML documents 
of anystructure, Ultimus strongly recommends you to use this feature very 
carefully.You must not specify a row count variable for top level schema 
node. 
You can specify the row count variable for a schema node only if it has 
morethan one child node. If you have specified row count for a schema 
node,restrictions stated above does not hold true. In this case XML Flobot 
will workin the following way: 

RowCount Working with Nested Nodes 

• Supposeyou have specified row count value 3 for a schema node. In this 
case, theschema node will be created once and its inner structure will be 
createdthree times. For example if there is the XML schema given below: 
<Schema> 
       <Node A> 
       <Node B> 
</Schema> 
 
If the row count specified for schema node is three then the 
resultingstructure will be as shown below: 
<Schema> 
       <Node A> 
       <NodeB> 
       <Node A> 
       <Node B> 
       <Node A> 
       <Node B> 
</Schema> 

• Incase you specify row count of 3 for main node and 2 for some of its 
childnode, then the child node will be repeated six times. 

PassingData: 

• Inthis case if you want to pass data to repeating nodes, the linked 
datavariable have to be multiple cell variable in column format. For 
example iffor a schema node you have specified the row count 3, and for 
its child nodeyou have specified row count 2 then as mentioned above this 
child node willbe created six times in the generated XML document. To 
pass data to thisvariable you must link a variable to child node that has six 
cells in columnformat for example range of cells A1:A6. 



• Forpassing data to repeating attribute type node, XML flobot reads value 
fromrange type variable by switching columns. For example if you want to 
passvalues to an attribute type whose parent node is to be repeated three 
times,you should link a range variable comprising of cells A1:C1. On 
execution,the XML Flobot will read data from cell A1, when the main node 
is createdfirst time, second time it will read the data from cell B1 (shifting 
to thenext column) and so on.  



Completing a Workflow Step Using XML Flobot 

This example illustrates how XML Flobot can be used for integrating two 
workflow processes. In most of the business scenarios, information generated at 
one step is used to complete a task at some other step in either a same workflow 
process or a different workflow process. For situations where the information 
passed by a step in a workflow process is used to complete the task for a step in 
another process, XML Flobot can be used. In the following it has been explained 
how XML Flobot can be used for across-processes step completion. 

1. Suppose we want the XML Flobot to pass the Account Number and 
Amount to a bank for the transfer of funds, as shown in the snap below:  

 
2. To train the XML flobot for performing the desired action, open the Budget 

Allocation Process in Ultimus BPM Studio. 
3. Create the following global variables:  

1. ProcessName: Used for passing the process name. In this 
example the process name to be passed is "Accounts 
Management". 

2. IncidentNumber: Used for passing the incident number. 
3. StepOwner: Used for passing the Step Owner. 
4. StepName: Used for passing the Step Name. In this example the 

step name to be passed is "Cash Transfer". 
5. BudgetAccountNumber: Used for passing the Account Number to 

which we want the amount to be transferred. 
6. BudgetedAmount: Used for passing the Amount.  

4. Double Click the XML Flobot step to switch to the Form View. 
5. Add the variables "BudgetAccountNumber" and "BudgetedAmount" in the 

variables list. For details see "Defining Flobot Steps". 



6. Click the Train Button. The Actions window Appears. 
 

 
7. Click New button to create a new action. Specify the Name of the 

Action and click OK. The Action Trainer Window Appears: 
 

 
8. Select the option Submit. 
9. Select the schema file. The schema must be the same as give below: 

 



<Schema> 
<?xml version="1.0"?> 
<ElementType name="comment" content="eltOnly" model="closed"> 
     <element type="Request" maxOccurs="1" minOccurs="0"/> 
     <element type="UltimusXML" maxOccurs="1" minOccurs="0"/> 
</ElementType> 
 
<ElementType name="WfMessageHeader" content="eltOnly" 
model="closed"> 
     <element type="comment" maxOccurs="1" minOccurs="0"/> 
</ElementType> 
 
<ElementType name="WfMessageBody" content="eltOnly" 
model="closed"> 
     <element type="ProcessName" maxOccurs="1" minOccurs="0"/> 
     <element type="StepName" maxOccurs="1" minOccurs="0"/> 
     <element type="StepOwner" maxOccurs="1" minOccurs="0"/> 
     <element type="Incident" maxOccurs="1" minOccurs="0"/> 
     <element type="LocalVariables" maxOccurs="1" minOccurs="0"/> 
</ElementType> 
 
<ElementType name="WfMessage" content="eltOnly" model="closed"> 
     <element type="WfMessageHeader" maxOccurs="1" minOccurs="0"/> 
     <element type="WfMessageBody" maxOccurs="1" minOccurs="0"/> 
</ElementType> 
 
<ElementType name="UltimusXML" content="empty" 
model="closed"></ElementType> 
<ElementType name="StepOwner" content="empty" 
model="closed"></ElementType> 
<ElementType name="StepName" content="empty" 
model="closed"></ElementType> 
<ElementType name="Request" content="empty" 
model="closed"></ElementType> 
<ElementType name="ProcessName" content="empty" 
model="closed"></ElementType> 
 
<ElementType name="LocalVariables" content="eltOnly" model="closed"> 
     <element type="ACC_NUMBER" maxOccurs="1" minOccurs="0"/> 
     <element type="AMOUNT" maxOccurs="1" minOccurs="0"/> 
</ElementType> 
 
<ElementType name="Incident" content="empty" 
model="closed"></ElementType> 
 
<ElementType name="CompleteStepSchema" content="eltOnly" 



model="closed"> 
     <element type="WfMessage" maxOccurs="1" minOccurs="0"/> 
</ElementType> 
 
<ElementType name="ACC_NUMBER" content="empty" 
model="closed"></ElementType> 
<ElementType name="AMOUNT" content="empty" 
model="closed"></ElementType> 
 
</Schema>  

Note: The variables names "ACC_NUMBER" AND "AMOUNT" should 
be replaced with the variable names as declared in the "Account 
Management" process. Using same schema as above, make sure two 
global variables have been declared in the Account Management 
process with the exact name as "ACC_NUMBER" and "AMOUNT". 

10. Select the destination 
Note: If using HTTP protocol with port 81 (whereas default is set at 
80) the  destination path would be as follows: 
htp://localhost:81/ultweb/ultisapi/ultisapi.dll? 

11. Link the variables as follows: 
     ProcessName with ProcessName 
     StepOwner with StepOwner 
     StepName with StepName 
     StepOwner with StepOwner 
     IncidentNumber with Incident 
     BudgetAccountNumber with ACC_NUMBER 
     BudgetedAmount with AMOUNT 
Note: While training the XML Flobot for step completion, 
SYS_SUMMARY and SYS_PRIORITY can be linked on the trainer 
window. No other SYSTEM variable should be linked using the 
trainer window. 

12. Click the Done Button. 
13. On Execution the XML flobot, completes the "Cash Transfer" step in the 

Accounts Management process for a give incident. 



Acrobat Flobot 

The Acrobat Flobot allows an Ultimus Process to export workflow data to 
into PDF forms. The workflow data filled form can then be saved to a specified 
location or printed. This extends the functionality and flexibility of Ultimus 
Workflow Suite by allowing it to fill in any PDF form.  

Note: An Acrobat Flobot trained for printing PDF forms, can only be 
executed on a FloStation that has Acrobat Reader 5.0 installed.  

How Acrobat Flobot is Used 

The Acrobat Flobot provides the following capabilities: 

• Linking workflow variables to fields an existing PDF form. 
• Save the completed PDF form to specified location as an FDF File. 
• Either specify a fixed filename for the output file or make it a workflow 

variable so that it can be changed for each workflow incident. 
• Print completed form to a printer. 
• Fax the completed form. 

Training the Flobot 

To train the Acrobat Flobot: 

1. Create the Flobot variable list. 
2. Click the train button. The Acrobat Trainer window appears. 

 



 
 
This trainer window is used to specify: 

3. PDF Form: Specify the name and path of the PDF form. This form can be 
located anywhere on the network. Workflow data is embedded in this form 
and saved as an FDF file. When the PDF form is selected, its fields are 
listed in the "Acrobat Forms Fields" list box. Fields are shown with 
different icons as follows: 

Name Icon 

Check Box  
Text Box  
Combo box/List Box  
Radio Button  

4.  



5. Field icons appears as nodes in a tree structure.  Fields with a “+” can be 
expanded to show possible values for that field 

6. Action: Specify whether the form will "Print", "Save" or both by checking 
the respective check boxes. When selecting Save, specify the path to 
which the file will be saved.  
Note: In case of Save, the file can only be saved on a local path. 

7. Link Variable: To link the variables with form fields, select the variable 
and the field that you want to link by clicking the variable, the field then the 
link button.   
Note:  
Acrobat Flobot does not support the linking of range type variables 
(variables comprising of more than one cell) or range cells with a 
form field. Therefore for passing data can be linked only to single 
cells or single-cell variables.  
Once the PDF form fields are linked with any variable, the PDF form 
cannot be changed or the following message is displayed: 
 

 
8. Encoding Schema: This edit box is provided for Encoding Strings to 

create a FDF file in localized versions using the Acrobat Flobot. A FDF file 
during its creation, requires an Encoding Scheme if the file is to be created 
in versions other than English. These encoding strings are available on 
the Adobe site. An example of a encoding scheme for simplified Chinese 
language is GB (must be in capital letters).  

9. Error Status: The Acrobat Flobot returns one of five error codes. Select 
the variable to which the error code should be returned. 

10. Click "Train". This completes the Flobot Training. 

Acrobat Flobot in Operation 

When the Acrobat Flobot is invoked as a step during the actual execution of a 
workflow incident, the following events take place automatically: 

• The Acrobat Flobot loads the PDF form specified during training. 
• It takes the values from workflow variables and creates an FDF file for the 

specified PDF file, with the values in the linked workflow variables. 
• If the Save option was checked during training, it saves the PDF and FDF 

file to the destination specified during training. 
• If the Print option was specified, the file is opened in Acrobat Reader on 

the FloStation while keeping the Acrobat Reader window minimized. The 
print job for the opened FDF file is sent to the printer configured on the 
FloStation and the Acrobat Reader is closed. 



Error Codes returned by Acrobat Flobot 

During training a workflow variable is defined to record the error status code. 
After the execution, a code (integer) is returned to the workflow variable. The 
codes are as follows: 

Error Code  Message  
0  Successful Completion.  
3  Acrobat Reader is not installed.  
4  Cannot Load Acrobat Reader, Unspecified Error.  
5  Unable to save file on the specified path.  
6  Printer not installed.  

 



Reusing Process Objects 

BPM Studio users have the ability to easily leverage existing development efforts 
by dragging and dropping steps from one process into another. 

Benefit:  

Reduced design effort through leveraging existing design elements of other 
processes. 



Reusing Steps 

Ultimus BPM Studio provides the user with the ability to drag and drop a step 
from one process to another. To do so, 

• Open a previously designed process in the Build Editor 
• From the Repository Window View select a step from another process. 
• Drag and drop the selected step into the open process in Build Editor. 

This makes a copy of the step in the process map and has no reference to its 
source. The Step's Properties, Forms and Local Spreadsheet will be copied 
when a Step is reused. 

Note: The Process from which the Step is being dragged must be either 
checked in or locked for this functionality to work. 



Reusing Entire Processes 

Ultimus BPM Studio provides the user with the ability to drag and drop an entire 
process into another process. To do so, 

• Open a previously designed process in the Build Editor 
• From the Repository Window View select a  process.  
• Drag and drop the selected process into the open process in Build Editor. 
• This creates a Maplet in the process. 

This operation creates a reference in the target process map to the original 
process that was dragged and dropped into the Build Editor; it does not make a 
copy of the process map. The benefit of this approach is that if the original 
process map is changed, the target process will not have to be updated. 

Note: The Process from which the Step is being dragged must be either 
checked in or locked for this functionality to work. 

For more information on working with Maplet Steps in processes, please view the 
Defining Maplet Step Properties section. 



Defining Inlets (Segmenting Processes) 

Users have the ability to define continuous sections of a process as an Inlet (or 
inline process). Inlets allow process owners to segment processes into exclusive, 
independent sections, and users can then work individually on those different 
sections without overwriting each other’s work. Thus, not only does BPM Studio 
support granular access control at the process and object level, it also provides 
fine-grained security for individual sections in processes. 

How to define inlets 

1. Open a process in Build editor 
2. Hold down left-click mouse button and select the area of the process for 

which you want to define the inlet.  
3. A dotted boundary appears showing the inlet area. 

 

4. Right-click the process and select Make Inlet from the menu option. 
5. The following dialog appears 

 

6. Type in a name for the inlet. 
7. Click OK 



Inlets allow multiple users to work on different sections of the process 
collaboratively without interfering with each others work.  

Editing rights of the inlet are set through Role-Based Security by the 
administrator. Editing options are described in the Defining Object Security 
section.  

Inlets are edited just like any other object and when a specific inlet is being 
edited, you cannot work on any other portion of the process. 



Simulation 

Simulation is a powerful tool which lets you thoroughly test the workflow 
application you have designed before you install it. Ultimus enables you to test all 
the following features of your workflow design using simulation: 

• The appearance and layout of electronic forms  
• Form attributes and properties  
• Database links  
• Flow of the process  
• Routing logic  
• Event conditions  
• Data links in spreadsheets  
• Calculations  
• Behavior of Flobots  
• Task assignment  
• Memos and attachments  



Using Simulation 

Essentially, everything about a workflow process can be tested before the 
application is installed. To appreciate the significance of this tool, it is important 
to realize that workflow is a "distributed" application. If you develop a workflow 
application which is used by many users, it is logistically impractical and time 
consuming to test the application after it is installed. You will have to walk to each 
user's computer to test each step, and even a simple modification requires you to 
re-install the process and start over. Simulation avoids all this. You test the 
process thoroughly on the same PC on which you designed it. Once you have 
tested it, you can install with the confidence that it will work properly. 

Rules and Guidelines About Simulation 

1. To simulate a workflow process, you must complete the design and save 
it. If you make a change in the design and try to simulate, the Ultimus 
BPM Studio prompts you to save it first.  

2. Simulation checks everything that it possibly can. It uses the exact same 
code as the BPM Server to ensure that you will get consistent behavior 
during Simulation and live testing.  

3. When the user clicks on a step that has been assigned to a group, a pop-
up menu appears listing up to 20 members of the group. The user selects 
a group member to test the step. You must test the process for each 
member of the group (except for the Begin Step, which only requires one 
user to perform the step). However, if you want to test it for fewer 
members, you can change the Minimum Response field to a lower 
number, then delete that number when you install the process.  

4. During Simulation, the workflow status data is kept in memory. This data is 
a replica of the Ultimus BPM Server database (Ultimus Workflow). Every 
time you re-simulate a process, the simulation begins with a new incident.  

5. You can run multiple incidents of a workflow process during simulation.  
6. Simulation is for testing only. During simulation, you cannot change the 

design of forms, or the contents of the spreadsheets. But you can look at 
the contents of the spreadsheets to check your workflow logic and 
calculations.  

7. If you are using Flobots in your workflow, you will not be able to run 
simulation unless you have trained all the Flobots.  

8. Only Standard Forms can be used in simulation. Thin forms can be tested, 
but not used in simulation.  

9. During simulation Maplet step is not activated, i.e., no maplet process is 
invoked when control goes to Maplet step. During simulation, Maplet step 
works like a Junction Step and passes the control to next step without 
initiating the specified child process. For detail of a Maplet Step see, 
"Maplet Steps".  

10. Simulation displays the status of the workflow graphically by using the 
process map. Once a step has been made active, the recipient name 



appears in green under the step. The step names change color to indicate 
the status. The following color codes are used:  

o Active Steps (steps you can invoke): Light Green.  
o Completed Steps: Dark Green.  
o Returned Steps: Red.  
o Aborted Steps: Dark Red.  
o Inactive Steps: Normal colors.  
o Skipped Steps: Normal colors.  
o Resubmitable Step: Blue.  



Simulating a Workflow Process 

The simulate function lets you test the process on one computer before 
deploying for all users. Running a simulation shows you exactly how your 
process will run when installed, except that all steps are completed on the same 
computer. You will be able to follow the process from step to step, and watch 
how the data is moved from person to person. 

A process can be simulated in multiple cases: 

• when it is being edited in Build Editor, 
• when it is simply checked-out, but not being edited 
• when it is checked-in 
• when it is locked 

The following numbered subsections discuss the various functions of running an 
Ultimus simulation. 

1. Starting Simulation 

When you start simulation, the program starts the Ultimus BPM Server. It also 
verifies the integrity of the application you are simulating and checks version and 
recipient information. Depending on the complexity of the process, this might 
take some time. 

To start a Simulation: 

1. Complete your workflow design and save it.  
2. Click the Simulate button or right-click on a process and select Simulate 

from the Object menu. The simulation server initializes the steps. When 
the process is ready, the Begin Step is highlighted. 



 

 

Note: Through this quick simulation you are not able to view variables 
through the watch window or view the spreadsheet. To do so initiate 
simulation when in Edit (Build) mode. 

2. Invoking a Workflow Step 

When you invoke a step in the process, the form for that step is displayed. If 
multiple steps are active, it means that these steps can be executed in parallel by 
several users. 

Steps can be assigned to both single-users and groups. In either case, a user's 
name appears beneath the step. For group steps, the BPM Server selects a 
random name from the group. When invoking a group step during simulation, you 
will select a member of the group to perform the task. 

To invoke a single-user step: 



• Click on a highlighted (light green) step. The form for that step appears. 
 

 

To invoke a group step: 

1. Click on a highlighted (Light Green) step. A pop-up menu appears, listing 
up to 20 members of the group.  

2. Select a member from the Group menu.  
3. The form for that step appears.  

3. Completing a Form 

When you invoke an active step, the program displays the form associated with 
the step. The view buttons are still in view, but most are disabled during 
simulation. 

Note: You can test the functionality of only standard forms using simulation i.e., 
during simulation only standard form is shown for a selected step and you cannot 
see thin form a step during simulation. 

Ultimus forms are used just like any other electronic form, particularly forms that 
appear on a web page. You can check all the features designed for the form, 
including the calculations. If you are prompted to enter a password for an 
electronic signature, however, you can type anything because password 
checking is disabled during simulation. You can also attach documents, write 
memos, and switch to other pages of the form by using the functions provided. 

The following buttons are available when testing forms: 

• Send: Sends the form to the next step.  
• Return: Returns the Form to the previously performed step.  



• Memo: Write a memo to subsequent workflow participants, and view and 
print memos from previous workflow participants. For more information 
about memos, see the Ultimus Client online Help.  

To complete a form: 

• When you finish entering a form, click the Send button. The form closes, 
and the simulation engine resumes operation.  

When you complete a step by sending the form, it turns dark green on the map. 
The engine then decides which step to invoke next, and those step(s) become 
active. You can, therefore, keep on "role-playing" as different users. Complete 
the forms for each step until the process is complete. 
 

 

4. Returning Steps During Simulation 

In simulation, you can return a step to test the behavior of your application, just 
as in a real-life situation. 

To Return a Step: 

• Click the Return button in the Form View.  

5. Resubmitting Steps During Simulation 



In simulation, you can resubmit a step to test the behavior of your application, 
just as in a real-life situation. In order to resubmit a step, it must be enabled for 
resubmit when the process is designed (see "Designing a Workflow Map"). When 
a resubmitable step is completed during simulation, the step icon turns blue. 

To resubmit a step: 

• Click the resubmitable step (blue). The Form View appears.  

6. Working with Memos During Simulation 

The memo function behaves in exactly the same way as it does when running an 
actual process. 

To open a memo: 

1. Click on the Memo button in the form. The Memo window appears.  

Note: If this is not the first step in the workflow and a memo has 
already been written in a previous step, the Memo button flashes. 

 

2. Enter the text for the Memo. The User Name, date and time are entered 
automatically.  



3. Click the Print button to print the memo.  
4. Click OK.  

7. Checking the Contents of the Spreadsheets 

At any point during simulation, you can switch to the Data View. In the Data 
View, you can check the contents of any cell in the local spreadsheet or the main 
spreadsheet and see if your calculations and links are working properly. You may 
not edit the contents of the spreadsheet in simulation mode. 

By looking at the spreadsheets, you can determine the values and status of the 
variables used in the process. Since you can look at the spreadsheet at any 
stage in the workflow, you can watch the variables change. This is a very useful 
diagnostic tool to check and debug the logic of your process and the user 
interface. 

Note: this capability is only available when simulating processes from within the 
Build Editor 

8. Working With Flobot Steps 

During simulation, you can invoke Flobot steps just like any other step. The 
Flobot performs the operations for which it has been trained. When the Flobot 
step is complete, it turns dark green and the simulation automatically moves to 
the next step. You can then go to the local spreadsheet for the Flobot step or the 
main spreadsheet to check the variables modified by the Flobot. 

To invoke a Flobot Step in Simulation: 

• Click on the highlighted (light green) Flobot step. The Flobot performs the 
operation for which it was trained.  

9. Using the Watch Window 

The Watch window is a tool to make it easier for you to debug and test your 
workflow applications. It lets you monitor the values of the workflow variables. 
Thus, as you run a simulation and the values of the variables change, you can 
observe them on the screen, without having to switch to the Data View. This 
allows you to easily identify problems and debug your workflow application. 

To work with the Watch Window: 

1. Click the Watch Window button . The Watch Window appears at the 
bottom of the screen.  



2. Select a workflow variable from the Workflow Variables combo box and 
click the Add button. The variable appears in the list box below. 

 
3. During simulation, observe the value of the selected workflow variables as 

they change from step to step. The Watch window provides graphical 
indication if the value of a variable has changed after the last step as 
follows:  

o A green check mark signifies that the value of the variable has not 
changed after the last step.  

o A red exclamation point signifies that the value of the variable has 
changed after the last step.  

4. You can hide the Watch window by clicking the Watch window button 
again. When you bring it back, it remembers the names of the variables 
selected for observation.  

Note: this capability is only available when simulating processes from within the 
Build Editor 

10. Ending and Restarting Simulations 

You can end the simulation when the process is complete or at any time during 
the process. You can also restart the simulation from the beginning. 

To end a Simulation: 

• Click the Simulation button .  

To restart a Simulation: 

• Click the Simulation button again .  



Creating Technical Documentation 

As companies develop complex, enterprise-wide workflow processes, the need 
to document these processes becomes essential. Once the final version of a 
workflow process has been designed and the key requirements, exceptions and 
special conditions have been documented, it is often necessary to render the 
design in to an electronic document that could be reviewed and shared with 
others. Documentation is a laborious, time-consuming and costly activity. Ultimus 
BPM Studio provides the capability to take the process design and produce an 
electronic document that describes the model, its objects and requirements. This 
printable technical description of the business process can contain the following 
information: 

• Business Process Name 
• Business Process Map 
• Business Role Definition 
• Process Design Instructions 
• Event Conditions and Instructions 
• Step Descriptions 
• Maplet Descriptions 
• Form Inputs, Actions, and Outputs  
• Flobot Specifications 

With Ultimus' powerful process documentation capability, you can define report 
templates using Microsoft Word and specify which parts of the process you wish 
to show in the documentation. When a report is selected and printed, the Ultimus 
BPM Studio automatically creates a Word document to define the process. 



Documentation Variables 

Ultimus provides a list of pre-defined documentation variables, which can be 
broken down into three categories: Process-related, Step-related, and Loop. 

Process-Related Variables 

Process-related variables deal with the entire process, and generally refer to one 
piece of data in a report. They are as follows: 

• Process Name: Name of the workflow process.  
• Process Owner: Owner of the workflow process.  
• Process Description: Description of the process.  
• Process Creation Date: Date the process was created.  
• Process Modified Date: Date that the process was last modified.  
• Process Map: Image of the process map.  
• Total Number of Steps: Total number of steps used in the process.  
• Number of User Steps: Total number of user steps used in the process.  
• Number of Flobot Steps: Total number of Flobot steps used in the 

process.  
• Number of Maplet Steps: Total number of maplet steps used in the 

process.  
• Number of Junction Steps: Total number of junction steps used in the 

process.  
• Main Spreadsheet: Image of the main spreadsheet.  
• Process Variables: List of all System and workflow variables.  

Step-Related Variables  

Step-related variables refer to specific steps in the workflow process, rather than 
the whole process. Step-related variables are generally used in a loop (see next 
section). The step-related variables are as follows: 
  
Step Label: The label of the step. 
 
Step User: The recipient of the step. 
Note: The documentation does not show any value for the step recipients if 
the recipient of a step is determined during Realtime execution of a 
process (For recipient types such as Queue and Sequential Groups etc.) 

• Step Task Cost : The cost rate at which the user performs the task. 
• * Step Recipient Notes: Notes about step recipients.  
• *Step Completion Time Notes: Notes about step completion Time. 
• *Step Extension Time Notes: Notes about Step Extension Time. 
• *Step Delay Time Notes: Notes about delay time for the step. 
• *Step Notes: Notes about the step. 
• *Step Inputs: Details about step inputs.  



• *Step Outputs: Details about step outputs.  
• *Step Actions: Details about step actions.  
• Step Completion Time: Time allowed to complete the step. 
• Step Extension Time: Extension time (grace period) allowed to complete 

the step. 
• Step Delay Time: Delay time associated with the step. 
• Step Variables Table: Workflow variables associated with the step and 

their values. 
• Step Conditions Table: Conditions table for the step. 
• Step Local Spreadsheet: Local spreadsheet for the step. 

* Available in Process Designer Stand-Alone only.  

Loop Variables 

One of the most useful features of the process Documentation function is the use 
of the Begin Step Loop and End Step Loop variables. When you place a step-
related variable between the two loop variables, Ultimus provides the values of 
that step variable for every step in the process. Therefore, if you wish to know the 
Step User, Step Task Cost, Step Completion Time, and Step Delay Time for 
every step in the process, you insert the following variables: 

Begin Step Loop 
Step User 
Step Task Cost 
Step Completion Time 
Step Delay Time 
End Step Loop 

Ultimus automatically "loops" through all the steps and prints the values of the 
documentation variables for each. 

The loop variables are as follows: 

• Begin Step Loop: Triggers the beginning of the loop.  
• End Step Loop: Triggers the end of the loop.  



Creating a Documentation Template 

Ultimus allows you to create a Documentation Template that specifies the format 
and content of the documentation. You can create multiple Document Templates 
and use them for different processes. 

Creating a Documentation Template 

To create a Documentation Template: 

1.  Right click on Documentation node from the Repository Window View.   
2. Select New From the menu. A node called New_Documentation appears 

node appears. 
3. Right click the object and select check-out from the menu. 
4. Right click the checked out object and select edit from the menu  
5. Ultimus launches Microsoft Word and the Documentation variables list 

window appears on top of Word. You can now use all the capabilities of 
Word to create a report template. 
 

   
6. Type in the desired field labels on the report template and format them as 

you wish. 
7.  For each label, select a variable from the Documentation window and 

click the Insert button, or double-click on the variable.  
8. The variable appears in the Word document.  
9. After you have inserted all the needed variables, click on the Done button 

in the Documentation window. 
10. Ultimus closes the Word document and the Documentation variables 

window.  

Editing a Document Template 



To edit a Documentation report template: 

1. Select Documentation from the Repository Window View.  
2. Select a report template from the Reports list box.  
3. Click Edit.  
4. Modify the report template as described previously. 

Creating a Documentation Report 

To create a documentation report: 

1. Select Documentation from the Repository Window View menu.  
2. Right click the desired documentation object. 
3. Select the Run Report option.  
4. Ultimus compiles the report and opens Microsoft Word to display the 

results. 



Working With Form Object Library Editor 

Ultimus BPM Studio includes the timesaving feature, which allows you to create 
and save reausble "form objects" in a library. A standard set of form controls can 
be grouped and saved in the Form Object Library (FOL) for insertion in any 
Ultimus Form in a process. Controls and objects in the Form Object Library retain 
their positioning, spreadsheet/recordset/action links, and formatting properties. 

This allows designers to easily create consistent forms. Any change to an object 
in the library can be propagated to all of those objects in all Ultimus Forms.  

Creating Form Object Libraries 

Form Objects can be used in different steps or different processes. When an 
object is modified, the changes can be inherited by all steps and processes, 
which use that Object (for more information, see the subsection "To update 
objects in a Form"). Forms objects can be reused without limitations. They retain 
all original formatting, such as size, color, variable links, scripts, recordset/action 
links, and position, and can also be moved to a new location. 

To create a form object library: 

1. Right-click on the Form Object Libraries node in the Repository View 
Window and select New from the menu.  

2. Right-click on the 'NewFOL' node and select new from the menu. The 
following dialog appears. 
 

 

3. Enter the name of the new object in the Object Name field.  
4. Click OK. The object appears under the 'NewFOL' node.   

To modify form objects in a library: 

1. Right-click on the object and select Check Out from the menu.  
2. Right-click on the checked-out object and select Edit from the menu.  
3. The object may also be dragged and dropped to the main window to open 

in the FOL Editor.  
4. Make the desired changes, close and save the form and check the form 

back in.  



To create a folder: 

Right-click on the Form Object Libraries node in the Repository View Window 
and select Create Folder from the menu. A 'Form Objects' node is added. 

To rename an object in a library: 

Right-click on an object in the Form Object Libraries node in the Repository View 
Window and select Rename from the menu. The object is renamed. 

Note: The Form Object Library must be checked-out before the Object is 
renamed. 

To delete an object from a library: 

Select the object in the Form Control Library tree and click on the Delete button, 
or right-click on the object and select Delete Object. 

Note: The Form Object Library must be checked-in before an  Object is 
deleted. 

To insert objects in a form from the Form Object Library tree node: 

• Open the form on to which the objects are to be inserted 
• Drag and drop the desired FOL object node from the tree on the open 

form  
• Inserted objects appear with a blue background. 
• The top of the form object appears at the mouse position. 

Note: If an attempt is made to add FOL objects previously present in the 
form, the following dialog appears 



 

This dialog shows all the conflicts, which appear on the form. The conflict can be 
in controls, Recordset/actions and Variables. When you click OK, previous 
controls, their links, variables and recordset/actions are overwritten.  

To update objects in a Form:  

When changes are made to an FOL object, the changes can be propagated to all 
areas where the object is referenced by following the steps below: 

1. Check Out a process  
2. Edit the process in Build Editor by selecting Edit (Build) from the Object 

menu  
3. Select 'Update FOL objects in Map' from the Tools menu.  
4. The List of Objects to be Updated window appears. The red X changes to 

a green checkmark when it is double clicked.  



 

 

5. Click the Update Map button to apply the changes to the process.  

Using controls from existing forms: 

This allows you to get controls from existing processes into the FOL. To do so 

1. Open a process in Build Editor 
2. Copy the desired Controls 
3. Close the Build Editor 
4. Open FOL object in FOL Object Editor 
5. Select Paste 

Using Recordsets with Form Objects 

Ultimus also allows you to add recordsets to form objects. When a recordset-
linked control is placed on a form, the recordset links are preserved. This allows 
you to easily insert commonly used controls that are linked to recordsets. For 
example, you may want to use in list box linked to a data record of product stock 
numbers in a series of forms.   

To create a form object linked to a recordset/database action: 

Insert a control on the form and link it to a recordset or a database action. For 
complete details on linking recordsets to controls, see "Using Databases with 
Forms."   
  



Advanced Design Features 
In this chapter, we discuss some advanced BPM features offered by Ultimus. 
Some of these features include the ability to set periodic launches for Ultimus 
process, and leveraging dynamic groups and dynamic routing They are as 
follows: 

• Dynamic Groups  
• Dynamic Routing Based On Cell Contents  
• Indexed Links  
• Periodic Launches  
• Initiating Processes via Web Links  
• Maplet Steps  
• Repeating Maplet Steps  
• An Example of Using Periodic Launches and Repeating Maplet Steps  
• Working with Databound Variables  
• Using Scripts  
• System Variables  

  



Dynamic Groups 

As discussed in "Designing Process Maps," each Step in a workflow process has 
a "recipient" who performs the task at that Step. The recipient is specified when 
you design the workflow, either by providing a user name, a job function, or a 
group. A group is a collection of users that you define in the Organization Chart. 

These different ways of specifying the recipient assume that you have prior 
knowledge of who the recipients will be. That is, you must decide who the 
recipients are when you design the process. The individuals who launch a 
process incident, or participate at some other Step in the process, cannot decide 
who will be the recipient of some subsequent Step. 

For some types of workflow processes, it may be advantageous to enable the 
individual who participates in the process to decide, at the time an incident of the 
process is executed, who the recipient will be for a subsequent Step in the 
process. For example, if you want to create a process which forwards a 
document for review by several individuals, you do not know when designing the 
process who the reviewers will be. You may want the flexibility of designing a 
process that allows the individual who launches a process incident to decide who 
will review the documents. The "dynamic group" feature allows you to do just 
that. Dynamic groups are defined as the process is executed. For each incident 
of the process, the recipients may be different. This capability is also sometimes 
called "ad hoc" routing. 

Define a Dynamic Group for a Step 

A dynamic group for a Step is defined by selecting any one of the following 
recipient types for the Step: 

• Cell Contents: The step recipient is the individual named in a 
spreadsheet cell.  

• Supervisor Cell Contents: The step recipient is the supervisor of the 
individual named in a spreadsheet cell.  

• Manager Cell Contents: The step recipient is the manager of the 
individual named in the spreadsheet cell.  

• Relative Job Function (Cell Contents): The step recipient is the job 
function closest to the individual named in the spreadsheet cell.  

If one of these recipient types is selected, you then select the name of a single 
column cell range in the main spreadsheet as the recipient. The contents of the 
cell range in the main spreadsheet are used to define the dynamic group. It is up 
to you to ensure that the cell range is populated by registered names. When the 
Step is invoked, the BPM Server looks at the cell range and uses the contents to 
determine the recipients of the Step. 



To define a dynamic group: 

1. Use the Data View to name a range of one or more cells in the main 
spreadsheet. For example, you can call this range by the name 
"Reviewers."  

2. Go to the Map View.  
3. Right-click on the user step for which you want to define the dynamic 

group and select Properties. The User Step Properties window appears. 
 

 

4. Select either Cell Contents, Supervisor Cell Contents, Manager Cell 
Contents, or Relative Job Function (Cell Contents) from the Recipient 
Type combo box.  

5. The Recipient combo box now contains a list of all named cells and cell 
ranges in the main spreadsheet. Select a cell name or range, such as 
"Reviewers." When this Step is invoked, the BPM Server looks at the 
contents of the range to find out who the recipients are for the Step. It is 
up to you to make sure that the range named in the main spreadsheet is 
populated by valid user names. If any cell in the range is blank, the BPM 
Server ignores the cell.  

6. Enter a minimum response number in the Min Resp. field if it is not 
necessary for all members of the dynamic group to perform the task.  

Note: It is up to you to decide how the range will be populated based upon 
your workflow logic. You can do this by having a user type the names in a 
form and link it to the main spreadsheet, read names from a database, or 
by using a server-side DLL to populate the names. This gives you a lot of 
flexibility in deciding who will be members of the group. Group members 
can be both user names and Job Functions. 

A Simple Example of Using Dynamic Groups 



We want to design a process which allows an employee to solicit and receive 
feedback from three reviewers. The reviewers are selected by the employee 
when she launches the process incident. The process map appears as follows: 

 

The recipients for each Steps are declared as follows:  

Step  Recipient 
Type  Recipient Comments  

Begin  Group  All 
Employees  

Any employee can launch a process 
incident.  

Review  Cell 
Contents  "Reviewers" 

Contents of the range named "Reviewers" in 
the main spreadsheet determine the 
recipients.  

Feedback Initiator     Feedback is given to individual who 
launches process incident.  

The form and the local spreadsheet for the Begin Step appear as follows: 

 

Note that each of the three fields in the form are linked to cells B1, B2, and B3 in 
the local spreadsheet of the Begin Step. 

The main spreadsheet for the process is shown below: 



 

The main spreadsheet B1:B3 are named as a global variable, "Reviewers." The 
process works as follows: 

1. An employee initiates a process incident with the Begin Step form. The 
employee names the three reviewers.  

2. The names of Reviewers #1, #2, and #3 are entered in cells B1, B2, and 
B3, respectively, of the local spreadsheet. The three edit fields in the form 
are linked to these cells.  

3. When the employee "sends" the form to launch the incident, the contents 
of B1, B2, and B3 in the local spreadsheet are sent to cells B1, B2, and B3 
in the main spreadsheet because these cells are linked as the global 
variable called "Reviewers."  

4. The BPM Server invokes the Review Step. The recipient type for this Step 
is specified as "Cell Contents" and the recipient is the range B1:B3 named 
"Reviewers." The BPM Server looks at the contents of the range B1:B3 
and sends the Review Step form to the individuals named in cells B1, B2, 
and B3.  

5. When the Review Step is complete (i.e., the individuals named in B1, B2, 
and B3 have completed their tasks), the BPM Server invokes the 
Feedback Step. The Initiator is the Step recipient.  



Dynamic Routing Based On Cell Contents 

Ultimus allows you to dynamically route workflow to users, groups, job functions, 
job function groups, and departments on an ad hoc basis determined by cell 
contents. In the workflow, the user names the individual recipient, the group, job 
function group, or department previously defined in the Org Chart and the 
workflow is routed based on the user's selection. 

The data entered by the user must adhere to the following format and entered as 
the contents of a spreadsheet cell: 

  Format/Content Example 
To route to a 
User [User_Name] Lisa Evert 

To route to a 
Group  GROUP:[group_name] GROUP:ECO 

Committee 
To route to a 
Job Function [chart_name]\[job_function_name] Marketing\Publishers

To route to a 
Job Function 
Group 

JFG:[chart_name]\[job_function_group_name]JFG:MIS\Tech 
Support 

To route to a 
Department DEPT:[department_name] DEPT:Marketing 

If you are using domain prefixes: 
To route to a 
User DOMAIN:[domain_name]\[user_name] DOMAIN:Admin\Lisa 

Avert 

Notes: There cannot be any spaces between the colon and the group, job 
function group, or department name. If there is a space, the workflow is 
routed to the SYSTEMUSER. In case of user name, you can specify either 
short or full name. 

It is the responsibility of the user to enter correct user name, group name 
etc. If in the cell content, the name of a non-existent user, group etc. is 
specified, the task is routed to the inbox of a dummy user. If this scenario 
becomes true, the task routed to dummy user will have to be re-assigned 
by the workflow administrator. 

For details about domain prefixes, see the Ultimus Administrator Help. 

Workflow tasks are sent to all the members of the named group, job 
function group, or department simultaneously. 

Examples of Using Dynamic Routing Based on Cell Contents 



In our Org Chart for DEF, Inc., we have three groups defined: ECO Committee, 
Review Committee, and Social Committee. In the following two examples, we'll 
use a simple two-step process to route the workflow to one of the committees 
based on the contents of a cell. In the first example, we'll type the name in an edit 
field. In the second, we'll select the group from a combo box. These examples 
assume that you have a working knowledge of Ultimus and can easily define 
spreadsheets, place controls, and set the properties for steps in a workflow map. 

Notes: The examples given only demonstrate groups; however, the same 
principals are true for job function groups and departments. 

In order to perform the steps in the examples below, you should have at 
least one group defined in your org chart. 

To dynamically route workflow based on cell contents entered in an edit 
field: 

1. Create a process map with two steps, the Begin Step and one user step, 
which we will name "Group" at a later step. 

 
2. Create a global variable in the main spreadsheet called "Reviewers." In 

this case, we used cell B1.  
3. In the Begin Step, create a simple form with an edit field labeled "Group" 

and link it to the "Reviewers" global variable. 

 
4. Return to the Map View and open the Step Properties for the Begin Step. 

Set the user to someone in your org chart.  
5. Open the Step Properties for the Group step (Step 2 if you haven't named 

it yet). 

 



6. Label the step, select Cell Contents as the Recipient Type, and select the 
"Reviewers" workflow variable as the Recipient.  

7. Simulate the process . Open the form for the Begin Step and type the 
following in the edit field, "GROUP:ECO Committee" (no quotes). 

 
8. Send the form. The Simulation returns to the process map and the Group 

step is activated.  
9. Click on the group step and a pop-up menu appears, displaying all of the 

members in the group. Select a group member to open the form (which in 
this case is blank). You may click the Send button to complete the step 
and do the same for all members of the group to complete the process.  

Using the same process, we can also name the recipient of the Group step 
based on the selection from a combo box. 

To dynamically route workflow based on cell contents entered in a combo 
box: 

1. Create a process map with two steps, the Begin Step and one user step, 
which we will name "Group" at a later step. You may use the same  

2. Create a global variable in the main spreadsheet called "Committees." In 
this case, we used cell B6.  

3. Go to the local spreadsheet for the Begin Step and enter the following 
data in the spreadsheet cells shown:  

Cell Address Type In This...  
B7  GROUP:ECO Committee  
B8  GROUP:Review Committee 
B9  GROUP:Social Committee 

4. Open the form for the Begin Step and insert a combo box labeled 
"Committees" and link it to the "Committees" global variable. 

 
5. Open the Control Links for the combo box and type "B7:B9" in the Source 

Cell(s)/Variable field. 

 



6. Return to the Map View and open the Step Properties for the Begin Step. 
Set the user to someone in your org chart.  

7. Open the Step Properties for the Group step.  
8. Label the step (if you haven't done so already), select Cell Contents as the 

Recipient Type, and select the "Committees" workflow variable as the 
Recipient.  

9. Simulate the process . Open the form for the Begin Step and select a 
committee from the combo box. 

 
10. Send the form. The Simulation returns to the process map and the Group 

step is activated.  
11. Click on the group step and a pop-up menu appears, displaying all of the 

members in the group. Select a group member to open the form (which in 
this case is blank). You may click the Send button to complete the step 
and do the same for all members of the group to complete the process.  



Indexed Links 

When a step with a "group" as the recipient is invoked, the form for that step 
goes to all users named in the group. The form and local spreadsheet for the 
step is actually replicated and a copy is sent to each user named in the group. If 
the task involves collecting information from the group, the contents of the form 
are placed in the local spreadsheet. Since there is a local spreadsheet for each 
user, the information entered goes into the local spreadsheet at the user's 
computer. 

If the cell in the local spreadsheet is linked globally to a single cell in the main 
spreadsheet, the data entered by all the users goes into the same cell in the 
main spreadsheet. Therefore, you will be unable to collect the information from 
the entire group in the main spreadsheet. You will get only the input from the 
user who happens to perform the step task last. 

Indexed links are designed to solve this problem. A link from the local to the main 
spreadsheet can be specified as output indexed. Instead of transferring the 
contents of a local spreadsheet cell to the main spreadsheet cell to which it is 
linked, the row address of the main spreadsheet cell is incremented by one each 
time the link is executed. Thus, if cell B1 in the local spreadsheet is linked to cell 
B1 in the main spreadsheet and the link is configured as output indexed, the first 
response from the group goes to B1, the second goes to B2, the third goes to B3, 
and so on. 

Defining Indexed Links 

Defining indexed links between local spreadsheet cells and main spreadsheet 
cells is described in "The Data View." When defining the link, be sure to select 
"Output Indexed" as the data flow. 

An Example of Using Indexed Links 

Let us expand the example of using dynamic groups provided in the previous 
section to illustrate the use of Indexed Links. For the Review step, we want each 
reviewer to enter their name and a numeric grade between 0 and 100 based on 
their review. In the last Feedback step, we want the initiator to be notified of the 
name of each reviewer and the numeric grade given by the reviewer. 



To provide this capability, we can design the form for the second Review step as 
follows: 

 

Ultimus can automatically enter the user's name when the form is invoked. To do 
so, select the edit field and open the Control Links window. Select "User Name" 
from the Source Cell(s)/Variable combo box and enter "D5" in the Destination 
Cell(s)/Variable combo box. When the process is run, the name of the user filling 
in the form will end up in cell D5 of the local spreadsheet. This can be done with 
any control. 

The Grade edit field is linked to cell E5 of the local spreadsheet. In the Properties 
window for this field, we have declared it to be a required, numeric only field with 
a range between 0 and 100. Thus, when the user invokes the form, she will be 
required to enter a grade in the range 0 to 100. The grade is sent to cell E5 of the 
local spreadsheet. 

The local spreadsheet of the Review step is linked to the main spreadsheet as 
follows: 

 

Note that each Link from the local spreadsheet to main spreadsheet is specified 
as Output Indexed. This means that the contents of D5:E5 in the local 
spreadsheet of the first responding recipient in the group are written to cells 
D5:E5 in the main spreadsheet. The row address of the main spreadsheet linked 
cells are then "indexed," or incremented by one. The contents of D5:E5 in the 
local spreadsheet of the second responding recipient, therefore, are written to 
cells D6:E6. Next, the contents of D5:E5 in the local spreadsheet of the third 
responding recipient are written to cells D7:E7. 



Once we have gathered the names and grades assigned by each Review step 
recipient, we pass this information to the Feedback step. The form for the 
Feedback step is as follows: 

 

The three Reviewer edit fields are linked to cells D5, D6, and D7, and the three 
Grade fields are linked to cells E5, E6, and E7 of the local spreadsheet. 
Furthermore, the local spreadsheet of the Feedback step is linked to the main 
spreadsheet as follows: 

 

Note that each link from the main spreadsheet to the local spreadsheet is an 
input. This means that the contents of the range D5:E7 in the main spreadsheet 
are written to the cell range D5:E7 in the local spreadsheet. 

Thus, the Review and Feedback steps behave as follows: 

1. When the BPM Server invokes the Review step, it sends the form to the 
three recipients in the range named "Reviewers" (described previously in 
the section "Dynamic Groups").  

2. When the first Reviewer responds, her name and the numeric grade she 
assigned go to main spreadsheet cells D5 and E5, respectively.  

3. When the second Reviewer responds, his name and grade go to the main 
spreadsheet cells D6 and E6.  

4. Likewise, when the last reviewer responds, main spreadsheet cells D7 
and E7 receive the name and the grade assigned by the last Reviewer.  



5. The BPM Server then determines that the Review step is complete 
because all the recipients have responded. It then invokes the Feedback 
step.  

6. When the Feedback step is invoked, the BPM Server sends the contents 
of the range D5:E7 in the main spreadsheet to the same range D5:E7 in 
the local spreadsheet of the Feedback step. The BPM Server also knows 
that the recipient for Feedback step is the initiator. When the initiator 
invokes the form for the Feedback step, he receives the names and the 
grades assigned by each of the Reviewers.  

Note: Ultimus also supports Input Index, which is the reverse of Output 
Index. With Input Index, you can actually send different pieces of 
information to different members of the group which will appear in the 
same form. 



Periodic Launches 

Most workflow processes are launched by individuals. However, in some cases it 
is advantageous to launch a process automatically on a periodic basis. For 
example, if a company implements a weekly Time Sheet process, the process 
launches automatically every Friday morning. When the employees come to 
work, their Time Sheets are ready and waiting to be filled out. This takes out the 
human factor of someone having to launch the weekly Time Sheet process 
manually. 

Other examples of processes that can be launched periodically are as follows: 

• Monthly Departmental Forecasts  
• Annual Performance Reviews  
• Weekly Order Reports  

Any process that is done repetitively on a periodic basis benefits from this 
feature. 

Defining Periodic Launch Steps 

A periodic launch step is a special case of the Begin Step. 

To configure a Periodic Launch step: 

1. After defining the workflow map, select the Begin Step.  
2. Right-click on the Begin Step and select Properties. The Begin Step 

Properties window appears. 

 
3. Use the Launch Type combo box to select a periodic launch type, such as 

"Every Monday," "Every Friday," or "Every First of the Month." The 
following is the complete list of periodic launch types:  



Every Sunday  Every Monday  
Every Tuesday  Every Wednesday 
Every Thursday  Every Friday  
Every Saturday     
First of Every Month Last of Every Month 
Day of the Month  Every Day  
Every Hour     

4. If you Select a "Day of the Month" launch type, select the day you want 
the process launched from the Day of the Month combo box.  

5. Select the launch Frequency (between 1 and 10) from the Frequency 
combo box. For example, if you select the launch type "Every Monday" 
and a Frequency of 5, the process is launched automatically every fifth 
Monday.  

6. If you select a launch type of "Every Day," or "Every [Day_of_Week]," you 
may also specify an exact hour, such as 08:00 AM. If no launch time is 
specified, it defaults to 00:00 AM. Time of day is defined in 24 hour time.  

7. Click OK.  

Note: When a Begin Step is configured for a periodic launch, the process is 
launched automatically without any user involvement. Therefore, the Begin 
Step does not need a form or local spreadsheet. If you define a form and 
local spreadsheet for a Begin Step which has been configured for periodic 
launch, they are ignored. 



Initiating Processes via Web Links 

Ultimus processes can also be initiated via from a web page link. For standard 
recipient types (e.g., user, job function, department), the user must enter her user 
name and password before she can access the Begin Step form. However, if 
Anonymous User has been named as the recipient, anyone who accesses the 
link can launch the process. Using the web link in conjunction with the 
Anonymous User is very helpful for processes in which the initiator does not have 
any input into the process beyond the Begin Step. 

To create a link in your web page for the process, you must adhere to the 
following format: 

http://[Server_Name]/ultweb/ultisapi/ultisapi.dll?[Process_Name] 

e.g.: http://myserver]/ultweb/ultisapi/ultisapi.dll?Expense Report 

For registered users, a login page appears. 

 

After the user enters his login information, the form page appears, bypassing the 
Client. Using this method, the Client user is given a choice of accessing the 
Standard Form or thin form for the process. Anonymous Users are taken directly 
to the form (though, if this is the first time the user accesses Ultimus, she will 
have to wait for the controls to download). 



You may also set up the link to take Client users directly to the thin form via a "/t" 
switch at the end of the link. 

http://[Server_Name]/ultweb/ultisapi/ultisapi.dll?[Process_Name]/t 

If this link is used with a process that has a registered user named as the Begin 
Step recipient, the user still has to log in before accessing the form. 



Maplet Steps 

A Maplet step invokes a workflow process from within a process. This function 
allows you to design workflow processes that are modular, manageable, and 
properly structured. It also enables you to break complex workflow processes 
into simpler sub-processes. 

For example, most companies have a formal procedure for Engineering Change 
Orders (ECOs). When an employee suggests an engineering change to improve 
a product or eliminate a defect, generally, the request must be approved by 
several individuals in Engineering, Manufacturing, and Marketing. If the change is 
approved, a formal ECO is issued which goes through its own sequence of steps 
until the change is made and documented. Instead of designing one complicated 
process, it is more advantageous to break this down into two workflow processes 
-- the Engineering Change Request (ECR) process and the ECO process. The 
ECR process can automatically trigger the ECO process if the change request is 
approved. 

Defining a Maplet Step 

To define a Maplet step: 

 

1. Insert a Maplet step in the workflow map as described in "Designing 
Process Maps"  

2. Right-click on the Maplet step and select Properties. The Step Properties 
window appears. 

 
3. Type the name of the Maplet step in the Label field.  
4. Click the browse button beside the Maplet Name field and select the 

process to be launched at this step.  



5. Type a number in the "Repeat Count" combo box, or select a workflow 
variable if you want the Maplet to repeat. if you leave this field blank, it will 
only be launched once. For more information on multiple launches, see 
the next section, "Repeating Maplet Steps."  

6. Check the "Wait for Completion" box if you want the calling process to wait 
for the completion of the Maplet before proceeding to the next step in the 
process.  

7. Check the "Transfer Global Variables" checkbox if you want to transfer the 
global variables (and their values) of the calling process to the Maplet.  

Notes: When you transfer global variables, the global variables are 
linked and then transferred to the exact same cells in the main 
spreadsheet of the Maplet. For this reason, care should be taken in 
designing spreadsheets for Maplets so that they match the parent 
process. 

You may also link main spreadsheet variables to any cell location in 
the local spreadsheet of the Maplet step. These variables are then 
passed to the sub-process. This is helpful if the main spreadsheets 
of the processes do not match and you are, therefore, unable to use 
global variables. This is handled in the same manner as linking local 
variables to main spreadsheet variables for any step (see "The Data 
View.") 

8. Click OK.  
9. Switch to the Data View . You will notice that Ultimus BPM Studio has 

automatically copied the local spreadsheet of the Begin Step for the 
Maplet and inserted it as the local spreadsheet of the Maplet step.  

Notes: Make sure that the cells linked to the form of Begin Step in the 
Maplet receive the correct data from the main spreadsheet of the calling 
process. 

If you want to launch the Maplet on a conditional basis, right-click on the 
step and select Event Conditions. Use the event conditions table to define 
the conditions under which the Maplet step is invoked. The event 
conditions table is described in "Documenting Event Conditions ." 

When the Maplet step is invoked, the BPM Server sends the contents of the 
linked cells from the main spreadsheet to the local spreadsheet of the Maplet 
step. The BPM Server automatically launches the Maplet by taking the form for 
the Begin Step and filling all fields with the contents of the local spreadsheet. 
Thus, an incident of the Maplet is launched automatically by using data passed to 
it by the calling process. 

Viewing Maplets 



Ultimus allows you to view the workflow map of a Maplet from the parent 
process. This is very helpful when designing a process that uses a Maplet 
created by another designer. Maplets can only be viewed from inside the parent 
process, they cannot be edited. 

To view a Maplet: 

• Double-click the Maplet step in the workflow map. The Maplet View 
window appears and displays the Maplet. 

 

Note: This feature will only work if the ".wfl" files of child 
process and parent process are in the same directory. 

Defining a Process as Maplet Only 

Maplets can be complete processes that are used independently, or partial 
processes that are only used in within other processes. For partial processes, it 
is best to define them as Maplet Only. Maplet Only processes can only be 
launched as Maplets and do not show up within the Ultimus Client. Likewise, they 
do not count as installed processes. 

To define as process as Maplet Only: 

1. Open the Begin Step properties for the Maplet process. 

 
2. Select Maplet Only from the Launch Type combo box.  



Repeating Maplet Steps 

A Maplet step can be repeated multiple times. This powerful capability allows one 
process to launch multiple incidents of another process. This allows you to 
design a process which spawns many incidents of another process. 

For example, in many companies it is normal for every employee to be reviewed 
annually. This review is typically given in the month the employee joined the 
company. Thus, the employee review process actually consists of two distinct 
processes: 

Process 1: At the start of every month, someone in Human Resources creates a 
list of all the employees who joined the company that month. 

Process 2: For every employee whose anniversary is in that month, the Human 
Resources person has to initiate a Review process. 

Defining Repeating Maplet Steps 

Repeating Maplet steps are defined exactly the same way as Maplet steps 
(described in the previous section) with the following two exceptions: 

1. In the Step Properties window for the Maplet, the "Repeat Count" combo 
box is used to select a named main spreadsheet cell that contains a 
repeat count. The BPM Server uses the contents of this main spreadsheet 
cell to determine the number of times the Maplet step is invoked.  

2. The links between the cells in the main spreadsheet and the local 
spreadsheet of the Maplet step determine the data passed from the main 
spreadsheet to the local spreadsheet. Once the data is in the local 
spreadsheet, it may be passed to the Begin Step of the Maplet as 
discussed above. When the Maplet step has a repeat count of more than 
one, the main spreadsheet cell links are indexed. For this reason, you 
cannot use global variables in Repeating Maplet steps. You must use 
Input Indexed Links.  

For example, we create the following links between the main spreadsheet and 
the local spreadsheet of the Maplet: 

 

If the repeat count is 3, the Maplet step is repeated 3 times, one after the other. 
The first time, the contents of D5:E5 in the main spreadsheet are passed to the 
local spreadsheet of the Maplet step, then the Maplet is launched. The second 
time, the contents of D6:E6 in the main spreadsheet are passed to the local 



spreadsheet, then the Maplet is launched. The third time, the contents of D7:E7 
in the main spreadsheet are passed to the local spreadsheet, then the Maplet 
launched. 

This capability allows you to invoke a Maplet step multiple times as controlled by 
the contents of a cell in the main spreadsheet. Each time the Maplet step is 
invoked, a different set of values may be passed to the local spreadsheet of the 
Maplet step, and from there to the Begin Step of the Maplet. 



An Example of Using Periodic Launches and Repeating Maplet 
Steps 

In this example, we describe a process that demonstrates the use of Periodic 
Launches, Flobot steps, and repeating Maplet steps. In our example process, we 
want to accomplish the following: 

1. The Performance Review process is launched periodically the first day of 
the month, every month.  

2. It searches the company's Employee database to find the names of all 
employees who joined the company in the current month. For the purpose 
of this example, the number of employees whose reviews are due each 
month does not exceed 10.  

3. The Performance Review process then launches a number of Individual 
Review Maplets, one for each employee who joined the company in the 
current month.  

4. The first step of the Individual Review Maplet is completed by the 
Supervisor of the employee.  

5. The last step of the Individual Review Maplet is completed by the Human 
Resources Manager.  

In the following pages, we describe the most significant aspects of designing 
such a process. We focus on the advanced features discussed in this chapter 
and elsewhere in the manual. For the sake of brevity, we do not cover the details 
of designing the forms for each step. 

First, we discuss the Individual Review Maplet. The process map for the 
Individual Review is as follows: 

 

The steps for this process are configured as follows using the step Properties 
window:  

Step  Recipient 
Type  Recipient  Comments  

Begin  Job Function  HR Manager  The HR Manager can launch a process 
incident.  

Supervisor Supervisor 
Cell Contents  

Supervisor of 
"Employee"  

The Supervisor of the employee named 
in the cell "Employee" in the main 
spreadsheet is the recipient for this 
step.  

HR  Job Function  HR Manager  The HR Manager reviews and 
completes the review.  



Note that for the Supervisor step, we declare a dynamic group with one member. 
The employee who is to be reviewed, and consequently the supervisor of the 
employee, is determined by the HR Manager when she launches the process 
incident. 

The form for the Begin Step of the Individual Review process appears as follows: 

 

The Employee, Current Salary and Current Rating edit fields are linked to cells 
A1, B1 and C1 in the local spreadsheet of the Begin Step. The local spreadsheet 
of the Begin Step is linked to the main spreadsheet as follows: 

 

Cell A1 in the main spreadsheet is labeled "Employee." 

The Individual Review process behaves as follows: 

1. When the HR Manager initiates the process incident, she is required to fill 
in the form for the Begin Step shown above. She enters the name of the 
employee to be reviewed, his current salary, and current rating in the form 
fields provided. For example, she enters "John Doe" for the employee 
name.  

2. The employee name, current salary, and current rating go into cells A1, 
B1, and C1 of the local spreadsheet.  

3. When the HR Manger "sends" the form, the contents of A1:C1 in the local 
spreadsheet are sent to the cells A1:C1 in the main spreadsheet because 
of how we defined the links. Cell A1 in the main spreadsheet is labeled 
"Employee" and gets the name "John Doe," the employee to be reviewed.  



4. The BPM Server then invokes the next step, labeled Supervisor. It 
determines that the recipient type is "Supervisor Cell Contents" and the 
recipient is the cell named "Employee," whose current content is "John 
Doe." The BPM Server, therefore, sends the task to the Supervisor of 
John Doe. By linking main spreadsheet cells with the cells in the local 
spreadsheet of the Supervisor step, you can pass other information to the 
step.  

5. When the Supervisor step is complete, the BPM Server invokes the final 
step, labeled HR.  

The Performance Review process uses the Individual Review process described 
above as a Maplet. The process map for the Performance Review Maplet 
appears as follows: 

 

The periodic launch step is configured as follows:  

Launch Type: First Day of Month 
Frequency:  1  
Since the Begin Step is configured for periodic launch there is no need to specify 
a form and local spreadsheet for the step. 

The second step is a Flobot step configured as follows:  

Flobot Name: ODBC 
The Database Flobot for this step is trained to search the Employee database 
and fill the range A1:C10 in the local spreadsheet with the results of the search. 
The search is programmed to check the database for all employees who joined 
the company in the current month. The names of the Employees are returned in 
cells A1:A10, their current salaries are returned in cells B1:B10 and their current 
rating are returned in cells C1:C10. Furthermore, the Flobot is trained to return 
the count of the number of records found in cell D1. 

The local spreadsheet for the Database Flobot step is linked to the main 
spreadsheet as follows: 

 



The third step is a process step and is configured as follows:  

Launch Process: Individual Review Process 
Repeat Count:  "Review Count"  
Cell D1 in the main spreadsheet is named "Review Count." 

The local spreadsheet of the process step is linked to the main spreadsheet as 
follows: 

 

Since the launch process for the process step is the Individual Review process, 
we can link the field in the first step of the Individual Review process to the local 
spreadsheet cells as follows:  

Field  Local Spreadsheet Cell
Employee  A1  
Current Salary B1  
Current Rating C1  
The Performance Review process behaves as follows: 

1. The periodic launch step is invoked automatically by the BPM Server on 
the first day of each month.  

2. The BPM Server then invokes the Database Flobot step.  
3. The Database Flobot queries the Employee database and find the names, 

current salary, and current ratings of all employees who joined the 
company in the current month. These records are saved in the local 
spreadsheet range A1:C10. Moreover, the Flobot returns the number of 
records found to local spreadsheet cell D1.  

4. When the Flobot step is complete, the contents of A1:C10 and D1 in the 
local spreadsheet are transferred to the corresponding cells in the main 
spreadsheet.  

5. The BPM Server then invokes the process step. It knows that the process 
step has to be repeated the number of times specified in cell D1, named 
"Review Count." It also knows that the process to be launched is the 
Individual Review process.  

6. The BPM Server transfers the contents of main spreadsheet cells A1, B1, 
and C1 to cells A1, B1, C1 in the local spreadsheet of the HR Manager 
Client.  

7. It then launches the Individual Review process. The Client takes the 
contents of cells A1, B1, and C1 in the local spreadsheet and uses them 



to automatically fill the Begin form of the Individual Review process and 
launch an incident.  

8. The BPM Server repeats the Previous step by the number of times 
specified in main spreadsheet cell D1, named "Review Count." This cell is 
filled with the number of records that were found by the Database Flobot 
in the Previous step. Each time the BPM Server invokes the process step, 
it indexes, or increments, the main spreadsheet cell addresses linked to 
the local spreadsheet of the process step. Thus, the second time the 
process step is invoked, the contents of A2, B2, and C2 from the main 
spreadsheet are transferred to A1, B1, C1 in the local spreadsheet. The 
third time the contents of A3, B3, and C3 from the main spreadsheet are 
transferred to A1, B1, C1 in the local spreadsheet of the process step. 
This repeating process causes the Individual Review process to be 
launched the number of times specified by the "Review Count" cell. For 
each launch, a different employee, current salary, and current rating is 
filled in the Begin Step form.  

This example demonstrates the power of using a database search to launch 
multiple incidents of a process. Likewise, more complex processes may be 
designed using these advanced features. 



Working with Databound Variables 

Workflow variables can be used as databound variables. Every databound 
variable is linked to a distinct database field. During the execution of the workflow 
process, whenever a workflow Incident is initiated and executed, the Ultimus 
BPM Server automatically updates the linked database fields after every step. 
Before a workflow variable can be declared as a databound variable, the process 
map must be linked to a database table in the Map Properties (see "Designing 
Process Maps"). The example given below explains the usage of databound 
variables. (The reader is assumed to have a fair knowledge of Ultimus BPM 
Studio)  

Using Databound Variables 

In general databound variables are used to store information about individual 
workflow incidents and tasks. If in a particular business process, all the tasks on 
a step are identified using a corresponding invoice number, its better to list tasks 
by invoice number than by process name. By default the task list in Ultimus client 
displays following information against every task: 

• Process Name 
• Summary 
• Incident Number 
• Step 
• Priority 
• Time Due 
• Client 
• Process Owner 
• Process Version 

This information is displayed for every task in Ultimus Client as shown in the 
snap below.  

      



Using databound variables, you can change the information displayed for every 
task. This proves very helpful for the users participating in a workflow process 
and sometimes this may even become a requirement to display custom 
information in the client list. For example the task list for the above mentioned 
process will look much more meaningful to a user if it displays the following 
information for every task: 

      

This example illustrates how databound variables can be used to store custom 
information about individual tasks. Assume we want to display the Invoice 
Number, Shipment Date and Company in the client list. To create such a 
workflow process using Ultimus BPM Studio follow the steps given below: 

Step A: Create a database table 

• Databound variables are workflow variables linked to a database field. To 
create databound variables in Ultimus BPM Studio, you need a database 
table that must have two fields with following settings: 

Field Name Data type 
Name char(16) 
Incident Int(4) 
   

• In this example we use SQL Server to create a table for storing 
information entered in databound variables. For the purpose of ease, 
Northwind database has been used. This sample database is included 
with SQL Server. On the database server, open Enterprise Manager and 
browse to the Northwind Database, as shown in the picture below: 



 

• Right click on the node Tables and select the option "New Table". The 
'Create New Table' dialog appears. On this dialog create a table as shown 
in the snap below:  



         
 
Note: For any table to be linked to databound variables, it must have the 
fields "Name" and "Incident" as shown above. 

• Save the table with the name of DataBound and close Enterprise 
Manager. 

• Create a DSN with the name "Northwind", pointing to the Northwind 
database. 

Note: For details of DSN creation, contact your network administrator. 

Note: Ultimus does not recommend using databound variables for large 
cell ranges. This may impair the performance. 

Step B: Create Workflow Process 

To create a workflow processes with databound variables, follow the steps given 
below: 

• Open Ultimus BPM Studio and create a new process, as shown below.  



         

• From the File menu, select the option "Map Properties". The Map 
Properties dialog appears. This dialog defaults to General Tab, select the 
'Databound Database' tab. 

• On this tab enter the information as shown below:  

         
 
Note: Contact your network administrator, if you do not know the DSN etc. 

• Click OK on the Map Properties dialog. On Ultimus BPM Studio switch to 
Data View.  

• Select the Main Spread Sheet and declare a variable as shown below:  



 
 
Enter following information on "Main Variable" dialog:  

o Name: Enter "InvoiceNumber" as the variable name. 
o Bound Column: This combo box will list the names of fields in the 

linked databound table. You would notice that the fields "Name" 
and "Incident" are not displayed. These two fields are not displayed 
since these are used and populated by Ultimus. Select the field 
"InvoiceNum". 

o Set the other settings as shown above and click Save button. 
• Repeat the above process to declare two more variables named ShipDate 

and Customer. Link these two variables to bound columns "Shipment" and 
"Customer" respectively.  

• Switch to form view for first step, and design a form as shown below:  



       

 

• On this form link the text box labeled Invoice Number to variable named 
InvoiceNumber, Shipment Date to ShipDate and Company to Customer. 
For details about linking controls to workflow variables see, "Description of 
Control Links". 

• Create a similar form for the step labeled "Approve Invoice". 
• Save the workflow process with the name "Databound Process". 
• Open Ultimus Administrator and install the workflow process. 

Step B: Configure Client and Test Process 

• Once the process has been installed, the client task list can be configured 
to display the databound variables as follows:  

o Open client for the second step user of above designed process. 
o Click the view button. The View Configuration dialog is shown to 

you. Select view "Inbox" and from the Process Name combo box 
select the process named "Databound Process".  



         

o Click on the button labeled "Columns". Column selection dialog 
appears. Uncheck all columns except the last three, as shown 
below:  

         
 
Note: For further details about customized views, please see Ultimus 
Client Manual. 

• Having configured the client view, open client for the first step in above 
created process and initiate two new incidents for the process with 
following data: 
Incident#1  



           
 
          Incident#2  

           

• Open client for user on second step of the above created process and 
switch to the inbox view. Following task list is displayed: 



         
 
The task list displays customized databound columns. 



Using Scripts 

Note: Existing Scripts & DLLs that are called from Event Conditions and 
Control Event Actions are available for viewing only. These have to be 
replaced with the ability to call .NET code, since no changes are allowed to 
existing Scripts & DLL calls.  



Referencing External .NET Assemblies When Calling .NET Code 

BPM Studio provides the ability to call .NET Code from the following areas:  

• Event Actions of Ultimus Forms, Pages and Form Controls 
• Event Conditions in Ultimus Steps  
• The Ultimus .NET Code Flobot  

When calling .NET Code from Ultimus, in certain cases, you may want to 
reference an external Assembly in your .NET Code. In order for Ultimus to 
correctly reference this Assembly, you will need to ensure that this Assembly is 
listed in the Ultimus Global.REF file. The Ultimus Global.REF file can be found in 
the Ultimus /Install Folder/Resources folder.  

If you open this file in Notepad, you will see that the file lists the default 
“System.*.DLL” Assemblies provided with the .NET Framework. By listing these 
Assemblies in the Global.REF file, Ultimus is able to correctly call any .NET Code 
that references these .NET Framework Assemblies. By simply adding the name 
of a .NET Framework Assembly to the Global.REF file (full path to the Assembly 
is not needed), other Microsoft .NET Framework Assemblies can also be 
referenced.  

However, the Global.REF file can also be used to call custom Assemblies that 
are created outside of the .NET Framework. Calling custom Assemblies can be 
accomplished in two ways:  

a. By registering the custom Assembly in the default .NET Assembly Cache 
(Microsoft .NET Framework configuration). In this case, only the name of 
the custom Assembly must be listed in the Global.REF file (example 
“MyAssembly.DLL”) 

b. Or by placing the custom Assembly file into the windows /system32 folder 
on the BPM Server. In this case, the full path of the custom Assembly 
must be placed in the Global.REF file (example: 
c:\winnt\system32\myassembly.dll) 

Referencing Ultimus Enterprise Integration Kit (EIK) .NET Methods from 
Ultimus Processes  

In order to call Ultimus EIK .NET methods from Ultimus processes, you will need 
to ensure that UltEIK.dll (normally at C:\inetpub\wwwroot\ultweb\bin\UltEIK.dll) is 
referenced in the Global.ref file. For real time execution, UltEIK.dll, with all its 
dependencies, should be in Windows system32 folder. 

If you have any additional questions about this functionality, please contact your 
regional support center. 



System Variables 

System variables are workflow variables that are common to the entire process. 
They function in the exact same way as global variables and can be used at any 
Step in the workflow. The only difference is that these are pre-defined. You do 
not have to define or link them. 

Ultimus allows users to display and even modify system variables during the 
process. For example, you can let a user see the priority of the process and 
change it as the situation demands. 

All system variables are saved in pre-defined cells in the main and local 
spreadsheet. Local spreadsheet cells can be linked to the forms to display or edit 
the system variables. The following is the list of available system variables and 
the spreadsheet cells in which they are saved:  

Cell 
Number 

System 
Variable 

Name  
Description  

A10002  
Process 
Name 
(Display Only) 

The name of the workflow process. You may display this 
information, but there is no reason to change it.  

A10003  Priority 
(Modifiable)  

The priority of the workflow. By linking an edit field to this 
system variable, you can have the user specify or 
change the priority of the incident at any Step.  

A10004  Initiator 
(Display Only) 

The name of the person who started the process. This 
field is automatically assigned by Ultimus, based on who 
initiated the workflow incident.  

A10005  
Incident 
Summary 
(Modifiable)  

The incident summary description. An incident is 
identified by the process name, incident number, and an 
incident summary. For good workflow design, you 
should have an incident summary field in the first Step of 
the process, so the initiator can enter a brief description 
of the incident. You can then display the summary in 
other Steps. Also, the incident summary is automatically 
displayed in the Client task list and various places in the 
Ultimus Administrator where incidents are listed.  

A10006  Incident No. 
(Display Only) 

The incident number of the process. The incident 
number is automatically assigned by the Ultimus BPM 
Server after an incident is initiated. You may seed the 
number in the Begin Step when designing the workflow 
process so that it always begins with a certain number 
(see "Designing Process Maps").  



A10007  Disable Abort 
(Modifiable)  If set to 1, the incident cannot be aborted.  

Linking System Variables to Form Controls 

You can link form controls to system variables. In this way, you can use the 
control to display or modify the value of system variables. As shown in the table 
above, some system variables are modifiable, and some are for display only. For 
the modifiable system variables, you must link both the Source and Destination 
for the control. For display only system variables, you only link the source. 

To link system variables to a form: 

1. Create the sample form shown below using the Forms Designer. 

 
2. Select the "Process Name" Edit field, right-click on it, and select "Control 

Links." The Control Links window appears and defaults to the 
Spreadsheet tab.  

3. Select "Process Name" from the Source Cell(s)/Variable combo box. All 
system variables are listed in this combo box.  

4. Click OK.  
5. Repeat steps 2-4 for the Initiator and Incident No. edit fields.  
6. Open the Control Links window for the Priority edit field.  
7. Select "Priority" from the Destination Cell(s)/Variable and Source 

Cell(s)/Variable combo boxes and click OK.  
8. Repeat steps 6-7 for the Incident Summary and Disable Abort edit fields.  



You can test the system variables by creating the form shown previously 
and designing and simulating a two-step process. The first Step is the 
Begin Step and the second is a user Step. When you run simulation, you 
will input values in the Priority, Incident Summary, and Disable Abort edit 
fields. 

 

Notes: Remember that system variables are global variables linked 
automatically by Ultimus and are available at each Step. You do not have to 
worry about linking them to other steps. 

 


